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1.0 OBJECTIVE
Micro-Soft Word 2000 is a popular component of the MS Office 2000. This is a word processor,

which provides various kinds of word processing facilities. The course includes basic concepts of Saving, Edit-

ing, Copying, Paste, Fonts, Mail merge, Font styles, etc. for performing various processing operations on text. This

course is designed to advance user’s knowledge of the formatting features within Word and realize the advantages

of using a powerful electronic processing of word. The course is entirely ‘hands on’, so those reading will get

practice in creating and processing of actual text, enhancing them with Fonts, Styles & advance features like

bullets, borders & colors.

1.1 INTRODUCTION TO MICROSOFT WORD 2000
Word processing software provides a much more easy way of word Processing. Microsoft Word 2000 is

such type of Word Processing Software.  Microsoft Word 2000 is a tool of Microsoft Office 2000.

Word processing software provides following functions

o Creating & Opening a Text Document

o Provide Edit facility (Cut, Copy, Paste, Clear, Redo, Undo, Select All, Find &Replace)

o Spell Checking

o Import/Export Text

o Mail Merge

o Table Handling

o Print preview of text

o Font style and font sizes.

o Graphics

o Templates

o Document wizard

Ø And this word processor can be used in wide range of Applications.

o It can be used for Writing letters

o It  can used to create Resumes

o It can be used for Writing Books

o It can be used to create World Wide Web Pages

1.1.1 Standard Toolbars used  in Microsoft Word 2000

Common Buttons of the Standard toolbars are

(1) New (2) Open (3) Save

(4) E-mail (5) Print (6) Print-Previews

(7) Spell Checker (8) Cut (9) Copy

(10) Paste (11) Format Painter (12) Undo

(13) Redo (14) Insert Hyperlink (15) Tables and Borders

(16) Insert Table (17) Insert Microsoft Excel Worksheet (18) Columns

(19) Drawing (20) Document Map (21) Show/Hide

(22) Zoom (23) Help

These tools are discussed later in this unit with their respective actions.

1 2 3  4 5 6 7 8 9 10 11 12 13 14   15  16 17 18 19 20 21 22 23
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1.1.2 Starting of MS-Word

Microsoft Word is a Windows based word processing application.  Steps to start MS Word 2000 .

A Click on the start button on the Taskbar

A Click on the Program option in start menu.

A Click on the Microsoft word icon.  .

1.1.3 Components of the Word Window

1. Caption Bar 2. Menu Bar 3. Standard Tool Bar 4. Formatting Toolbar

5. Ruler 6. Cursor 7. Drawing Toolbar 8. Status Bar

9. View Buttons 10. Scroll Bars 11. Document Navigator 12. Office Assistant

1.1.4 Function of the Various Components of Microsoft Word Window

1. Title Bar :– Title bar shows the name of the document and situated in the top of the window

application.
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2. Menu Bar :– Menu bar contains the various commands under the various topics to perform some

special tasks. Menu bar is located under the title bar.

3. Standard Toolbar :– Toolbar is nothing more than the shortcut of the Menu options to execute or

perform the menu options in the easiest and faster way. Standard toolbar contains the commands for

 the Word’s most frequently used commands.

4. Formatting Toolbar :– Formatting toolbar contains the various commands related to the formatting

of the document.

5. Ruler :–From Ruler margins and indents can be adjusted in the easier way and it also provides

measurement for the page formatting.

6. Cursor:– Cursor is Word pointer, which tells that from the or on the cursor position you can perform

your action.

7. Drawing Toolbar :– Drawing toolbar has the various commands related to the graphics and the

drawing options.

8. Status Bar:– It displays the positioning of the cursor, displays the status of some important keys of

keyboard, and shows the messages for the toolbar button when a mouse points to it, display

messages for menu option when a menu option is selected or pointed out by a user.

9. View Buttons :– View buttons are shortcuts of various views in the View Menu which will be

discussed later.

10. Scroll Bars :– There are two types of scroll bars

i. Horizontal Scrollbar

ii. Vertical Scrollbar

Working of both the scroll bar is to scroll the document in the either directions

11. Document Navigator:– Document Navigator allows navigating the document in different types of

objects and is activated when clicked on the ball type button on the vertical scroll bar.

12. Office Assistant:– Office assistant provides you the online help, real-time tips while working.

1.2 CREATING & OPENING DOCUMENT
For creating a new file or Opening an existing file we should follow the following steps.

1.2.1 Open a New File

To open a new file, follow the following steps

i. Click on the File menu

ii. Now Click on the New option of the File menu (directly press the Ctrl+N from the key

board.)
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iii. Select the Blank document from the General Tab from the following dialog box and then

press OK button.

1.2.2 Opening of an Existing File (Document)

To open an existing file/document, following steps are required to be followed

1. Select the Open option from the File menu (or directly press the Ctrl+O from the key board)

OR

Click on the Open tool from the standard toolbar

Then the open dialog box will appear as shown in figure

2. Select the appropriate folder from Look in combo box.

3. Select the required file from the file window

OR

Write the required file’s name in the File name window

4. Click on open button on the right hand side

1.3     SAVING  A  DOCUMENT
For Saving a Document we are having two Options:

1. Save Option

2. Save as Option

1.3.1 Save Option

For saving a document, following are the steps

1. Click on the File → Save option.

OR

Press Ctrl + S

OR
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Press the Save tool from standard toolbar

If you are saving the file for the first time the Save as window will appear

2. Choose the appropriate folder from Save in combo box.

3. Write the proper file name in the File name text box

4. And then press the Save button

1.3.2 Save As Option

For saving a document, following are the steps

1. Click on the File → Save As option.

2. Choose the appropriate folder from Save in combo box.

3. Write the proper file name in the File name text box

4. And then press the Save button

1.3.3 Difference Between Save and Save as

Save and Save As options do the same work of saving a document but the difference between both

options is that the Save As command every time gives you the Save As dialog box and you can save the file with

different names also.

But the Save option will gives you the Save As dialog box when you are saving the document for very first

time. Other times it will save the document with the previous name without giving any dialog box.

& CHECK YOUR PROGRESS
Before reading next section, practice the following questions.

1. Save the document.

2. Scroll down one page.

3. Select the first line of the document at a single mouse click.

4. Save the document in the name Lab 1.

5. Adjust the left margin of the document measure to 1.50”.

6. Close the document.

If your answers are correct, then proceed to the next section.

1.4 ENTERING  TEXT  IN  A  DOCUMENT
Following steps are to be followed for entering a text in a document:–

1. Start → Programs → MS-Word → Enter

2. Now open New Document (Ctrl+N) or open existing document file (Ctrl+O)

3. Now any text can be typed in the document file by using any font and size with help of  keyboard.

4. Now Save the document by pressing Save (Ctrl+ S) / Save As – option.

1.5 EDITING  TEXT  IN  A  WORD  DOCUMENT
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1.5.1 Moving Text and Copying Text in a Document

Moving Text means transfer of a text from one location to another location.

Copying Text means copy of a text from one location and transfers it to another location.

For this we can use the following commands:

A Commands Undo and Redo

A Cut and Paste

A Copy and Paste

A Finding and Replacing Text in a Document

A Go To

1.5.2 Commands Undo and Redo

1. Undo

To reverse changes while editing, undo command is used. To perform undo you can

Click on the Undo option under Edit menu

Or

Click on the Undo button on Standard toolbar

Or

Press Ctrl+z.

2. Redo

If an undo has to perform on last reversed action that is known as Redo. To perform redo you can

Click on the Redo option under Edit Menu

Or

Click on the Undo button on Standard Toolbar

Or

Press Ctrl+y

1.5.3 Cut and Paste

Cut and Paste means moving of text and moving of text means removing text from one portion of the

document and placing it at some other location.

A To cut text:

i. Select the text or make the block of the text

ii. Select cut from Edit menu

or

Click on the cut button of standard toolbar

or

Press the ctrl+x button

or

Move the mouse pointer on the selected text and right click and select cut.

A To paste the selection

i. Move the cursor at the location where the text is to be pasted

ii. Select Paste from Edit menu

or

Click paste button on the standard toolbar

or

Press Ctrl + v

or

Click the right mouse button and select paste from the context menu.
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1.5.4 Copy and Paste

Copying means duplicating the contents of a document at some other desired place. The procedure for

copying text is almost the same as that of moving text with a little difference, which is being discussed in following

steps.

F To copy a particular text

i. Select the text or make the block of the text

ii. Select copy from Edit menu

Or

Click on the copy button of standard toolbar

Or

Press the Ctrl + c button

Or

Move the mouse pointer on the selected text and right click and select copy.

Paste operation is same as described in the cut and paste section
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1.5.5 Finding and Replacing Text in a document and GoTo

Find

Some times while working in document you need to find a particular text. Finding of text can be done in

following way

1. To find a particular text you have to perform the following steps

i. On the Edit menu, click Find. Then you will see the following window

ii. In the Find what box, enter the text that you want to search for.

iii. Select the direction of searching from Search list box.

iv. Select any other options that you want.

Match case: To find the characters that are a word by themselves and are not a part of another word.

Find whole words only: To find the characters that are a word by themselves and are not a part of

another word.

Use wildcards: To specify the wildcard characters (? Or *) in the Find what text box.

Sounds like: To find words that sound similar but are spelt differently. For example hair, heir, hear and

hare sound similar to here.

Find all word forms: To find all grammatical forms of the word. For example, on entering the word eat

it also searches ate, eaten and eating words.

v. For Help on an option, click the question mark and then click the option.

vi. Click Find Next.

vii. If you want find similar word again in the rest of the document click on the Find next button.

Replace

If you have to replace a word in the document with another word you can use find and replace command

to do that. Find we have discussed above now it’s the turn of Replace.

i. On the Edit menu, click Replace. Then you will find the following window.

ii. The Find what box, enter the text that you want to search for.

iii. In the Replace with box, enter the replacement text.

iv. Select any other options that you want.

v. For Help on an option, click the question mark and then click the option.

vi. Click Find Next, Replace, or Replace All.

vii. To cancel a search in progress, press ESC.
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Go to

To go to on a particular location or particular item use Go to option under the Edit menu. Steps are as

follows:

1. Click on the Go to option under the Edit menu. Then the following window will appear on the screen.

2. Select according to what you want to navigate in the document from Go to what combo box.

3. Enter the parameter as page number or name of the bookmark.

4. Click on the previous or next depending upon the direction you want to go.

& CHECK  YOUR  PROGRESS
Before reading next section, practice the following questions.

1. Move the second paragraph of the text to the end of the paragraph.

2. Undo your last change.

3. Select the entire document and then deselect it.

4. Search the word “is” occurring in the document.

5. Change the word “is” to “in” occurring in the whole document at a time.

6. Quickly move to page 4 of the document.

If your answers are correct, then proceed to the next section.

1.6 FORMATTING  TEXT  IN  A  DOCUMENT
Formatting of a document involves following main options:

Ø Text Formatting

Ø Font
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Ø Paragraph

Ø Bullet and Numbering

Ø Tab

Ø Columns

Ø Styles

Once the text of a document has been typed, it is required to be formatted. MS-Word provides Format

menu to give a meaningful format of your document, so that a user can read and understand the document in an

easy manner. Following are the options available in the Format menu.

1.6.1 Page/Text Formatting

Format of font i.e. the font type, font size, font style, font Color; character spacing etc can be changed by

going in the option Font of Format menu.

1.6.2  Fonts

The word font means the way of writing characters.
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To change the font-using Font dialog box gives you the opportunity to see the result within the dialog box

before applying it on the text. Other benefit of using the font dialog box is that you can apply several effects within

the same dialog box like font color, bold or font size etc. Following are the steps to change the font using Font

dialog box.

1. Select the desired text to change the font.

2. Select the Font option from Format menu. It will give you the following window.

3. Scroll through the Font list and click the font that you want.

4. Select the font color, underline style and Effects of your choice.

5. Select the font style according to the text.

6. Click on Ok button.

1.6.3 Paragraphs Formatting

Alignment of the Paragraph

Alignment refers to the way the right and left edges of a paragraph line up along the right and left margins

of your document. Word gives you four alignment choices - left, centered, right and justified.

Center Aligned

Left Aligned

Justified

Right Aligned

Click on the paragraph in which you want to change the alignment.

1. Bring up the Paragraph dialog box as stated above.

2. Choose the alignment from Alignment drop down list.

3. Press the Ok button.

1.6.4 Tabs

A position you set for placing and aligning text on a page. Microsoft Word has four kinds of tab stops, as

shown below.

Left text extends to the right from the tab stop.

Center text is centered at the tab stop.

Right text extends to the left from the tab stop until the tab’s space is filled, and then the text

extends to the right.

Decimal text before the decimal point extends to the left, and text after the decimal point extends

to the right.

Bar tabs generates a bar.
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Center 

Left Tab

Right Tab

Decimal 

TabBar Tab

1.6.5 Bullets and Numbering

Word’s bulleted and numbered list features add bullets or numbers for you, and they create hanging

indents so that when text in an item wraps to the next line, it doesn’t wrap underneath the number of bullet.

Word enables you to create single level lists as well as multilevel lists.

Single Level Lists

Single level lists are shown below in the figure

Bulleted List

Numbered List

Follow these steps to create a single-level bulleted or numbered list:

1. Click where you want to start a list.

2. Click the Bullets or Numbering button on the Formatting toolbar.
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3. Type the first item in the list and press Enter. Word automatically inserts a bullet or number on the next

line for you.

4. After the last item press Enter twice to turn off the bullets or numbers.

Instead of turning on the bulleted or numbered list feature and then typing the list, you can also type the list

first, select it, and then click the Bullets or Numbering toolbar button.

1.6.6  Columns

You can use columns to create documents such as newsletters or book pages. The column option controls

the width and number of columns. Narrower column widths make your text easier to read. Often, creating col-

umns enables you to fit more text on a single page. Columns work particularly well where you have several shorter

topics making up a larger document, as with a newspaper.

To create a column:

1. Select the text which you want to convert in column.

2. Click on the column button in the Standard toolbar.

3. A drop-down list appears with four columns across it. Click on the first column in the drop-down list

and drag across to highlight desired number of columns.

Bulleted List

Numbered List

4. Leave the mouse button.

. 1. Click anywhere in the column-text.

2. Choose Column option from Format menu to display the column dialog box.

3. Click on the format that you want for the column.

4. If you have specific requirements for column widths, fill it into the Width and spacing and fill the

Number of column box.

5. For line, check the Line between check box.

6. Press Ok Button.
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1.6.7 Styles

A style is a set of formatting characteristics that you can apply to text in your document to quickly changes

its appearance. When you apply a style, you apply a whole group of formats in one simple task. For example, you

may want to format the title of a report to make it stand out. Instead of taking three separate steps to format your

title as 16 pt, Arial, and center-aligned, you can achieve the same result in one step by applying the Title style.

When you start Microsoft Word, the new blank document is based on the Normal template, and text that

you type uses the Normal style. This means that when you start typing, Word uses the font, font size, line spacing,

text alignment, and other formats currently defined for the Normal style. The Normal style is the base style for the

Normal template, meaning that it’s a building block for other styles in the template.

There are a number of other styles besides Normal available in the Normal template. A few basic ones are

shown in the Style list on the Formatting toolbar. You can preview and select others in the Style dialog box (Format

menu, Style command).

Advantage of Using Styles
1. Styles can dramatically reduce the time it takes to format a document often by 90% or more.

2. Styles can also help you make sure all your documents look consistent, with very little effort on your

part.

3. If you export your word document to a desktop publishing program, most programs can use Word

styles to help automate their work.
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4. If you need to change the way your styled document looks, you need to change only a few styles, not

hundreds of manual formats.

5. it’s much easier to take advantage of Word’s powerful automation and organization features if you use

styles. For example, Word can automatically build and update a table of contents based on the styles

in your document. Without styles, you would have to manually apply a field to every single item you

want to include in your table of contents.

Types of  Style

Style comes in two types:

1. Character based style

2. Paragraph based style

1. Character based Style: A character style affects selected text within a paragraph, such as the font and

size of text, and bold and italic formats. Characters within a paragraph can have their own style even if a paragraph

style is applied to the paragraph as a whole. If you want to be able to give certain types of words or phrase the

same kind of formatting, and the formatting isn’t in an existing style, you can create a new character style..

2. Paragraph Based Style: A paragraph style controls all aspects of a paragraph’s appearance, such

as text alignment, tab stops, line spacing, and borders, and can include character formatting. If you want a

paragraph to have a particular combination of attributes that aren’t in an existing style (for example, a bold, italic,

center-aligned heading in the Arial Narrow font), you can create a new paragraph style.

Apply a Different Style

1. Do one of  the following:

F To apply a paragraph style, click the paragraph or select the group of paragraphs you want to

change.

F To apply a character style, click the word or select the words you want to change.

2. On the Format menu, click Style.

3. In the Styles box, click the style you want to apply, and then click Apply.

If the style you want is not listed, select another group of styles in the List box. A paragraph mark appears

to the left of each paragraph style. A bold, underlined letter “a” appears to the left of character styles. .

Create a New Character Style
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1. On the Format menu, click Style.

2. Click New and the following dialog box will appear.

3. In the Name box, type a name for the style.

4. In the Style type box, click Character.

5. Select the other options you want, and then click Format to set attributes for the style.

6. Click Ok button.

Create a New Paragraph Style
The quickest way to create a new paragraph style is to format a paragraph, select it, and then base the

new style on the formatting and other properties applied to the selected text.

1. Select the text that contains the formatting you want to use for your style.

2. On the Formatting toolbar, click inside the Style box.

3. Type over the existing style name to create the name for the new style.

4. Press ENTER.

Modify a Style
1. On the Format menu, click Style.

2. In the Styles box, select the style you want to modify, and then click Modify.

3. Click Format, and then click the attribute — such as Font or Numbering — you want to change.

4. Click OK after you’ve changed each attribute, and then repeat for any additional attributes you want

to change.
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& CHECK  YOUR  PROGRESS
Before reading next section, practice the following questions.

True or False

1. A Paragraph style affects selected text within a paragraph, such as the font and size of text, and bold

and italic formats. [  ]

2. Background and Themes are used to create a web page in word. [  ]

3. You can use columns to create documents such as newsletters or book pages. [  ]

4. Break is a position you set for placing and aligning text on a page. [  ]

5. Tabs can dramatically reduce the time it takes to format a document often by 90% or more. [  ]

Fill in the Blanks

1. A _____________ is a set of formatting characteristics that you can apply to text in your document to

quickly changes its appearance.

2. You can use _____________ to create documents such as newsletters or book pages.

3. To promote the item to a higher numbering level, click anywhere in the item, and click _____________

Indent.

4. An ______________________ is a list created by using the Bullets and Numbering command (For-

mat menu) to apply a _____________ structure to any list or document, including a legal or technical

document.

5. ______________ is the space between two lines in a paragraph.

1.7 HANDLING  TABLES  IN  THE  TEXT

A table is made up of rows and columns of cells that you can fill with text and graphics. Tables are often

used to organize and present information, but they have a variety of other uses as well. You can use tables to align

numbers in columns, and then sort and perform calculations on them. You can also use tables to create interesting

page layouts and arrange text and graphics.
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1.7.1 Create a Table

Word provides you three methods for creating tables.

1. Create table using Insert Table button in Standard toolbar.

2. Create table using Insert Table option From Table Menu.

3. By Drawing Method.

1.7.1.1 Creating a Table with the Standard Method

1. Place your cursor from where you want to create the table.

2. Click on the Insert Table button on Standard toolbar.

3. Drag the mouse over the grid that appears while holding down the mouse button and highlight 3 x 2

Table.

4. Word will insert an empty table when you release the mouse button.

1.7.1.2 Create Table using Insert Table Option from Table Menu.

1. Place the cursor from where you want to create the table.

2. Choose Table option from Insert option of Table menu

3. Enter the desired number of columns and rows for table in the dialog box that appears.
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4. Press the OK button

1.7.1.3 Drawing a Table

1. Make sure that you are in print layout view, (Tables and Borders menu is available only in Print Layout

view.) and then click the Tables and Borders button on standard toolbar to display the Tables and

Borders toolbar.

Table and Borders

2. Click the Draw Table button. Now your mouse pointer will looks like a small pencil

Draw Table Line Style Border Color

Eraser Line Weight

3. Choose the Line Style and Line weight.

4. Choose the Border Color.

5. Starting from the upper-left corner, drag diagonally down and to the right, releasing the mouse button

when the outline is the right size.
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6. Now draw the inside lines for rows and columns.

7. Use eraser to delete any unwanted lines.

1.7.2 Entering and Editing Text in a Table

1. Enter text in table just as it is entered in the MS-Word document. Use mouse or arrow keys to

position the insertion point in a cell and then type the text. MS-Word will automatically wrap the text

within the cell as we reach the right edge.

2. To move from cell to cell within the table, se mouse or use the Tab or Shift + Tab keys to move to the

next or previous cell. If Tab is pressed in the last cell of the last row, MS-Word creates a new row.

3. Since we use the tab key to navigate within a Table, we cannot use Tab to enter tab characters, for this

use Ctrl + Tab keys.

4. When a table is inserted, the insertion point is positioned in the first cell. We can start typing right

away.

1.7.3 Inserting Rows and Columns

1. Place the cursor in the table where you want to insert the row or column.

2. Choose Insert row (above or below) or insert column (right or left) from Insert option of Table menu.

Note: To add a row at the end of the table, position the insertion point in the last cell of last row and then press

the Tab key. The cells in the new row will have the formatting of the cells in the preceding row.
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1.7.4 Deleting Rows and Columns

1. Select the Rows or Column which you want to delete.

2. Right Click. A context menu will appear and the delete option is there according to your selection.

3. Select the option of Delete row or Delete column that will appear according to your selection of row

or column.

1.7.5 Change the Column Width in a Table

Rest the pointer on the column boundary you want to move until it becomes, and then drags the boundary

until the column is the width you want.

Notes

To change a column width to a specific measurement, click a cell in the column. On the Table menu, click

Table

Properties, and then click the Column tab. Choose the options you want.

To make the columns in a table automatically fit the contents, click a table, point to AutoFit on the Table

menu, and then click AutoFit to Contents.

To display column width measurements, click a cell and then hold down ALT as you drag the markers on

the ruler.
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1.7.6 Change the Row Height in a Table

Rest the pointer on the row boundary you want to move, and then drag the boundary.

Notes:

To change a row height to a specific measurement, click a cell in the row. On the Table menu, click Table

Properties, and then click the Row tab. Select the options you want.

To display row height measurements, click a cell, hold down ALT as you drag the markers on the vertical ruler.

1.7.7 Merge and Splitting Cells

Merge Cells into One Cell in a Table

You can combine two or more cells in the same row or column into a single cell. For example, you can

merge several cells horizontally to create a table heading that spans several columns.

1. On the Tables and Borders toolbar, click Eraser

2. Drag the eraser over the cell dividers you want to remove.

Note: You can quickly merge multiple cells by selecting them and clicking Merge Cells from the context menu

produced by right click.

Split a cell into multiple cells in a table

1. On the Tables and Borders toolbar, click Draw Table.

The pointer changes to a pencil.
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2. Drag the pencil to create new cell partitions.

Note: To split multiple cells, select them, and then click Split Cells

Sorting of the Table

1. Select the table or the column which you want to sort.

2. Choose Sort option from table menu. You will find out the following dialog box on the screen.

3. Select the Column on which you want to do the sorting. You can select more than one column.

4. Select the Ascending or descending option.

5. Select the Header row if there is any header row in the table.

6. Click on the OK button.

1.7.8 Calculation in Tables

You can also perform the calculations on the table columns. Steps for performing calculation will be.

1. Put the mouse in the cell in which you want your calculation. (But remember that the numeric values on

which you want to perform calculation must be in continuous order i.e. there must not be any blank

cell or there must not be any text value.

2. Select the option Formula from the Table menu.
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3. Select the type of calculation you want to perform from the paste function list box. Whatever you

select will come in Formula Text box. By default it is SUM().

4. Select the Number Format.

5. Press Ok Button. Results will come out in the cell.

& CHECK  YOUR PROGRESS

Practice the following questions.

1. Create a New file on student’s performance report using Tables.

2. Split the table from the fourth row.

3. Merge two columns into one column.

1.8 HEADER  AND  FOOTER
Headers and footers are typically used in printed documents. You can create headers and footers that

include text or graphics for example, page numbers, the date, a company logo, the document’s title or file name, or

the author’s name that are usually printed at the top or bottom of each page in a document. A header is printed in

the top margin; and the footer is printed in the bottom margin.

Steps to create a header or footer are given below.

1. Select Header and Footer from the View menu.

2. Header and Footer toolbar is displayed, Header area is activated and document’s text color changes

to light gray.

3. Type the text in Header area.

4. If you want to create footer, click the switch between Header and Footer toolbar button to enable

footer area active.

5. Type the text in footer area.

6. Apply any formatting that you like on header or footer of the document.

7. Click on close button to return back to the document
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& CHECK YOUR PROGRESS

Before reading next section, practice the following questions.

1. View the document as it will appear in Web browser.

2. View the document with Page layout and formatting.

3. View the headers before printing the document.

4. Insert the page number as footer.

If your answers are correct, then proceed to the next section.

1.9 SUMMARY
This unit has introduced you the basic features of word-processing software and what it can do for

individuals and other business houses. We have learnt how to create our own documents, open existing documents

and finally save them before closing. The standard toolbar and the formatting toolbar offer a variety of buttons

which offer a quick service to the user.  Look of the document can be made impressive and eye-catching by

applying different font types, styles and sizes. You can emphasize or highlight your text by making it bold, italicized

and underlined. Lowercase characters can be changed to uppercase and vice-versa by pressing <Shift + F3>

keys together. This makes the major heads clearly readable and remembered. The ‘Find and Replace’ feature of

WORD 2000 helps us in finding a particular word and can be replaced with some other desired word. This makes

searching of the words easier and global replacements happen without fail in no time. MS-WORD 2000 can give

you numbers to your pages which make referencing easier.
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1.10 GLOSSARY
Copy: Copying means duplicating the contents of a document at some other desired place

Header: A header is any information printed in the top margin.

Footer: Footer is any information printed in the bottom margin.

Merge: combine two or more cells in the same row or column into a single cell.

Split: Partition of a single cell into two or more cells.

Table: A table is made up of rows and columns of cells that you can fill with text   and graphics.

Bookmark: A bookmark is an item or location in a document that you identify and name for future

reference. You can use bookmarks to quickly jump to a specific location, create cross-references; mark page

ranges for index entries, and so on.

Font: means the way of writing characters.

Word wrap: means to adjust a word in a given specified area.

Formatting: means changing the size, color, style, font, pattern, etc of given text.

Template: A template determines the basic structure for a document and contains document settings such

as AutoText entries, fonts, key assignments, macros, menus, page layout, special formatting, and styles.

Undo: is used to reverse changes while editing,

Redo: If an undo has to perform on last reversed action that is known as Redo.

Cut and Paste: Cut and Paste means moving of text and moving of text means removing text from one

portion of the document and placing it at some other location.

1.11 FURTHER  READINGS
1. Microsoft WORD: The Microsoft Reference Guide to All Commands, Functions, and Features by

Nancy Andrews.

2. Microsoft Word for Windows: a tutorial to accompany Peter Norton’s Introduction to computers by

Heather Millet Duggan, Peter Norton.

3. Writing Your Dissertation with Microsoft Word: A Step-by-step Guide - by Vincent

Kiernan – 2005.

4. Microsoft Word 5 Quick Reference by Bryan L. Pfaffenberger using Microsoft Word by B i l l

Camarda.

5. Microsoft Word 97 at a Glance by Jerry Joyce, Marianne Moon.

1.12 ANSWER TO THE SELF LEARNING EXERCISES

Answer to check your progress 1.1, 1.2 &1.3 (1-6) Practice by seeing the Text.

Answer to check your progress 1.4 &1.5 & (1-6) Practice by seeing the Text.

Answer to check your progress 1.6

True or False

1. False 2.True 3. True 4.  False 5. False

Fill in the Blanks

1. Styles 2. Columns (3 -5) Search Yourself

Answer to check your progress 1.7

(1-3) Practice by seeing the Text.

Answer to check your progress 1.8

(1-4) Practice by seeing the Text.
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Solved Questions

I. True or False

1. Microsoft Word is a Windows Based as well Linux Based word processing application. [  ]

2. Save and Save as options are exactly same. [  ]

3. To insert Header and footer one can select the option Header and footer from Insert menu. [  ]

II. Fill in the Blanks

1. ________________ Shows the name of the document and situated in the top of the window appli-

cation.

2. There are two types of scrollbars (a.) ____________________ (b.) ________________

3. Hot keys for Copy and Paste are ________________ and ___________.

Answers :

I. True or False

1. False 2. False 3. False

II. Fill in the Blanks

1. Title Bar

2. (a) Horizontal Scrollbar (b) Vertical Scrollbar.

3. (a) Ctrl+c (b) Ctrl+v

1.13 UNIT  END  QUESTIONS

Describe the Following

1. Write a short note about Paragraph formatting.

2. How are Tabs set?

3. What are columns and where are columns used.

4. Write a short note about Styles.

5. Find the average of  three subjects using insert field and substituting formulas.

6. Sort the table in ascending order assigning the Roll no as the suitable position.

Practice the following

1. Make the following changes in the text:

(a) Replace the word ‘ability’ with ‘suggest’. Use ‘Find and Replace’ command.

(b) Delete the blank lines in the letter.

(c) Combine paragraph one and two such that they form one paragraph.

(d) Copy the last paragraph in the beginning of the letter.

(e) Insert a new paragraph at the end of the first paragraph and key in the contents yourself.

(f) Make the last paragraph left aligned.

(g) Make the right paragraph right aligned.

(h) Delete the last paragraph.

(i) Move the first paragraph and make it the last paragraph.

(j) Make the whole letter justified.

(k) Change the left margin to 5 and right margin to 55.

(l) Save the document by the name Book.

(m) Close the file that you have just created.
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True or False

1. Microsoft word is not a word processor. [  ]

2. Title bar contains the various commands under the various topics to perform some special

tasks. [  ]

3. Copying means duplicating the contents of the document at some other desired place. [  ]

4. If you have to replace a word in the document with another word you can use  GO TO

command to do that. [  ]

5. Cut and Paste means moving of text. [  ]

6. To reverse changes while editing redo command is used. [  ]

7. You have to use the same header and footer throughout a document. [  ]

Ans (True or False)

1. False 2. True 3. True

4. False 5. True 6. True 7. True

����
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UNIT II : SPELL CHECKING AND GRAMMAR CHECKING

Structure  of  the  Unit

2.0 Objective

2.1 Introduction

            2.1.1 Standard Toolbars
            2.1.2 Start with MS Word
            2.1.3 Components
            2.1.4 Functions of the Component

2.2 Tools of Microsoft Word 2000

            2.2.1 Spelling and Grammar
            2.2.2 AutoCorrect

Check your progress

2.3 Insertion

2.3.1 Inserting Objects
2.3.2 Inserting Pictures
2.3.3 Inserting Files
2.3.4 Inserting Break
2.3.5 Auto Text Entries
2.3.6 Create Cross-references for Index Entries
2.3.7 Table of Contents
2.3.8 Word Wrapping

Check your Progress

2.4 Template and Wizards

2.4.1 Templates
2.4.2 Wizards

Check your Progress

2.5 Mail  Merge

2.5.1 Creating the Main Document
2.5.2 Building Data Source
2.5.3 Merge the data with the document

2.6 Macro

2.6.1 Recording a Macro
2.6.2 Record a Macro in Word

Check Your Progress

2.7 MS  Publisher

2.7.1 Overview
2.7.2 Design and reuse Pages
2.7.3 Editing Fills and Re-coloring Pictures
2.7.4 Personalize Publications
2.7.5 Share, Print and Publish
2.7.6 Applications

Check your Progress
2.8 Summary
2.9 Glossary
2.10 Further Readings
2.11 Answer to the Self Learning Exercise
2.12 Unit-end Questions
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2.0 OBJECTIVE
Micro-Soft Word 2000 is a popular component of the MS Office 2000. This chapter includes Spell

Checking and Grammar Checking facilities in big documents with speed and accuracy. The course also includes

facilities of inserting objects, pictures, files, template, wizards, Mail merge, MS Publisher etc. in various applica-

tions. After reading the complete unit you would be comfortable enough in editing and processing of a word

document.

2.1 INTRODUCTION  TO MS WORD 2000
Ø  Microsoft Word 2000 is a tool of Microsoft Office 2000. Spell checking and Grammar checking is

a part of MS Word. and it can be used in wide range of Applications. It is used for writing letters;

create Resumes, Writing Books, and World Wide Web Pages.

Microsoft Word 2000 provides following functions:

(1) Creating & Opening a Text Document

(2) Provide Edit facility

(3) Spell Checking

(4) Mail Merge

(5) Table Handling

(6) Print preview of text

(7) Font style and font sizes

(8) Graphics

(9) Templates

(10) Document wizard

2.1.1 Standard Toolbars used in Microsoft Word 2000

Common Buttons of the Standard toolbars are:

1 New 2 Open 3. Save

4 E-mail 5 Print 6 Print Previews

7 Spell Checker 8 Cut 9 Copy

10 Paste 11 Format Painter 12 Undo

13 Redo 14 Insert Hyperlink 15 Tables and Borders

16 Insert Table 17 Insert Microsoft Excel Worksheet 18 Column

19 Drawing 20   Documents Map 21 Show/Hide

22 Zoom 23 Help

These tools are discussed later in this unit with their respective actions.

2.1.2 Starting of MS-Word

Microsoft Word is a Windows based word processing application.  Steps to start MSWord 2000.

Ø Click on the start button on the Taskbar

Ø Click on the Program option in start menu.

1 2 3  4 5 6 7 8 9 10 11 12 13 14   15  16 17 18 19 20 21 22 23
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Ø Click on the Microsoft word icon.

2.1.3 Components of the Word Window

1 Caption Bar 2 Menu Bar 3. Standard Tool Bar

4. Formatting Toolbar 5. Ruler 6. Cursor

7. Drawing Toolbar 8. Status Bar 9. View Buttons

10. Scroll Bars 11. Document Navigator 12. Office Assistant

2.1.4 Function of the Various Components of Microsoft Word Window

1. Title Bar : Title bar shows the name of the document and situated in the top of the window application.

2. Menu Bar : Menu bar contains the various commands under the various topics to perform some

special tasks. Menu bar is located under the title bar

3. Standard Toolbar : Toolbar is nothing more than the shortcut of the Menu options to execute or

perform the menu options in the easiest and faster way. Standard toolbar contains the commands for

the Word’s most frequently used commands.

4. Formatting Toolbar : Formatting toolbar contains the various commands related to the formatting of

the document.

5. Ruler : From Ruler margins and indents can be adjusted in the easier way and it also provides

measurement for the page formatting.

6. Cursor : Cursor is Word pointer, which tells that from the or on the cursor position you, can perform

your action.
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7. Drawing Toolbar : Drawing toolbar has the various commands related to the graphics and the

drawing options.

8. Status Bar : It displays the positioning of the cursor, displays the status of some important keys of

keyboard, shows the messages for the toolbar button when a mouse points to it, display messages for

menu option when a menu option is selected or pointed out by a user.

9. View Buttons : View buttons are shortcuts of various views in the View Menu which will be dis-

cussed later.

10. Scroll Bars : There are two types of scroll bars

i. Horizontal Scrollbar

ii. Vertical Scrollbar

Working of both the scroll bar is to scroll the document in the either directions

11. Document Navigator : Document Navigator allows navigating the document in different types of

objects and is activated when clicked on the ball type button on the vertical scroll bar.

12. Office Assistant : Office assistant provides you the online help, real-time tips while working.

2.2 TOOLS OF MICROSOFT WORD 2000
Microsoft Word Tools menu provides various tools to make your work more accurate and faster.

2.2.1 Spelling and Grammar

As you typed, Word can automatically check your document and underline possible spelling and

grammatical errors, spelling errors by default underlined in RED color and grammatical errors are underlined in

GREEN.

To correct the Spelling of Words and Grammar

1. Right click the word. A context menu will appear with a list of possible spelling corrections.

2. Select the best suitable spelling or grammar.

3. Or, Add the word using add option if you think that the word is correct.

4. If you don’t want to add the word, you can ignore it, if according to you, the word is right.
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Using the Spelling and Grammar Checker

The spell checker lets you check the spelling and grammar of an entire document all at once. You won’t

really need to use it if you use automatic spelling checking to fix your spellings. However if you’re working on a

rather larger document, the spelling and grammar checker comes in use.

To check your document with spelling and Grammar checker do the following steps.

1. Click on the Spelling and Grammar button of Format toolbar, or Spelling and Grammar option of

Tools menu, or press F7 key

Spelling and Grammar

2. This will bring you the following dialog box and the first error it encounters within the red color text

and the suggestions in the next window.
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3. Sometimes Word doesn’t offer the correct spelling or the grammar for a misspell word. If this happens,

select the word in the top half of the dialog box and type the correct grammar or the word there.

4. If the word is spelt right, then click the add button.

5. To leave the word as it is, click the ignore button.

6. After finishing of spell and grammar check, it shows you a message box to inform you of the finishing

of the spell check. Click on the Ok button.

2.2.2 AutoCorrect

What is AutoCorrect?

You can use the AutoCorrect feature to automatically detect and correct types, misspelled words,

grammatical errors, and incorrect capitalization. For example, if you type “the” plus a space, then AutoCorrect

replaces what you have typed with “the.” You can also use AutoCorrect to quickly insert text, graphics, or

symbols. For example, type (c) to insert ©, or type ac to insert “Acme Corporation.”

Add an AutoCorrect Entry to Correct a Typing Error

1. On the Tools menu, click AutoCorrect.

2. In the Replace box, type a word or phrase that you often mistype or misspell — for example, type

usually.

3. In the with box, type the correct spelling of the word — for example, type usually.

4. Click Add.

Create an AutoCorrect Entry to Store and Automatically Insert Text and Graphics

1. Select the text or graphic you want to store as an AutoCorrect entry.

Ø To store paragraph formatting with the entry, include the paragraph mark in the selection.

2. On the Tools menu, click AutoCorrect.

3. Make sure the ‘Replace text as you type’ check box is selected.

4. In the Replace box, type a name for the AutoCorrect entry (that is, the abbreviation or word that

Ø Microsoft Word replaces automatically as you type).

5. Do one of the following:

Ø To save the entry without its original formatting, click Plain text.

Ø To save the entry with its original formatting, click formatted text.
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6. Click Add.

When you’re ready to automatically insert the AutoCorrect entry, type the entry name, followed by a

space or other punctuation. There are many other tools in MS Word such as mail mege, macros etc which we

cover separately in other sections.

& CHECK YOUR PROGRESS
Describe the following:

1. Explain the different types of tools available in MS Word.

2. What is AutoCorrect?

3. What do you mean by Spelling and Grammar Checker?

If your answers are correct, then proceed to the next section

2.3 INSERTION

Insert Menu

Insert menu helps you to insert various word components in between the word document. Insert menu has

the following options.

Inserting Objects, Inserting Pictures, Inserting files, Inserting Break, Auto Text Entries, Create

Cross-references for Index Entries, Table of Contents and Word Wrapping

2.3.1 Inserting Objects

You can create two types of objects.

(1) Linked Object: An object that is created in a source file and inserted into a destination file, while

maintaining a connection between the two files. The linked object in the destination file can be updated

when the source file is updated.

(2) Embedded Object:  Information (object) that is contained in a source file and inserted into a destina-

tion file. Once embedded, the object becomes part of the destination file. Changes you make to the

embedded object are reflected in the destination file.

Create a new embedded object

1 Click in the document where you want to place the embedded object.

2 On the Insert menu, click Object, and then click the Create New tab.

3 In the Object type box, click the type of object you want to create.

4 To display the embedded object as an icon — for example, if others are going to view the document

online — select the Display as icon check box.



38

Spell Checking and Grammar Checking            Unit-II

5 You can also insert a Microsoft Excel worksheet as an embedded object by clicking Insert Microsoft

Excel.

Create a linked object or embedded object with existing information

1. Open both the Microsoft Word document and the Microsoft Excel worksheet that contains the data

you want to create a linked object or embedded object.

2. Switch to Microsoft Excel, and then select the entire worksheet, a range of cells (cell: A box formed

by the intersection of a row and column in a worksheet or a table, in which you enter information.), or

the chart you want.

3. Click Copy.

4. Switch to the Word document, and then click where you want the information to appear.

5. To link or embed the object, do one of the following:

Create a linked object

1. Click Paste.

2. Place the insertion point on the Paste Options button near the copied object, and then click the arrow

on the button to select an option to link the data.

Create an embedded object

1 On the Edit menu, click Paste Special

2 Click Paste.

In the as box, click the entry with the word “object” in its name. For example, click Microsoft Excel

Worksheet Object

2.3.2 Inserting Pictures

Add Word Art

1. On the Drawing toolbar, click Insert WordArt

2. Click the WordArt (WordArt: Text objects you create with ready-made effects to which you can

apply additional formatting options.) affect you want, and then click OK.

3. In the Edit WordArt Text dialog box, type the text you want.

4. Do any of the following:

F To change the font type, in the Font list, select a font.

F To change the font size, in the Size list, select a size.

F To make text bold, click the bold button.

F To make text italic, click the Italic button.

Inserting Images from Clip Gallery

To insert an image from Clip Gallery you have to follow these steps:

1. Move the cursor where you want to insert the image.

2. Select Clip art option from Insert->Picture menu.

3. Click the picture category from which you want to insert the picture.

4. If you know what type of image you’re looking for, type a descriptive word or two in the Search for

Clips text box, and press Enter. Word displays the images that are most closely match your key-

words.

5. When you find out the image that you want to use, click it.

6. Clicking on the image will display a small toolbar. From that toolbar, click the Insert button as given in

the  figure given below

This will insert a clipart in your document.
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Insert 

2.3.3   Inserting Files

From an entire file

1. Click in the document where you want to place the linked object or embedded object.

2. On the Insert menu, click Object.

3. Click Create from file.

4. In the File box, type the name of the file you want to create a linked object or embedded object from,

or click Browse to select from a list.

5. To create a linked object, select the Link check box.

An embedded object is created if you don’t select the Link check box.

6. To display the linked object or embedded object as an icon — for example, if others are going to

view the file online — select the Display as icon check box.

2.3.4 Break Option

Break option is to insert a break in between the page. This break is of any kind i.e., it can be page break, column

break etc. To insert a break choose the Break option from Insert menu. It will give you the following dialog box.

This dialog has various options

1. Page Break : It inserts a manual page break at the insertion point.

2. Column Break:  Inserts a manual column break at the insertion point.

3. Text Wrapping Break: Ends the current line and forces the text to continue below a picture, table,

or other item.

4. Next Page: Inserts a section break and breaks the page so that the next section starts at the top of

the next page.
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5. Continuous Page : Inserts a section break and starts the new section immediately, without inserting

a page break.

6. Even Page : Inserts a section break and starts the next section on the next even-numbered page. If

the section break falls on an even-numbered page, Word leaves the next odd-numbered page blank.

7. Odd Page : Inserts a section break and starts the next section on the next odd-numbered page. If the

section break falls on an odd-numbered page, Word leaves the next even-numbered page blank.

2.3.5 Auto Text Entries

 AutoText provides you a way to store and quickly insert text, graphics, fields, tables, bookmarks etc. that

you use frequently. Microsoft Word comes with a number of built-in AutoText entries that are divided into different

categories. For example, if you’re working on a letter, Word can offer letter-specific AutoText entries, such as

greetings and closings.

Also you can create you own AutoText entries. This is useful if you often use the same large or complex

item and don’t want to have to reinsert or retype it, or if you want to store text that contains a particular style or

format.

To Create an AutoText entry you have to perform following steps:

1. Select the text that you want to create in AutoText entries.

2. Select the option New under Insert -> AutoText options or press alt+F3 keys to display the AutoText

dialog box given in following figure.

3. Enter the name of the entry you want to give to the AutoText entry in the text box.

4. Click Ok.

To insert an AutoText entry into your document you have to follow these steps.

1. Place your cursor where you want to insert your entry

2. Type the first few letters of the name. A screen tip will appears for your entry.

3. Press Enter.

4. A more convenient way is to write the name of AutoText entry and press F3 key.

2.3.6 Create Cross-references for Index Entries

1. Select the text you want to use as an index entry (index entry is a field code that marks specific text for

inclusion in an index. When you mark text as an index entry, Microsoft Word inserts an XE (Index

Entry) field formatted as hidden text.)

2. Press ALT+SHIFT+X.
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3. Under Options, click Cross-reference, and then enter the text you want to use as a cross-reference

for the index entry.

4. Click Mark.

2.3.7 Table of Contents

Creating Table of Contents has following advantages:

1. The table of contents is actually a field, so you can update it at any time to reflect changes in your

document. Word can update both the headings and page numbers or just the page numbers.

2. Each heading in the table of contents is a hyperlink that leads to that heading in the document text. The

hyperlink lets your table of contents double as a navigation tool.

Before creating Table of Contents you have to apply heading style.

Then you have to follow these steps.

1. Click the location where you want the table of contents to appear, if you want it to be on a separate

page, insert manual page breaks before and/or after it as necessary.

2. Select the Index and Tables from Insert menu to display the Index and Tables dialog box, and click the

Table of contents tab.

3. Select the desired format from Format drop down list.

4. Select the levels up to which you want to take the heading levels from Show levels option.

5. Click the Ok button.

2.3.8 Applying Word Wrapping
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Word gives you six options for controlling how text flows around your image. The same options are

available for all graphics. To set a text-wrapping option you have to perform following steps.

1. Click the picture or drawing object.

2. On the Format menu, click the command for the type of object you selected — for example, AutoShape

or Picture, and then click the Layout tab.

3. Click the text-wrapping style you want.

4. For more text-wrapping options, click Advanced, and then click the Text Wrapping tab.

& CHECK  YOUR  PROGRESS
Before reading next section, practice the following questions.

1. Insert a page break after the second paragraph.

2. Insert a page number on all the pages of the document.

3. Insert an endnote represented by the symbol.

4. Create a Cross reference for the Labels, Endnote, and Footnote.

5. Create an index or content of your document.

6. Insert a picture from Clip Art.

If your answers are correct, then proceed to the next section

2.4 TEMPLATES AND WIZARDS

2.4.1 Template

Every Microsoft Word document is based on a template. A template determines the basic structure for a

document and contains document settings such as AutoText entries, fonts, key assignments, macros (An action or

a set of actions you can use to automate tasks.), menus, page layout, special formatting, and styles. There are two

basic types of templates:

1. Global Template

2. Document Template

1. Global Template: A document template that you have loaded in Microsoft Word by using the

Templates and Add-Ins command on the Tools menu. You can use the macros, AutoText entries, and

custom toolbar, menu, and shortcut key settings stored in a global template while you work with any

document, not just documents based on that template.

The Normal template is by design always a global template. Customized items you store in the

Normal template are available to all documents. Normal template: A general-purpose template that

you can use for any type of document. When you start Microsoft Word or click New Blank

Document, Word creates a new blank document that is based on the Normal template. You can

modify this template to change the default document formatting or content.

2. Document template: Templates you save in the Templates folder appear on the General tab in the

Templates dialog box. If you want to create custom tabs for your templates in the Templates dialog

box, create a new subfolder in the Templates folder and save your templates in that subfolder. The

name you give that subfolder will appear on the new tab.

Create a document template

Creating a Template involve following Steps:

To base a template on an existing document

1. On the File menu, click Open.

2. Open the document you want.

To base a new template on an existing template
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1 On the File menu, click New.

2 In the New Document task pane under New from template, click General Templates.

3 Click a template that is similar to the one you want to create, click Template under Create New, and

then click OK.

4 On the File menu, click Save As.

5 In the Save as type box, click Document Template. This file type will already be selected if you are

saving a file that you created as a template 

6 The default folder is the Templates folder in the Save in box. To save the template so that it will appear

on a tab other than General, switch to the corresponding subfolder within the Templates folder.

7 In the File name box, type a name for the new template, and then click Save.

8 In the new template, add the text and graphics you want to appear in all new documents that you base

on the template, and delete any items you don’t want to appear.

9 Make the changes you want to the margin settings, page size and orientation, styles, and other for-

mats.

10. On the Standard toolbar click Save, and then click Close on the File menu

2.4.2 Wizards

Use the Wizard to create a letter

The Letter Wizard helps you easily enter the set phrases characteristic of seasonal greetings and greetings

of personal inquiry. Use the Letter Wizard to easily create a letter.

1. On the Tools menu, click AutoCorrect, and then click the AutoFormat as You Type tab.

2.  Select the Insert closing and Launch Letter Wizard check boxes under automatically as You Type.

3. Click OK.

4. Enter a salutation in a document and press ENTER.

On the line following the line where the cursor is placed, the closing is automatically entered, the Letter

Wizard is started, and the Letter toolbar is displayed.

5. On the Letter toolbar, click Letter.

The Letter Wizard dialog box is displayed.

6. In the Seasonal Greeting box, enter the current month. Below the box, a list of seasonal greetings

appropriate to the month entered is displayed. Select an appropriate greeting.

7. Do one of the following:

To write a letter of personal inquiry, click an appropriate greeting in the Personal Inquiry Greeting box.

To enter a thank you letter, click Next, and click an appropriate greeting in the Thank You Greeting

box.

8. When you have selected the necessary greetings, click Finish.

& CHECK YOUR PROGRESS
Before reading next section, practice the following questions.

1. What is Template?

2. What is Wizard?

3. What is the difference between global and document Template?

4. Create a Letter using Wizard.

If your answers are correct, then proceed to the next section

2.5 MAIL MERGE
Mail merge is a pretty simple concept. You take a document (such as a form letter) and a set of information

(such as the names and addresses of all your clients) and you merge them. When you merge the form letter and the

list of names, you can generate a mass mailing. Each copy of the document you print will be personalized with a
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different name and address. Typing the letter once, combining it with your client list, and printing it can therefore

accomplish a mailing to hundreds of clients.

Before Starting Mail Merge

Before you start learning mail merge process, you need to understand the two documents that make up a

mail merge:

1. Main Document : In a mail-merge operation, the document containing the text and graphics stays

the same for each version of the merged document. ¾ For example, the return address and the body

of a form letter.

2. Data Source : A file that contains the text and graphics that varies with each version of a mail-merge

document. For example, a list of names and addresses for a form letter you want to send to a list of

client’s ¾ or in any report in which you want to use information from a database.

2.5.1 Creating the Main Document

The main document can be a form letter, an invoice, an invitation or any type of document. The idea here

is that the document will go to many recipients, and some unique information must be included to personalize it.

1. If you have an existing letter that you want to use for your form letter, open it, and modify it according

to your need or  if you want to start a letter from scratch, start a new blank document.

2. Save the document.

3. Choose tools, Mail Merge to display the Mail Merge Helper Dialog box.

4. Click the Create button.

5. Select Form Letter from the drop-down list. Dialog boxes will appear with two choices: to create a

form letter within the active window or in new window.

6.   Click the Active window Button

7. Then the Helper dialog box will come again but with different shape: with some more buttons and

some active buttons, which were inactive before.

8. Click on edit button if you haven’t written the letter body.



Unit-II Spell Checking and Grammar Checking

45

2.5.2 Building Data Source

In this second phase, you tell Word which document you want to use as your data source. You can either

create a new one or open an existing one.

A data source is a file that contains the data that varies in each copy of a merged document. For example,

a data source can include the name and address of each recipient of a form letter.

Create a New Word Data Source

1. Make sure you’ve already set up the main document.

2. If you don’t see the Mail Merge Helper dialog box, click in the main document, and then click Mail

Merge on the Tools menu.

3. Under Data source, click Get Data, and then click Create Data Source.

4. In the Field names in header row box, specify the data fields (A category of information in a data

source. A data field corresponds to one column of information in the data source. The name of each

data field is listed in the first row (header row) of the data source. “Postal Code” and “Last Name” are

examples of data field names.) That you want to include in the data source:

To delete a data field, click the field name in the Field names in header row box, and then click

Remove Field Name.

     To add a data field, type a new field name in the Field name box, and then click Add Field Name.

     To change the order of the data fields, click a field name in the Field names in header row box, and then

click one of the arrow buttons.

5. When you finish specifying the data fields, click OK.

6. Locate the folder that you want to save the data source in, type a file name, and then click Save.

7. Click Edit Data Source
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8. In the Data Form dialog box, fill in the information for each data record (A complete set of related

information in a data source. A data record corresponds to one row of information in the data source.

All information about one client in a client mailing list is an example of a data record:

F To fill in a record, type information for a data field, and then press ENTER to move to the next field.

If you don’t want to include information for a particular field, press ENTER to skip the field. Don’t

type spaces in the box.

F To start a new data record, click Add New.

9. To return to the main document, click Mail Merge Main Document on the Database toolbar.

Mail Merge Main Document

Now the main document displays out with the new toolbar of Mail Merge.

Inserting the Merge Fields

It’s time to enter merge fields in the form letter you typed. The merge fields in the letter will correspond to

the fields in your database.

1. Place your cursor halfway between the date and salutation.

2. Choose the Insert Merge field’s button on the Mail Merge toolbar.
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3. Word inserts the merge field surrounded by chevron brackets. Insert the remaining merge fields in the

address block, pressing Enter and adding spaces and commas where necessary. If you have a saluta-

tion field, add it after Dear, and follow it with a colon or comma.

4. Save the main document.

2.5.3 Merging Document and DATA

At this point you have the following options:

F you can view the letters that would result from performing a mail merge.

F you can run a check for errors in the merge before performing any of the above actions. This check

looks for things such as fields that don’t match the fields in your data source.

F you can merge your letters to a new document, creating one large file containing all the letters, one

after the other that would result from combining your data and document.

F you can merge to your printer, proceeding to print out these letters without previewing or saving them

to a document.

F you can print the documents to e-mail.

It is always safer to view your merged document before printing or check for the errors in the merging if any.

2.6 MACRO

What is a Macro?

If you perform a task repeatedly in Word, you can automate the task by using a macro. A macro is a series

of Word commands and instructions that you group together as a single command to accomplish a task automatically.

Instead of manually performing a series of time-consuming, repetitive actions in Word, you can create and run a

single macro –– in effect, a custom command — that accomplishes the task for you.

Here are some typical uses for macros:

F to speed up routine editing and formatting
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F to combine multiple commands; for example, inserting a table with a specific size and borders, and

with a specific number of rows and columns

F to make an option in a dialog box more accessible

F to automate a complex series of tasks

Word offers two ways for you to create a macro: the macro recorder and the Visual Basic Editor.

2.6.1 Recording a Macro

The macro recorder can help you get started creating macros. Word records a macro as a series of Word

commands in Visual Basic for Applications. When you record a macro, you can use the mouse to click commands

and options, but the macro recorder doesn’t record mouse movements in a document window. For example, you

can’t use the mouse to move the insertion point or to select, copy, or move items by clicking or dragging. You must

use the keyboard to record these actions. When you’re recording a macro, you can temporarily pause recording

and then resume recording where you stopped.

For quick access to your macro, you can assign it to a toolbar, a menu, or shortcut keys. Running the

macro is as simple as clicking the toolbar button or menu command or pressing the shortcut keys. You can also use

the Macros command (Tools menu, Macro submenu) to run a macro.

2.6.2 Record a Macro in Word

1. On the Tools menu, point to Macro, and then click Record New Macro.

2. In the Macro name box, type a name for the macro.

3. In the Store macro in box, click the template or document in which you want to store the macro.

4. In the Description box, type a description for the macro.

5. If you don’t want to assign the macro to a toolbar, a menu, or shortcut keys, clicks OK to begin

recording the macro.

To assign the macro to a toolbar or menu, click Toolbars. In the Commands box, click the macro you are

recording, and drag it to the toolbar or menu you want to assign it to. Click Close to begin recording the macro.
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To assign the macro to shortcut keys, click Keyboard. In the Commands box, click the macro you are

recording. In the Press new shortcut key box, type the key sequence, and then click Assign. Click Close to begin

recording the macro.

6. Perform the actions you want to include in your macro.

You can use the mouse to click commands and options, but the macro recorder cannot record mouse

actions in a document window. To move the insertion point or select, copy, or move text, for example,

you must use shortcut keys.

7. To stop recording your macro, click Stop Recording.

& CHECK YOUR PROGRESS

Before reading next section, practice the following questions.

True or False

1. Macros are used to send same letter to different recipients. [   ]

2. The Letter Wizard in Word can help you write a letter quickly and easily. [   ]

3. In mail merge a data source is a file that contains the data that varies in each copy of

a merged document [   ]

4. Word count option gives you all the statistics of the document that how many word,

characters, lines, paragraphs are there in the document. [   ]

Fill in the Blanks

1. If you perform a task repeatedly in Word, you can automate the task by using a _____________.
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2. The ________________ can be a form letter, an invoice, an invitation any type of document

3. After viewing tracked changes, you can _________________________ each change

4. If you are finding any difficulty to understand a word or if you want a synonym for a particular word

you can take the help of __________________.

5. The spell checker lets you check the spelling and grammar of an entire document all at once.

Describe the Following

1. Write a short note about mail merge.

2. What is macro? And how it is used?

3. What is the difference between auto correct and track changes options?

If your answers are correct, then proceed to the next section.

2.7 MS PUBLISHER

2.7.1 Overview of Microsoft Office Publisher

This section provides an overview of MS Publisher 2007, the desktop publishing and marketing materials

solution for the 2007 Microsoft Office system. MS Publisher can help you create a wide variety of high-quality

publications and marketing materials—from single-page flyers to more complex brochures, catalogs, and e-mail

newsletters.

2.7.2 Design and Reuse Pages That Reflect Your Business Brand

Unless you are starting a new business, you are likely to have an established brand identity for your

business, such as a business logo, color scheme, fonts, and business information (your tagline and address, for

example). MS Publisher 2007 includes tools to help you efficiently create, customize, and reuse marketing

communications materials that reflect your brand identity. Use the collection of intuitive design tools in Office

Publisher 2007 to create custom publications. With Office Publisher 2007, you can use your creativity to take

your publications further.

Choose from Hundreds of Templates—Offline or Online

You can get started quickly by choosing from a library of hundreds of customizable design templates or

blank publications, including newsletters, brochures, flyers, postcards, Web sites, e-mail formats, and more.

Easily Save and Locate Your Customized Templates

When you have created or customized a template, you do not want to waste time trying to locate it later.

Office Publisher 2007 enables you to create and assign categories for any publication that you save as a template.

Start with a Recently Used Publication

Now, you can browse previews of recently used work in the startup screen, so finding your work is quick

and easy.

Apply Elements from Your Brand Identity

Most businesses have an established brand identity with an existing logo, colors, and fonts that their clients

know and recognize. New functionality enables you to apply your brand identity to every template within Office

Publisher 2007 before actually starting.

Build Custom Materials from a Database

Marketing materials such as datasheets or catalogs are often most effective when they are up to date and

targeted to a specific client or client segment. However, you do not always have the time to create a new, custom-

ized datasheet for every client meeting or conference or to create a new weekly sales sheet.
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2.7.3 Editing fills and Re-coloring Pictures

Whether you are starting from a template or a blank publication, you can further customize and refine your

publication using the collection of intuitive design, layout, graphics, and typography tools in Office Publisher 2007.

The following table describes some of the layout and design features found in Office Publisher 2007.

Adjust Images within Office Publisher 2007

F Recolor pictures
F Adjust brightness and contrast
F Crop and compress images
F Set text-wrapping properties
F Insert an empty picture frame to use as a placeholder
F Insert images from a scanner or digital camera
F Rotate and flip images
F Have more control with drawing tools and Auto Shapes
F View image details with Graphics Manager

F Save elements as a picture

Take control of your layout

F Create multiple master pages
F Align text and objects with baseline alignment, movable rulers, grids, and guides
F Link text frames

            F Easily navigate, move, rename, duplicate, insert a page, or apply a master page with page navigation

Improve the appearance of text

            F Adjust character spacing with tracking and kerning
F Set text-wrapping properties
F Use TrueType fonts
F Create bulleted and numbered lists
F Add headers and footers

            F Handle paragraph and line breaks with widow and orphan controls

Incorporate design elements

F Create a consistent look with color and font schemes
F Insert professionally designed objects from the Design Gallery

F Check your work with Design Checker

2.7.4 Personalize Publications and Marketing Materials for Professional, Targeted Results

 Create personalized e-mail publications using the new E-mail Merge. Enhancements to Mail Merge now
support sending personalized e-mail publications and enable you to add bookmarks to help readers navigate
through an e-mail newsletter, as well as add personalized hyperlinks to direct users to unique online information.

 Create, manage, and store a single-client list or data list in Office Publisher 2007 by combining and
editing lists from multiple sources, including Microsoft Office Excel 2007 spreadsheet software, Office Outlook

2007, Office Outlook 2007 with Business Contact Manager, Microsoft Office Access 2007, and more.

2.7.5 Easily Share, Print, and Publish Your Publisher Publications

Office Publisher 2007 provides new and improved ways for you to easily share, print, and publish your

publications.

2.7.6 Application of MS-Publisher

MS Publisher provides direct mail formats for following Application:

(1) Brochure (2) Flyer (3) Post card

(4) Invitation (5) Personal letter (6) Newsletter

(7) Catalog
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You can create most of these in a simple word processing program or with small publishing software such

as Microsoft Publisher. MS Publisher has templates for each format, which makes it easy. You simply insert your
graphic and text where you want it and print. You can print them on a standard home office printer for a few

pennies per sheet. With MS Word, you can design pages using WordArt as well as photos, clip art and other
graphics. If designing a flyer using MS Word, however, use text boxes instead of just typing text on the page. It will
be a lot easier.

An invitation is essentially a four-sided post card. If you’ve been to a wedding or a graduation you’ve seen

them. They are also applicable for business use, especially if you have an event you want to invite people to attend.
Again, MS Publisher comes in handy. A personal letter is best done in MS Word. You type it up like any letter but
address it to a specific individual. But if you plan to do this be sure to use a high-grade paper. It will look more
professional and the extra pennies you spend on it will boost your image. A newsletter is very simple. In the

electronic age you can create one in MS Publisher using the e-mail template and e-mail it to your list at no charge.

2.8 SUMMARY
This unit has introduced you to the basic features of a MS Word and what it can do for individuals and

other business houses. The standard toolbar and the formatting toolbar offer a variety of buttons, which offer a
quick service to the user. The looks of the document can be enhanced by adding clips to it from the Clip Gallery.

WORD 2000 flags the misspell or incorrect words. The ‘Spell Check’ facility helps in finding out incorrect

words and finally corrects them this unit has introduced the steps for Inserting objects, Pictures, Files etc. This unit
has defines global, document templates, wizards for letter creation. , Mail Merge Procedure and also defines
Procedure for addition and deletion of Macro. This unit also includes MSPublisher in which we design pages using
MS Publisher. With all these advanced features, WORD 2000 is fast gaining popularity among users. Its easy and

ready to use tools have made the life of end users very comfortable.

2.9   GLOSSARY
Copy: Copying means duplicating the contents of a document at some other desired place.

Header: A header is any information printed in the top margin.

Footer: Footer is any information printed in the bottom margin.

Merge: Combine two or more cells in the same row or column into a single cell.

Split: Partition of a single cell into two or more cells.

Table: A table is made up of rows and columns of cells that you can fill with Text   and graphics

Bookmark: A bookmark is an item or location in a document that you identify and name for future

reference. You can use bookmarks to quickly jump to a specific location, create cross-references; mark

page ranges for index entries, and so on.

Font: means the way of writing characters

Word wrap: Means to adjust a word in a given specified area.

Formatting: Means changing the size, color, style, font, pattern, etc of given text.

Template: A template determines the basic structure for a document and contains. Document settings such

as AutoText entries, fonts, key assignments, macros, menus, page layout, special formatting, and styles.

Undo: It is used to reverse changes while editing,

Redo: If an undo has to perform on last reversed action that is known as Redo.

Cut and Paste: Cut and Paste means moving of text and moving of text means removing text from one

portion of the document and placing it at some other location.

Wizards: are used to automatically create applications.

Macro:  A macro is a series of Word commands and instructions that you group together as a single

command to accomplish a task automatically. Instead of manually performing a series of time-consuming,

repetitive actions in Word, you can create and run a single macro — in effect, a custom command — that

accomplishes the task for you.

Mail Merge: You take a document (such as a form letter) and a set of information (such as the names

and addresses of all your clients) and you merge them.
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Break: Break option is to insert a break in between the page. This break is of any kind i.e., it can be page

break, column break etc.

Spell Checker: The spell checker lets you check the spelling and grammar of an entire document all at once.

Autocorrect: You can use the AutoCorrect feature to automatically detect and correct types, misspelled

words, grammatical errors, and incorrect capitalization.

2.10 FURTHER READINGS
1. Microsoft WORD: The Microsoft Reference Guide to All Commands, Functions, and Features by

Nancy drews

2. Microsoft Word for Windows: a tutorial to accompany Peter Norton’s Introduction to computers by

Heather Millet Duggan, Peter Norto

3. Writing Your Dissertation with Microsoft Word: A Step-by-step Guide - by Vincent Kiernan -

2005

4. Microsoft Word 5 Quick Reference by Bryan L. Pfaffenberger using Microsoft Word by Bill

Camarda

5. Microsoft Word 97 at a Glance by Jerry Joyce, Marianne Moon

2.11 ANSWERS TO SELF LEARNING EXERCISE

Answer to Check your Progress 2.1 & 2.2

1. See the Text.

2. AutoCorrect: You can use the AutoCorrect feature to automatically detect and correct types, mis-

spelled words, grammatical errors, and incorrect capitalization.

3. The spell checker lets you check the spelling and grammar of an entire document all at once. You

won’t really need to use it if you use automatic spelling checking to fix your spellings. However if

you’re working on a rather larger document, the spelling and grammar checker comes in use

Answer to Check your Progress 2.3

(1. –6) Practice by Seeing the Text.

Answer to Check your Progress 2.4

1 A template determines the basic structure for a document and contains document settings such as

AutoText entries, fonts, key assignments, macros, menus, page layout, special formatting, and styles

2. Wizard helps you easily enter the set phrases characteristic of seasonal greetings and greetings of

personal inquiry. Use the Letter Wizard to easily create a letter.

3. See the Text

4. See the Text

Answer to Check your Progress 2.5 & 2.6

True or False

1. True 2. True 3. True 4. True

Fill in the Blanks

1. Macro 2. Main Document   3. Search yourself 4. Spelling & grammar

Describe the Following

1. Mail Merge: You take a document (such as a form letter) and a set of information (such as the names

and addresses of  all your clients) and you merge them.

2. Macro: A macro is a series of Word commands and instructions that you group together as a single

command to accomplish a task automatically. Instead of manually performing a series of time-con-

suming, repetitive actions in Word,  you can create and run a single macro — in effect, a custom

command — that accomplishes the task for you
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SOLVED QUESTIONS

Que.1. What is Bookmark?

Ans. A bookmark is an item or location in a document that you identify and name for future reference. You

can use bookmarks to quickly jump to a specific location, create cross-references; mark page ranges

for index entries, and so on.

Que.2. What is the use of MS Publisher?

Ans. MS Publisher provides the desktop publishing and marketing materials solution for the system. MS

Publisher can help you create a wide variety of high-quality publications and marketing materials from

single-page flyers to more complex brochures, catalogs, and e-mail newsletters.

Que.3. What is Linked Object?

Ans. An object that is created in a source file and inserted into a destination file, while maintaining a connection

between the two files. The linked object in the destination file can be updated when the source file is

updated.

Que.4. What is Embedded Object?

Ans. Information (object) that is contained in a source file and inserted into a destination file. Once embedded,

the object becomes part of the destination file. Changes you make to the embedded object are

reflected in the destination file.

Que.5 . What is the difference between Page Break and Column Break?

Ans. Page Break inserts a manual page break at the insertion point. Where as Column Break Inserts a

manual column break at the insertion point

Que.6. What are the uses of  Macros?

Ans. There are some typical uses for macros:

F To speed up routine editing and formatting

F To combine multiple commands; for example, inserting a table with a specific size and borders, and

with a specific number of rows and columns

F To make an option in a dialog box more accessible

F To automate a complex series of tasks

2.12 UNIT-END QUESTIONS

Que-1. How do you Record a Macro in Word?

Que-2. How does you Insert Images from Clip Gallery?

Que-3. What is the step to set a text wrapping.

Que-4. How do you create a letter-using Wizard?

Que-5. What is data source?

Que-6. Write down the Applications of MS Publisher.

Que-7. Write a short note about mail merge.

Que-8. Write is Template?

Que-9. What is Global Template?

Que-10. What is Document Template?

Que-11. What is Mail Merge?

Que-12. What is MS Publisher?

����
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UNIT III–SPREAD  SHEET PACKAGE-MS EXCEL 2000

Structure  of  the  Unit

3.0 Objectives

3.1 Introduction

3.2 How to start with MS Excel 2000

3.2.1 Components of Excel Window

Check your progress

3.3 Spreadsheet terminology

3.3.1 Organization of worksheet area

Check your progress

3.4 Worksheet management: name, Add, Delete, Move, Copy multi select

3.4.1 Data type

3.4.2 Data entry

3.4.3 Editing

3.4.4 Data coping

3.4.5 Math Operators and expressions

3.4.6 Creating Formulas and functions

Check your progress

3.5 Summary

3.6 Further Readings

3.7 Glossary

3.8 Answer to the self learning exercise

3.9 Unit-end Questions
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3.0 OBJECTIVES
This course provides an introduction to spreadsheet fundamentals. The current version of software is MS

Excel 2003; however Excel XP is the minimum acceptable platform. The course includes basic spreadsheet

construction and layout, commands, files, graphics, and printing and involves hands-on computer use. Some

computer knowledge and basic mathematics skills are recommended.

3.1 INTRODUCTION
EXCEL 2000 is a very powerful and easy to use spreadsheet package, which is being commonly used

these days. It is basically an end user application package. It works very well with numbers and their complex

calculations. Excel 2000 helps to prepare your data in an organised, orderly and meaningful fashion. Excel 2000

finds its major contribution in creating reports, using formulas and performing calculations. It is best suited for

scientific and statistical analysis. Excel 2000 can also be used to prepare Profit and Loss accounts, Balance sheet

and other Tax statements. It works well for both simple and complicated numbers. It can be used for preparing

analytical reports including statistical analysis, forecasting and regression analysis. Good looking and attractive

charts can be created which depict data in clearer and meaningful fashion. Excel 2000 can also used to create

relationships between different types of data. Excel 2000 can do all the work of a full-fledged word-processor but

it lacks the advanced features of desktop publishing it also supports the high level features of object linking and

embedding which means data from WORD can be safely and easily put and linked with data in Excel and vice

versa is also true.

3.2 HOW\ TO START WITH MS EXCEL 2000
To start with Excel

One has to follow the following steps.

1. Click on the Start Button at windows taskbar.
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2. Select Program option

3. Select Microsoft Excel option.

4. Choosing this option will open up Microsoft Excel and you will see the following screen.

3.2.1 Excel Window Components

An Excel window has the following components.

Functioning of various components of Microsoft Excel is given below.

1. Title Bar : Title bar shows the name of the document and situated in the top of the window

application.

2. Menu Bar : Menu bar contains the various commands under the various topics to perform some

special tasks. Menu bar is located under the title bar

3. Standard Toolbar : Toolbar is nothing more than the shortcut of the Menu options to execute or

perform the menu options in the easiest and faster way. Standard toolbar contains the commands for

the Word’s most frequently used commands.

4. Formatting Toolbar : Formatting toolbar contains the various commands related to the formatting of

the document.

5. Status Bar : It displays the positioning of the cursor, the status of some important keys of keyboard,

shows the messages for the toolbar button when a mouse points to it, and display messages for menu

option when a menu option is selected or pointed out by a user.

6. Formula Bar : Formula bar shows you the formula instead of the result whenever you click on a cell

in which you have a formula.
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& CHECK YOUR PROGRESS

(1) How many bars(components) are available in the spreadsheet?

(a) 5 (b) 6 (c) 7 (d) 3

(2) Which toolbar contains the various commands related to the formatting of the document?

(a) Title bar (b) menu bar (c) status bar (d) formatting toolbar

(3) Which bar shows the name of the document and situated in the top of the window Application?

(a) Title bar (b) menu bar (c) status bar (d) formula bar

3.3 SPREADSHEET TERMINOLOGY

1. Active cell : the cell in a spreadsheet application in which data may be entered.

2. Cell : the space on a spreadsheet where a column and row intersect.

3. Column : a vertical row of cells in a spreadsheet document.

4. Entry bar : the bar across the top of a spreadsheet document that displays the data being entered in

the active cell.

5. Formula : an equation which will perform a mathematical calculation in a spreadsheet.

6. Row : refers to the numbered cells that appear horizontally on a spreadsheet document.

7. Sort : to arrange information by kinds or classes, or in a particular order. “Sort” is a command that

may be used in spreadsheet or database programs.

8. Spreadsheet : a program that is similar to an electronic ledger book. Columns of numbers in a

spreadsheet program can be added automatically.

9. Tab : a command key that is used for spacing in word processing programs; for traveling from cell to

cell in a spreadsheet program; or for moving from field to a field database programs, etc.

3.3.1 Organization of a worksheet area

1. Rows : Rows are combination of all the horizontal cells joined together in single horizontal line. An

Excel workbook has maximum 65,536 rows in a worksheet

2. Columns : Columns are combination of all the vertical cells joined together in a single vertical line. An

Excel workbook has maximum 256 columns in a worksheet

3. Cell : A Cell is an intersection point of row and column. It is used to store data.

There are 65536 x 256 = 16777216 cells in a single worksheet.

4. Name Box : This box shows the name or the address of the currently active cell.

5. Formula Bar : Formula bar shows the formula instead of the result whenever you click on a cell in

which you have a formula.

& CHECK YOUR PROGRESS

(1) What is cell?

(a) The space on a spreadsheet where a column and row intersect

(b) The space on a spreadsheet where a column intersect.

(c) The space on a spreadsheet where a row intersect.

(d) All are the above
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(2) How many rows are available in the spreadsheet?

(a) 65,536 (b) 65,535 (c) 65,537 (d) 65,534

(3) How many columns are available in the spreadsheet?

(a) 256 (b) 255 (c) 254 (d) 257

(4) Which box shows the name or the address of the currently active cell?

(a) Name box (b) formula box (c) cell (d) none

3.4 WORKSHEET MANAGEMENT: (NAME, ADD, DELETE, MOVE, COPY,

MULTI SELECT)
Following steps are required to manage a work sheet:-

Name or Rename of Worksheet:

Rename: For this, right click on the worksheet the following option will display.

Choose the rename option.

Name: The worksheet may be selected for naming. Here you can type the worksheet name.

Addition of a new worksheet:



60

Spread Sheet Package–MS-EXCEL 2000          Unit-III

For adding/inserting a new worksheet choose the worksheet option in the following manner-

Open all the workbooks that you want to open as a group.

1. Click on the insert menu of the menu bar

2. Choose the worksheet option and click.

Delete a Worksheet:

Delete sheet command is used to delete the current sheet and keep remember that once a sheet deleted

can’t be recovered. So take care while issuing this command that you are on the sheet, which you want to delete.

Or

You can delete using delete option that you can find in the following menu.

Move or Copy Worksheet

A sheet can be copied or moved to the same workbook as well as to the other workbook. To do so the

user has to make use of the Move or copy sheet option from the edit menu in the following manner.
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To copy or to move a worksheet, follow these steps.

1. Select the workbook from To books list box in which you want to copy or move the current worksheet.

2. If you want to create a copy of the current work sheet check mark the Create a copy option.

Otherwise if you want to move the current worksheet, remains the Create a copy option unchecked.

3. Press Ok button.

Multi selection of worksheet:

This can be done in the following manner-

1. Right click on worksheet

2. Select All Sheets option.

3.4.1 Data Type

In a spreadsheet there are three basic types of data available to it.

F labels - (text with no numerical value)

F constants - (just a number — constant value)

F formulas* - (a mathematical equation used to calculate)

Data Types Examples Descriptions

LABEL Name or Wage or Days Anything that is just text

CONSTANT 5 or 3.75 or -7.4 Any number

FORMULA =5+3 or = 8*5+3 Math equation

*ALL formulas MUST begin with an equal sign (=).

3.4.2 Data entry

A cell contains the data entered by operator. At any time, one cell is always highlighted which is called the

currently active cell.

The address of this currently active cell is shown in the ‘Name’ box, which lies in the upper left corner of

the screen, exactly above the column letter A. You can place your data in any portion of the worksheet.

Take your cell pointer at a place wherever you want to put your data in any portion of the worksheet.

Take your cell pointer at a place wherever you want to put your data with the help of either the mouse pointer or

move to that particular cell with the help of arrow keys. Similarly, in order to select a group of continuous cells,

take your mouse pointer at the cell from where you want your range to start.
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Click at that cell and then drag your mouse pointer diagonally to the opposite corner, release the mouse

pointer when the desired range is made. All the cells in the range become highlighted.

3.4.3 Data editing

Cut and Paste

Cut and Paste means moving of text of cells and moving of text means removing text from one portion of

the worksheet and placing it at some other location.

To cut text of cells:

1. Select the cells or make the range of the cells

2. Select cut from Edit menu

or

Click on the cut button of standard toolbar

or

Press the ctrl+x button

or

Move the mouse pointer on the selected text and right click and select cut as shown in figure given

below

To  paste  the  selection

1. Move the cursor at the location where the text is to be pasted

2. Select Paste from Edit menu

or

Click paste button on the standard toolbar

or

Press Ctrl + v

or

Click the right mouse button and select paste from the context menu.

Reversing Commands
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1. Undo

To reverse changes while editing undo command is used. To perform undo you can

Click on the Undo option under Edit menu

or

Click on the Undo button on Standard toolbar

or

Press Ctrl+z.

2. Redo

If an undo has to perform on last reversed action that is known as Redo. To perform redo you can

(a) Click on the Redo option under Edit Menu or

(b) Click on the Undo button on Standard Toolbar or

(c) Press Ctrl+y

Find Replace and go to Options

Find

Some times while working in Worksheet you need to find a particular text.

To find a particular text you have to follow the steps given below:

1. On the Edit menu, click Find. Then you will see the following window

2. In the Find what box, enter the text that you want to search for.

3. Select the direction of searching from Search list box.

4. Select any other options that you want.

Match case: To find the characters that are a word by themselves and are not a part of another word.

Find entire cell only: To find the characters that are a word by themselves and are not a part of another

word.

i. For Help on an option, click the question mark and then click the option.

ii. Click Find Next.

iii. If you want find similar word again in the rest of the document click on the Find next button.
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Replace

If you want to replace a word in the document with another word you can use find and replace command.

i. On the Edit menu, click Replace. Then you will find the following window

ii. The Find what box, enter the text that you want to search for.

iii. In the Replace with box, enter the replacement text.

iv. Select any other options that you want.

v. For Help on an option, click the question mark and then click the option.

vi. Click Find Next, Replace, or Replace All.

vii. To cancel a search in progress, press ESC.

Go to

Follow the Following steps to do so-

1. Click on the Go to option under the Edit menu. Then the following window will appear on the screen.

2. Enter the parameter as page number or cell name in the reference text box.

3. Click on the Ok button.

Create Linear and Growth Trends with the Series Command

When you use the Series command, the resulting series replaces the original selected values. To save the

original values, copy them to a different row or column. Then create the series by selecting the copied values.

1. Select the cell where you want to start the series. The cell must contain the first value in the series.

2. On the Edit menu, point to Fill, and then click Series.

3. Now do one of the following:

F To fill the series down the page, click Columns.

F To fill the series across the page, click Rows.
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4. In the Step value box, enter the value that you want to increase the series. In a linear series, the step

value is added to the first starting value and then added to each subsequent value. In a growth series,

the first starting value is multiplied by the step value. The resulting product and each subsequent

product are then multiplied by the step value.

i. Under Type, click Linear or Growth.

ii. In the Stop value box, enter the value you want to stop the series at.
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Clear Command

Clear command is used to clear a content, format or comments.

1. Format: Clearing format means that if there is any content with some format is there in current cell

then by issuing clear format command will clear that format only not the contents. The content will

remains same as it is but the format of the cell or the format of the content will be cleared.

2. Contents: Clearing content means that if there is any content with some format is there in current cell

then by issuing clear content command will clear that content only not the formats. The format will

remains same as it is but the format of the cell or the format of the content will be cleared.

3. Comments: Clear Comments will clear the comments settled in a cell for reference. Setting of

comment you will learn in next few chapters.

4. All: Clearing all means to clear all whatever there in the cell or the in the range.

Delete

Issuing command Delete from Edit menu will give you four options to delete. These are as follows:

1. Delete cell and shift the right cell on the place of the current cell, which is going to be deleted.

2. Delete cell and shift the left cell on the place of the current cell, which is going to be deleted.

3. Delete the whole row.

4. Delete the whole column.

3.4.4 Data Copying

Copying does mean duplicating the contents of the document at some other desired location or place. The

procedure for copying text is almost the same as that of moving text with a little difference, which is being dis-

cussed in the following steps.

To copy a particular text

i. Select the cell or make the range of the cells

ii. Select copy from Edit menu

or

Click on the copy button of standard toolbar

or

Press the ctrl + c button

or

Move the mouse pointer on the selected range and right click and select Copy.

Paste operation has already been discussed and is same as described in the cut and paste section

3.4.5 Math Operators and expressions

Mathematical operators specify the type of calculation that you want to perform on the operands or

elements of a formula. Microsoft Excel has four types of operators i.e. Arithmetic, Comparison, Text, and

Reference.

Arithmetic operator Meaning (Example) 

+ (plus sign) Addition (3+3) 

– (minus sign) Subtraction (3–1) 

Negation (–1)

* (asterisk) Multiplication (3*3)

/ (forward slash) Division (3/3)

% (percent sign) Percent (20%)

^ (caret) Exponentiation (3^2)
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Arithmetic operators

To perform basic mathematical operations such as addition, subtraction, or multiplication; combine

numbers; and produce numeric results. Following are some arithmetic operators.

Comparison operators

By using these operators you can compare two values. When two values are compared by using these

operators, the result is a logical value either TRUE or FALSE.

Comparison operator Meaning (Example) 

= (equal sign) Equal to (A1=B1)

> (greater than sign) Greater than (A1>B1)

< (less than sign) Less than (A1<B1)

>= (greater than or equal to sign) Greater than or equal to (A1>=B1)

<= (less than or equal to sign) Less than or equal to (A1<=B1)

<> (not equal to sign) Not equal to (A1<>B1)

Text concatenation operator:

To perform concatenation operation we use the ampersand (&) to join, or concatenate, one or more text

strings to produce a single piece of text.

Text operator Meaning (Example) 

& (ampersand) Connects, or concatenates, two values to produce one continuous text 

value ("North"&"wind")

Reference operators:

Combine ranges of cells for calculations with the following operators.

Reference operator Meaning (Example) 

: (colon) Range operator, which produces one reference to all the cells between two references, 

including the two references (B5:B15)

, (comma) Union operator, which combines multiple references into one reference 

(SUM(B5:B15,D5:D15))

(space) Intersection operator, which produces on reference to cells common to the two 
references (B7:D7 C6:C8)

3.4.6 Creating Formulas and functions

ROUNDUP

Formula Description (Result) 

=ROUNDUP(3.2,0) Rounds 3.2 up to zero decimal places (4)

=ROUNDUP(76.9,0) Rounds 76.9 up to zero decimal places (77)

=ROUNDUP(3.14159, 3) Rounds 3.14159 up to three decimal places  (3.142)

=ROUNDUP(-3.14159, 1) Rounds -3.14159 up to one decimal place (-3.2)

=ROUNDUP(31415.92654, -2) Rounds 31415.92654  up to 2 decimal places to the left of the decimal (31500)
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SUM

Formula Description (Result) 

=SUM(B2:B3, B5) Adds 2 invoices from Buchanan, and one from Suyama (44,000)

=SUM(B2,B5,B7) Adds individual invoices from Buchanan, Suyama, and Dodsworth (57,500)

Note : The SUM function can include up to 30 cell or range references.

AVERAGE

Formula Description (Result) 

=AVERAGE(A2:A7) Averages all of numbers in list above (9.5)

=AVERAGE(A2:A4,A7) Averages the top three and the last number in the list (7.5)

=AVERAGE(IF(A2:A7<>0, 

A2:A7,""))

Averages the numbers in the list except those that contain zero, such as cell 

A6 (11.4)

ABS

It returns the absolute value of a number. The absolute value of a number is the number without its sign.

Number is basically the real number of which you want to find the absolute value.

  

Formula Description (Result) 

=ABS(2) Absolute value of 2 (2)

=ABS(-2) Absolute value of -2 (2)

=ABS(A2) Absolute value of -4 (4)

MULTIPLY

Formula Description (Result) 

=A2*A3 Multiplies the numbers in the first two cells (75)

=PRODUCT(A2:A4) Multiplies all the numbers in the range (2250)

=PRODUCT(A2:A4,2) Multiplies all the numbers in the range, and 2 (4500)

POWER

To do this task use the “^” operator or the POWER function.

The example may be easier to understand if you copy it to a blank worksheet.

Formula Description (Result) 

=POWER(5,2) Calculates five squared (25)

=5^3 Calculates five cubed (125)

COUNT

It count cells that contain numbers

Use the COUNT function to do this task.
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Formula Description (Result) 

=COUNT(A2:A6) Counts number of cells that contain numbers (3) in the list. A date is a number.

=COUNT(A2:A3,A6) Counts number of cells that contain numbers (2), of the top two and bottom cells 

in the list. A date is a number.

& CHECK YOUR PROGRESS

(1) Formula must begin with this symbol-

(a) + (b) - (c) = (d) none

(2) This mathematical function returns integer or absolute value-

(a) Abs () (b) absolute () (c) int () (d) sum ()

(3) Sum () is a –

(a) Mathematical function (b) statistical function (c) Text function (d) none of the above

(4) MIN (5,10,02,25,30) returns –

(a) 02 (b) 00 (c) 05 (d) 10

3.5 SUMMARY
Overall the evaluations would appear to indicate that the computer component of this course was highly

successful. The objectives of this development to cope with large numbers of students and to foster development

of spreadsheet skills were achieved. As such the described system offers accounting instructors and those in other

number based subjects (e.g. engineering) the opportunity to provide students with an improved learning experi-

ence in an efficient, cost effective manner.

3.6 FURTHER READINGS
1. Philip Howard (2005-04-22). Managing spreadsheets. IT-Directors.com.

2. Raymond R. Panko (2005-01). What We Know About Spreadsheet Errors.

3. Beare, R. (1993). A spreadsheet system for educational use based on Microsoft Excel, Australian

Educational Computing, July 1993.

3.7 GLOSSARY

F A spreadsheet is a rectangular table (or grid) of information, often financial information.

F The Graphical User Interface is a particular case of user interface for interacting with a computer

which employs graphical images and widgets in addition to text to represent the information and

actions available to the user.

F Microsoft Excel (full name Microsoft Office Excel) is a spreadsheet program written.

F A formula is a concise way of expressing information symbolically or a general relationship between

quantities.

F A data type is a constraint placed upon the interpretation of data in a type system in computer

programming.

3.8 ANSWER TO THE SELF LEARNING EXERCISE

Answer to Check your progress 3.2

1. (b) 2. (d) 3. (a)
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Answer to Check your progress 3.3

1.(a) 2. (a) 3. (a) 4. (a)

Answer to Check your progress 3.4

1.(c) 2. (a) 3. (a) 4. (a)

3.9 UNIT-END QUESTIONS

(1) What is spreadsheet and define workbook, row, column and cell.

(2) Explain the various components of EXCEL window.

(3) Define what is the work organization of the spreadsheet?

(4) What is the procedure to find the particular text and replace that with another text?

(5) Write the syntax of the following functions-

(a) Sum () (b) average () (c) abs () (d) power ()

(6) How many types of operators are available in the spreadsheet explain using suitable example?

(7) How can move and copy the text in the spreadsheet illustrate using steps?

����
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Unit IV: FORMATTING  FEATURES-MS  EXCEL  2000

Structure of Unit

4.0 Objectives

4.1 Introduction

4.2 Formatting Features

4.2.1 Text, Row & Columns Numbers, borders, colors & pallets

4.2.2 Absolute and relative addresses

4.2.3 Introduction to excel Functions
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4.4 Glossary
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4.7 Unit End Questions
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4.0 OBJECTIVES
MS Excel 2000 is the popular version of the spreadsheet from Microsoft. This course is designed to

advance users’ knowledge of the formatting features and functions within Excel and realize the advantages of using

a powerful electronic spreadsheet. The course is entirely ‘hands on’, so those reading will get practice in creating

and modifying actual spreadsheets, enhancing them with Text, Row & Columns Numbers, borders, colors &

pallets.

4.1 INTRODUCTION
MS-EXCEL 2000 is a window based application package of MS-Office suite, which is used to make

calculations and derive analysis on the basis of produced data in a tabular form. In addition to exhibiting detailed

account of annual budget and profit or loss in a table, it can be presented in different graphical forms. With the help

of this advance package, various formatting features like

Text, Row & Columns Numbers, borders, colors & pallets, Absolute and relative addresses, Functions,

Mouse techniques, preparing worksheets for use by other users, can be used for related purpose.

4.2 FORMATTING FEATURES TEXT NUMBERS, BORDERS, COLORS &

PLATTERS
The contents of a highlighted cell can be formatted in many ways. Font and cell attributes can be added

from shortcut buttons on the formatting bar. If this toolbar is not already visible on the screen, select

View|Toolbars|Formatting from the menu bar.

Format Cells Dialog Box

For a complete list of formatting options, right-click on the highlighted cells and choose Format Cells

from the shortcut menu or select Format Cells from the menu bar.

Number tab

The data type can be selected from the options on this tab. Select General if the cell contains text and

number, or another numerical category if the cell is a number that will be included in functions or formulas.

Alignment tab

These options allow you to change the position and alignment of the data with the cell.

Font tab

All of the font attributes are displayed in this tab including font face, size, style, and effects.

Border and Pattern tabs

These tabs allow you to add borders, shading, and background colors to a cell.
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Dates and Times

If you enter the date “January 1, 2001” into a cell on the worksheet, Excel will automatically recognize the

text as a date and change the format to “1-Jan-01”. To change the date format, select the Number tab from the

Format Cells window. Select “Date” from the Category box and choose the format for the date from the Type

box. If the field is a time, select “Time” from the Category box and select the type in the right box. Date and time

combinations are also listed. Press OK when finished.

Styles

The use of styles in Excel allows you to quickly format your worksheet, provide consistency, and create a

professional look. Select the Styles drop-down box from the formatting toolbar (it can be added by customizing

the toolbar). Excel provides several preset styles:
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F Comma :– Adds commas to the number and two digits beyond a decimal point.

F Comma [0] :– Comma styles that round to a whole number.

F Currency :– Formats the number as currency with a dollar sign, commas, and two digits beyond the

decimal point.

F Currency [0] :– Currency styles that round to a whole number.

F Normal :– Reverts any changes to general number format.

F Percent :– Changes the number to a percent and adds a percent sign.

Style Dialog Box

Create your own styles from the Style Dialog Box.

F Highlight the cell(s) you want to add a style to.

F Select Format Style... from the menu bar.

F Modify the attributes by clicking the Modify button.

F Check all the items under Style includes that the style should format.

F Click Add to preview the formatting changes on the worksheet.

F Highlight the style you want to apply to the paragraph and click Apply.
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Create a New Style

F Select the cell on the worksheet containing the formatting you would like to set as a new style.

F Click the Style box on the Formatting toolbar so the style name is highlighted.

F Delete the text in the Style box and type the name of the new style.

F Press ENTER when finished.

Format  Painter 

A handy feature on the standard toolbar for formatting text is the Format Painter. If you have formatted a

cell with a certain font style, date format, border, and other formatting options, and you want to format another cell

or group of cells the same way, place the cursor within the cell containing the formatting you want to copy. Click

the Format Painter button in the standard toolbar (notice that your pointer now has a paintbrush beside it).

Highlight the cells you want to add the same formatting to.

To copy the formatting to many groups of cells, double-click the Format Painter button. The format

painter remains active until you press the ESC key to turn it off.

Auto Format

Excel has many preset table formatting options. Add these styles by following these steps:

F Highlight the cells that will be formatted.

F Select Format|AutoFormat from the menu bar.

F On the AutoFormat dialog box, select the format you want to apply to the table by clicking on it with

the mouse. Use the scroll bar to view all of the formats available.

F Click the Options... button to select the elements that the formatting will apply to.

F Click OK when finished.
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4.2.1 Formation Row & Columns

Resizing Rows and Columns

There are two ways to resize rows and columns.

F Resize a row by dragging the line below the label of the row you would like to resize. Resize a

column in a similar manner by dragging the line to the right of the label corresponding to the column

you want to resize.

OR

F Click the row or column label and select Format|Row|Height or Format|Column|Width from the

menu bar to enter a numerical value for the height of the row or width of the column.

Selecting Cells

Before a cell can be modified or formatted, it must first be selected (highlighted). Refer to the table below

for selecting groups of cells.
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Cells to select Mouse action

One cell click once in the cell

Entire row click the row label

Entire column click the column label

Entire worksheet click the whole sheet button

Cluster of cells drag mouse over the cells or hold down the SHIFT key while 
using the arrow keys

To activate the contents of a cell, double-click on the cell or click once and press F2.

Moving and Copying Cells

Moving Cells 

To cut cell contents that will be moved to another cell select Edit then Cut from the menu bar or click the

Cut button on the standard toolbar.

Copying Cells 

To copy the cell contents select Edit then Copy from the menu bar or click the Copy button on the

standard toolbar.

Pasting Cut and Copied Cells

Highlight the cell you want to paste the cut or copied content into and select Edit then Paste from the

menu bar or click the Paste button on the standard toolbar.

Drag and Drop

If you are moving the cell contents only a short distance, the drag-and-drop method may be easier. Simply

drag the highlighted border of the selected cell to the destination cell with the mouse.

Inserting column

Sometimes we (all) make mistakes or things change. If you have a spreadsheet designed and you forgot to

include some important information, you can insert a column into an existing spreadsheet. What you must do is

click on the column label (letter) and chooses in Columns from the Insert menu. This will insert a column imme-

diately left of the selected column.

As you can see from this example there was a blank column inserted into the spreadsheet. You might

wonder if this will affect your referenced formulas. Yes, the Referenced cells are changed to their new locations.

For example:

Cell C4 was =C3+B4

and now is =D3+B4
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Inserting rows

Likewise, we can also insert rows. With the row label (number) selected you must choose the Row from

the Insert menu. Again this will insert a row before the row you have selected.

The formulas will be updated to their corresponding locations.

C3 was = C2+B3

NOW C4=C2+B4

4.2.2 Absolute and relative addresses

Calling cells by just their column and row labels (such as “A1”) is called relative referencing. When a

formula contains relative referencing and it is copied from one cell to another, Excel does not create an exact copy

of the formula. It will change cell addresses relative to the row and column they are moved to.

For example, if a simple addition formula in cell C1 “=(A1+B1)” is copied to cell C2, the formula would

change to “=(A2+B2)” to reflect the new row.

To prevent this change, cells must be called by absolute referencing and this is accomplished by placing

dollar signs “$” within the cell addresses in the formula. Continuing the previous example, the formula in cell C1

would read “=($A$1+$B$1)” if the value of cell C2 should be the sum of cells A1 and B1. Both the column and

row of both cells are absolute and will not change when copied.

Mixed referencing can also be used where only the row OR column fixed. For example, in the formula

“=(A$1+$B2)”, the row of cell A1 is fixed and the column of cell B2 is fixed.

4.2.3 Introduction to excel Functions

Basic Functions

Functions can be a more efficient way of performing mathematical operations than formulas. For example,

if you wanted to add the values of cells D1 through D10, you would type the formula

“=D1+D2+D3+D4+D5+D6+D7+D8+D9+D10”.

Function Example Description

SUM =SUM(A1:100) finds the sum of cells A1 through A100

AVERAGE =AVERAGE(B1:B10) finds the average of cells B1 through B10

MAX =MAX(C1:C100) returns the highest number from cells C1 through C100

MIN =MIN(D1:D100) returns the lowest number from cells D1 through D100

SQRT =SQRT(D10) finds the square root of the value in cell D10

TODAY =TODAY() returns the current date (leave the parentheses empty)

A shorter way would be to use the SUM function and simply type “=SUM(D1:D10)”. Several other

functions and examples are given in the table below:
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Function Wizard 

View all functions available in Excel by using the Function Wizard.

F Activate the cell where the function will be placed and click the Function Wizard button on the

standard toolbar.

F From the Paste Function dialog box, browse through the functions by clicking in the Function

category menu on the left and select the function from the Function name choices on the right. As

each function name is highlighted a description and example of use is provided below the two boxes.

F Click OK to select a function.

F The next window allows you to choose the cells that will be included in the function. In the example

below, cells B4 and C4 were automatically selected for the sum function by Excel. The cell values {2,

3} are located to the right of the Number 1 field where the cell addresses are listed. If another set of

cells, such as B5 and C5, needed to be added to the function, those cells would be added in the

format “B5:C5” to the Number 2 field.

F Click OK when all the cells for the function have been selected.

Autosum 
Use the Autosum function to add the contents of a cluster of adjacent cells.

F Select the cell that the sum will appear in that is outside the cluster of cells whose values will be added.
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Cell C2 was used in this example.

F Click the Autosum button (Greek letter sigma) on the standard toolbar.

F Highlight the group of cells that will be summed (cells A2 through B2 in this example).

F Press the ENTER key on the keyboard or click the green check mark button on the formula bar .

Spreadsheets have many Math functions built into them. Of the most basic operations are the standard

multiply, divide, add and subtract. These operations follow the order of operations (just like algebra). Let’s look

at some examples.

For these following examples lets consider the following data:

A1 (column A, row 1) = 5 

A2 (column A, row 2) = 7 

A3 (column A, row 3) = 8 

B1 (column B, row 1) = 3 

B2 (column B, row 2) = 4 

B3 (column B, row 3) = 6 

A B

1 5 3

2 7 4

3 8 6

Operation Symbol Constant

Data

Referenced

Data

Answer

Multiplication * = 5 * 6 = A1 * B3 30

Division / = 8 / 4 = A3 / B2 2

Addition + = 4 + 7 = B2 + A2 11

Subtraction - = 8 - 3 = A3 - B1 5

Subtraction - = 8 - 3 = A3 - B1 5

Probably the most popular function in any spreadsheet is the SUM function. The Sum function takes all of

the values in each of the specified cells and totals their values. The syntax is:

=SUM(first value, second value, etc)

In the first and second spots you can enter any of the following (constant, cell, range of cells).

F Blank cells will return a value of zero to be added to the total.

F Text cells can not be added to a number and will produce an error.

Lets use the table here for the discussion that follows: 

We will look at several different specific examples that show 
how the typical function can be used! Notice that in A4 there 
is a TEXT entry. This has NO numeric value and can not be 
included in a total.

A

1 25

2 50

3 75

4 test

5
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E xam ple C ells to A D D A nsw er

= sum  (A 1:A 3) A 1, A 2 , A 3  150

= sum  (A 1:A 3, 100) A 1, A 2 , A 3  and  100 250

= sum  (A 1+ A 4) A 1, A 4 #V A L U E !

= sum  (A 1:A 2, A 5) A 1, A 2 , A 5 75

There are many functions built into many spreadsheets. One of the first ones that we are going to discuss

is the Average function. The average function finds the average of the specified data. (Simplifies adding all of

the indicated cells together and dividing by the total number of cells.) The syntax is as follows.

=Average (first value, second value, etc.)

Text fields and blank entries are not included in the calculations of the Average Function.

Lets use the table here for the discussion that follows: 
We will look at several different specific examples that 

show how the average function can be used!

A

1 25

2 50

3 75

4 100

5

Example Cells to average Answer

=average (A1:A4) A1, A2, A3, A4 62.5

=average (A1:A4, 300) A1, A2, A3, A4 and 300 110

=average (A1:A5) A1, A2, A3, A4, A5 62.5

=average (A1:A2, A4) A1, A2, A4 58.33

Lets use the table here for the discussion that follows. 
W e will look at several different specific examples that show how the 
M ax functions can be used!

A

1 10

2 20

3 30

4 test

5

The next function we will discuss is Max (which stand for Maximum). This will return the largest (max)

value in the selected range of cells.

F Blank entries are not included in the calculations of the Max Function.

F Text entries are not included in the calculations of the Max Function.

Example of  Max Cells to look at Ans. Max

=max (A1:A4) A1, A2, A3, A4 30

=max (A1:A4, 100) A1, A2, A3, A4 and 
100

100

=max (A1, A3) A1, A3 30

=max (A1, A5) A1, A5 10
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The next function we will discuss is Min (which stands for minimum). This will return the smallest (Min)

value in the selected range of cells.

F Blank entries are not included in the calculations of the Min Function.

F Text entries are not included in the calculations of the Min Function.

Lets use the table here for the discussion that follows. 
We will look at several different specific examples that 
show how the min functions can be used!

A

1 10

2 20

3 30

4 test

5

Example of min Cells to look at Ans. min

=min (A1:A4) A1, A2, A3, A4 10

=min (A2:A3, 
100)

A2, A3 and 100 20

=min (A1, A3) A1, A3 10

=min (A1, A5) A1, A5 (displays the smallest number) 10

The next function we will discuss is Count. This will return the number of entries (actually counts each cell

that contains number data) in the selected range of cells.

F Blank entries are not counted.

F Text entries are NOT counted.

L e ts  u s e  th e  ta b le  h e re  fo r  th e  d is c u s s io n  th a t  fo l lo w s . 
W e  w i ll  lo o k  a t s e v e ra l  d iff e re n t  sp e c i f ic  e x a m p le s  
th a t sh o w  h o w  th e  C o u n t fu n c t io n s  c a n  b e  u s e d !

A

1 1 0

2 2 0

3 3 0

4 te s t

5

Example of Count Cells to look at Answer

=Count (A1:A3) A1, A2, A3 3

=Count (A1:A3, 100) A1, A2, A3 and 100 4

=Count (A1, A3) A1, A3 2

=Count (A1, A4) A1, A4 1

=Count (A1, A5) A1, A5 1

The next function we will discuss is IF. The IF function will check the logical condition of a statement and

return one value if true and a different value if false. The syntax is

F =IF (condition, value-if-true, value-if-false)

F Value returned may be either a number or text

F If value returned is text, it must be in quotes
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L ets  use  the  table here 
for the  discussion  that 
follow s. W e will loo k 
at several different 
specific  exam ples that 
sho w h ow  the IF 
functions can  be used!

A B

1 P rice O ver a d ollar?

2 $.95 No

3 $1.3 7 Y es

4 com paring # returnin g #

5 140 00
0.08

</T D <  tr>

Example of IF

typed into column B
Compares Answer

=IF (A2>1,"Yes","No") is ( .95 > 1) No

=IF (A3>1, "Yes", "No") is (1.37 > 1) Yes

=IF (A5>10000, .08, .05) is (14000 > 10000) .08

=IF (A6>10000, .08, .05) is (8453 > 10000) .05

The PMT function returns the periodic (in this case monthly) payment for an annuity (in this case a loan).

This is the PMT function that was used for the car purchase in the first example. There are a few things that we

must know in order for this function to work. To calculate the loan we must know a combination of the following–

F (rate) interest rate per period

F (NPER) number of payments until repaid

F (PV) present value of the loan (amount we are borrowing)

F (FV) future value of the money (for saving or investing)

F (type) enter 0 or 1 to indicate when payments are due.

=PMT(rate, NPER, PV, FV, type)

equation goes into c7 =PMT(C4/12,C5,-C3)

C4 is the yearly interest and since it's compounded 
monthly we divide by 12 

C5 is the number of months (# of payments) 

-C3 is the amount of money we have (borrow - negative)

angle sin cos tan

REF =sin(REF) =cos(REF) =tan(REF)

0 0.00 1.00 0.00

30 0.50 0.87 0.58

45 0.71 0.71 1.00

90 1.00 0.00

180 0.00 -1.00 0.00

Note that the rate is per period. If we have an annual interest rate of 9.6% and we are calculating monthly

payments, we must divide the annual interest rate by 12 to calculate the monthly interest rate.
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Excel has most of the math and trig functions built into it. If you need to use the SIN, COS, TAN

functions, they can be typed into any cell. If you wanted to find:

format for degrees formula = sin (angle * pi()/180) the argument angle is in degrees

format for radians formula = sin (angle) the argument angle is in radians

To calculate trig functions in degrees you must convert them - otherwise excel will calculate them in radians.

You can type in either an actual number for the REF or you can also type in a reference from the excel

spreadsheet (like A2).

& CHECK YOUR PROGRESS
1. Formatting features are available in –

(a) Edit bar (b) view bar (c) format bar (d) none of the above

2. Which options allow you to change the position and alignment of the data with the cell –

(a) Number tab (b) Assignment tab (c) font tab (d) Border and Palletsern tabs

3. Excel provides several preset styles –

(a) Comma (b) currency (c) both (a) & (b) (d) none of the above

4. What does show this  -?

(a) To cut (b) to copy (c) to paste (d) to move

4.3 SUMMARY
Overall the evaluations would appear to indicate that the computer component of this course was highly

successful. The objectives of this development to cope with large numbers of students and to foster development

of spreadsheet skills were achieved. As such the described system offers accounting instructors and those in other

number based subjects (e.g. engineering) the opportunity to provide students with an improved learning experi-

ence in an efficient, cost effective manner.

4.4 GLOSSARY
Formatting is to prepare a storage medium, usually a disk, for reading and writing.

Platter is a plate where user can choose combination of colors.

4.5 FURTHER READINGS
1. Philip Howard (2005-04-22). Managing spreadsheets. IT-Directors.com.

2. Raymond R. Panko (2005-01). What We Know About Spreadsheet Errors.

3. Beare, R. (1993). A spreadsheet system for educational use based on Microsoft Excel, Australian

Educational Computing, July 1993.

4.6 ANSWER TO THE SELF LEARNING EXERCISE

Answer to check your progress 4.2

1. (c) 2. (b) 3.(c) 4.(a)

4.7 UNIT-END QUESTIONS
1. Define each –

(a) Format Cells Dialog Box (b) Date & Times

(c) Styles (d) Auto Format

2. What are the Excel functions? Illustrate with example.

3. Explain about formation of rows & columns.

4. What is the purpose of absolute and relative address in EXCEL? Explain using suitable examples.

����
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Unit V : ADVANCE FEATURES-MS EXCEL 2000

Structure of the Unit

5.0 Objectives

5.1 Introduction

5.2 Advanced Features of MS –EXCELS

5.2.1 Data validation

5.2.2 Conditional formats

5.2.3 Comments, Options

5.2.4 Protection

5.2.5 Text data

5.2.6 Delimiters

5.2.7 Database Queries

5.2.8 Goal seek

5.2.9 Scenarios

5.2.10 Freezing

5.2.11 Painting

5.2.12 Excel worksheets sort

5.2.13 Filter

5.2.14 Naming ranges

5.2.15 past special options

5.2.16 Pivot table

5.2.17 Data table

5.2.18 Charts

5.2.19 Macros: reading, editing

5.2.20 working with objects.

Check your progress

5.3 Summary

5.4 Further Readings

5.5 Glossary

5.6 Answer to the self learning exercise

5.7 Unit-end Questions
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5.0 OBJECTIVES

MS Excel 2000 is the popular version of the spreadsheet from Microsoft. This course is designed to

advance users’ knowledge of the features and functions within Excel and realize the advantages of using a power-

ful electronic spreadsheet. The course is entirely ‘hands on’, so those reading will get practice in creating and

modifying actual spreadsheets, enhancing them with charts and graphics and using more advanced formulae.

5.1 INTRODUCTION

MS-EXCEL 2000 is a window based application package of MS-Office suite, which is used to make

calculations and derive analysis on the basis of produced data in a tabular form. In addition to exhibiting detailed

account of annual budget and profit or loss in a table, it can be presented in different graphical forms. With the help

of this advance package, various data validations, Conditional formats, Comments, Options, Protection, Text

data, Delimiters, Database Queries, Goal seek, Scenarios, Freezing, Painting, Excel worksheets sort, Filter, Naming

ranges, past special options, Pivot table, Data table, Charts, Macros: reading, editing, Working with objects can

be used for related purpose.

5.2 ADVANCE FEATURES OF MS –EXCELS

5.2.1 Data Validation

Validation is a facility on the track of accuracy. In computer technology, sometimes you need to put some

validations on some particular cells for the users to not to enter value other than some specific requirement. To

provide validation you have to follow the following steps.

1. Select the cells in which you want to provide some validations.

2. Select the Validation option from Data menu.
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3. Click a data validation option in the Allow box to apply restrictions on data entry to selected cells on

the worksheet. Click the Custom option to enter a formula, use an expression, or refer to a calculation

in another cell to determine valid entries.

4. Click the comparison operator you want to use. The available operators depend on the type of data

you chose in the Allow box.

5. Enter the minimum value, start date, or start time as a value, cell reference, or formula for the data

validation option you chose in the Allow box.

6. Apply the maximum value, end date, or end time as a value, cell reference, or formula for the data

validation option you chose in the Allow box.

 7. Now Click the Input Message tab to provide an input message when user clicks on the cells in which

validation is set.

8. Enter the value of Title and Input message.

9. Click on Error alert to provide some error message when the user enters value other than the

validations.

10. Enter the Error message title, Error message and click Ok button

11. Now if someone clicks on the restricted cells then he will input message and it will be displayed

12. If user will make some errors then error message will flash.



88

Advance Features–MS EXCEL 2000            Unit-V

5.2.2 Conditional Formats

If a cell contains formula results or other cell values that you want to monitor, you can identify the cells by

applying conditional formats. For example, you can apply green shading (highlighting) to the cell if the sales exceed

forecast and red shading if sales fall short.

When Conditions Change

If the value of the cell changes and no longer meets the specified condition, Microsoft Excel temporarily

suppresses the formats that highlight that condition. Conditional formats remain applied to the cells until you

remove them, even though none of the conditions are met and the specified cell formats are not displayed.

Highlight Cells that Meet Specific Conditions

1. Select the cells you want to highlight.

2. On the Format menu, click Conditional Formatting.
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3. Do one of the following:

To use values in the selected cells as the formatting criteria, click Cell Value Is, select the comparison

phrase, and then type a value in the appropriate box. You can enter a constant value or a formula. If you enter a

formula, you must start it with an equal sign (=).
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To use a formula as the formatting criteria (to evaluate data or a condition other than the values in selected

cells), click Formula Is in the box on the left, and then enter the formula in the box on the right. The formula must

evaluate to a logical value of TRUE or FALSE.

4. Click Format.

5. Select the font style, font color, underlining, borders, shading, or patterns you want to apply.

Microsoft Excel applies the selected formats only if the cell value meets the condition or if the formula

returns a value of TRUE.

6. To add another condition, click Add, and then repeat steps 3 through 5.

You can specify up to three conditions. If none of the specified conditions are true, the cells keep their

existing formats. You can use the existing formats to identify a fourth condition.

5.2.3 Insert a  Comment

1. Select the text or item you want to comment on, or click at the end of the text.

2. On the Insert menu, click Comment .

3. Type the comment text in the comment balloon.

Notes

1. If the comment balloons are hidden, you can type the comment in the Reviewing Pane.

2. You can rest the insertion point over the balloon to display the name of the reviewer.

3. To respond to a comment, click in the comment you want to respond to, and then click Comment on

the Insert menu. Type your response in the new comment balloon.

Clear command is used to clear a content, format or comments.

1. Format: Clearing format means that if there is any content with some format is there in current cell then

by issuing clear format command will clear that format only not the contents. The content will remains

same as it is but the format of the cell or the format of the content will be cleared.

2. Contents: Clearing content means that if there is any content with some format is there in current cell

then by issuing clear content command will clear that content only not the formats. The format will

remains same as it is but the format of the cell or the format of the content will be cleared.

3. Comments: Clear Comments will clear the comments settled in a cell for reference. Setting of com-

ment you will learn in next few chapters.

4. All: Clearing all means to clear all whatever there in the cell or the in the range.

5.2.4 Protection

1. Protecting Your Data

2. We protect our files using password protection , when you save your file. However, Excel also offers

several commands that let you protect workbooks, workbook structures, worksheets and individual

cells from access or modification by others. This type of protection is handy when you are sharing

files.

3. Once you assign a password, there is no way to unprotect the sheet or workbook
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4. without it. Don’t forget you passwords! And remember, capitalization matters!

5. Passwords are case sensitive.

6. Users can gain access to the workbook/worksheet only by providing the password you assign. When

individual cells have been locked, if

7. you try to change the content of the locked cell, Excel will display an error message Locked cells

cannot be changed.

To Assign a Password to a Workbook

Use the following steps to assign a password to a workbook:

1. Open the workbook.

2. Click on the File menu and click on Save As.

Excel displays the Save As dialog box.

Click on the Tools option menu. (See figure 26 above). A Menu will appear.

Click on General Options. Excel will display the Save Options Dialog Box.

In the Password to open field, type the password you want to assign to the file.
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*TIP* Your password is limited to 15 characters. It can be a mixture of alpha and numeric characters but

the first character should be an Alpha character. Excel is Case Sensitive in passwords.

In the Password to modify box, type the password you want to assign to the file.

3. Click OK to close the dialog box.

4. Excel will display the Confirm Password dialog box. (see Figure 28)

Re-type the password, and then click OK.

Excel will return to the Save As dialog box.

5. Click on Save.

Excel asks if you want to replace the existing file.

6. Click on Yes.

Excel saves the file and assigns the password you provided. Protecting Workbook Structure &

Windows .Once you have opened a workbook, you can also protect the workbooks Structure and

Windows from being modified.

Protecting the Structure prevents modification of the worksheet arrangement in a workbook.  Protecting

the Windows prevents moving or resizing of the workbook window.

To active these protections:

1. From the Tools menu select Protection.

2. From the Protection sub-menu select Protect Workbook.
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3. Select the appropriate box(s) in the “Protect Workbook for” field.

4. In the “Password” field, type in your password.

Remember - This field is case sensitive.

5. Click OK.

Your Workbook Structure and/or Windows are now secure. Unlocking Individual Cells on a worksheet

There are occasions when you want to only lock specific cells in your worksheet. For example, when you are

sharing a workbook and you want others to enter quarterly information but not alter the formulas that will be in the

total columns.

This process must be done PRIOR to protecting your workbook or worksheet.

Removing a Password

You can remove both the access and write reservation password from a

workbook once you no longer want to protect it.

To remove a password from a workbook, use the following steps:

1. Open or activate the workbook

2. Click on the File menu and click on Save As.

Excel displays the Save As dialog box.

3. Click on Tools, then General Options from the sub menu

Excel displays the Save Options dialog box.

4. Select the password characters in the Password to open or

Password to modify boxes.

5. Press the Delete key.

6. Click on OK.

Excel returns you to the Save As dialog box.

7. Click on Save. Excel will ask you if you want to replace the existing file.

8. Click on Yes. Excel will save the file and remove the password protection.
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5.2.5 Text data

In a spreadsheet there are three basic types of data that can be entered.

labels –(text with no numerical value)

constants – (just a number — constant value)

formulas* – (a mathematical equation used to calculate)

Data Types Examples Descriptions 

LABEL Name or Wage or 

Days

anything that 

is just text

CONSTANT 5 or 3.75 or -7.4 any number

FORMULA =5+3 or = 8*5+3 math equation

*ALL formulas MUST begin with an equal sign (=).

5.2.6 Delimiters

Split Column by Delimiter

Select a single cell in the column you want to split, then invoke ‘DigDB->Column->Split->by Delimiter...’

 The column will be automatically selected. You can now select how to split.
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Suppose we want to separate out the ‘Last Name’ part, that is to set split by the Last Space. Note we can

split by any text by typing the text into the input box.

Click ‘OK’ to split. In result, the original column is unchanged; two new columns will be added: the first

part consists the text before the delimiter (excluding the delimiter), the second part is simply the remainder (including

the delimiter).

In our case, the remainder have a preceding space in it. To get rid of the space, you can either use

DigDB->Column->Trim to trim it. Our you can further split it by length, i.e., split the remainder column by first 1 character.

Split Column by Length

1. Following the above example, after the split by delimiter, we have a ‘Remainder’ column with a

preceding space in it. To get rid of the preceding space means to split the column by the first 1

character. Therefore, click a single cell in the column, invoke ‘DigDB->Column->Split->by Length...’
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2. Set how to split:

3. Split result. Each cell is broken into two parts - (1) the first or last x number of characters you want,

(2) the remainder

5.2.7 Database Queries

The SQL Tester is an interactive Query Tool (add-in) for retrieving data and displaying it on the screen in

an ad hoc basis from almost all kinds of databases. The output can be placed in worksheets and added to

workbooks VBA projects. It also allows you to: Copy the displayed data into a worksheet including connection-

string and query-string Create dynamic queries where the data can be updated on a regular basis. Insert a

complete VBA-procedure which is based on the query and the database-connection. Easily create queries by

selecting keywords, names of tables and columns from user-friendly forms.

It also allows you to:

F Copy the displayed data into a worksheet including connection-string and query-string

F Create dynamic queries where the data can be updated on a regular basis.

F Insert a complete VBA-procedure which is based on the query and the database-connection. 

F Easily create queries by selecting keywords, names of tables and columns from user-friendly forms.

F Create, test and export the queries to the clipboard or to text files.

F Import queries from text files and have them executed.
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F Work with disconnected records.

F Get more accurate and higher quality of the retrieved data compared to MS Query.

F An extensive help file is available.

F The best part is that You are not bound to the databases tools & windows!

5.2.8 Goal Seek

Goal seek is a method for finding the input value that a formula needs to return a given result. When goal

seeking, Microsoft Excel varies the value in a cell that you specify until a formula that’s dependent on that cell

returns the result you want. Use the Goal Seek command when you want to find a specific value for a particular

cell by adjusting the value of only one other cell.

Steps of Goal Seeking

Suppose if you have a condition that you have a value of 10000 in A1 and you don’t know the value of B1

but you know the result of A1 and B1 is 20000 and now you want to know the value of B1. Perform the following

steps.

1. Write 10000 in cell A1 and write the formula in C1 to calculate the sum of cell A1 and cell B1.

2. Put the cursor on the C1.

3. On the Tools menu, click Goal Seek.

4. In the Set cell box, enter the reference for the cell that contains the formula you want to resolve i.e. C1.
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5. In the To value box, type the result you want i.e. 20000.

6. In the By changing cell box, enter the reference for the cell that contains the value you want to adjust.

This cell must be referenced by the formula in the cell you specified in the Set cell box i.e. B1

7. Press the OK button. You will see the result in a dialog box if the result is right press Ok button other

wise Press Cancel Button

5.2.9 Scenarios

If you have a formula or function that has an unknown variable as part of it, the <One-Input Table>

will be sufficient. If you have more than one unknown variable in your spreadsheet, you can set up a Scenario

that controls those cells in the formulas or functions that you want. The Scenario Manager is located under

the Tools menu.

We can now select the two variable cells 

(C4 & C6) and choose Scenarios from the 

Tools menu. This is done by clicking on C4 

and holding the [CTRL] key down while 

clicking C6.

Each scenario consists of a name, a 

description (if desired) and data for the 

variable cells. We'll create 3 scenarios: one 

for Expected, one for Higher than Expected, 

and one for Lower than Expected.
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For the Expected scenario, the increase for 2000 will be 3.5%, and the increase for 2001 will be

5%. For Higher than Expected, the numbers are 7% and 10%, and 1%-2% for Lower than Expected.

<Click here> to see a video which demonstrates the ability to double-click on any scenario and see the

results in the spreadsheet. (518K)

5.2.10 Freezing or Freeze Panes
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If you have a large worksheet with column and row headings, those headings will disappear as the worksheet

is scrolled. By using the Freeze Panes feature, the headings can be visible at all times.

F Click the label of the row below the row that should remain frozen at the top of the worksheet.

F Select Window|Freeze Panes from the menu bar.

To remove the frozen panes, select Window|Unfreeze Panes.

Freeze panes has been added to row 1 in the image above. Notice that the row numbers skip from 1 to 6.

As the worksheet is scrolled, row 1 will remain stationary while the remaining rows will move.

5.2.11 Printing

Print Preview

Select File|Print Preview from the menu bar to view how the worksheet will print. Click the Next and

Previous buttons at the top of the window to display the pages and click the Zoom button to view the pages

closer. Make page layout modifications needed by clicking the Page Setup button. Click Close to return to the

worksheet or Print to continue printing.

Print

To print the worksheet, select File  Print from the menu bar.

F Print Range - Select either all pages or a range of pages to print.

F Print What - Select selection of cells highlighted on the worksheet, the active worksheet, or all the

worksheets in the entire workbook.

F Copies - Choose the number of copies that should be printed. Check the Collate box if the pages

should remain in order.

F Click OK to print.
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5.2.12 Sorting of Data

Basic Sorts 

To execute a basic descending or ascending sort based on one column, highlight the cells that will be

sorted and click the Sort Ascending (A-Z) button or Sort Descending (Z-A) button on the standard toolbar.

Complex Sorts

To sort by multiple columns, follow these steps:

F Highlight the cells, rows, or columns that will be sorted.

F Select Data|Sort from the menu bar.

F From the Sort dialog box, select the first column for sorting from the Sort By drop-down menu and

choose either ascending or descending.

Select the second column and, if necessary, the third sort column from the Then By drop-down menus.

F If the cells you highlighted included the text headings in the first row, mark My list has...Header row

and the first row will remain at the top of the worksheet.

F Click the Options button for special non-alphabetic or numeric sorts such as months of the year and

days of the week.

F Click OK to execute the sort.
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5.2.13 Filtering List

Sometimes the user wants to locate some information from an extensive list. To find the information

quickly, Microsoft Excel provides Filter list option. This option enables the user to display the information regard-

ing the selected options.  Microsoft Excel provides two commands for filtering lists:

F AutoFilter, which includes filter by selection, for simple criteria

F Advanced Filter, for more complex criteria

Using Auto Filter

You can apply filters to only one list on a worksheet at a time.

1. Click a cell in the list you want to filter.

2. On the Data menu, point to Filter, and then click AutoFilter.

3. To display only the rows that contain a specific value, click the arrow in the column that contains the

data you want to display.

4. Click the value.

5. To apply an additional condition based on a value in another column, repeat steps 3 and 4 in the other

column.

Filter a List by using Advanced Criteria

Your worksheet should have at least three blank rows above the list that can be used as a criteria range.

The list must have column labels.

1. Select the column labels from the list for the columns that contain the values you want to filter, and

click Copy .

2. Select the first blank row of the criteria range, and click Paste .
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3. In the rows below the criteria labels, type the criteria you want to match. Make sure there is at least

one blank row between the criteria values and the list.

4. Click a cell in the list.

5. On the Data menu, point to Filter, and then click Advanced Filter.

6. To filter the list by hiding rows that don’t match your criteria, click Filter the list, in-place.

Criteria 
range

7. In the Criteria range box, enter the reference for the criteria range, including the criteria labels.

To move the Advanced Filter dialog box out of the way temporarily while you select the criteria range,

click Collapse Dialog.

5.2.14 Naming ranges

Name Box

This box shows the name or the address of the currently active cell.

5.2.16 Past special options

By default, when you Copy and Paste the content of any cell(s), Excel will Paste all cell formatting. We

can, however, use what is called Paste Special to nominate the attributes of the copied data we wish to Paste.

 To do this, again Copy the cell(s) in any of the above methods (except Drag and Drop). Now select your

destination cell and go to Edit>Paste Special or right click and select Paste Special from the Shortcut menu.

This will display the Paste Special dialogue box.  In this dialog box under the heading Paste, there are different

options that can be applied, the default is All, which is exactly the same as using any of the Paste methods

described above.
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5.2.17 Pivot Table

A PivotTable report is an interactive table that you can use to quickly summarise large amounts of data.

You can rotate its rows and columns to see different summaries of the source data, filter the data by displaying

different pages, or display the details for areas of interest.

When to use a PivotTable Report 

Use a PivotTable report when you want to compare related totals, especially when you have a long list of

figures to summarise and you want to compare several facts about each figure. Use PivotTable reports when you

want Microsoft Excel to do the sorting, subtotaling, and totaling for you. Because a PivotTable report is interactive,

you or other users can change the view of the data to see more details or calculate different summaries.

Creating a PivotTable Report

To create a PivotTable report, use the PivotTable and PivotChart Wizard as a guide to locate and specify

the source data you want to analyse and to create the report framework. You can then use the PivotTable toolbar

to arrange the data within that framework.

Follow the steps give below to create a pivot table:

1. Select the source table in the worksheet for which a pivot table is to be created. A pivot table from an

external data source can also be created.

2. On the Data menu choose the Pivot table and Pivot Chart Report option.

3. In this step click an option for the data source type and

4. click next.

5. In the next step specify the data source range in the Range box if you haven’t selected the range yet.

6. Click the next button
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7. Click the layout button to set the layout of the pivot table.

8. Select the field, drag and drop it into the section Row (summarises the data from top down as well as

applies a vertical format to the table). Column (Summarises the data from left to right as well as

applies a horizontal format to the table), Page (Create a drop down menu above the table.), or Data

(Data drop area is the summary of numbers) of the dialog box to create a desired layout.

9. Click Ok button and then click the Finish button.
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5.2.18 Insert Chart

Charts allow you to present data entered into the worksheet in a visual format using a variety of graph

types. Before you can make a chart you must first enter data into a worksheet. This page explains how you can

create simple charts from the data.

Chart Wizard 

The Chart Wizard brings you through the process of creating a chart by displaying a series of dialog

boxes.

F Enter the data into the worksheet and highlight all the cells that will be included in the chart including

headers

F Click the Chart Wizard button on the standard toolbar to view the first Chart Wizard dialog box.

F Chart Type - Choose the Chart type and the Chart subtype if necessary. Click Next.

F Chart Source Data - Select the data range (if different from the area highlighted in step 1) and click

Next.
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F Chart Options - Enter the name of the chart and titles for the X- and Y-axes. Other options for the

axes, grid lines, legend, data labels, and data table can be changed by clicking on the tabs. Press Next

to move to the next set of options.
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F Chart Location - Click As new sheet if the chart should be placed on a new, blank worksheet or

select As object in if the chart should be embedded in an existing sheet and select the worksheet from

the drop-down menu.

F Click Finish to create the chart.
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Resizing the Chart

To resize the chart, click on its border and drag any of the nine black handles to change the size. Handles

on the corners will resize the chart proportionally while handles along the lines will stretch the chart.

Moving the Chart

Select the border of the chart, hold down the left mouse button, and drag the chart to a new location.

Elements within the chart such as the title and labels may also be moved within the chart. Click on the element to

activate it, and use the mouse to drag the element to move it.

Chart Formatting Toolbar

Chart Objects List - To select an object on the chart to format, click the object on the chart or select the

object from the Chart Objects List and click the Format button. A window containing the properties of

that object will then appear to make formatting changes.

Chart Type - Click the arrowhead on the chart type button to select a different type of chart.

Legend Toggle - Show or hide the chart legend by clicking this toggle button.

Data Table view - Display the data table instead of the chart by clicking the Data Table toggle button.
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Display Data by Column or Row - Charts the data by columns or rows according to the data sheet.

Angle Text - Select the category or value axis and click the Angle Downward or Angle Upward button

to angle the the selected by +/- 45 degrees.

Copying the Chart to Microsoft Word

A finished chart can be copied into a Microsoft Word document. Select the chart and click Copy. Open

the destination document in Word and click Paste.

5.2.19 Macros: reading, editing,

Recording A Macro

Macros can speed up any common editing sequence you may execute in an Excel spreadsheet. In this

example we will make a simple macro that will set all the margins on the page to one inch.

F Click Tools|Macro|Record New Macro from the menu bar.

F Name the macro in the Macro name field. The name cannot contain spaces and must not begin with

a number.

F If you would like to assign a shortcut key to the macro for easy use, enter the letter under Shortcut

key. Enter a lower case letter to make a CTRL+number shortcut and enter an upper case letter to
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assign a CTRL+SHIFT+number shortcut key. If you select a shortcut key that Excel already uses,

your macro will overwrite that function.

F Select an option from the Store macro in drop-down menu.

F Enter a description of the macro in the Description field. This is for your reference only so you

remember what the macro does.

F Click OK when you are ready to start recording.

F Select options from the drop down menus and Excel will record the options you choose from the

dialog boxes, such as changing the margins on the Page Setup window. Select File|Page Setup and

change all the margins to 1". Press OK. Replace this step with whatever commands you want your

macro to execute. Select only options that modify the worksheet. Toggle actions such as View|Toolbars

that have no effect on the worksheet will not be recorded.

F Click the Stop button the recording toolbar. The macro is now saved.

Running A Macro

F To run a macro you have created, select Tools|Macro|Macros from the menu bar.

F From the Macros window, highlight the Macro name in the list and click Run.

F If the macro is long and you want to stop it while it is running, press BREAK (hold CTRL and press

PAUSE).

5.2.20 Insert Objects

Excel provides you the facility to link or embed the objects of other software’s in your worksheet and

work on the linked or embedded objects as you are working on that software itself.
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To embed an object you have to follow these steps.

1. Click in the document where you want to place the embedded object.

2. On the Insert menu, click Object, and then click the Create New tab.

3. In the Object type box, click the type of object you want to create.

4. To display the embedded object as an icon — for example, if others are going to view the worksheet

online — select the Display as icon check box.

Notes:

F Only programs that are installed on your computer and that support linked and embedded objects

appear in the Object type box.

F When you click Microsoft Word Document in the Object type box, an entire document is inserted

into your worksheet. The document displays only one page at a time. To display a different page,

double-click the Microsoft Word object, and then click a page down button.

Menus and 
Toolbar 

changed 
according 
to the 
embedded 

object
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& CHECK YOUR PROGRESS

(1) Validation option find in –

(a) Data menu (b) format menu (c) file menu (d) none of the above

(2) Comment option find in –

(a) Insert menu (b) data menu (c) file menu (d) none of the above

(3) Macro find in –

(a) Edit menu (b) tool menu (c) view menu (d) format menu

(4) How many features are available in chart formatting menu bar-

(a) 7 (b) 5 (c) 8 (d) 6

5.3 SUMMARY

The objectives of this development to cope with large numbers of students and provide Advanced pre-

sentation features like Formatting slide appearance, Macros Adding finishing touches to a presentation, Advanced

saving and presenting options, Recording a macro and adding it to a custom toolbar, Setting up a slide show and

transitions.

5.4 GLOSSARY

Validation implies one is able to testify that a solution or process is correct or compliant with set

standards or rules.

Comment is a statement of fact or opinion, especially a remark that expresses a personal reaction or

attitude.

Protection is a safe guard from unauthorized accessing.

Delimiter is a character or combination of characters used to separate one item or set of data from

another. For example, in comma-delimited records, a comma is used to separate each field of data.

A database is a collection of records or information which is stored in a computer in a systematic way.

Freeze is to stop functioning properly, usually temporarily.

Sort is to arrange according to class, kind, or size.

Filter is used to extract impurities.

Macro is a symbol, name, or key that represents a list of commands, actions, or keystrokes.

5.5 FURTHER READINGS

1. Philip Howard (2005-04-22). Managing spreadsheets. IT-Directors.com.

2. Raymond R. Panko (2005-01). What We Know About Spreadsheet Errors.

3. Beare, R. (1993). A spreadsheet system for educational use based on Microsoft  Excel, Australian

Educational Computing, July 1993.
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5.6 ANSWER TO THE SELF LEARNING EXERCISE

Answer to check your progress 5.2

1.  (a) 2. (a) 3.(b) 4. (a)

5.7 UNIT-END QUESTIONS

(1) What are the advanced features of MS-EXCEL 2000?

(2) Describe the following

1. Shift the contents of the cell C1 to D1.

2. Insert a new row between row 7 and 8.

3. Insert a new column between D and E.

4. Insert a picture into the worksheet.

(3) Describe the Following

1. Write a short note on inserting a chart.

2. What is formulas and how to insert a function in formulas?

3. What is the use of giving name to cells?

4. What is the difference between embedding and linking an object?

(4) How can create macro and objects?

����
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Unit VI: PRESENTATION  SOFTWARE -MS  POWER  POINT 2000

Structure of  the Unit

6.0 Objectives

6.1 Introduction

6.2 Anatomy of PowerPoint Presentation

6.2.1 Creating a Presentation choosing a Design Template

6.2.2 Adding a Slide

Check your progress

6.3 Creating and viewing a presentation: Choosing a design Template,

6.3.1 Creating a title slide,

6.3.3 Adding a new slide to a presentation,

6.3.4 Creating a bulleted list slide

Check your progress

6.4 Summary

6.5 Further Readings

6.6 Glossary

6.7 Answer to the self learning exercise

6.8 Unit-end Questions
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6.0 OBJECTIVES

The computer with power point presentation software combines the advantage of the overhead projector,

the slide projector, flip chart. With computer projection systems, presentation can be made to audiences as small

as five (use a monitor only) or as large as an auditorium full of students. Projection can best be done in a semi-dark

room.  A darkened room is not necessary. The trainer faces the audience.  By keeping eye contact with the

participants, the trainer is able to maintain control of the group while at the same time controlling the presentation.

The presentation is prepared by using presentation software. The software has a number of special effects: Anima-

tion, Backgrounds, Slide transitions, Uncover (Left-down, Left-up, Right-down, Right-up), Wipe  (Down, Left,

Right, Up), Fly from (Bottom, Left, Right, Top, Bottom-left, Bottom-right, Top-left).

6.1 INTRODUCTION TO POWERPOINT 2000

PowerPoint is the component of Microsoft Office that is used to create professional- quality presentations.

A presentation is a structured delivery of information. These can be reproduced on transparency, paper,

on-screen presentations. PowerPoint components can be used to work on slides, organize presentation contents

with outlines, and generate speaker notes and audience handouts. Teachers, professors, politicians, and sales

representatives make presentations to sell their concepts.

PowerPoint 2000 helps you to structure the ideas and information that you want to convey to your

audience. It allows you to create the contents of your presentation by typing the text and inserting pictures, sounds

and animations. With it, you can add visual images, supporting documents, and audio recordings to enhance your

presentation. PowerPoint makes the creation of any presentation simple by providing you with built - in

professional design called Auto Layouts and presentations templates. You can also create different versions of a

presentation for different audiences and build your contents in either a text – based outline view or a design –

based slide view.

Starting  Power Point 2000

The steps to activate PowerPoint 2000 are:

1. Click the Start button in the taskbar.

2. Select the Programs option from the Start menu.

Start Button 

3. Click the PowerPoint option (refer Starting Excel 2000). The PowerPoint dialog box is displayed as

shown in figure below
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All the options shown in the dialog box will be dealt with subsequently

6.2 ANATOMY OF POWERPOINT PRESENTATION

Before you start creating presentations, you need to understand the structure of the PowerPoint screen.

The PowerPoint screen displays several toolbars and other basic screen elements (refer figure given below).
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The components of a PowerPoint screen are:

F Menu Bar – is similar to the menu bar in other Microsoft Office applications having File, Edit, View,

Insert, Format, Tools, Window, Help menus.

F Toolbars – are collections of buttons that you can click and activate some of the most common

commands in PowerPoint. These commands can also be activated through menus.

F Status Bar – is located at the bottom of the PowerPoint screen. It displays the number of the current

slide and the name of the template on which the presentation is based.

F Vertical Scroll Bar – helps you to scroll through the slides in a presentation.

F Slide Buttons – are located at the bottom of the vertical scroll bar and help you to display the

previous and next slides.

6.2.1 Creating a Presentation Choosing a Desing Template

A presentation template is a saved presentation file that contains predefined slide and title masters, color

schemes and graphic elements. The presentation templates also include masters with pre – formatted fonts and

styles.

The steps to apply a template to a new presentation are:

1. Select the Template option from the PowerPoint opening dialog box. The following screen appears .

2. Click on the Design Template tab to display various design templates.

3. Select the template and click on the OK button to activate the template. The New Slide box is

displayed as shown in the figure below.
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4. Select the layout from the New Slide dialog box and click OK button.

Template in a general meaning is a pattern, which will remain the same throughout the presentation.  All the

slides will have the same background as selected by you.

Creating a Blank Presentation
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The third option in the PowerPoint dialog box is creating a blank presentation.

The steps in creating a blank presentation are as follows:

1. Select the New option from the File menu.

2. Select the General tab and double – click on the Blank Presentation icon. The New slide dialog box

is displayed.

3. Select the suitable layout and click on the OK button.

A slide as shown in the following figure will be displayed.

6.2.2 Adding a Slide

The steps to add a new slide are:

1. Select the New Slide option from the Insert menu or click on the Insert New Slide button on the

toolbar.

2. Select an appropriate layout from the New Slide dialog box.

3. Click on the OK button.

& CHECK YOUR PROGRESS

(1) Power point is a –

(a) Powerful drawing application (b) word processor

(c) Presentation software (d) all of the above

(2) This is like in the presentation –

(a) Slides (b) layouts (c) handout (d) none of the above

(3) Speakers or presenter creates this for their help –

(a) Speaker’s notes(b) slides (c) handouts (d) none of  the above

(4) How many components are available on the presentation slide –

(a) 5 (b) 6 (c) 7 (d) 10

(5) Presentation template contains –

(a)  Predefined slide (b) post defined slide

(c) both (a) & (b) (d) none of the above

6.3 CREATING AND VIEWING A PRESENTATION: CHOOSING A DESIGN

TEMPLATE,

6.3.1 Creating a title slide, Text attributes,

Entering and Editing Text

Every Slide in a presentation contains text of some kind even if it is just the title. Entering and editing text

in PowerPoint is similar to entering and editing text in any MS Office application.
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Text Placeholders

In PowerPoint, you enter all text in text placeholders. The method of entering slide text involves replacing

the sample text in a placeholder with your own text. The slide shown in the figure below includes two placeholders

– one that contains a sample title and another that contains a bulleted list.

Inserting Text

The steps to insert text are:

1. Click on the slide title, which reads Click to add title (refer figure above). The text disappears and is

replaced by the blinking insertion point.

2. Type a Title

3. Position the mouse pointer inside the placeholder, which reads Click to addtext and click on the

mouse button. The bullet item text disappears and is replaced by the blinking cursor.

4. Type the text at the first bullet point and press the Enter key. This adds a second bullet point followed

by the blinking insertion cursor.

5. Type the text.

6. Repeat steps 4 and 5 until you have added all the points for the slide.

7. Click anywhere outside the text block to view how the text will look on the slide.

Changing Case of the Text

The steps to change case of the text are:

1. Select the text for which you want to change the case.

2. Select the Change Case option from the format menu. The Change Case dialog box is displayed as
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shown in figure below.

3. Select the appropriate option.

4. Click on the OK button.

Checking Spelling

The steps to spell check a presentation file are:

1. Open the presentation you want to spell check.

2. Select the spelling option from the tools menu.

The spelling dialog box is shown in the figure at next page. Spell check highlights the first unrecognised

word in the presentation file and displays the word in the ‘Not in Dictionary’ text box.

3. Select the appropriate command button such as: Ignore, Ignore All, Change, Change All or Add. The

spelling checker takes the indicated action and then highlights the next unrecognised word.

4. Repeat step 3 until the Spell Checker displays a message saying that the entire presentation has been

checked.

5. Click the OK button.

You can stop using Spell Checker at any time by clicking on the Close button in the Spelling dialog box.
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Copying Text Styles

The steps to copy a style are as follows:

1. Select the word that has the format you want to copy.

2. Click on the format Painter icon in the Standard toolbar.

3. If you want to change one word only, click anywhere in that word. Otherwise, click and drag to select

the text you want to change.

Before doing all this we should know how to select the text so that we can make changes to our desired

style text or Bullets characters.

What to Select How to Select 

Any amount of text Place the mouse pointer at the beginning of the text; the pointer 

should be shaped like character I, hold the mouse button down and 

drag the pointer till where you want to select the text.

Single Paragraph Place the mouse pointer (shaped like character I) anywhere on the 

paragraph and triple - click

Changing Text Attributes

Attributes of the text means the characteristics, which are associated with the text, for example Font, Font

style, Font Size, Color, Effects etc. You can find most Font attributes in the Font dialog box. If you want to select

the attributes of the text you must first select the text as told above. The font dialog box is displayed below.
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Changing Slide Color Scheme

To change the Color Scheme of the entire presentation, follow the following steps:

1. Choose the Slide Color Scheme option from the Format menu.

The Color Scheme dialog box is displayed as shown at next page.

2. Click on the Custom tab.

3. Select the Background Color in the ‘Color Scheme’ Section of the dialog box, and then click on the

Change Color button.

4. To change the Background color, select another color from the palette.

5. To see the effects of a new background color without changing it permanently click the preview

button.

6. Click on the OK button

The color scheme dialog box is redisplayed with the changed color scheme.

Choose the ‘Apply to All’ button to apply the new Color scheme to the entire presentation. If you choose

the Apply button, the new scheme is applied only to currently displayed slide.
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6.3.3 Viewing a PowerPoint Presentation

Microsoft PowerPoint comes with different views to help you while you are creating a presentation. The

two main views you use in PowerPoint are normal view and slide sorter view. To easily switch between views, you

click the buttons at the lower left of the PowerPoint window.

(a) Normal View

Normal view contains three panes: the outline pane, the slide pane, and the notes pane. These panes let

you work on all aspects of your presentation in one place. You can adjust the size of the different panes by

dragging the pane borders.

Outline pane: Use the outline pane to organise and develop the content of your presentation. You can

type all of the text of your presentation and rearrange bullet points, paragraphs, and slides.

Slide pane: In the slide pane, you can see how your text looks on each slide. You can add graphics,

movies, and sounds, create hyperlinks, and add animations to individual slides.

Notes pane: The notes pane lets you add your speaker notes or information you want to share with the

audience. If you want to have graphics in your notes, you must add the notes in notes page view.

These three panes are also displayed when you save your presentation as a Web page. The only

difference is that the outline pane displays a table of contents so that you can navigate through your presentation.

(b) Slide Sorter View

In slide sorter view, you see all the slides in your presentation on screen at the same time, displayed in

miniature. This makes it easy to add, delete, and move slides, add timings, and select animated transitions for

moving from slide to slide. You can also preview animations on multiple slides by selecting the slides you want to

preview and then clicking Animation Preview on the Slide Show menu.

At any time while you are creating your presentation, you can start your slide show and preview your

presentation by clicking Slide Show

Viewing the Slides

There are several ways to navigate from slide to slide when you are editing your presentation. The method

you choose depends on what view is currently active.
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The Keyboard or the Mouse can be used to navigate through the slides whichever you find easy to use.

Using the Keyboard to navigate through the slides in your presentation. Table 1 lists keyboard navigation

which you can use to display different slides in your presentation.

Handle the slide using keyboard  

Key Combination Movement 

Page Up Positions you back one slide at a time

Page Down Positions you Forward one slide at a time

Ctrl + Home Positions you at the beginning of the presentation

Ctrl + End Positions you at the end of the presentation

When you start a new presentation using either a Design Template or Blank Presentation option, the first

screen you see is the New Slide Dialog box. After you create your presentation file, you can add or delete slides

whenever necessary.

The first screen of your presentation is the Title Slide, which should be attractive, as it is said first

impression is the last impression. This is the first slide of your presentation which the audience sees, so it sets the

tone for the rest of the presentation. The AutoContent Wizard automatically creates the Title Slide. When you do

not use AutoContent Wizard, you need to create a Title Slide for your Presentation by selecting the Title Slide Auto

Layout.

6.3.4 Creating a bulleted list

Bullet lists are one of the most effective tools you can use in a presentation. They provide a brief and

concise way to get the important points of your subject matter across to the audience. You can put any text into a

bulleted list format.

 The steps to change bullet characteristics are:

1. Select the text whose bullet you want to change.

2. Select the bullet option from the Format menu.

The bullet dialog box as shown at next page is displayed.

3. Select the new color from the Color drop – down list.

4. Size the bullets by changing the percentage in the Size box.

5. Select the desired bullet character from the Character palette.

6. Click on the OK button to apply the bullet.
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& CHECK YOUR PROGRESS

(1) PowerPoint lets you add slide to your presentation using –

(a) Insert->slide (b) insert-> new slide

(c) Format->new slide (d) none of the above

(2) You can also add text by inserting text box. To do this we –

(a) Click text box on the drawing toolbar

(b) Click text box on the standard toolbar

(c) Click text box on the formatting toolbar

(d) None of the above

(3) Text can be copied in the slide using –

(a) Menu command (b) drag and drop method

(c) Double click the mouse button (d) both (a) and (b)

(4) How many views are used in slide presentation –

(a) 4 (b) 5 (c) 6 (d) 3

(5) Ctrl + End is used –

(a) Positions you back one slide at a time

(b) Positions you Forward one slide at a time

(c) Positions you at the end of the presentation

(d) all of the above
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6.4 SUMMARY

With PowerPoint students can make learning more dynamic by creating presentations of classroom mate-

rials and projects. User can use graphics, text, movies, sounds, and the Internet to share information on any topic.

Using PowerPoint templates, students can quickly and easily create presentations for many purposes, including

lectures, research reports, meeting handouts and agendas, speaker introductions, and flyers.

6.5 FURTHER READINGS

(1) Wward Tufte. The Cognitive Style of PowerPoint: Pitching Out Corrupts Within (Second

edition). Graphics Press, 2006.

(2) External links: Official website of PowerPoint at Microsoft

6.6 GLOSSARY

Power Point Animation is a form of animation which involves in using Microsoft PowerPoint and similar

programs to create a game or movie.

Slides: Individual parts of a presentation. Slides are similar to the individual pages in a print document,

and can contain text, graphics, and animation.

View: Microsoft PowerPoint has three main views: normal view, slide sorter view, and slide show view.

Power Point presentations have the same design template for all slides, although it is possible to select a

different design template for each slide.

Slide Show: The way a presentation appears when you are presenting it.

Placeholder: Boxes with dotted or hatch-marked outlines that appear when you create a new slide.

These boxes act as “placeholders” for objects such as the slide title, text, clip art, charts, and tables.

Placeholders are sometimes called “text boxes.”

6.7 ANSWER TO THE SELF-LEARNING EXERCISES

Answer to check your progress 6.2

1. (c) 2. (a) 3.(a) 4.(a) 5. (a)

Answer to check your progress 6.2

1. (b) 2.(a) 3.(d) 4.(a) 5.(c)

6.8 UNIT-END QUESTIONS

(1) What does PowerPoint do? Is it a member of Office Suite?

(2) Describe the way to create a presentation using design Templates?

(3) Describes all the ways to add text to slide.

(4) How will you change the lower case in to upper case of the text?

(5) What is the purpose of viewing in slide presentation?

����
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Unit – VII : ADVANCE  FEATURES  OF  POWER  POINT

Structure of the Unit

7.0 Objectives

7.1 Introduction

7.2 Using Hyperlink in the presentation

7.3 Adding Graphics in a Slide Show

7.3.1 Insert a picture from the Clip Gallery

7.3.2 Insert an imported picture

7.3.3 Insert a Scanned picture

7.4 Organizing Formats with Master Slides

7.5 Navigation with Action Buttons

7.5.1 Insert action buttons and hyperlinks for a self-running or Web presentation

7.6 Adding Animation Effects

7.6.1 Animated Layers or Slides

7.7 Start a Slide Show from within PowerPoint

7.7.1 About Self-Running Presentations

7.8 Printing

7.9 Using E-mail to Send Presentations in Microsoft PowerPoint

7.9.1 Send a Copy of an Entire Presentation  

7.10 Putting the Presentation on the Web

7.10.1 HTML Wizard

7.10.2 Testing the Web Presentation

7.11 Summary

7.12 Glossary

7.13 Further Readings

7.14 Answers to the self-learning exercises

7.15 Unit-end questions
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7.0 OBJECTIVES

After going through this unit you will be able to :

F Understand the advanced features of Power Point like hyperlink creation, use of navigation buttons,

master slides etc.

F Apply animation on objects, slides

F Create a presentation for the web and E-mailing a slide show

7.1 INTRODUCTION

Microsoft PowerPoint is a powerful tool to create professional looking presentations and slide shows.

PowerPoint allows you to construct presentations from scratch or by using the easy to use wizard.

This unit will help you to get some ideas about advanced features of Power Point 2000.

7.2 USING HYPERLINK IN THE PRESENTATION

Hyperlinks cause the selection of an object to result in a move to a new location or the performance of an

action. You can create your own object or choose an AutoShape Action button.

To link an object with an action, select the object, then choose SLIDE SHOW : Action Settings.

Figure: Hyperlink Action Dialog Box

In the Action Settings dialog box, choose either Mouse Click or Mouse Over. Then select the button

“Hyperlink to” then select the destination or action. You can also choose to play a built-in PowerPoint sound

during this action and/or to highlight the object as you click it.
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7.3  ADDING GRAPHICS IN A SLIDE SHOW

You can insert clip art or a picture from the Clip Gallery, or you can insert a picture or a scanned photo you

import from other programs and locations.

7.3.1 Insert a Picture from the Clip Gallery

1. Display the slide you want to add a picture to.

2. Click Insert Clip Art on the Drawing toolbar, and then click the Pictures tab.

3. Click the category you want.

4. Click the picture you want, and then click Insert Clip on the shortcut menu.

5. When you are finished using the Clip Gallery, click the Close button on the Clip Gallery title bar.

Note :  You can also drag a picture from the Clip Gallery to your slide.

7.3.2 Insert an Imported Picture

1. Display the slide you want to add a picture to.

To add the picture to every slide in your presentation, add it to the slide master.

2. On the Insert menu, point to Picture, and then click From File.

3. Locate the folder that contains the picture you want to insert.

4. Click the picture.

5. Do one of the following:

To embed the picture into your presentation, click Insert.

To link the picture in your presentation to the picture file on your hard drive, click the arrow next  to

Insert, and then click Link to File.

7.3.3 Insert a Scanned Picture

To do this procedure, your device (a scanner or digital camera) must be connected to your computer and be

TWAIN-compatible. You should also make sure that you have installed the device software that supports TWAIN.

1. Display the slide where you want to insert the scanned picture.

2. Set up the picture in the scanning device.

3. On the Insert menu in Microsoft PowerPoint, point to Picture, and then click From Scanner or

Camera.

4. If you have more than one device attached to your computer, under Device select the device you

want to use.

5. Do one of the following:

If the selected device is a scanner and you want to use default settings for scanning the image, click

Web Quality (if you are going to show your presentation on the screen) or Print Quality (if you are

going to print your presentation), and then click Insert to scan your picture.
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If  the selected device is not a scanner (for example, a digital camera) or you want to customize any

settings before you scan the picture, click Custom Insert. Follow the instructions that come with the

device you’re using.

6. When the image is displayed, make any changes you want.

By using the tools on the Picture toolbar, you can crop the picture; adjust its brightness, contrast, and

color; and make other adjustments.

& CHECK YOUR PROGRESS (7.2 AND 7.3)

1. Fill in the blanks :

(a) To add the picture to every slide in your presentation, add it to the ____________.

(b) A Picture can be _________ and _________ into a Power Point presentation.

2. What is hyperlink?

3. Differentiate between linked object and embedded object.

7.4 ORGANIZING FORMATS WITH MASTER SLIDES

Change the style of all slides in the presentation by changing the properties on the Slide Master. Each

Design Template has its own Slide Master that can be altered. If you create slides from scratch, a consistent style

can be added to the presentation by formatting the Slide Master.

1. Select View|Master|Slide Master from the menu bar.

2. Format the master slide just as you would format a regular slide by formatting text, formatting lists,

adding background patterns and effects, and setting footers.
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3. Click the Close button on the Master toolbar to quit editing the master slide and return to the

presentation.

Headers and Footers

Add the date and time, slide numbers, and other footer text to the master slide from the Header and

Footer window.

1. Select View|Header and Footer... from the menu bar.

2. Check the Date and time box to add this feature to the slide. Select Update automatically to

always display the current date and time or click Fixed and enter a date that will not change in the text

field provided.

3. Check the Slide number box to add this feature to the slides.

4. Click the Footer box and add other text to the footer area of the slide.

5. Check the Don’t show on title slide box to hide these features on the title slide of the presentation.

6. Click the Notes and Handouts tab to make the same changes to notes and handouts pages.

7. Click Apply to All to add the changes to every slide or Apply to add only to the current slide.

Slide Numbers

To add the slide numbers in a fixed position on the slide, use the Header and Footer window detailed

above. The slide number can otherwise be added anywhere on the slide by placing the cursor where the slide

number should appear and selecting Insert|Slide Number from the menu bar. The text of the slide number can be

formatted just as regular text style.
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Date and Time

A date and/or time can also be added using the Header and Footer window or anywhere else on the

slide. Place the cursor where the date and time should appear on the slide and select Insert|Date and Time from

the menu bar. Select a format from the Available formats box and click Update automatically if this feature

should always be updated to reflect the current date and time. Click OK to finish.

& CHECK YOUR PROGRESS (7.4)

1. What is Slide Master?

2. How date and time can be changed on all the slides of a presentation?

7.5 NAVIGATION WITH ACTION BUTTONS

Action buttons : PowerPoint also comes with some ready-made action buttons that you can insert in

your presentation and define hyperlinks for. Action buttons contain shapes, such as right and left arrows. Use them

when you want to include commonly understood symbols for going to next, previous, first, and last slides. You can

use these buttons for a self-running presentation at a kiosk or for a presentation that you plan to publish on your

company intranet or the Internet. PowerPoint also has action buttons for playing movies or sounds.

7.5.1 Insert action buttons and hyperlinks for a self-running or Web presentation

Action buttons are ready-made buttons that appear pressed in when you click them during a slide show.

If you want the same action buttons to appear on every slide, put them on the slide master.

1. Select the slide you want to place a button on.

2. To place the buttons on every slide, point to Master on the View menu, and then click Slide Master.

3. Point to Action Buttons on the Slide Show menu, and then select the button you want — for

example, Home, Back or Previous, Forward or Next, Beginning, End, or Return.

4. To insert a button with a predefined size, click the slide. To change the size of the button, drag the

shape to the size you want. To maintain the shape’s width-to-height ratio, hold down SHIFT as you

drag the shape.
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5. When the Action Settings dialog box appears, click OK to accept the proposed hyperlink in the

Hyperlink to list, or specify the link you want

& CHECK YOUR PROGRESS (7.5)

1. What are action buttons?

7.6 ADDING ANIMATION EFFECTS

To animate a single object on a PowerPoint slide

1. Select the object.

2. Choose SLIDE SHOW : Preset Animation.

3. Select the animation effect you desire for the selected object

Preset Animation Dialog Box

7.6.1 Animated Layers or Slides

You may find it useful to bring a layered object into a presentation one layer at a time, building it on-screen.

To animate a layered object or to animate each object on a slide,

1. Choose SLIDE SHOW : Custom Animation. (You must be in Normal, Outline, or Slide View.)

2. In the Custom Animation dialog box, each object is identified in the Check to animate slide objects

list.

3. Click in the object’s checkbox to animate that object. It will be added to the Animation order list.
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4. To change the order that the animated objects appear, select the object in the Animation order list,

then click the up or down arrow to move the object through the list.

5. Choose whether the object appears only on a mouse click or after a specified number of seconds.

To choose other effects such as sound effects and how the object appears on the slide during the on-

screen presentation, click on the Effects tab.

Layer Animation dialog box

To animate text,

1. Click on the Effects tab.

2. In the Introduce Text section, from the drop-down box, choose whether the text is introduced all at

once, by word, or by letter.

To animate charts click the Chart Effects tab. You can choose to introduce the data by series, categories,

or elements.

& CHECK YOUR PROGRESS (7.6)

1. In which view mode you can create customized animation on a slide?

2. How do you change the order of animated objects appear on a slide?

7.7 START A SLIDE SHOW FROM WITHIN POWERPOINT

To start a slide show from within the power point do any of the following:

F Click Slide Show at the lower left of the PowerPoint window.

F On the Slide Show menu, click View Show.

F On the View menu, click Slide Show.

F Press F5.
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7.7.1 About Self-Running Presentations

Self-running presentations are a great way to communicate information without having to have someone

available to run a slide show. For example, you might want to set up a presentation to run unattended in a booth or

kiosk at a trade show or convention. You can make most controls unavailable so that users can’t make changes to

the presentation. A self-running presentation restarts when it’s finished and also when it’s been idle on a manually

advanced slide for longer than five minutes.

When designing a self-running presentation, you’ll want to keep the setting in mind — for example, whether

the booth or kiosk will be in an unmonitored public place or whether supervision will be available. The answer will

help you determine what elements you add to your presentation, how much control you give users, and what steps

you need to take to prevent misuse.

To set up a self-running show: open the presentation, click Set Up Show on the Slide Show menu, and

then click Browsed at a kiosk (full screen). When you click this option, Loop continuously until “Esc” is

automatically selected.

Options you might want to consider when designing a self-running presentation include:

Automatic or manual timings : You can set up a slide show to run by itself with automatic timings, or you

can set it so that users can move through the show at their own pace by using the mouse to click action

buttons. Mouse clicks are ignored unless they’re on objects you’ve created hyperlinks to.

Set slide show timings

1. In normal or slide sorter view, select the slide or slides you want to set the timing for.

2. On the Slide Show menu, click Slide Transition.

3. Under Advance, click Automatically after, and then enter the number of seconds you want the

slide to appear on the screen.

4. To apply the timing to the selected slides, click Apply.

To apply the timing to all the slides, click Apply to All.

5. Repeat the process for each slide you want to set the timing for.

Hyperlinks : You can use hyperlinks to move through the slide show or to jump to other slides and

programs.

Voice narration : You can add recorded narration that plays with your slide show.

ActiveX controls : You can use the ActiveX controls that come with Microsoft PowerPoint to create

a response slide in your show. For example, you can add a text box in which people can enter their

names and addresses to receive further information.

& CHECK YOUR PROGRESS (7.7)

1. How you can stop a self-running show?

2. What is Slide sorter view?
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7.8 PRINTING

Select File|Print from the menu bar to print the presentation.

Print range - Select All to print all the slides in the presentation, Current slide to print only the current

slide, or enter slide numbers in the Slides field to print only certain slides.

Copies - Enter the number of copies of each slide specified in Print range and check the Collate box if

necessary.

Print What –

F Slides prints a full-page slide on each page.

F Handouts prints as many slides as you designate on each page.

F Notes Page prints one slide with that slide’s notes on each page

F Outline view prints the outline of the presentation

F Click OK to print.

7.9 USING E-MAIL TO SEND PRESENTATIONS IN MICROSOFT

POWERPOINT

To send a presentation in e-mail directly from PowerPoint, you simply click E-mail. A message appears

that allows you to send your PowerPoint work in one of two ways:
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Send a copy of a single slide   When you send a copy of a slide in e-mail, the slide is sent in HTML

format as the body of the message. Recipients can view your slide in any e-mail program that can read e-mail

messages in HTML format. Recipients do not need PowerPoint installed on their computer in order to view the

slide, although there are other system requirements for viewing, as well as for sending, routing, or posting a slide or

presentation. When you send a copy of a slide in e-mail, the message header is displayed in PowerPoint to allow

you to address the message and to set any message options you want.

After you send the slide, the message header closes and the presentation remains open. The recipient list,

along with any message options and attachments, is saved with the presentation. If you send a copy of the slide

again, the information you entered previously will be displayed in the message header. This is useful if you send

recurring updates of a slide to the same people.

If a recipient is using Microsoft Office 97 or earlier, it is better to send a slide as an attachment in an e-mail

message. If you send a slide as the body of the message, the formatting will be lost.

7.9.1 Send a Copy of an Entire Presentation  

To send an entire presentation, you must send it as an attachment in an e-mail message. You might also

want to do this if the recipient you are sending your work to doesn’t have an HTML-compatible e-mail program.

To view a presentation you send as an attachment, recipients need PowerPoint 97 or later.

& CHECK YOUR PROGRESS 7.8 AND 7.9

1. What are the options available in “Print What”?

2. If you send a slide to any one, In which format this slide will reach to the recipient?

7.10 PUTTING THE PRESENTATION ON THE WEB

Placing a presentation on the Web can be accomplished in one of two ways:

1. Place the presentation file itself (the .ppt file) on a web server. In this option, you would place a

hyperlink on a web page, referencing the PowerPoint file, or simply tell your audience the address to

access the presentation file.

2. For example, assume that your PowerPoint presentation is called “snow.ppt.” You can create a link to

snow.ppt from an existing or new web page. Depending on how your reader’s computer is config-

ured, the presentation either opens directly in PowerPoint or prompts the reader to save the file. This

option gives the reader full control over a copy of the presentation, exactly as you created it.

3. The second option is to use PowerPoint’s HTML wizard to prepare an HTML version of the

presentation that you can then place on a web server. This option is presented next.
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7.10.1 HTML Wizard

To save your presentation as HTML, choose FILE : Save as Web Page.

The bottom three choices allow you to specify the file type, file name, and the page title. You should leave the type

set to Web page (*.htm, *.html).

Save as Dialog Box for Web Pages

PowerPoint will pick up the first line of text in the presentation and set the HTML TITLE tag to that text.

It is unlikely that is what you will prefer. The TITLE information is that which displays in the colored band at the top

of the browser window. It should not be confused with your heading or page contents title.

To make additional choices for your web pages, click Publish. In the Publish as Web Page dialog box, you

can choose

F To publish the entire presentation or a range of slides.

F Display any speaker’s notes you may have in your presentation.

F Specify the browser versions you wish your presentation to be viewable by. Choosing Microsoft

Internet Explorer or Netscape Navigator version 3.0 or later will keep your presentation accessible to

the greatest number of readers. Choosing the IE 4.0 version will not produce acceptable results in

Netscape Navigator.

Publish as Web Page Dialog Box
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When you make selections not supported by the reader’s web browser, they will see a message to that

effect when selecting the presentation and will be asked if they wish to continue. The static presentation slides will

show, but any special effects not supported by the browser will be ignored.

Click Web Options for more selections. Click the General tab to choose to add navigation controls (such

as forward, back, home) and their colors, to display any slide animation you may have used (slide transitions, not

movement on the slide itself), and to resize slides dynamically according to the size of the reader’s browser

window.

The Pictures tab allows you to specify the default browser window (800x600 is the current standard).

To create the web files, click Publish.

7.10.2 Testing the Web Presentation

To test the web files, start your web browser, and choose FILE : Open Page. Browse for the folder where

you stored the web presentation. Unlike previous versions of PowerPoint, PowerPoint 2000, creates a single

“control” file name with the name you specified in the Save as Web Page dialog box. All additional files will be

placed by PowerPoint in a folder with the same name. DO NOT try to rename either the control file or the folder,

or to move the control file into the folder. PowerPoint won’t know how to find the files for your presentation.

When you have located the folder containing the control file, and open it, the presentation will open as a local file

for you to review.

The web presentation looks similar to the sample below. Notice that it looks a great deal like the PowerPoint

Normal View with the list of slide titles in the left pane, the slide graphic in the upper left pane, and the presentation

navigation buttons in the lower right pane. The left pane demonstrate another reason why it is important to title

each of your slides in the Title Placeholder.

Remember that you will still have to move your PowerPoint/HTML files to a web server in order to make

the presentation available for public use.
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& CHECK YOUR PROGRESS 7.10

1. What is HTML Wizard?

2. Is it necessary to publish entire presentation?

7.11 SUMMARY

PowerPoint allows you to construct presentations from scratch or by using the easy to use wizard.

Hyperlinks cause the selection of an object to result in a move to a new location or the performance of an action.

You can insert clip art or a picture from the Clip Gallery, or you can insert a picture or a scanned photo you

import from other programs and locations.

To Change the style of all slides in the presentation by changing the properties on the Slide Master. Each

Design Template has its own Slide Master that can be altered. If you create slides from scratch, a consistent style

can be added to the presentation by formatting the Slide Master.

An action button is a ready-made button that you can insert into your PowerPoint slides to create links to

other slides or documents. These buttons only work when you are viewing your Slide Show, not when you are in

design mode. You can use these buttons for a self-running presentation at a kiosk or for a presentation that you plan

to publish on your company intranet or the Internet. PowerPoint also has action buttons for playing movies or sounds.

A self-running presentation restarts when it’s finished and also when it’s been idle on a manually advanced

slide for longer than five minutes.

7.12 GLOSSARY

Hyperlink : Hyperlinks cause the selection of an object to result in a move to a new location or the

performance of an action.

Template : A template determines the basic structure for a document and contains document settings such

as AutoText entries, fonts, key assignments, macros, menus, page layout, special formatting, and styles.

Slide master : PowerPoint comes with a special type of slide called the slide master. The slide master

controls certain text characteristics — such as font type, size, and color — called “master text,” as well as

background color and certain special effects, such as shadowing and bullet style.

Clip Gallery : The Clip Gallery contains a wide variety of pictures, photographs, sounds, and video clips

that are ready for you to insert and use in your presentations.

Linked object : When an object is linked, information is updated only if you modify the source file.

Linked data is stored in the source file. The destination file stores only the location of the source file and

displays a representation of the linked data.

Embedded object : When an object is embedded, information in the destination file doesn’t change if you

modify the source file. Embedded objects become part of the destination file and, once inserted, are no

longer part of the source file.
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7.13 FURTHER READINGS

F Basic Power Point 2000 by RSU Heathcate

F Microsoft Power Point 2000 step by step by Katherine Pinard, Microst Press

F Easy Micosoft Power Point 2000 by Laura Stewart, Que Series

7.14 ANSWERS TO THE SELF LEARNING EXERCISES

Answers to Check Your  Progress 7.2 and 7.3

1. (a)  slide master

(b) embed, link

2. A hyperlink is a hypertext link or a hypermedia link that contains links to other text documents,

allowing the reader to skip around and read the documents in various order.

3. An embedded object is linked to the original data and is updated when the original data is updated or

changed.

Answers to Check Your  Progress  7.4

1. Slide Master is a special kind of a slide. If you want an object, such as a company logo or clip art, to

appear on every slide in your presentation (except the title slide), place it on the Slide Master. All of

the characteristics of the Slide Master (background color, text color, font, and font size) appear on

every slide.

2. Place the cursor where the date and time appear on the slide and select Insert|Date and Time from

the menu bar. Select a format from the Available formats box and click Update automatically if

this feature should always be updated to reflect the current date and time. Click OK to finish.

Answers to Check Your Progress 7.5

1. An action button is a ready-made button that you can insert into your PowerPoint slides to create links

to other slides or documents. These buttons only work when you are viewing your Slide Show, not

when you are in design mode. You can use these buttons for a self-running presentation at a kiosk or

for a presentation that you plan to publish on your company intranet or the Internet. PowerPoint also

has action buttons for playing movies or sounds.

Answers to Check Your  Progress 7.6

1. Normal, Outline, or Slide View

2. To change the order of the animated objects appear, select the object in the Animation order list, then

click the up or down arrow to move the object through the list.

Answers to Check Your Progress 7.7

1. By pressing “Esc” key.

2. In slide sorter view, you see the entire presentation displayed in miniature. You can add slide transi-

tions and preview slide transitions, animations, and timings.
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Answers to Check Your Progress 7.8 and 7.9

1. Slide, Handouts, Notes Page and Outline

2. as a HTML page.

Answers to Check Your Progress 7.10

1. A wizard that can be used to convert your presentation into HTML format.

2. No. We can publish the entire presentation or a range of slides.

7.15 UNIT-END QUESTIONS

1. What is the advantage of Slide Master? How we can add action buttons in a presentation?

2. What are the basic printing options provided by MS PowerPoint?

3. What do you mean by term “Publishing of Web Pages”? How you can publish a presentation

from within Power Point?

����
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Unit VIII : MS-ACCESS  2000

Structure  of  the Unit

8.0 Objectives

8.1 Introduction to MS-Access 2000

8.2 New Features in MS-Access 2000

8.3 Exploring Access 2000

8.4 Setting Up a Database

8.4.1 Exploring Tables

8.4.2 Viewing Tables

8.4.2.1 Datasheet view

8.4.2.2 Design view

8.4.3 Creating tables

8.4.3.1 To Create a Table using the Table Wizard

8.4.3.1.1  Navigating in the table

8.4.3.1.2 To Move within a Record

8.4.3.1.3 To move from record to record

8.4.3.2 Changing a Table in Design View

8.4.3.2.1 To add a field to a table

8.4.3.2.2 To rename a field to your table

8.4.3.3 Setting a Data Type

8.4.3.3.1 To set a data type

8.4.3.3.2 Setting field properties

8.4.3.4 To add data to a table

8.4.3.5 Deleting data from a table

8.4.3.6 Sorting records

8.4.4 Exploring Forms

8.4.5 Creating Forms

8.4.5.1 Navigating a form

8.4.5.1.1 Finding records in a form

8.4.6 Exploring Reports

8.4.6.1 AutoReport

8.4.6.2 To create a new report

8.4.6.3 To insert a picture in a report

8.4.6.4 To adjust the position of the picture

8.4.6.5 Report Printing

8.5 Summary

8.6 Glossary

8.7 Further Readings

8.8 Answers to the self-learning exercises

8.9 Unit-end questions
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8.0 OBJECTIVE OF THE UNIT

After completion of this unit you will be able to :

F Know about new features of MS-Access 2000

F Create a database, table

F Modify the table by adding new data categories.

F Use a form to add data to your database table.

F Create and print a new report.

8.1 INTRODUCTION TO MS-ACCESS 2000

Microsoft Access is a computer application used to create and manage computer-based databases on

desktop computers and/or on connected computers (a network). Microsoft Access can be used for personal

information management (PIM), in a small business to organize and manage all data, or in an enterprise to communicate

with servers.

8.2 NEW FEATURES IN MS-ACCESS 2000

Access 2000 has several new and improved features that make it even easier to view and share information

from a database. These features include:

F Improved wizards. The wizards help you create tables, forms, and queries and are even more

intuitive to use.

F Name AutoCorrect. When you rename a field (column) in a table, the change is automatically

updated in all dependent tables, queries, and forms.

F Drag and Drop to Excel. You can export data from Access 2000 to Excel 2000 simply by dragging

the Access 2000 objects into Excel 2000 (tables, queries, and so on). This feature is convenient when

you maintain information on your students in both Access 2000 and Excel 2000 and you need to

transfer some data from one file to another.

F Compact on close. Databases can grow in size quickly and take up space on your hard disk. Access

2000 automatically compresses a database when the file is closed to reduce the file size. This is

especially useful when space on the hard disk is limited and you are storing databases for a number of

classes.

F Report snapshot. You can create snapshots of Access 2000 reports that can be distributed to a

disk, printer, Web page, or e-mail.

F Data access pages. Creating Web pages from the objects in your database is a simple process using

this new feature in Access 2000.

& CHECK YOUR PROGRESS 8.1 AND 8.2

1. What is MS Access 2000?

2. What are the new features of MS Access 2000?
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8.3 EXPLORING ACCESS 2000

To use Access 2000 effectively, you should be familiar with the structure of a database. A database

consists of a collection of tables, queries, forms, reports, and pages that you use to manage and present data.

These components are also called database objects. When you build a database, you create as many of these

objects as you need and Access 2000 stores them in one database file. Each object you create in the database is

dependent on other objects. That is, a query, form, or report draws information from tables, so changing data in

any one of these objects changes the data in all of these objects. Because the objects in a database are related to

one another, building a database requires careful planning.

In fact, it only makes sense to build a database when you need a flexible system for organizing and

analyzing data. For example, when you are teaching three sections of one subject and you want to grade all three

classes on one curve, it makes sense to store your records in a database instead of in an Excel 2000 workbook.

You can store information on each class in separate tables and connect them by a common field. Then you can use

a query to analyze student performance in all three classes.

Changes how 

Access 2000 

displays icons. 

Deletes 

selected  

objects. 

Standard toolbar

Provides options for 

opening objects in 
your database.

Click one of these 

four buttons to 

create or open a 
database object. 

Click Pages to 
create a Data 

Access Page.

 

There are seven main components of a database in Access 2000:

F Tables. Use tables to store database information.

F Forms. Use forms to enter or edit the information in your tables. Forms let you view one record at a

time.
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F Reports. Use reports to deliver a professional presentation or written report to your class.

F Queries. Filter data so that you retrieve selected records or fields from the database.

F Pages. Create HTML pages from a database quickly and efficiently.

F Macros. Automate tasks that you perform on a regular basis in a database.

F Modules. Automate a group of related procedures in Access 2000.

You create and open database objects from the Access 2000 database window, which lists the objects

in the left pane of the window. When you click on one of the first five items, the right pane gives options for

creating the object, and it shows all existing objects of that type in the database. You can open an object by

double-clicking it.

You first learn about tables in Access 2000. Later, you learn about forms, queries, reports, and pages.

Macros and modules are features for advanced Access 2000 users.

& CHECK YOUR PROGRESS 8.3

Fill in the blanks :

1. Use ___________ to store database information.

2. __________ can be used to automate tasks that you perform on a regular basis in a database.

3. __________ can be used to filter data so that you retrieve selected records or fields from the

database.

8.4 SETTING UP A DATABASE

To get started with Access 2000, you can create a database for a class project to conduct a census.

Students can gather information from interviews and store it in a database, then compare the results with city

census results from the past four decades. They can use Access 2000 queries to analyze how demographics vary

in different neighborhoods and how they have changed over time.

To create a database

1. Start Access 2000.

2. In the Microsoft Access dialog box, select Blank Access 2000 database and click OK.

3. In the File New Database window, decide where you want to store the database on your computer

and name the database Student Census.

4. Click Create.

When you click Create, the Student Census database opens. You can now create and store tables,

forms, reports, and queries in the census database.

8.4.1 Exploring Tables

The first object to add to your database is a table. You use tables to store all the data in the database. Each

row of a table contains one record. Records are made up of fields that contain a particular piece of data in the
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table. For example, when you create the census database, all the data for one household will be stored in a record.

One field in the table might specify the number of people in the household or the neighborhood where the

household is located.

Every table in Access 2000 must have a field that uniquely identifies each record in the table. This field is

called the primary key. You can recognize the primary key in a table by the ID appended to it. The primary key

ensures that you can retrieve data accurately and efficiently when you pull information from the database. Access

2000 automatically assigns a primary key to each of your records for you when you use an Access 2000 Table

Wizard.

8.4.2 Viewing Tables

There are two ways to view your table: Datasheet view and Design view. When you double-click a

table object from the Access 2000 database window, it opens in Datasheet view.

Use Datasheet view when you want to view, add, or delete data from a table. You can also reformat your

table to change the size and order of the field columns in this view.

8.4.2.1 Datasheet View

Use Sort Ascending and Sort 
Descending to sort records by 
a selected field.

 

Click Find to search 

for a record.

 

Click New Record and 

Delete Record to add 
or delete records.

 

Use these buttons to 
move to different 

records in a table.

 

8.4.2.2 Design View

Use Design view when you want to change the structure of a table. You can add or delete fields, change

a field caption or size, or select the type of data you plan to enter into a field in Design view.
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Click the Database 

Window button to open 
the main database 
window.  

Click one of these 

buttons to insert or 
delete rows. 

Use this area to add notes to 

yourself about each field. 

 

Read this note for 

information about 
the currently 
selected field. 

 

Use this button to 
set or change your 
primary key. 

Click View to switch to 
Datasheet view. 

Identifies the properties of the 
currently selected field.  

8.4.3 Creating Tables

When you open a database, you see three options for creating a table:

F Create table in Design view

F Create table by using wizard

F Create table by en tering data

Unless you are already familiar with Access 2000, you should use the Table Wizard when you create tables.

The Table Wizard helps you to organize data by providing sample fields that you can include in a table and

it assigns a primary key to each record. Later, if you need to change the design of your table, you can modify it

using Design view. The Table Wizard even provides a sample student table that you may want to build after you

have finished designing the census database.
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8.4.3.1 To Create a Table using the Table Wizard

1. From the objects box in the Student Census database window, click Tables.

2. Double-click Create table by using wizard. The Table Wizard dialog box opens.

3. Click each of the tables in the Sample Tables list and scroll through the Sample Fields

list.

4. When you see a field that you want to include in your table, click it and then click the single right arrow

next to the Sample Fields list. If you want to include all of the  Sample Fields in one table, simply click

the double right arrow.

5. If you accidentally add a field that you don’t want or add the same field twice, click it  in the Fields in

my new table list and then click the single left arrow to remove it.

6. When you are satisfied with the fields in the table, click Next. If you need to later, you  can modify the

fields in the table using Design view.

7. The Table Wizard provides a name for the table. Replace this name by typing Census  Table.

8. Make sure the option for the Table Wizard to assign a primary key is selected and then  click Next.

9. Click Finish to exit the Table Wizard.

The census table appears in Datasheet view.

8.4.3.1.1 Navigating in the Table

Before you enter data into a table, you need to know how to move around in it. Depending on what you

want to do, you can use the TAB key, the navigation buttons at the bottom of the table, the arrow keys, or the

HOME, END, PAGE UP, and PAGE DOWN keys.

8.4.3.1.2 To Move within a Record

F To select any field, click it.

F To move one field to the right, press TAB or use the right arrow key.

F To move one field to the left, press SHIFT+TAB or use the left arrow key.
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F To move to the first field of the active record, press HOME.

F To move to the last field of the active record, press END.

8.4.3.1.3 To Move from Record to Record

F To move to the next record, click the single right arrow next to Record.

F To move to the previous record, click the single left arrow next to Record.

F To move to the first or last record in the table, click the First Record or Last Record icon next to

Record.

F To move one window down, press PAGE DOWN.

F To move one window up, press PAGE UP.

8.4.3.2  Changing a Table in Design View

When you use the Access 2000 Table Wizard, chances are that you will not be able to design the table

exactly as you like it. In the census, for example, you may want to include information on ethnicity and income, two

fields that are not available from the Table Wizard Sample Fields list.

To modify a table, you must open it in Design view by selecting the table you want to modify from the main

window of Access 2000 and then clicking Design, or if the table is already open, click the Design icon in the left

corner of the table window.

8.4.3.2.1 To Add a Field to a Table

1. Open the table in Design view.

2. Click in the first empty row of the Field Name column.

3. Type the field name. Press the DOWN ARROW to move to the next empty row if you want to add

another field. A data type will automatically be assigned to the field (which you can change later).

4. If the fields are in the wrong order, you can click to select a field and then drag it to where you want

it to appear.

5. When you have finished adding fields, save and close the table.

To delete a field from the table, select the entire row by clicking the leftmost box and then press the

DELETE key.

8.4.3.2.2 To Rename a Field to your Table

1. Open the table in Design view.

2. Select the row containing the field name you want to change by clicking it.

3. Type the new field name in the Caption box under Field Properties.

4. Save and close your table.

With the new AutoCorrect feature, the field name change is automatically updated in all queries, forms,

reports, and pages that draw information from the table you have modified.
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8.4.3.3 Setting a Data Type

The data type determines the kind of data that can be entered into a field. It also formats the value you

enter for the data type. For example, when you enter numbers in a field with a currency data type, the dollar and

decimal signs will be automatically added to the numbers. Some of the more common data types are:

F Text. Any combination of letters and numbers.

F Currency. Numbers and monetary symbols. You can only add numbers to a field with a currency

data type.

F Date/Time. The date and the time in 12- hour and 24- hour formats.

F Yes/No. A single value that indicates yes or no, true or false.

Each field in an Access 2000 table must be assigned a data type. The fields you select from the Table

Wizard already have a data type assigned to them. Text is the default data type for any fields you add to your table.

8.4.3.3.1 To set a data type

1. Open the table in Design view.

2. Click in the data type column of the field for which you want to set a data type.

3. Click the arrow in the data type text box to see the drop-down list of data types.

This arrow appears 

when you click in 
any cell. Click  to 
view the drop-down 

list.

 

4. Select the data type you want from the drop-down list.

5. Save and close the table.

8.4.3.3.2 Setting field properties

Each field in a table is defined by a set of properties. These properties determine the size of the field, how

it is formatted, and what it is called, among other things. You can view or change field properties in Design view.

To set field properties

1. Open the table in Design view.

2. Select the field for which you want to set properties.

3. Click the General tab in the Field Properties window.
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4. Click the property you want to modify and type the appropriate text. Do one or more of the following :

F Type a number in the Field Size box to indicate the maximum number of characters that field can

hold.

F Select Y or N in the Required box to indicate whether data must be entered in this field for every

record.

F Type the caption you want for a field in the Caption box. This caption appears on the tables and

forms. If you do not enter a caption, the field name appears as the caption.

5. After you have set the field properties, save and close your table.

8.4.3.4 To add data to a table

1. Open the table in Datasheet view.

Press TAB to move from the primary key column to the second column in the table. (You cannot add

data to the primary key column. Access 2000 automatically generates the information in this column.)

2. Type data in the second column. As soon as you enter a value into the second column, Access 2000

automatically numbers the first record and adds another record to the table.

3. Press TAB to move to the next column in the table, and type your data. Unless a field is required, you

can leave a field empty.

4. When you reach the end of the first record, press TAB to move to the next record in the table.

5. Save and close your table.

8.4.3.5 Deleting data from a table

You may add a field to your census table and later discover that you cannot collect data for that field, so

you need to delete it from your table. Deleting fields and records in Access 2000 is simple:

F To delete an entire record, make sure you are in Datasheet view and click the record selector in the

box at the left of the record and then press the DELETE key. Then click Yes.

F To delete an entire field from a table, go back to Design view and click the field header so that the

whole row is selected and then press the DELETE key.

8.4.3.6 Sorting records

Access 2000 displays the information in a table in alphabetical or numerical order based on the primary

key. However, you can sort information so that it appears in an order that works better for you. For example, if

you want to group people by educational level in the census table, you can select that field and then click one of the

sort buttons. Access 2000 alphabetizes the records according to the data in that field.

To sort  records

1. In Datasheet view, click the header of the field to sort by so that the whole column is selected.

2. Click the Sort Ascending button  or the Sort Descending button  on the Datasheet toolbar..

3. Save and close the file.
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8.4.4 Exploring Forms

Forms make it easy for you to access information in a database. With a form, you can focus on one record

in a database at a time, and you can view, add, and delete data from that record. In addition, you can customize

a form to view and print information in a style you like. You can create a simple multi-page form that looks like this:

Change the color 
of the font, 

background, or 
border for any 
text box in the 

form.

 

Create a multi-page 
form when you want 

to organize fields 
into sub-categories.

 

8.4.5 Creating Forms

The easiest way to build a form is by using the Form Wizard. The Form Wizard lets you choose the layout

of records in the form and also the background, color, and format of the display. The Form Wizard lets you

preview the layout and style options when you create a form.

To create  a  form

1. From the list of objects in the census database window, click Forms.

2. Double-click Create form by using wizard.

3. Under Tables/Queries, select the table the form will be based on from the drop-down list.

4. Select the fields that you want to appear in the form by clicking each one and then clicking the arrow

that appears to the right of the Available Fields list. If you want all the fields from the table to appear

in the form, click the double arrow and then click Next.

5. Select the layout for your form by clicking Columnar, Tabular, or Datasheet and then click Next.

6. Select the style of the background print you prefer and then click Next.

7. Enter a name for the form you have created, then select Open the form to view or enter information,

and then click Finish.

To open a form stored in the database, double-click it in the main database window.

8.4.5.1 Navigating a form

Many of the techniques you used for moving around in tables also apply to forms:

F To add data to a record, click in the box in which you want to add data and then type.

F To delete information, double-click in a box to select the text and then press the DELETE key.

F To move from record to record, press the arrow keys next to Record at the bottom of the window.

F To add a record to a form, click the New Record icon on the Form View toolbar.
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F To delete a record from a form, select it by clicking the bar on the left (indicating the whole record is

selected) and then press the DELETE key. Click Yes to delete.

Any changes you make to a record in a form automatically appear in the table that the form draws

information from.

8.4.5.1.1 Finding records in a form

At times, you may want to make changes to a record in a database, but the record isn’t visible when you open

your form. You can quickly find a record, or information within a record, by using Find on the Standard toolbar.

To find a record

1. On a form, activate the field for which you plan to enter a value. For example, if you want to find the

record for a person with the last name “Smith,” click in the Last Name box of the visible record.

2. Click Find  on the Standard toolbar..

3. In the Find What box, type what you are looking for. For example, if you are looking for Linda

Smith’s record, select the Last Name field, then type Smith.

4. Click Find Next to begin the search, and continue until all matches have been displayed.

5. Click Close to stop the search and close the window.

8.4.6 Exploring Reports

After you and your students have added information to the census database, you may want to report on

some aspect of the data you have collected. Reports let you customize the display of information from the database.

You can select the data you want to include and then select the report layout from a variety of design and format

options. You can insert pictures, add headers, footers, and page numbers, group the information, and change the

background colors, among other things.

8.4.6.1 AutoReport
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A report provides an object used to print a database records. Although you can print tables, queries, or

forms, reports are customized to be printer friendly. They can perform and display calculations. Once again,

Microsoft Access provides wizards to quickly create reports.

The simplest way to create a report is by using the AutoReport feature available either from the New

Object button on the Database toolbar or the New Report dialog box.

When you design your first report, use the Report Wizard. The Report Wizard asks you a series of

questions to help you design the data exactly as you want. After you have created the report, you can open it in

Design view to modify its structure.

8.4.6.2 To create a new report

1. From the list of objects in the Student Census database window, click Reports.

2. Double-click Create report by using wizard.

3. Select the table for which you want to create a report from the Tables/Queries drop-down list and

then double-click the fields in the Available Fields list to add them to the Selected Fields box. Click

Next.

4. If you want to prioritize the fields, add grouping levels to your report. Do this by clicking a field and

then clicking the right arrow to position it at the top of the list. You can select up to four fields to appear

at the top of your report.

Click these buttons 

to change the order 
of the groups.

 

5. To rearrange the grouping, use the up and down Priority arrows to move fields. When you have

grouped the fields according to your preferences, click Next.

6. To order the values in a particular field, select the field from the drop-down list by clicking the arrow

in the box and then click Ascending or Descending. You can sort records in up to four fields. After

you indicate the sort preferences, click Next.

7. Select a Layout style from the list of options and then click Next.

8. Select a report style and then click Next.
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9. Type the title you want to appear on the report. The title will also be the file name for the report.

10. Make sure Preview the Report is selected and then click Finish. The report appears in Print

Preview after you click Finish.

If you like, you can enhance the appearance of your report by adding a picture or a hyperlink. To insert

objects into a report, you must open it in Design view.

Use the Insert menu to 

insert pictures or 
hyperlinks into a 

report.

Click the Tools button 
for the toolbar to 

appear. 

 

8.4.6.3 To insert a picture in a report

1. In Design view, click the section of the report where you want to insert a picture.

2. On the Insert menu click Picture.

3. From the drop-down list in the Insert Picture dialog box, select the folder containing the picture.

Then double-click the file you want to insert.

4. Click OK. The picture is inserted into the selected area of the report.

Follow this same process for inserting hyperlinks, except click Hyperlink instead of Picture on the

Insert menu.
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8.4.6.4 To adjust the position of the picture

1. Position the pointer over the picture until the pointer changes into a hand.

2. To move the picture, click and drag it. Use the horizontal and vertical rulers to align the picture.

3. Select Print Preview from the drop-down menu in the left corner to preview the report with the

picture in it.

4. When you are satisfied with the position of the picture, save and close the report.

To learn more about customizing a report, open the report in Design view then click Toolbox. Experiment

with the buttons in the toolbox to see what you can do.

8.4.6.5 Report Printing

The report is the favorite object used to print data. As done with the other objects, you can print a report

whether it is opened or not. Before printing a report, you must first select or open it. If you want to print a report

without opening it, in the Database window, make sure the Reports section is selected. Then, you can locate and

right-click the desired report. If you follow this approach, the report would be sent directly to the printer.

If you want to control or customize the printing of a report, first select it in the Reports section of the Database

window or open it. Then, on the main menu, you can click File -> Print… This would display the Print dialog box,

allowing you to select a printer if you have more than one. You can also specify such aspects as the color, the

number of copies or the range of records to be printed.

& CHECK YOUR PROGRESS 8.4

Fill in the blanks :

1. A table can be created in _________ different ways .

2. The _________ key uniquely indetifies each record in the table.

3.  ___________  are made up of the fields.

4. There are two ways to view the table ________ and __________

5. __________ is used to change  the structure of the table.

6. To move to the first field of the active record, press key _______

7. Each field in a ________ is defined by set of properties.

8. By using  a  ________  you can view add and delete data from a record.

9. With a ________ you can focus on one record in database at a time.

10. Any changes in a record in a form automatically appears in the __________.

11. The simplest way to create a report is by using the _________ feature.

12. Before printing a report, you must first __________ or __________ it.
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8.5 SUMMARY

To use Access, or to even plan an Access project, you need a good working familiarity with the Access

user interface and the objects that make up a project. The primary display in Access is the Database view. This is

where you can see all the objects within your database, either classified by type or clustered within a heteroge-

neous group. The Database view has an object bar allowing views of other types of objects and a toolbar (below

the title bar) allowing you to take actions on the selected objects.

There are seven types of Access objects grouped within the Database view: tables, queries, forms,

reports, pages, macros, and modules. Tables hold data. The other objects either display or manipulate that data.

Tables store all data within a relational database such as Access. Access offers three ways to make a

table: Design view, by entry example, and by a wizard. Each field within a table must have a specific data type

conforming to the type of data it’s to hold. Each field also has an array of developer-set options called field

properties. The properties for each field depend upon the data type. Primary fields act as unique identifiers for a

record within a table. Although you should try to use actual data as a key, using artificial data such as an incrementing

AutoNumber field is much better than no key (which should never occur). By linking fields between tables, which

is the essence of a relational database, you can later construct various views of data from more than one table.

Although other database objects such as forms or queries might do the job better (to some people’s view), you

can filter, sort, and find data within tables.

Forms present data in a way most people find easier to edit or view than simple datasheets. You can

create forms using the AutoForm Wizard, the regular Form Wizard, or using Design view. You can always modify

the wizard-generated forms using Design view. Many developers let the wizard make a simple form and then

modify the layout using Design view. Forms have up to five bands. These are Form Header, Page Header, Detail,

Page Footer, and Form Footer. You can add controls, either bound or unbound, to any of these bands. To add a

bound control to a band, click on the field name in the field name list box, and drag it to the band on the form where

you want it to appear. To add a non-default (non-text box) control to a form, click in the toolbox on the control

type and on the field in the list box, and then click on the form where you want the control to reside.

Reports are to printers what forms are to screens. That’s a bit of a simplification, but it does make the point of

what each specializes in. The chief operational difference between a report and a form is that a report has no way

to edit or enter data and a form does.

The skills you learn in report design or form design are almost 100 percent transferable to the other. Each

object has an adjustable design grid, controls that can be bound or unbound, a toolbox, and the critical Properties

list box for controls and other objects compromising the report. Additionally, both objects are constructed of

bands.

You can use built-in (or user-defined) functions in unbound controls in reports, similar to how you can use

them in forms. The function, when applicable, will operate differently depending on the band within which it is

located. For example, a control with the COUNT() function in a group band will count occurrences over the

group.
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8.6 GLOSSARY

Data type - The attribute of a field that determines the kind of data the field can contain.

Database - A collection of data and objects related to a particular topic or purpose.

Database Objects - Tables, queries, forms, reports, macros and modules.

Datasheet - Data from a table, form or query displayed in a row-and-column format.

Default - A value or setting that a device or program automatically selects if you do not specify a

substitute.

Design View - A window that displays the design of a table, form, report or query.

Embed - Information created in one document and inserted into another document.

Export - Exchanging files between Access and other programs.

Expression - A formula that calculates a value. You can use expressions in forms, reports, tables, queries,

macros and modules.

Field - An element of a table that contains a specific type of data. A series of grouped fields make up a

record. A collection or records make up a table.

Form - A view of data in a table.

Import - Copying data from another application into Access.

Link - A logical relationship between two or more tables, often based on corresponding or related fields

in each of the tables.

Macro - A set of actions used to automate a task.

Module - A collection of statements and procedures stored together as a single named unit.

Object - A table, chart, graphic, equation, or other form of information you create and edit. An object can be

Primary Key - A field, or fields, used to uniquely identify a field.

Record - A collection of data about a particular entity, such as a person, place, event, or some other item.

Records are represented as rows in Datasheet view.

Relational Database - A database schema in which information is linked by common fields between

several tables.

Report - A document that presents information in a formatted and organized manner.

Table - A database object that consists of a group of rows (records) divided into columns (fields) that

contain data.

Wizards - Tools used to assist the user in the creation of objects and controls in Access

8.7 FURTHER READINGS

The following books are suggested for further readings :

Sams Teach Yourself Microsoft Access 2000 in 24 Hours
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by Timm Buchanan; Craig Eddy

Sams, Macmillan Computer Publishing

Sams Teach Yourself Microsoft Access 2000 in 21 Days by Paul Cassel

Macmillan Computer Publishing

8.8 ANSWERS TO THE SELF-LEARNING EXERCISES

Answers to Check Your Progress 8.1 and 8.2

1. Microsoft Access is a database application on desktop computers and/or on connected computers (a

network). Microsoft Access can be used in a small business to organize and manage all data, or in an

enterprise to communicate with servers.

2. MS Access provides some new features like :

(a) Improved wizards. (b) AutoCorrect the table name in dependent tables, forms etc. (c) Compact

the database on close (d) Report snapshot that can be distributed to a disk, printer, Web page, or

e-mail (e) Data access pages can be used to Create Web pages from the objects in the database.

Answers to Check Your Progress 8.3

1. tables 2. macros 3. querries

Answers to Check Your Progress 8.4

1. 3 2. primary

3. record 4. data sheet view, design view

5. design view 6. home

7. table 8. form

9. form 10. table

11. AutoReport 12. select, open

8.9 UNIT-END QUESTIONS

1. Create a database and add a table tblFriends with the following fields :

(a) Name of the friend (b) Address

(c) Office Phone No. (d) Residence Phone No.

(e) Mobile No.

Take suitable data types for all the fields and some data in the table by using datasheet view.

2. Create a Form to view data from table tblFriend.

3. Create a Report  to print all the data available with table tbl Friend.

����
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Unit IX : DATA HANDLING  IN  MS-ACCESS

Structure of the Unit

9.0 Objectives

9.1 Access Help System

9.1.1 Examining Ways to Get Help

9.1.2 Using the Office Assistant

9.1.3 Using the Help Topics Dialog Box

9.1.4 The Contents Tab

9.1.5 The Index Tab

9.1.6 Screen Tips

9.2 Planning and Designing Your Database

9.2.1 Relational Databases

9.2.2 Review of Relational Database Terms

9.2.3 Relationships and Joins

9.2.4 The Three Types of Keys

9.2.5 Referential Integrity

9.2.6 The Three Types of Relationships

9.3 Creating and Using Table Indexes

9.3.1 Setting and Changing Indexes

9.3.2 Which Fields to Index

9.4 Joining Tables

9.5 Creating Queries

9.5.1 Ways to Create Queries

9.5.2 The Query Design View

9.5.3 Steps in Creating a Query

9.5.3.1   Creating a Basic Query

9.5.3.2   Specifying a Sort Order

9.5.3.3   Specifying Criteria

9.5.3.4   Showing and Excluding Fields

9.5.4 Using Advanced Selection Options in Queries

9.5.4.1   Wildcards

9.5.4.2   Creating Queries that Accept Parameters

9.5.4.3   Adding Calculated Fields

9.5.5 Working with Subdatasheets

9.5.5.1   Formatting the Datasheet

9.5.5.2   Printing the Datasheet
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9.5.5.3   Closing the Datasheet

9.6 Understanding Field Properties

9.6.1 Understanding Field Size

9.6.2 Input Mask

9.6.3 Captions

9.6.4 Understanding the Required Property

9.6.5 Comparing Format and Input Mask

9.6.6 Understanding Format

9.6.7 Understanding an Input Mask

9.6.8 Creating a Validation Rule

9.6.9 Creating Validation Text

9.7 Summary

9.8 Glossary

9.9 Further Readings

9.10 Answers to the self-learning exercises

9.11 Unit-end questions
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9.0 OBJECTIVES OF THE UNIT

F After completion of this unit you will be able to :

F Understand how to use Access Help System

F Understand the need of planning and designing of a database

F Create table indexes

F Able to join tables and make different kind of queries, sub datasheets etc.

9.1 ACCESS HELP SYSTEM

9.1.1 Examining Ways to Get Help

You probably need some help learning more about the program. Online Help systems provide a reference

tool and information about various Access tasks. The questions you might have can be answered in many ways,

and several online functions are available to help you:

F Office Assistant

F Standard Windows Help menus

F Screen tips

Many of the examples in this chapter make use of the Northwind sample database that ships with Access

2000. To open the Northwind database, start Access, select the Open an Existing Database option, and

double-click the More Files option. The Northwind database default location when Access 2000 is installed with

Office 2000 is C:\Program Files\Microsoft Office\Office\Samples. It might be in a different location on your PC.

9.1.2 Using the Office Assistant

Figure 1: Using the Office Assistant menu.
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One of the first things you notice when starting Access 2000 is a new, curious-looking creature in a box at

the bottom right-hand corner of the screen. This is the Office Assistant—a feature in all the applications in the

Office 2000 suite. His main function is to help you with any questions or problems you might have with any Office

2000 product. To activate the Office Assistant, click on him with your mouse. After you click the Office Assistant,

press F1, or select Help, Microsoft Access, a menu is displayed by the Office Assistant listing several options.

Under the heading “What would you like to do?,” a few context-sensitive Help topics are listed that are

relevant to what you currently are doing in Access. You can view even more topics by clicking the See More topic

at the bottom of the list. Below this option is a text box with room for you to type a request or Help question. If you

need help but are not exactly sure which Help topic you should select, this is a good place to start. You can type

a question using plain English, without relying on technical language. Or, you can just type one or two words

related to the Help topic for which you are searching. After you finish typing, click the Search button. You then see

Help topics that are related to the question you typed.

9.1.3 Using the Help Topics Dialog Box

The Help Topics dialog box shows you a few ways to get started with Access 2000. This dialog box

offers three options:

F Contents: Displays the default view in the table of contents. After you click a topic, a menu of

subtopics appears.

F Answer Wizard: Enables you to type in a question in plain English, and displays topics that should

help you with your question.

F Index: Displays an alphabetical listing of the Help topics available to you. You can scroll through the

list or type the first few letters of the topic on which you want to get help.

9.1.4 The Contents Tab

Figure 2: Viewing specific topics indicated by the book and page icons.
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The list of Help topics under the Contents tab is very general. Book icons designate general topics.

Double-click a book icon to display more specific topics. You can double-click an open topic to close it. Double-

clicking the general topics leads you to specific Help topics, which are indicated by open-book icons and page

icons, as shown in the above Figure.

9.1.5 The Index Tab

You can click the Index tab to search for help alphabetically. Type the first few letters of the help topic for

which you are searching, and the menu jumps to the topics that start with those letters. Double-click a topic, or

select the topic and click the Display button, to view the help topic.

When a Help topic is displayed, some words appear underlined. If you click these words, which are

called hyperlinks, you are taken to a new area with more information on that specific word or topic. When

viewing these Help topics, you can click the Back button to return to the previous Help topic. You can click Help

Topics to return to the main Help menu.

9.1.6 Screen Tips

Screen tips are similar to ToolTips but usually provide more information. Screen tips give you a short expla-

nation about the various parts of Access. They consist of text only, displayed in a rectangle. Screen tips provide a

paragraph about the topic, whereas ToolTips consist only of a word or two. You use screen tips by clicking the Help

icon on the toolbar or choosing Help, What’s This? You then click the area of the screen that you want information on,

and Access displays a screen tip consisting of a paragraph of text about the item you selected.

& CHECK YOUR PROGRESS 9.1

(a) ________ key can be used to invoke the Access help system.

(b) _________ can be used to search for help alphabetically.

9.2 PLANNING AND DESIGNING YOUR DATABASE

The first step in creating any database is to plan the database carefully. This is especially important when

you’re designing a relational database such as the ones that you can create and view with Access 2000. In fact,

having a good design is the single most important factor in creating an effective database. The design must be

flexible, logical, and methodical.

Some of the key points that define an effective relational database are

F It is easily adapted to meet future changes in design requirements.

F Its table layout and relationships are easily understood.

F It provides acceptable performance and disk space utilization.

9.2.1 Relational Databases

There are many different qualities which make a database system a relational database. A relational

database can best be described as a set of data tables, each modeling a single entity and having certain “key” fields

in common with other tables. These key fields establish the relational links between the data tables. The relational
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database model excels in providing the capability to collect, organize, and report on data that might be of a

different nature, but is in some way related. This section discusses relational databases in detail by providing

definitions for the database terms used when discussing relational databases.

The many table relationships contained in the Northwind sample database are shown in the following

figure. The lines connecting the tables represent the joins (that is, relationships) between the key fields in the tables.

It should be obvious that the Northwind database is a highly relational database, containing many related tables.

Figure 3: The Northwind database’s Relationships window.

9.2.2 Review of Relational Database Terms

Field

The term field refers to the basic building block of any database, relational or not. A field is the database’s

way of representing a single piece of information or an attribute of an object. Fields should always be atomic,

meaning that they cannot be broken into multiple pieces of information. For example, a field representing a person’s

entire name is not atomic because it could be broken into First Name and Last Name fields.

Fields are given a data type that defines the kind of data that can be stored in the field. There are many

different data types available, including Text and Numeric.

Table

A table is a collection of fields. The data contained in a table is stored as a record. Each table in a database
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should represent a different entity. For example, the Northwind database contains separate tables for customers,

suppliers, employees, products, and orders. Although these are all related in some way, they are all completely

different entities.

Record

A record is a collection of data for a specific object or table. In the Northwind database, a customer

record is the row of data stored for each customer. Each record in the database should contain a unique piece of

information, representing one specific instance of the entity represented by the table. In the Customers table, for

example, each record should represent one and only one customer.

Because a relational database does not store or retrieve records in any set way, there is no physical order

to the records. In other words, there is no concept of a record number as there is in many other database systems.

Key Field

A field is said to be a key field when it can be used to relate two or more tables to each other. The keys are

fields that these related tables have in common. The data values stored in key fields are identical between related

records in the related tables. For example, in the Orders table, CustomerID and EmployeeID are fields that relate

a specific order to a customer and an employee, respectively. Therefore, if an order record is created for Around

the Horn (a customer in the Northwind database), the CustomerID field in the Orders record will contain the data

AROUT. This, of course, is the CustomerID value found in the Customers table for Around the Horn.

Keys are classified as either primary, foreign, or composite, depending on their use and the fields that

comprise them. Primary keys uniquely identify a record. Foreign keys point to a related record in another table.

Composite keys are those made up of two or more fields.

9.2.3 Relationships and Joins

A relationship between two tables indicates that the two tables share a common key value. The order

record discussed in the preceding section is related to a customer. The fact that the order has a value in its

CustomerID field establishes a relationship between this particular order and Around the Horn’s record in the

Customers table.

A join is a sort of virtual table created when the user requests information from different tables that

participate in a relationship. The key fields are used to find the matching records in the different tables participating

in the join.

A more advanced form of a join is called the self-join. This is a join in which a table is joined to itself based

on a field or combination of fields that have duplicate data in different records. This can be used in the Northwind

Employees table, for example, to create a join among the employees using the ReportsTo and EmployeeID fields.

The ReportsTo field might contain the EmployeeID of another employee’s record in the table. This EmployeeID

would be the EmployeeID of the employee the current employee reports to.
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9.2.4 The Three Types of Keys

Primary Keys

Each table in a relational database should have a unique identifier that consists of one or more fields.

Without this unique identifier, there is no way to define relationships between tables. The field or group of fields

that is the unique identifier for a table is called the table’s primary key. The selection of which field or fields to use

as the primary key is one of the most important decisions made when designing a database.

The primary key must be able to uniquely identify each record in the table and, therefore, must never have

duplicated values. Using an AutoNumber field guarantees that a duplicated value is never inserted in the primary

key field. Access automatically inserts a unique value in the field when a record is inserted into the database.

Access also prevents you from modifying or deleting the values in this field after they are inserted.

Composite Keys

There are often cases in which a record cannot be uniquely identified by a single field. In these cases, a

composite key is used. A composite key is the group of fields that together uniquely identify a record. A composite

key is also the primary key for that table. Although duplicate values are allowed within any of the fields of a

composite key, there cannot be duplicated values across all the fields that make up the composite key.

An example explains this concept in a clearer way. The OrderDetails table is used to relate a record in the

Orders table to a record in the Products table. Each line item of an order references a specific product. The

OrderDetails table has a composite key consisting of its OrderID and ProductID fields. Using this table and its

composite key, you can create relationships between many orders and many products. A specific OrderID can

appear many times in the OrderDetails table, as can a specific ProductID. However, the same values for both

OrderID and ProductID in a record cannot be repeated within the table. Each order can have only one OrderDetail

for each product on the order. This is illustrated in the following Table.

OrderID ProductID

1 2

1 3

2 2

2 3

2 4

Foreign Keys

A foreign key is a field (or group of fields) in one table that references the primary key field or fields of a

related table. For example, the Orders table has a CustomerID and an EmployeeID field. These fields are foreign

keys in the Orders table but are the primary keys of the Customers and Employees tables, respectively. The
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Relationships window graphically shows the relationship between foreign and primary keys. It is the relationship

that actually allows Access to join data between the tables.

9.2.5 Referential Integrity

The term referential integrity refers to the capability to maintain links among tables. Basically, maintaining

referential integrity means that every foreign key value stored in a table must map to a corresponding record in the

table that has this foreign key as its primary key.

For example, if an order was created and an invalid value was placed in the CustomerID field, there

would be no corresponding record in the Customers table. This Orders record would be called an “orphan”

record because it has no “parent” record in the Customers table. Allowing this condition would violate the rules of

referential integrity and would render your data practically useless.

Access can be made to enforce referential integrity and thus avoid this situation. This mechanism is part of

the Relationships window (select Relationships from the Tools menu). To change the referential integrity settings

for a relationship, select the relationship by clicking the line that joins the two tables and then use the Relationships,

Edit Relationship menu.

9.2.6 The Three Types of Relationships

The real power of a relational database is the capability to combine primary and foreign keys to establish

relationships between data tables. There are three types of relationships that can be created using the relational

database model. Essentially, the type of relationship created between tables determines the format of the data

retrieved when the tables are joined.

One-to-One

The simplest type of relationship is the one-to-one relationship. This means that for every record in one of

the tables in the relationship, there is a single corresponding record in the other table that takes part in the relation-

ship. Because these tables could easily be combined into a single table (thus avoiding having to join the two

tables), this relationship is used only in special circumstances.

One-to-Many

A one-to-many relationship is a relationship in which a record in one table has one or more related records

in another table. The one-to-many relationship is by far the most common relationship used in a relational data-

base. Strictly speaking, the Northwind database contains nothing but one-to-many relationships.

In the Northwind database, there is a one-to-many relationship between the Customers table and the Orders

table. Each customer can have more than one order related to it. The key field CustomerID is used to join the tables.

Many-to-Many

A many-to-many relationship is a relationship in which many records in one table can have many records

in another table. The strict definition of relational databases does not allow for many-to-many relationships.
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Instead, an intermediate table is created that holds the primary keys from the two original tables as foreign keys.

This creates two one-to-many relationships for the intermediary table—one for each table in the many-to-many

relationship.

& CHECK YOUR PROGRESS 9.2

(a) A table is a collection of ___________.

(b) Three types of keys are ___________, ___________ and ____________.

(c) The term ________________ refers to the capability to maintain links among the tables.

(d) A ____________ relationship is a relationship in which a record in one table has one or more related

records in another table.

9.3. CREATING AND USING TABLE INDEXES

Access uses indexes as road maps to find your data in a timely and efficient manner when you run a query

or report or simply browse your tables. Indexes are similar to the index in the back of this book that you use to

search for a particular topic or word. If you enter a lot of records and then run a query or a report based on the

fields in one of your indexes, Access can more quickly handle the output of the data.

9.3.1 Setting and Changing Indexes

You create indexes on a table-by-table basis. To create an index for a table in a database using the

desktop database store, perform the following steps:

1. In the Database window, select the table and click the Design button.

2. Click the Indexes button on the toolbar (the one with a few lines next to a lightning bolt). Even if this

is a brand new table, Access might have created some indexes for you. For example, the primary key

is always used as an index and will be listed on the Indexes dialog box.

3. Click an empty row in the Index Name column. Type a name for the index. The name must be unique

on the current table.

4. In the Field Name column, click the arrow and select a field to include in this index.

5. If  the index will include multiple fields, click in the Field Name column of the row immediately

following this one and select the next field’s name. Do not enter anything for the Index Name column

on this row. Repeat this step for each field in the index.

6. If you have additional indexes to define, return to step 3. Otherwise, click the Close button on the

Indexes dialog box to return to the Design view window. Be sure to save the table design (Access will

prompt you if you attempt to close the Design view window without having saved the changes).

Access will create a default name for the index and put the focus in the Column Name column. Select

the name(s) of the field(s) to be used in the index.

9.3.2 Which Fields to Index

It is not always obvious what types of fields should be indexed. Some data types, such as text, seem to

always perform better with an index. AutoNumber fields and other nontext fields don’t seem to gain much benefit
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from indexing. As a rule of thumb, you should index any Number or Date/Time fields that are frequently used as

search criteria in queries. Some database pros feel that you cannot have too many indexes on a table. It’s impor-

tant to realize, however, that every index placed on a table must be updated whenever records are added, modi-

fied, or deleted.

9.4 JOINING TABLES

Access 2000 uses relationships to relate the data within various tables, especially when they’re used in

queries. To establish a relationship between two tables:

1. Close any tables you might have open and activate the Database window.

2. Click the Relationships button on the toolbar or click the Tools menu and select Relationships. De-

pending on your database, you might or might not have some relationships already established.

3. If either of the tables that are involved in the relationship is not visible in the Relationships window,

click the Show Table button on the toolbar (a yellow plus symbol). If you prefer to use the menu, click

the Relationships menu and then select Show Table.

4. Double-click the two tables. This adds them to the Relationships window. Click the Close button.

5. Drag the tables around so they are side-by-side and easier to work with.

6. Now the fun part: Select the table that contains the foreign key field. Click the foreign key field and

drag this over to the primary key field of the related table. Drop it right over the primary key field.

Access displays the Relationships dialog box.

7. Verify that the fields from each table are correct. Using the information from your database design, set

the various properties of this new relationship.

8. Click the Create button and the Save button on the toolbar. Your new relationship is now safely

embedded into your database.

& CHECK YOUR PROGRESS 9.3 AND 9.4

State whether the given statement is true or false :

(a) Indexes can be used to find your data in a timely and efficient manner when you run a query or report

or retrieve the data from the table.

(b) You should not index any Number or Date/Time fields that are frequently used as search criteria in

queries.

(c) To improve the performance of the table we should not make so many indexes on a table.

(d) To make a relationship between two tables there must be a common field in both the tables.

9.5 CREATING QUERIES

Queries are used to retrieve specific data from the tables in the current database, from other data sources,

and even from other queries. Such queries are called select queries. Queries can also perform actions upon the

data in your tables, such as updating or deleting specific records. These queries are called action queries.
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A select query, the most common kind of query, retrieves data from one or more tables (or other queries).

The resulting data can be displayed in a datasheet or used as the data source for forms, reports, or data access

pages.

An action query is a query that’s designed to perform some sort of operation on the data in a table or

tables, or to modify a table’s structure. There are four kinds of action queries: the delete query, which is used to

delete rows from the database, the update query, which is used to update data in the database, the append query,

which is used to add new rows to a table or tables, and the make-table query, which creates a new table using data

in existing tables.

9.5.1 Ways to Create Queries

Like most tasks in Access 2000, you have your choice of means to create new queries. Access provides

five different mechanisms for creating queries:

Design view :– This is the manual means of creating a query. The Design view method provides you both

a QBE Design Grid (known, confusing as it is, as the “Design view” on the View menu and toolbar button)

and a SQL View. The Design Grid is a graphical tool for creating queries. The SQL View enables you to

fine tune the SQL code that underlies the query.

Simple Query Wizard :– This wizard enables you to create the most basic of select queries. About all

this wizard automates is the task of selecting which tables and queries will be used as the source of the

data and which fields from those queries will be output by the query.

Crosstab Query Wizard:– This wizard helps you create a crosstab query, which displays summarized

values from one field in a table and groups them by one set of data listed down the left side of the datasheet

(such as a region or category) and another set of data listed across the top of the datasheet (such as year,

quarter, or month). For example, you may wish to see sales grouped by region and quarter. The Crosstab

Query Wizard assists you in creating such a query.

Find Duplicates Query Wizard :– Assists you in creating a query which will identify duplicate data

contained in a table or returned by another query.

Find Unmatched Query Wizard:– This wizard helps you find records which are “orphaned” by related

tables. In other words, records that should be related to one or more records in a different table but

aren’t. Orphaned records can be created when referential integrity is not enabled for a relationship and

records are deleted from one of the tables.

9.5.2 The Query Design View

Whenever you edit an existing query or create a new query using the Design view method, you’ll more

than likely see the Query Design view shown in Figure below. Using the Design view you can visually create and

modify the query which is being displayed. Throughout this chapter, the terms Design Grid and Design view refer

to the same window (the one shown in Figure).

The Design view is divided into two sections: the table/query pane and the field pane. The table/query

pane displays a Field List window for each of the tables and queries involved in the query. The field pane at the

bottom of the window is also known as the QBE Design Grid. This is where you define the fields returned by the

query, set the sort order, and specify any criteria.
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Figure 4: The Query Design Grid.

9.5.3 Steps in Creating a Query

To follow along, open the Northwind Traders sample database.

There are four major steps to creating a query:

1. Create the basic query.

2. Specify the sort order.

3. Specify the selection criteria.

4. Decide which fields that you want to see.

Each of these steps can themselves be broken down into a series of steps or actions that you must

performed.

9.5.3.1 Creating a Basic Query

To create a new query, follow these steps:

1. Open the database to which you want to add the query. Activate the Database window and click on

the Queries section. The Queries list will be displayed in the Database window.

2. Double-click the Create query in Design view entry in this list, or click the New button at the top of the
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Database window, select Design view in the New Query dialog that appears, and click the OK

button. Either way, the Query Design Grid window and the Show Table dialog box, will appear.

Figure 5: The Query Design Grid window and Show Table dialog for a new query.

3. Add the tables or queries on which this new query is to be based by clicking the table or query name

and then clicking the Add button. Alternatively, you can double-click the table or query name. As an

example, double-click the Customers table. When you’ve added the appropriate tables and queries,

click the Close button. This will close the Show Table dialog and leave you staring at the Query

Design Grid with the table/query pane populated.

4. Add the fields which will be output by the query or used as criteria for selecting records to the QBE

Design Grid at the bottom of the Design View window. This is done by either dragging and dropping

the field’s name from the Field List window onto the QBE Design Grid or by double-clicking the

field’s name. For our example, add the ContactName, CompanyName, and ContactTitle fields.

Following figure shows the results of adding these fields to the grid.

5. Save the query using the Save toolbar button. To view the results of the query, click the drop-down

arrow on the View toolbar button and select Datasheet view (or use the View menu and select Datasheet

view). The datasheet window for your query will be displayed. To return to the Design Grid, use the

Design View toolbar button or menu item.
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Figure 6 : The Design View window with some query design in place.

9.5.3.2 Specifying a Sort Order

The query you just created is not much different than viewing the Customers table in Datasheet view.

There aren’t as many fields showing, of course, but otherwise the results really haven’t been worth the effort.

There is, however, more that you can do. One advantage of queries is the capability to specify a sort field (or

fields) and sort order (ascending or descending) that’s particular to the query.

To specify a sort order for a query, follow these steps:

1. With the query open in the Design Grid, find the field you want to sort by in the QBE Grid at the

bottom of the Design Grid window. Click in the Sort row. If you’re following along from the previous

section, click in the ContactName column.

2. Click the drop-down arrow to the right of the cell and select the sort order (ascending or descending)

to be used for this field. For our example, select Ascending.

3. Repeat step two for any other fields which should also be used as sort fields. The order from left to

right that the fields appear in the QBE Grid determines which are used first in the sorting. For example,

if you set ascending sort order for both the ContactName and CompanyName fields, the sorting

would be done by ContactName first and then by CompanyName. This means that if two Customer

records have a contact named John Smith, the two rows will appear one after the other with the value

of the CompanyName field determining which appears first. If you’re following along, set the

CompanyName field to be sorted ascending as well. Following figure shows how the Design View

window should look.
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Figure 7: The Design View window with a sort order specified for the query.

4. Save the query’s design by clicking the Save button. Go to the Datasheet view to see the results.

9.5.3.3 Specifying Criteria

Now you can select some fields and sort them in a specific way, but we’re still not much better off than

viewing the table’s datasheet. However, queries also give you the capability of specifying the criteria with which to

select the records. In other words, you tell the query what data must be present in (or missing from) the records

that the query will display. This lets you work with a specific subset of data which may be more meaningful than the

entire set of data contained in a table or returned by another query.

To specify criteria for your query, follow these steps:

1. With the query open in Design view, make sure the field or fields which will be used to specify the

criteria are present in the QBE Grid at the bottom of the Design View window. If you’re following

along, add the Country field to the QBE Grid.

2. Click in the Criteria row for the field whose criteria you are specifying (in our example, the Country

field). Enter the criteria to be used when selecting records by typing an expression.

3. Save the query and switch to the Datasheet view.

9.5.3.4 Showing and Excluding Fields

Now you’ve got a query that returns only selected fields, that sorts the returned data for you, and that
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shows you the subset of data that you’re interested in working with. But if you followed along with the previous

section and saw that the query returned the customers in France only, there’s a little more tweaking to be done.

Notice that the Country field, despite the fact that it always contained the word France, was also returned

by the query. If you know the value in the field will always be France, you don’t really need to display that field, do

you? Well, Access provides a mechanism, which you can use to sort by or specify criteria on fields but not display

those fields. For the default data store, this is done using the Show row’s checkbox in the QBE Grid.

To have a field appear in the query’s output, make sure its Show checkbox is checked. To have it not

appear in the output, clear (uncheck) the Show checkbox. If you’re following along with the example, uncheck the

Show checkbox for the Country field and view the datasheet again. Your results should appear similar to the

following Figure.

Figure 8: The Datasheet View window for the sample query.

9.5.4 Using Advanced Selection Options in Queries

Access 2000 provides a wide variety of additional features that enable you to create more complex

queries.

9.5.4.1 Wildcards

The criteria we used in the example query above (=‘France’) was perfect when we knew the exact value

we were looking for from the query. But what if you don’t want to require an exact match or don’t know the exact

spelling of a value ahead of time?
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Access provides special wildcard characters which can be used in query criteria to cover such circum-

stances. These characters, listed in the following table, can be used as placeholders within the value or can specify

the beginning or ending characters of a text field.

Access 2000 Wildcards

Symbol Usage Example Matches 

* Used to match any number of 

character in a field either at the 

beginning or the end of the field.

An* Anil, Anand, Allan

? Use to match a single character in 

a field

Ro? Row, Rod

# Use to match any single number in 

a field

7#7 727, 737, 767

- Use to find a single character 

within a range of characters you 

specify

J[a-o]N Jan, Jon, Jen

9.5.4.2 Creating Queries that Accept Parameters

In our sample query we added the criteria =‘France’. This criteria is just fine if we always want to return

only the rows where the Country field has France in it. But what if we want to be able to choose which country will

be used each time we run the query? In this case, you have to turn the criteria into a parameter.

After you’ve done so, you’ll be prompted to enter a value for the country field each time you view the

query’s results, and Access will retrieve only records for that country. Now you won’t have to create a query for

each country, but instead can enter the desired country each time the query is viewed.

To turn a criteria into a parameter, simply replace the value portion of the criteria (‘France’ in our example)

with a prompt question surrounded by square brackets. For our example, change the criteria to read =[Enter the

desired country]. Then view the query in Datasheet view. When you do this, Access will prompt you with the

dialog shown in the following figure. Enter a value (no need to enter the single quotes on this dialog, Access will

supply them for you when it evaluates what you enter here) and click the OK button. The results are displayed in

the Datasheet view.

Figure 9 : The Enter Parameter Value dialog box.

9.5.4.3 Adding Calculated Fields

Another useful reason to create queries is their capability to transform data through the use of calculated

fields. You’re not restricted to having your queries return the exact data from tables or other queries. Using
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calculated fields, you can perform data manipulation on the data in your database and return more meaningful

results from the query.

For example, if you have an order entry table, you could create a query, which calculates a discount

priced based on the quantity of each item ordered. You can also use calculated fields to create a compound text

field, which concatenates the values of several fields in the table. This is useful for creating mailing labels where you

want the name and city/state/ZIP (or city/province/postal code) fields concatenated into one line.

To see how to work with calculate fields, return to the example query and follow these steps (or, open any

query in Design view mode):

1. Click in the Field row of the first empty column in the QBE Grid.

2. Enter Addr2: [City] + “, ” + [Region] + “ ” + [PostalCode]. This specifies that the calculated field

should be named Addr2 and that its value should be calculated by concatenating the values of the City,

Region, and PostalCode fields. The square brackets in the expression inform Access that what’s

within the brackets is a field name. If you have the same field name in two different tables referenced

by your query, use the format [tablename.fieldname] to indicate exactly which field you mean.

3. You can leave the Table row empty for this field. Check the Show checkbox so that the field will be

output by the query.

4. Click the View button to switch to Datasheet view. Enter an appropriate country when prompted (we

have already added a parameter to the query earlier).

Review of the Datasheet Windows

Figure 10 : A typical Datasheet window.
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Datasheet views are very similar to Excel spreadsheets. An example is shown in the above Figure.  As you

can see, data is displayed in a row and column format. Each row represents a single record in the table or query

results. Each column represents a field in the table or returned by the query. Tables, queries, and forms all have

Datasheet views available.

You can use the row and column headings for various editing functions or to sort and filter the information.

Using the + sign in the first column, you can expand the subdatasheet to show records related to the selected

record. You can also format the way the data is displayed within the datasheet, as well as print or export that data.

9.5.5 Working with Subdatasheets

A subdatasheet shows records from another table or query which are related to the row whose expander

(the plus sign) you clicked. The following figure shows the Customers table and the records from the Orders table

related to a certain customer.

Figure 11 : The Customers table with an expanded subdatasheet.

You can continue this “drilldown” process with the subdatasheet’s records, if a subdatasheet is available.

For example, following figure shows the Customers table with a subdatasheet within a subdatasheet. The first

subdatasheet shows all the orders related to the selected customer. The inner subdatasheet displays all the line

items for the selected order.

Subdatasheets don’t appear by magic. You have to define the relationships between the tables and inform

Access that you want to use the subdatasheet features. When a subdatasheet has the focus, you can perform all

the same functions available in the standard datasheet window. This includes formatting and filtering.
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Figure 12: The Customers table with two levels of subdatasheets expanded.

9.5.5.1 Formatting the Datasheet

Changing Datasheet Formatting

By changing the datasheet formatting you can change elements such as the background color and how the

cells are displayed graphically. To access these elements, use the Format, Datasheet menu item. The Datasheet

Formatting dialog appears.

On this dialog you can choose whether or not to display the horizontal and vertical gridlines, what color

and line style to use for the gridlines and the cell background, and whether to make the cells appear flat, raised, or

sunken. To change the line style for a specific type of line (such as the datasheet border, horizontal grid lines, or

vertical gridlines), select the appropriate entry in the left-hand drop-down list box of the Border and Line Styles

frame. The Sample frame of this dialog shows how the datasheet will look if you click the OK button.

Changing Datasheet Font

You can also change the font used for all text displayed in the datasheet. Use the Format, Font menu item

to access the Font dialog.

Changing Column Width and Row Height

You can also change the width of individual columns and the height of all rows in the datasheet. To resize

a column or row, move the cursor to the line in the column or row header that separates the columns and rows.
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When it’s in the proper position, the cursor will change from a pointer to a sizing cursor. For the column header,

this cursor is a vertical line with arrows pointing left and right . For the row header, this cursor is a horizontal line

with arrows pointing up and down. You can drag this cursor in the desired direction to either expand or contract

the row or column sizing.

In addition to this method, you can also double-click the mouse when the sizing cursor is active. This will

cause the row or column to be sized to fit the data currently displayed in the datasheet. Also, you can use the

Format, Column Width and Format, Row Height menu items to display dialog boxes.

To move a column to a different place in the datasheet, simply click the column header, hold the mouse

button down, and drag the column to its new location.

9.5.5.2 Printing the Datasheet

After you have your datasheet loaded with the data you’d like to print, use the File, Page Setup menu item

to set the output page’s margins, paper orientation, and paper size.

Next, use the File, Print Preview menu item to display the output in the print preview window. This gives

you a chance to see just how the printout will look and to make any adjustments if necessary. If everything is in

order, click the toolbar’s Print button and the datasheet will be output to your default printer.

To print using a dialog to choose the printer, select the print range, or set the number of copies to be

printed, use the File, Print menu item. The Print dialog box appears where you can set these properties to meet

your current needs.

9.5.5.3 Closing the Datasheet

When you’ve finished working with the datasheet, you need to close the window. Click the close button

in the upper-right corner of the window. You can also use the File, Close menu item. If you have modified any of

the formatting for the datasheet, such as the column widths, font, and so on, Access will prompt you asking

whether you want to save these format changes. If you select Yes, then the next time you open that datasheet it will

look just like it does now. If you don’t care to save the formatting changes you’ve made, select No.

& CHECK YOUR PROGRESS 9.5

1. Can I use the OR and AND selections in a filter?

2. Will sorting in Datasheet view take precedence over the design-designated sort order?

3. Can I use the greater than or less than signs for dates?

4. How can you filter for data by example in a datasheet?

5. What will the criterion >100 return?

6. You’ve set two sorts in the Design view of a query. Which field is the primary sort?

7. What does the SQL keyword ON mean?

8. Can you select by one table’s fields but show another table’s fields in a query?
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9.6 UNDERSTANDING FIELD PROPERTIES

At the bottom of the design view of a table, you see a list of the Field properties. Let’s examine some Field

properties more closely.

9.6.1 Understanding Field Size

Field size designates the number of characters that can be stored in a field. The default value for the field

is 50 characters. If this field will never need to be more than x characters, let’s reduce the size.

9.6.2 Input Mask

An input mask is composed of literal display and mask characters that specify where, what kind, and how

much data is to be entered. Notice the input mask is (000\-00\-0000). The zeroes, backslashes, and hyphens are

special Access codes. The zeroes mean “require a numeric digit at this position,” and the backslashes mean

“display the next character as a literal,” meaning that the hyphen characters will be displayed at their position, after

the backslash. The input mask is defined so that if the user only enters numeric digits, hyphens will automatically be

displayed in the appropriate positions.

9.6.3 Captions

A caption is the text displayed in the field prompt. The Caption for this field includes spaces, even though

the field name does not.

9.6.4 Understanding the Required Property

The Required property indicates whether the user is required to enter data in a field. The current setting is

No which is misleading in this case. Remember that the primary field must contain data regardless of the Required

Property setting. Normally, however, the Required property should be set to Yes for any non-primary key field in

which the user must enter data.

9.6.5 Comparing Format and Input Mask

So far, you’ve entered birthdates with two-digit years. Access assumes the century of two-digit years.

The century assumption is made at the number 29. For example, if you enter a two-digit year between 30 and 99,

Access assumes it’s a twentieth century year or 19xx. If, on the other hand, you enter a two-digit year between 00

and 29, Access assumes it’s the twenty-first century, or a year between 2000 and 2029. These assumptions have

worked well for records entered so far. Assume, however, that an employee was born in 1929. If “29” is entered

as the employee’s birth year, Access will incorrectly assume the year was meant to be 2029. Though it is possible

to change the century assumption in Access, it’s easier to simply display the date field with four digits.

9.6.6 Understanding Format

Format affects how data is displayed in a table after it has been entered by the user and saved. It does not

affect how the data is actually stored in the table. For example, the Birthdate Field format is set to Short Date,

which will automatically display the day and month with two digits and the year with four digits. Regardless of how

the data is entered in the field, the Short Date format will always display it in the correct format. If a date of “10 24
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19” is entered, the Short Date format will automatically display it is as “10/24/2019”. If a date of “August 16

1916” is entered, then the Format will display it as “08/16/1916”. Even though the display of the data has changed,

the data will always be stored in the manner in which it was entered.

9.6.7 Understanding an Input  Mask

Remember that an Input Mask restricts the user to entering data in a specified way. It determines what

kind and how data can be entered. This can be a useful tool in most cases. However, due to the century assump-

tion it can be problematic in a Date field.

For example, the Input Mask for the Birthdate field is set to 99/99/00;0, which restricts the user to

entering the day, month, and year with only two digits. If “08 16 16” is entered, Access will assume the year is

2016. When the input mask is combined with the format, the user is restricted to only entering years with two

digits, but the year will be displayed with four digits due to the Short Date format. However, if the year 1916 is

actually intended, the input mask prevents the user from being able to correct the year, even though all four digits

are displayed. The input mask must be deleted since it is set to allow only two-digit years.

9.6.8 Creating a Validation Rule

A Validation rule limits the value or data that can be entered in a field. For example, we want to indicate

that the only acceptable values in a field called Gender are M, F, or a null value so let’s create a Validation rule.

To enter a new Validation rule, type:

M or F or Is Null

You see the cursor in the Validation Text field.

Notice that when you pressed enter, Access formatted the text to read: “M” Or “F” Or Is Null.

9.6.9 Creating Validation Text

Validation text is displayed when a user enters incorrect data. Now that you’ve created a Validation rule,

it’s a good idea to define this Validation text. If you leave it blank, the user will see a generic message from Access

if a data entry error is made.

To enter Validation text, in the Validation Text field, type:

Please enter M or F in the Gender field.

Now, if the user makes a data entry error in the Gender field, the previous message will be displayed.

& CHECK YOUR PROGRESS 9.6

1. What do you mean by input mask?

2. What do you understand by Required property?

3. What is Validation rule?
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9.6 SUMMARY

You can create a query using either the Design view or a wizard. In many cases, the add fields facility of

the wizard can save you a lot of time compared to using the design grid exclusively. Although you can also create

queries using SQL natively.

This unit covered select queries that are subsets of fields, records, or both, of other queries or tables. After

you’ve included the fields you want in your query, you can add criteria to the design grid (or the SQL view) to

narrow down the selection of your query. You can add criteria for any field included in a query, even if that field

doesn’t show (or return) when the query is run. You can do all the datasheet layout manipulation in a query that you

can in a table’s datasheet. Changes in field order in the Datasheet view won’t change the Design view, but changes

in field order in the Design view will change the datasheet’s layout.

You can sort on fields in the design grid. The sorting priority is left to right. You can also filter and sort in

Datasheet view just as you can with a table’s Datasheet view.

Adding criteria to different rows in different columns creates an OR query selecting records based on

either criterion. Entering criteria on the same row for two or more columns creates an AND query requiring both

criteria to be satisfied for a record return.

Using built-in Access functions and expressions, you can construct sophisticated query selections span-

ning dates, times, or alphanumeric strings.

Besides joins, you saw how to construct a new field in a query using an expression. You can also create

new fields based on other expression fields. Finally, you saw how to construct ranges in queries and combine them

with other criteria, which can be optionally ranged, too.

9.7 GLOSSARY

Criteria - A set of limiting conditions used in creating a query or filter to locate a specific subset of

records.

Destination - A document or program receiving information that was originally generated in another

program or document.

Expression - A formula that calculates a value. You can use expressions in forms, reports, tables, queries,

macros and modules.

Filter - A set of criteria you can apply to data to show specific tasks, records or resources.

Import - Copying data from another application into Access.

Join - A link between tables that is identified by an association between a field in one table and a field of

the same data type in another table.

Link - A logical relationship between two or more tables, often based on corresponding or related fields

in each of the tables.

Macro - A set of actions used to automate a task.

Many-to-many relationship - A relationship between two tables in which one record in either table can

have many matching records in the other table.

Module - A collection of statements and procedures stored together as a single named unit.

Object - A table, chart, graphic, equation, or other form of information you create and edit. An object can be

One-to-Many Relationship - Records in one table have one or more related records in a second table,

but each record in the second table is related to only one record in the first table.

One-to-One Relationship - One, and only one, record in a table relates to one, and only one, record in

a second table.

Primary Key - A field, or fields, used to uniquely identify a field.

Query - Asking Access a question about records in a table of group of tables. The result of a query is a dynaset.
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Referential Integrity - Rules employed in a relational-database schemes that are used to preserve the

relationships between tables when you add or delete records.

9.8 FURTHER READINGS

The following books are suggested for further readings :

Sams Teach Yourself Microsoft Access 2000 in 24 Hours by Timm Buchanan; Craig Eddy

Sams, Macmillan Computer Publishing Sams Teach Yourself  Microsoft Access 2000 in 21 Days

by Paul Cassel, Macmillan Computer Publishing

9.9 ANSWERS TO THE SELF-LEARNING EXERCISES

Answers to Check Your Progress  9.1

(a) F1 (b) Index Tab

Answers to Check  Your Progress  9.2

(a) Fields (b) Primary Key, Foreign key, Composite key

(c) Referential integrity (d) One-to-many

Answers to Check  Your Progress  9.3 and  9.4

(a) True (b) False (c) True (d) True

Answers to Check Your Progress  9.5

1. Yes. Entering two field criteria in a filter by form will create an AND query. Using the OR keyword in

a field will create an OR criterion.

2. Yes, it will. The last sort order holds reign.

3. Yes. >#12/31/99# will return records in which the date is at least the year 2000.

4. Click the filter by form button on the toolbar when in datasheet view.

5. Records where the criterion field is greater than 100.

6. The one leftmost in design view.

7. Specifies the fields to link two or more database objects.

8. Yes. Uncheck the show box for the fields you don’t wish to display.

Answers  to Check Your Progress  9.6

1. An input mask is composed of literal display and mask characters that specify where, what kind, and

how much data is to be entered.

2. The Required property indicates whether the user is required to enter data in a field.

3. A Validation rule limits the value or data that can be entered in a field.

9.10 UNIT-END QUESTIONS

1. How does Access store date and time information?

2. Must you use only built-in Access functions in queries?

3. What are Indexes? How they can help?

4. What are the various field properties? Explain.

����
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Unit X : Data Base System Architecture

Structure  of  the  Unit

10.0 Objectives

10.1 Introduction

10.2 Traditional File Oriented Approach

10.3 Basic Concepts

10.3.1 What are Databases?

10.3.2 Types of databases based on processing:

10.3.3 Types of databases based on organization requirement:

10.3.4 Components of Database System

10.3.5 Advantages of the Database Approach

10.3.6 Limitations of the Databases

10.4 Database System Architecture

10.4.1 Abstraction

10.4.2 System Architecture

10.4.3 Data Independence

10.5 Database Performance Issues

10.5.1 Physical database design

10.5.2 Sequential Access File Organization

10.5.3 Direct (or Random) Access File Organization

10.6 Tuning the database for performance.

10.7 Summary

10.8 Glossary

10.9 Further Readings

10.10 Answers to the self learning exercises

10.11 Unit-end questions
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10.0 OBJECTIVES

After going through this unit student will be able to :

F Understand the databases and database management system

F Identify the drawbacks in file based systems

F Identify the components and properties of DBMS.

10.1 INTRODUCTION

A database system is basically a computer based record keeping system. The collection of data, usually

referred to as the database, contains information about one particular organization. It maintains any information

that may be necessary for the decision-making process for the management. The intention of a database is that the

same collection of data should serve as many applications as possible. A database is often conceived of as the

repository of information needed for running certain functions in an organization. Such a database would permit

not only the retrieval of data but also the continuous modification of data needed for control of operations. The

database management system is the major software component of a database system. Some commercially and

popular databases are ORACLE, INGRES etc. The role of the DBMS as an intermediary between the users and

the database is very much like the function of a salesman in a consumer's system. The database user needs to

know only what data he or she requires, the DBMS will take care of retrieving it.

10.2 TRADITIONAL FILE ORIENTED APPROACH

The traditional file-oriented approach to information processing has for each application a separate

master file and set of transaction files used in the old applications like payroll, inventory, production planning and

control with the COBOL programming language. An organization needs to share information between different

departments and users. It is not easily possible in the traditional approach. The major drawback of such a file

based approach is that the programs become dependent on the files and the files become dependent on the

programs.

The file oriented approach to information processing has the following disadvantages:-

F Data Redundancy - The same piece of information may be stored in two or more files repeatedly

(Duplication of data) like student's name, address etc. Some of this information may be changing. It is

therefore possible that while the address in the master file for one application has been updated and in

the other file may have not been. It may not be easy to find out the redundancy in different files. The

solution for this problem is that to avoid data redundancy and multiple copies of the data.

F Lack of Flexibility - Due to the strong association between the program and data, most of the

information retrieval possibilities would be limited to well-anticipated and pre-determined requests for

data. The system would normally be capable of producing scheduled information and reports. In the

today's fast changing business environment, there is a need for responding to un-anticipated queries or

data.

F Program-Data dependency - If a data field is to be added to a master file, all such programs that

access the master file would have to be changed to allow for the new field added to the file.
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F Data availability - Due to non-uniformity in file design, similar data may be stored in different files

with different identification thus obtaining data is usually difficult.

F Limited Data Sharing - With the traditional file processing approach, each application has its own

private files and users have little opportunity to share data outside their own applications. In addition,

a major management effort may also be required since different organizational units may own these

different files.

F Data Integrity - Integrity means accuracy and completeness of the data is not maintained because

there is no control over their use and maintenance by authorized user and same data is found in

different files. Therefore, there is a possibility that data in one file is correct and in another file is wrong.

F Lengthy Development Times - With traditional file processing systems, there is little opportunity to

leverage previous development efforts. Each new application requires that the developer essentially

start from scratch by designing new file formats and descriptions, and then writing the file access logic

for each new program. The lengthy development times required are often inconsistent with today's

fast-paced business environment, in which time to market (or time to production for an information

system) is a key business success factor.

F Excessive Program Maintenance - The preceding factors all combine to create a heavy program

maintenance load in organizations that rely on traditional file processing system. In fact, as much as 80

percent of the total information systems development budget may be devoted to program mainte-

nance in such organizations. This of course leaves little opportunity for developing new applications.

Therefore, these disadvantages of file based system encourages a database approach.

& CHECK YOUR PROGRESS 10.2

1. Data redundancy means __________.

2. Traditional file system is not suitable for ________.

10.3 BASIC CONCEPTS

10.3.1 What are Databases?

Computer system organizes the data in a hierarchy that begins with bits, bytes, fields, records, files and

databases.

D a ta b as e

F i le s

R e co rd s
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Database is a collection of related data means which have implicit meaning. In other words, a database is

logically coherent collection of data with some inherent meaning to facilitate rapid updating of individual records,

concurrent updating of related records, easy access to all records by all application programs, generating routine

or special purpose reports.

A database system is basically a computerized record keeping system whose overall purpose is to store

information and to allow users to retrieve and update that information on demand.

10.3.2 Types of databases based on processing:

The databases can be managed dynamically and can be processed on-line. The database processing is of

two types:-

(i) Analytical Databases - On Line Analytical Processing (OLAP) are basically static, read only

databases. In this archived and historical data is stored and used for analysis.

(ii) Operational Databases - On Line Transaction Processing (OLTP) are used to manage more

dynamic data. These types of databases allow the user to modify the data. These types of databases

are used to retrieve realtime information.

10.3.3 Types of databases based on organization requirement:

The databases have been developed in various organizations to meet particular need. The growth of

distributed processing data warehousing, data mining, end user computing, DSS(decision support system) also

known as EIS(executive information system) have caused the development of several types of databases. The

different types of databases found in computers using organizations are the following:-

(i) Management Databases – These databases can respond to dynamic requests for information

which require quick answering. These databases store selective data extracted from operational

database. In management databases, request for data is spontaneous and not preprogrammed.

The basic objective of management database is to support planning and urgent information needs.

(ii) Operational databases – These databases stores detailed data with anticipated processing

requirements programmed in conventional computer languages. The basic objective is to support

routine operations.

(iii) Distributed Databases (DDB) – These databases are defined as a collection of multiple

logically interrelated databases distributed over a computer network. These databases may be

located in a same building or geographically distributed over large distances. They have the ability

to access remote sites and transmit queries maintaining integrity of overall database.

(iv) End User Database – End users are the people whose job require access to the database for

querying, updating and generating reports. End user database may contain documents generated

by MSWORD or data files generated from spreadsheet package or DBMS package.

(v) Text Databases – These databases support storage, search and retrieval for text objects. Text

databases are outcome of the advancement in use of computers in creating and storing the

documents electronically.

(vi) Image Databases – These databases can store images in a variety of formats such as TIFF,

JPEG, GIF commonly used images and video sequences in the databases. These are used in

business for document image processing.
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10.3.4 Components of Database System:

The database system comprises of four components:

(a) Database Files: The database systems are designed and developed around centralized, integrated

shared files that emphasize the independence of program and data. These files have data elements

stored in database file organization formats. The different database systems have different ways of

representing data physically on disk. These physical is usually hidden from the end user. The way data

files stored at physical level are managed by DBMS facilitate faster access and economically save the

storage area.

(b) Hardware: Four hardware components are basically required:

(i) For support of execution of the database system i.e. hardware processor and associated main

memory

(ii) For Storage, secondary storage devices such as Magnetic discs etc.

(iii) For end users on-line terminals are required for accessing and updating database files.

(iv) Hardware component required is the output system, or report generator. It allows user or

programmer to design output without writing an application program in a programming language.

(c) Software: In order to handle all requests made to database by user are facilitated by software known

as Data Base Management System. DBMS allows the user to access the files, update, insert, delete

and retrieve records as per request. DBMS ensures data security, integrity because database is

accessed by many users. The other software that play a vital role and are sub modules of DBMS are:

(i) A host language Interface system – This is one of the module of DBMS that communicates

with application programs. Its basic functions are, To interpret instructions of application program

written in HLL and To retrieve requested data from the database files.

(ii) The application Program - These programs are independent of the data files in a database

environment, In order to perform query, it uses standard data definitions.

(iii) A natural language interface system - The English like simple easy to understand and write,

command oriented language SQL(Structured Query Language) is used to retrieve and perform

online update on to the database by the user.

(iv) Data Dictionary - It is often seen that when a program becomes somewhat large in size, keeping

a track of all the variable names that are used in the program and the purpose for which they were

used becomes extremely difficult. Data dictionary holds the detailed information about different

structures and data types, details of logical structures, details of relationship between data items

and details of user privileges and access rights. An ideal data dictionary should include everything

a DBA (Database Administrator) wants to know about the database.

(d) User: Users can be categorized on the basis of their level of interaction and association with the data

bases, these are:

(i) Application Programmers: responsible for writing database application programs in some

programming language. Such programs access the database by issuing the appropriate request

typically an SQL statement - to the DBMS.

(ii) End Users: who interact with the system from online workstations or terminals. A given end user
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can access the database via one of the online applications mentioned in the previous paragraph, or

he or she can use an interface provided as an integral part of the database system software.

(iii)Database Administrator: person who understands the data, and the needs of the enterprise

with respect to that data, at a senior management level.

10.3.5 Advantages of the Database Approach

The database approach offers a number of potential advantages compared to traditional file processing

systems.

(i) Program Data Independence– The separation of data description (metadata) from the

application programs that use the data is called data independence. With the database approach,

data descriptions are stored in a central location called the repository. This property of database

systems allows an organization's data to change and evolve (within limits) without changing the

application programs that process the data.

(ii) Minimal Data Redundancy– The design goal with the database approach is that previously

separate (and redundant) data files are integrated into a single, logical structure. Each primary fact

is recorded in only one place in the database. At other times it may be desirable to include some

limited redundancy to improve database performance.

(iii) Improved Data Consistency– By eliminating (or controlling) data redundancy, we greatly

reduce the opportunities for inconsistency. For example, if a customer address is stored only

once, we cannot have disagreement on the stored value. Also, updating data values is greatly

simplified when each value is stored in one place only. Finally, we avoid the wasted storage space

that results from redundant data storage.

(iv) Improved Data Sharing – A database is designed as a shared corporate resource. Authorized

users are granted permission to use the database, and each user (or group of users) is provided

one or more user views to facilitate this use.

(v) Standards can be enforced – In a centralized database environment, industry, state, country

standards can be enforced more easily than in an environment where each group of user controls

his own files and software.

(vi) Flexible – DBMS allows changes to the structure if required, of the database affecting the stored

data and existing application.

(vii) Development time of an application may be reduced – Designing and implementing a new

database may take more time but once the database is set up, then developing any new application

using DBMS requires 1/6th time of the traditional file processing system.

(viii) Reduces overall cost – The DBMS approach reduces the wasteful overlap of activity of data

processing personnel in different departments. This reduces the overall cost of operation and

management as well.

(ix) Unauthorized access may be restricted – Database are used when multiple users share the

database. Only authorized user is permitted to make changes in the existing database. The DBMS

provides a security and authorization system for each class of user.

(x) Provide multiple user interface and support 4GL(or non procedural language) for

manipulation of data - DBMS provides a variety of user interfaces. The most common is
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graphical user interface. In addition to this users do not have to learn programming techniques to

access the database.

(xi) Database can maintain integrity – A DBMS generally possess the capability for defining and

enforcing the constraints (restrictions) that must hold for the data that results to the correctness

and accuracy of data.

(xii) Provision of backup and recovery system – If there is any failure of hardware or software,

then DBMS provides the facility of recovery by maintaining its regular backup. It also ensures that

program may be resumed from the point at which it was interrupted.

10.3.6 Limitations of the Databases

There are certain limitations of using DBMS, They are -

(i) Security Problem– Sharing of data also carries the risk of the data being accessed by unauthorized

user. The DBA must cope up this problem by taking security measures, concurrency control,

recovery and integrity.

(ii) Problem of Resources– To answer online queries, it requires large amount of data to be stored.

As a result more terminals may be needed to put managers and other users on-line. Communication

devices are also required to connect to the database. It may require more resources such as

multiprocessor system, software, storage devices etc.

(iii) Concurrency problem– Several problems can occur when concurrent transactions execute in

an uncontrolled manner. There may be lost update problem when two transactions that access the

same database items.

(iv) Overhead Cost – For large amount of data, database requires a powerful hardware platform

and software for database management, which are quite expensive. More cost is added for skilled

personnel such as system analyst, database designers, database administrators, programmers etc.

& CHECK YOUR PROGRESS 10.3

1. The database processing is of __________ and ___________ types.

2. _________ can take the total control on the database.

3. _________ holds the detailed information about different structures and data types, details of logical

structures, details of relationship between data items and details of user privileges and access rights.

10.4 DATABASE SYSTEM ARCHITECTURE

10.4.1 Abstraction

Database Abstraction means to provide users only that much information that is required by them. This

means that the system does not disclose all the details of data, rather it hides certain details like how the data is

stored and maintained.

10.4.2 System  Architecture

The database system architecture possesses three level architecture, these are -

Internal (Physical) Level: The lowest level of abstraction describes how the data are actually stored. It describes

how the data are actually stored on the storage medium.
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Conceptual (Logical) Level: The next-higher level of abstraction describes what data are stored in the

database, and what relationships exist among those data. The logical level thus describes the entire database in

terms of a small number of relatively simple structures. The users of this level are not concerned with how these

logical data structures will be implemented at the physical level, they are just concerned about what information is

to be kept in the database.

External (View) Level: The highest level of abstraction describes only part of the entire database. Even

though the logical level uses simpler structures, complexity remains because of the variety of information stored in

a large database. Many users of the database system do not need all this information; instead, they need to access

only a part of the database. The view level of abstraction exists to simplify their interaction with the system. The

system may provide many views for the same database.

10.4.3 Data Independence

Database may be viewed through three levels of abstraction, any change at a level may affect other levels.

The ability to modify a scheme definition in one level without affecting a scheme definition in the next higher level is

called data independence.

There are two levels of data independence:–

(i) Physical data independence – It refers to the ability to modify the scheme followed at the physical

level without affecting the scheme followed at the conceptual level i.e. the application programs

remain the same even though the scheme at physical level gets modified.

(ii) Logical data independence – It refers to the ability to modify the conceptual scheme without

causing any changes in the schemes followed at view levels. It also ensures that the application

program remains the same.

It is more difficult to achieve logical data independence than the physical data independence. The

reason being that the application programs are heavily dependent on the logical structure of the

database.

User 1 User 2 …………. User NExternal 

Level

Conceptual Level

Physical Level
Internal 

Level

Logical 

Level
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& CHECK YOUR PROGRESS 10.4

1. __________means to provide users only that much information that is required by them.

2. The lowest level of abstraction is __________.

3. The ability to modify the conceptual scheme without causing any changes in the schemes followed at

view levels is __________.

10.5 DATABASE PERFORMANCE ISSUES

The database performance is critical because the speed of processing time is important. The speed of

processing is greatly determined by the storage structure of the database and the access technique.

10.5.1 Physical database design

Physical database design is the process of choosing specific storage structure and access paths for the

database files to achieve good performance for variety of database applications. Choosing file organization and

access paths usually depends on the different DBMSs of the companies. These includes indexing, clustering of

records of files on a storage device. The following criterion may be used while designing physical database:-

(i) Response Time:- The response time is measured by the time between submitting a database

transaction and the response received.

(ii) Storage Space:- The amount of storage space used by the database files and their access paths and

indexes structure on the disk.

(iii) Transaction throughput:- The average number of transactions which can be processed per minute,

when system is in peak load condition.

The performance of the database also depends on record size and number of records in a file and the

primary and secondary key values that determine records in a file and key values that determine the access path.

The growth of the file and data must be calculated in advance. The database performance can be improved by the

following ways:–

(i) Choosing data types:– Data is usually in the form of records. Each record consists of a collection of

related data values. Each value is a collection of one or more bytes i.e. field of the record. A field may

be simple or composite. The emphasis must be given on to specify the data type which specifies the

type of value a field can take. While selecting the data type consider the following:-

(a) Which represents maximum possible values

(b) Which minimizes the storage space

(c) Which maintains the data integrity

(d) Which supports all data manipulations as proposed by DBMS

(ii) Coding and compression techniques:– The storage space occupied by database is very large. It

may happen that data fields are placed at distance, which yields slow data processing rate. To

improve data processing performance the following techniques can be applied:-

(a) Zip file routines may be applied to compress the whole of the file that minimizes the space

utilization.

(b) A field that can contain limited number of possible values, they can be converted into a code that

consumes less space.
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(iii) Data Volume and usage analysis: - The database designer must consider the following before the

designing of the physical database design:–

(a) Expected size of the organization

(b) Intended use of database

(c) Expected rate of queries

These factors are determined during system analysis and design phase. The access frequencies can be

estimated from the transaction volume and timing of events, reporting and querying the transactions.

(iv) Optimization of SQL:– The optimization of SQL commands can improve the database perfor-

mance. The SQL statement SELECT…FROM…WHERE.. must consider ORDER BY and

GROUP BY clauses to improve the speed and efficiency of the command.

(v) Access Method and File Organization:– File has been defined as a collection of related information

that may be payroll file, accounts file etc. Data files used in business can be classified into the following

categories:-

(a) Master Files– These files contains relatively permanent information which is used as a source of

reference and is updated periodically.

(b) Transaction Files– These files are created from source documents. These are used for recording

events or transaction pertaining to the master file. These are also used to update master files.

(c) Reference Files– These files contains keys that have records in other files because in order to

retrieve a record from a file, referenced file is searched first to find the address of the record.

(d) Table Files– These files contains data in tabular form.

(e) Report Files– These files are concise, meaningful and are generated from other data files for

presenting reports online or on paper for the users and management.

(f) Historical Files– These files contains the information about the past. They usually contain

statistical data for analysis purposes.

(g) Backup Files– These files are the copy of master files kept as a measure of security, and can be

used for recovery in case of disaster.

File management refers to logically organization of data into fields so that it is best understood by the

users.

File Processing refers to an environment in which data are physically organized into files.

File organization refers to the organization of the data of a file into records, blocks and access structure.

Access Methods are group of operations that can be applied to a file.  There are two types of access

methods that are sequential access methods and direct access methods.

10.5.2 Sequential Access File Organization

In this file organization, the physical ordering of the records in a file on a storage device based on the

values of one of their fields known as ordering field or primary key field. To locate a particular record, the

sequential access method used in the program scans the file from the beginning till the desired record is located.

The advantages of this organization are:–

(a) The designs of these files are simple and records are organized in a simple and contiguous fashion.

(b) These organizations are best to update master files when number of transactions or file activity ratio is

high and transactions are batched.

(c) Easy to maintain backup
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(d) This type of file organization is efficient, economical and less prone to errors.

The limitations of using this organization are:-

(a) This is costly and time consuming if file activity ratio is low.

(b) The response for locating information for a particular value is very low, thus online enquiry cannot be

accomplished.

(c)  To update master file, the transactions have to be batched and whole master file has to be read even

if few records are to be updated.

10.5.3 Direct (or Random) Access File Organization

In this file organization, records are placed in a manner that a desired record is found directly without

searching sequentially. As records are stored in random order, records are also retrieved in any sequence irre-

spective of their physical order on the storage medium. This is directly performed by the CPU to access the

desired record using randomizing procedure without searching all other records in the file. This is known as direct

(self) addressing. This organization is useful for online inquiry system where immediate response is required.

The advantages of this organization are:-

(a) Records can be accessed both randomly and sequentially.

(b) Records need not be sorted it may be in any random order.

(c) Transactions need not be batched as any single transaction is processed as it is entered.

(d) It is useful in interactive realtime online processing environment such as banks, railway/air reservation etc.

The limitations of using this organization are:–

(a) Storage space is not efficiently used because location of the stored records is randomly arranged.

(b) It involves extra computation work to locate the address of the records.

(c) It uses relatively expensive media such as magnetic disk.

The most commonly used direct access techniques are:–

(i) Direct Sequential Access

(ii) Random Access

(i) Direct Sequential Access– This access method uses the following methods:–

(a) Self direct addressing method – It refers to addressing the record by its record key. It is easy to

compute the record's address from the record key and physical address of the first record in the file.

This method assists in computing the bucket address of the fixed length record, where keys are

arranged in a consecutive number.

For example, if 10,000 records of university students need to be stored in the magnetic disk pack of 6

disks, cylinder-wise, let the first cylinder carry first 500 records, the second cylinder carries the next 500 records

and so on. During retrieval of these records, read/write heads move cylinder by cylinder in which records have

been sequentially arranged. Now if ten faces of the first cylinder carry the first 500 records in the following

manner:–

Cylinder 1,1 1     to 50

Cylinder 1,2 51   to 100…

Cylinder 1,10 451 to 500

In order to have direct access in such file organization, we can show it in the following way:-
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The total number of buckets = 1000,

Number of records per bucket = 10

We assume, the bucket address range from 101 to 1100

The keys of the records range from 1 to 10,000

To find the record key 9897 i.e. in which bucket it is stored, follow the steps given below:–

1. Divide the record key(to be searched)/No. of records per 9897/10 = 989 and a remainder 7 bucket.

2. Add first bucket number to the quotient of the record key 101+989=1090

3. The remainder (7) is the record's position within the bucket and remainder 0 indicates last record in

the preceding bucket.

Advantages of Self-Addressing:-

1. A random enquiry can be made because it is easy to locate the position of a record,

2. It does not require index.

Disadvantages of Self-Addressing:-

1. The records must be of fixed length.

2. This method is impractical because gaps in key values would lead to empty buckets.

3. If some records are deleted their storage space remains empty. This results in wastage of storage

space.

(b) Index sequential addressing method – In this organization, the records are stored either in

sequential or non-sequential manner. In business data processing system, a common file organization is used in an

ordered file with multilevel primary index on its ordering key field, such an organization is called indexed sequential

file. These files have indexed sequential access methods (ISAM).

In indexed file organization, an index is created. To locate a record, the cylinder index is searched to find

the cylinder address. Then for that cylinder, track index is searched to find the track address of the desired record.

Each index entry matches a key value of the record and points to unique record. An index table usually contains

the key value (unique) and address of that record (track number, cylinder number, surface numbers). The access-

ing is faster because no sorting and additional block access is required.

Advantages of using Index Sequential access file organization are:–

1. It includes the features of sequential and direct organization. Direct access is achieved by means of

generating index.

2. If file activity ratio is high, then this file organization is efficient and economical.

3. It can be used in any kind of application.

Limitations of using Index Sequential access file organization are:–

1. It increases the processing time as reading of indexes is required prior to accessing the record.

2. It requires extra storage as record insertion causes overflow condition.

3. It requires more time because indexes are searched prior to record access.
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& CHECK YOUR PROGRESS 10.5

1. Time between submitting a database transaction and the response received is called ______________.

2. Files contains relatively permanent information are called ______________.

3. ISAM stands for _____________.

4. The average number of transactions which can be processed per minute is called __________.

10.6 TUNING THE DATABASE FOR PERFORMANCE.

After the logical and physical design of the database, then the database can be loaded with data. The

database transactions must be implemented by applications program according to the conceptual specification of

transactions and then writing and testing of program code can be performed. Most systems include a monitoring

utility program to collect performance statistics which are kept in the data dictionary or in system catalogue for

later analysis. Thus, it is always necessary to modify the design on the basis of its observed performance after the

database is implemented. This activity is known as database tuning. The objectives of tuning are:-

(a) To minimize the response time of queries.

(b) To make application run faster.

(c) To improve the overall performance of the transaction.

If a given physical database design does not meet the expected objectives, then database designer reverts

to logical database design and makes the adjustment to the logical schema with a view to remap it to a new set of

physical tables and indexes. If the processing requirements are constantly changing, then changes must follow in

logical and physical design. When trying to maintain a well tuned database, the following areas should be

considered which relates to transactions, concurrency control and recovery:-

(a) DBMS Installation (b) Input/Output Contention

(c) Use of Memory (d) Use of CPU

(e) Application tuning

10.7 SUMMARY

The collection of data, usually referred to as the database, contains information about one particular

organization. The database management system is the major software component of a database system. A

database system is an integrated collection of related files along with the details about their definition, interpretation,

manipulation and maintenance. The primary goal of a DBMS is to provide an environment which is both convenient

and efficient to use in retrieving information from and storing information into the database.

The database administration defines and maintains the three levels of the database as well as the mapping

between levels to insulate the higher levels from changes that take place in the lower levels. The DBA is responsible

for implementing measures for ensuring the security, integrity and recovery of the database.

The speed of processing is greatly determined by the storage structure of the database and the access

technique. Choosing file organization and access paths usually depends on the different DBMSs of the companies.

These includes indexing, clustering of records of files on a storage device



202

 Data Base System Architecture                        Unit-X

10.8 GLOSSARY

F Block A block normally consists of several records usually of fixed word length so as to make read/

write operations simpler.

F Blocking Factor– The number of records in a block is called as the Blocking Factor.

F Cluster– A grouping of sectors on disk that function as a single unit.

F Data– A collection of facts in raw form that become information after proper organization or

processing.

F DBMS–A set of programs provided to facilitate the users in organizing, creating, deleting and

manipulating their data in a database.

F Data Dependence– Dependency of data on the application.

F Data Dictionary A document  that  maintains  the data  definitions of a  database.  It  is

automatically created/updated by the DDL  as  the database scheme is defined or changed.

F Data IntegrityConsistency of data in all files.

F Data Redundancy Repetition of the same data items in more than one file.

F Database One  who is  responsible  for  defining,  updating   and  controlling

F Administrator  access to a database.

F Sector The smallest unit with which any disk can work. Disk drives are designed to access only

whole sectors at a time.
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4. An introduction to Database Systems, Bipin C. Desai, Galgotia publications

10.10  ANSWERS TO THE SELF LEARNING EXERCISES

Answers to check Your Progress 10.2

1. Duplication of data 2. On line information system

Answers to Check Your Progress 10.3

1. Analytical and Operational 2. Database Administrator 3. Data Dictionary.

Answers to Check Your Progress 10.4

1. Abstraction 2. Physical 3. Logical data independence.

Answers to Check Your Progress 10.5

1. Response time. 2. Master Files 3. Indexed Sequential Accessing Methods

4. Throughput

10.11 UNIT-END QUESTIONS

1. What are the components of database system? Explain each of them briefly.

2. Explain the differences between a file-oriented system and a database oriented system.

3. Explain three level architecture of database system.

4. Explain the various ways by which database performance can be improved.

5. What are the important decisions which influence the physical design of a database?

����
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11.0 OBJECTIVES

After going through this unit student will be able to :

F Identify the structures in the different models of DBMS

F Identify the meaning of normalization and different forms

F Identify the essential features of relational model.

F Able to draw E-R diagrams

11.1 INTRODUCTION

A model is an abstraction process that hides superfluous details while highlighting details related to the

applications at hand. A data model is a mechanism that provides this abstraction for database applications. The

models can also enforce a set of constraints to maintain the integrity of the data. In modeling, we represent an

entity set in the database by a set of its properties. The association between the properties is explicitly captured.

A better design of the database can be achieved by normalization. Different forms of normalization exist which

leads to better approach in terms of data retrieval and storage.

11.2 DATABASE MODELS

Databases can be differentiated according to function and also according to how they model the data.

Data models are abstraction, usually mathematical algorithms and concepts. The evolution of databases is due to

the analysis and design of data models. The advancement in data models has led to the database efficiency.

A database model is a collection of logical constructs used to represent the data structure and the data

relationships found within the database. In other words, Database model is basically a description of container for

data and methodology for storing and retrieving data from that container.

Database models can be grouped into categories: conceptual models and implementation models.

The conceptual model focuses on the logical nature of the data representation. Therefore, the conceptual model is

concerned with what is represented in the database rather than how it is represented. Conceptual models include

the Entity Relationship model and the Object-Oriented Model.

Conceptual models use three types of relationships to describe associations among data. These three

relationship types are:

1. One-to-one: Suppose that a company owns three computers and that each computer is operated by

a single employee. In this case, a one-to-one relationship exists because each computer is assigned to

only one employee, and each employee is assigned to only one computer.

2. One-to-many: A painter might create many different paintings, but each painting is created by only

one painter.

3. Many-to-Many: An employee might have many job skills and each job skill might be learned by

many employees. Similarly, a student can take many courses, and each course can be taken by many

students.
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In contrast to the conceptual model, an implementation model places the emphasis on how the data are

represented in the database or on how the data structure are implemented to represent what is modeled. Imple-

mentation models include the hierarchical database model, the network database model and the relational data-

base model.

The databases can be modeled in three ways these are:

F Hierarchical

F Network

F Relational

Before 1980s the common database models were hierarchical and network systems and new model

range is relational database models.

11.2.1 The Hierarchical Database Model

As the name implies, the hierarchical database model defines hierarchically arranged data. It represents

one-to-many(1:M) relationship. It can be visualized as parent-child relationship. A parent data element can have

one or more child data element. It can also be represented as inverted tree structure having root at the top and

branches below. The following figure shows typical database occurrence of a hierarchical structure:-

University

College-1 College-2 …… ..

Dept.-1 D ept.-2 Dept.-3 Dept.-1 D ept.-2 …… .

 Thus hierarchical schema defines the tree structure. Every node except the root has exactly one parent

node and a node can have several child nodes and they may be ordered from left to right. Parents and children

links are called pointers. It is not a popular technique because it does not support flexible data access.

Accessing of  Data Records

A

B C D

E F G H I J

A tree is a collection of nodes. One node is designated as root node and the remaining nodes form trees

or sub trees. An ordered tree is a tree in which the relative order of the sub trees is significant. This relative order
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not only signifies the vertical placement or level of the sub trees but also the left to right ordering. The following

figure shows an ordered tree:

The path traces all segments from the root, starting at the leftmost segment. This "left-list" path is known as

the preorder traversal or the hierarchic sequence. The preorder processing of the ordered tree will process the

nodes in the sequence A,B,E,F,C,G,D,H,I,J.

Advantages

i. Because all data are held in a common database, data-sharing becomes practical, and security is

provided and enforced by the DBMS.

ii. The DBMS creates an environment in which data independence can be maintained, thereby

substantially  decreasing programming  effort and program maintenance.

iii. Given the parent/child relationship, there is always a link between the parent segment  and  its  child

segment(s).  Because  the  child segment  is  always  automatically  referenced  to  its  parent,  the

hierarchical model promotes a condition known as database integrity.

iv. The hierarchical model is very efficient when a database contains  a large volume of data in 1:M

relationships and when require large number of transactions, using  data whose relationship are fixed

over time.

Disadvantages

i. Any changes in the database structure, such as  the  relocation  of  segments, still  require changes in

all applications  programs t hat access the  database. Therefore,  the implementation of a database

design can become very complicated.

ii. A  common  many-to-many (M:N)  relationship  is  difficult  to  implement  in  a hierarchical model.

iii. A common two-parent condition cannot be implemented.

iv. A hierarchical database is complex to manage and lack flexible. A deletion of one  segment that leads

to the involuntary deletion of all the segments under it. Such an  error could be extremely costly.

v. Modifications in the database  structure  can  lead  to problems  with applications programs that were

operating correctly before the changes were made; the benefit of data independence are thus limited

by structural dependence.

vi. Moving from one hierarchical DBMS to another is difficult; that is, portability was limited.

vii. Perhaps the most serious criticism of the hierarchical model is that its use requires extensive program-

ming activities. In fact, the hierarchical database has been called  "a system created by programmers

for programmers".

11.2.2 The Network Database Model

A Network data model can be defined as an extension of the hierarchical model. It represents many to

many relationship (M:N). In this technique, a child data element can have more than one parent or no parent at all.

When database is initially designed, the relationship among the data elements must be determined.
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The basic data structures in the network model are records and sets. Records are classified into record

types. Each record type specifies the structure of group of records that store the same kind of information. It uses

a set theory to provide a tree like hierarchy and represents relationship between records using the construct called

set type. A set type basically describes 1:N relationship between two record types. Each set type is accomplished

by its name, an owner record type and a member record type.

The network data modeling supports a flexible data access, because the desired data element fetching is

not required to route from root data element. It forms a complex structure and therefore network databases are

not used quite often.

PGDCA B.Sc. B.Pharma

Rajeev Aman Vijay

St-1 St-2 St-3 St-4 St-5

Course

Instructor

s

Students

Advantages

i. Conceptual simplicity. Like the hierarchical database model, the conceptual view of the database is

simple, thus promoting design simplicity.

ii. Handles more relationship types. The M:N relationships are easier to implement.

iii. Data access flexibility. An application can  access  an  owner  record  and  all the  member records

within a set.  Therefore,  if a  member  record  has  two or  more owners, you can move directly from

one owner to another.

iv. Promotes database integrity. The  network  database  model  enforces  database  integrity

because the user first must define the owner record and then the member.

v. Data independence. This model achieves sufficient data independence to at least partially isolate

the  programs  from complex physical storage details. Therefore, changes i n  the data  characteristics

do  not require  changes  in  the  applications programs.

Disadvantages

i. Network databases are difficult to design and use properly. The user must be very familiar with the

database structure to take advantage of the system's efficiency.

ii. It is difficult to make changes in a database, and s ome changes  are impossible to make. If changes

are made to the database  structure, all  sub-schema  definitions must be revalidated before any

applications programs can access the database.
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iii. The  network  model  yields  a  very   complex  structure   from  the   application  programmer's point

of view. Consequently, the programmer must be very familiar with the internal structure in order to

access the database

11.2.3 The Relational Database Model

The Relational database model is implemented through a very sophisticated relational database

management system (RDBMS). The most important advantage of the RDBMS is its ability to let the user/

designer operate in a human logical environment. The RDBMS manages all of the complex physical details. The

Relational Model is based on the mathematics of n-ary relation, which is in turn founded on the disciplines of

predicate calculus and set theory. Thus, the relational database is perceived by the user to be a collection of tables

in which data are stored.

Each table is a matrix consisting of a series of row/column intersection. Tables, also called relations, are

related to each other by sharing common entity characteristics. Each table is made up of records. Horizontal rows,

known as tuples or records and vertical columns are known as attributes. The number of attributes defines the

degree of relation. The number of tuples in a relation is known as cardinality of the relation.

A relational table stores a collection of related entities. In this respect, the relational database table re-

sembles a file. But there is one crucial difference between table and a file: a table yields complete data and

structural independence and uses constraints because it is a purely logical structure. How the data are physically

stored in the database if of no concern to the user or the designer; the perception is what counts here.

Advantages

1. Structural Independence. The data access paths are irrelevant to relational database designers,

programmers, and end users. Changes in the relational database structure  do not affect the DBMS's

data access in any way.

2. Data Independence is achieved more easily with normalization structure  used in  a relational data-

base  than in the more complicated tree or networked structure.

3. Improved conceptual simplicity. The relational database model is simpler at the  conceptual  level.

Because  the  relational  database  model gives us the luxury of ignoring  physical  data  storage

characteristics, we can concentrate on the logical  view of the database.

4. Security control and authorization can also be implemented more easily by moving  sensitive

attributes in a given table into a separate relation with its own authorization controls.

5. Easier  database  design,  implementation,  management,  and  use. Because  the relational model

achieves both data independence and structural independence, it becomes much easier to design the

database and to manage its contents.

6. Ad hoc query capability.

7. A powerful database management system.

Disadvantages

1. Substantial hardware  and  system software overhead. Relational database model takes a  more

powerful  computer  to  perform all  the  RDBMS - assigned tasks. Consequently,  the relational

database  system  tends  to  be slower than the other database systems.
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2. Poor design and implementation is made easy. The relational environment's easy to-use asset also

becomes its liability. Relational software, especially at the micro computer level, is so simple to use

that relatively untrained people  find it easy to generate handy  reports and  queries  without giving

much thought to the need to design a proper database. As  the  database  grows, lack of proper

design tends to slow the system down and to produce the data anomalies found in file system.

3. May promote "islands of information" problems. Because the relational database model is so easy to

use, too many people find it easy to create their own database subsets and applications. Although end

user autonomy  is desirable when the end users query a common database, such autonomy may also

lead to the development  of database subsets that are "owned" by divisions or individuals. The prolif-

eration of such database subsets may produce the same "islands of information" problem that was

characteristics of the file management system, with the same tendency to  promote inconsistent data,

thus causing problems in information generation and validation.

11.2.4 Difference between Relational and Other Models

1. Normalization Theory- Properties of a database that make it free of certain problems of updation

and redundancy have been developed within the context of the relational model. However these

properties can  also be designed into a network data model database.

2. Set Theory - As RDBMS is based on mathematical set theory, the usage of relational algebra and

relational calculus for the manipulation of the relations/tables ensures that there is no ambiguity, which

may otherwise, arise in establishing the linkages in a complicated network type database.

3. Implementation Independence - The relational model logically represents all relationships

implicitly. Therefore, the physical associations represented by an efficient access path among various

files, one does not know without looking at the internal data model. However, the complexities of

Network and Hierarchical models are defined at logical level. Thus relational model provides data

independence over other models.

4. Logical key pointers - The relational data model uses primary and secondary keys in records to

represent the association between two records. This model's implementation is independent of the

data manipulation language as only the physical database use address pointers and physical database

is totally masked from the user of a relational database.

& CHECK YOUR PROGRESS 11.2

1 A collection of conceptual tools for describing data, data relationship and semantics  is called ____.

2 A ____________  represents data by records organized in the form of trees and the  relationships

among data are represented links.

3 A ____________ organizes the data into tables known as relations.

4 ______________ allows modification of  a  scheme  definition  without affecting  other scheme

definitions.

11.3 THE RELATIONAL MODEL

The relational model was propounded by E.F. Codd of the IBM and has since been acknowledged as a

very important concept in DBMS technology. This model has established itself as the primary data model for

commercial data processing applications.
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11.3.1 Terminology

Different terms used in the relational model are:-

F Relation –  A table storing logically related data, data must be in a cell, all rows of this table are

distinct, ordering of rows and columns is immaterial. Each row of the relation can be uniquely

identified by its contents.

F Domain – A domain is a pool of values (valid values) from which the actual values appearing in a

given column are drawn.

A main feature of relational data model is that associations between rows are represented solely by

data values in columns drawn from a common domain.

F Tuple–A row of a relation is generally referred to as a tuple.

F Attribute–A column of a relation is generally referred to as an attribute.

F Degree – It refers to the number of attributes in a relation.

F Cardinality – It refers to the number of tuples in a relation.

F View - It is a virtual table that does not really exist in its own right but is instead derived from one or

more base tables.

F Primary Key – A primary key is a set of one or more attributes that can uniquely identify tuples within

the relation.

F Candidate Key – All attribute combinations inside a relation that can serve as primary key are

candidate keys as they are candidates for primary key position.

F Alternate Key – A candidate key that is not primary key, is called an alternate key.

F Foreign Key – A non key attribute whose values are derived from the primary key of some other

table is known as foreign key in its current table.

F Referential Integrity – It is a system of rules that a DBMS uses to ensure that relationships between

records in related tables are valid and that users don't accidentally delete or change related data.

When referential integrity is enforced, the following must be observed:-

F User can't enter a value in the foreign key field of the related table that doesn't exist in  the primary  key

of  the  primary  table. However,  user can  enter a Null value in the foreign key, specifying that the

records are unrelated.

F User can't delete a record from a primary table if matching records exist  in  a related table.

F User can't change a primary key value in the primary table, if that  record  has related records.

11.3.2 The Relational Algebra

The Relational Algebra is a collection of operations on relations. Each operation takes one or more

relations as its operand and produces another relation as its result. The operations defined in relational algebra are

select, project, Cartesian product, union, set difference, set intersection, natural join, division etc. The select and

project are unary operations since they operate on one relation. The other operations are binary operations as

they operate upon pairs of relations.
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Select  Operation

The select operation selects tuples from a relation that satisfy a given predicate i.e. a given condition. The

selection is denoted by letter σ  (Sigma).

Emp_code Name Dept

1 Rajeev 10

2 Aman 20

3 Sanjay 10

4 Surendra 30

To select only those tuples from emp relation where the department is equal to 10.

Which can be represented as: σ dept =10(emp)

On the basis of the given selection, the following tuples will be selected:

Emp_code Name Dept

1 Rajeev 10

3 Sanjay 10

Project Operation

The project operation yields a vertical subset of a given relation in contrast to the horizontal subset

returned by select operation i.e. the projection allows the user to select specified attributes in a specified order. As

the result is also a relation, the duplicating tuples are automatically removed. Projection is denoted by pi (π).

To project employee names and department from the above relation emp. Which can be represented as:

ð name,dept (emp)
Name Dept

Rajeev 10

Aman 20

Sanjay 10

Surendra 30

Cartesian  Product Operation

The Cartesian product is a binary operation and is denoted by a cross(x). The Cartesian product of two

relations P and Q is written as PxQ. The Cartesian product yields a new relation which has a degree equal to the

sum of the degrees of the two relations operated upon. The number of tuples of the new relation is the product of

the number of tuples of the two relations operated upon. The Cartesian product of two relations yields a relation

with all possible combinations of the tuples of the two relations operated upon.

Emp. table Grade

Emp_code Name Dept

1 Rajeev 10

2 Aman 20

3 Sanjay 10

4 Surendra 30

Grade GName

G1 CLERK

G2 OFFICER



212

 DBMS–Classical Data Management           Unit-XI

Emp. x Grade

Emp_code Name Dept Grade GName

1 Rajeev 10 G1 CLERK

1 Rajeev 10 G2 OFFICER

2 Aman 20 G1 CLERK

2 Aman 20 G2 OFFICER

3 Sanjay 10 G1 CLERK

3 Sanjay 10 G2 OFFICER

4 Surendra 30 G1 CLERK

4 Surendra 30 G2 OFFICER

All rows of emp table matches the all rows of grade table.

Union Operation

The union operation is a binary operation that requires two relations as its operands. It produces a third

relation that contain tuples from both the operand relations. The union operation is denoted by U. The union of two

relations P and Q is written as P U Q.

For a union operation P U Q is to be valid, if the following two conditions must be satisfied by the two

operands P and Q:

1. The relations P and Q must be of the same degree i.e. they must have the same number of attributes.

2. The domain of the ith attribute of P and the ith attribute of Q must be the same.

C

Rollno Name Age

1 Sanjay 22

2 Alok 21

C++

Rollno Name Age

2 Alok 21

9 Shakti 22

Result of C U C++

Rollno Name Age

1 Sanjay 22

2 Alok 21

9 Shakti 22

Difference Operation

The set difference operation denoted by - (minus) allows us to find tuples that are in one relation but not

in another. The expression P-Q results in a relation containing those tuples in P but not in Q.
C

Rollno Name Age

1 Sanjay 22

2 Alok 21

C++

Rollno Name Age

2 Alok 21

9 Shakti 22

Result of C - C++

Rollno Name Age

1 Sanjay 22
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Intersection Operation

The set intersection operation finds tuples that are common to the two operand relations. The set intersection

is denoted by n

C

Rollno Name Age

1 Sanjay 22

2 Alok 21

C++

Rollno Name Age

2 Alok 21

9 Shakti 22

Result of C n C++

Rollno Name Age

2 Alok 21

& CHECK YOUR PROGRESS 11.3

1. The ________ extracts columns from a relation and is denoted by _____.

2. The __________ yields a relation containing tuples from both the operand relations and is

denoted by ________.

3. The _____ extracts tuples from a relation depending upon a condition and is denoted by __________.

11.4 NORMALIZATION

Designing a database is a complex task and the normalization theory is a useful aid in the design process.

The process of normalization is concerned with the transformation of the conceptual schema into a computer

representable form.

A bad database design may lead to certain undesirable situations like:-

F Inability to represent certain information

F Repetition of Information

F Loss of Information

All these may lead to the rewriting of applications. To minimize these anomalies (An anomaly is undesired

consequence of data modification), normalization is used.

Normalization helps to attain a good database design and there by ensures continued efficiency of the

database. If the database is in a normalized form, the data can be restructured, and the database can grow without

rewriting of application programs. Normalization, which is a process for assigning attributes to entities, offers

following advantages:–

(i) It reduces data redundancies.

(ii) It helps to eliminate data anomalies.

(iii) It produces controlled redundancies to link tables.

A number of normal forms have been defined for classifying relations. Each normal form has associated

with it a number of constraints on the kind of functional dependencies that could be associated with the relation.
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The normal forms are used to ensure that various types of anomalies and inconsistencies are not intro-

duced into the database. An unnormalized relation contains non atomic values.

11.4.1 First Normal Form (1NF)

A relation is in first normal form (1NF) if the values in the domain of each attribute of the relation are

atomic (indivisible) values. This definition of 1NF has been expressed in the following two forms:-

(i) In every tuple of the relation, no attribute should have repeating groups.

(ii) In every tuple of the  relation,  each  attribute  must have a value and that too an atomic value.

Student Student

RN# Name Subject

1 Ajay C, VB, 

JAVA

2 Shankar HTML, 

JavaScript, 

VB

SN# Name Subject

1 Ajay C

1 Ajay VB

1 Ajay JAVA

2 Shankar HTML

2 Shankar JavaScript

2 Shankar VB

Unnormalized Relation Relation in INF 

To achieve the first normal form, the following tasks should be completed:-

F All key attributes must be defined

F No repeating groups in a table

F All attributes dependent on primary key

11.4.2 Second Normal Form (2NF)

Before preceding to 2NF, we must understand the term functional dependence. Functional dependence is

a relationship that exists between any two fields. Consider a relation R

A B C

 I 2 1

 I 2 7

 J 5 2

 J 5 8

 K 4 5

Aà B (B is functionally dependent on A)

AàC (C is not functionally dependent on A)

B is functionally dependent upon A since for each value of A, there is only one value of B associated with.

(For I in A, B stores 2, J in A, B stores 5, for K in A, B stores 3)

A relation is in second normal form (2NF) if and only if it is in 1NF and every non key attribute is fully

dependent on the primary key.

Partial Dependency refers to the dependence of a non-key attribute on the portion of the composite

primary key and not the whole primary key.
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Example :– Given a 1NF relation as Student-Proj

rollno Projectno Hours Studentname projlocation

Primary Key

Functional dependencies are:-

Rollno + projectno à Hours

Rollno à studentname
Projectno à projlocation

2NF by decomposing into three tables:-

studprojhours stud Projloc.

rollno projectno hours rollno studentname projectno Projlocation

To achieve the second normal form, the following tasks should be completed:–

F In first normal form

F It includes no partial dependencies

F It can exhibit transitive dependencies.

11.4.3 Third Normal Form (3NF)

The elimination of transitive dependence from a 2NF relation leads to the relation in 3NF.

Transitive dependency means a non-key attribute (say A) is dependent on another attribute (say B) which

in turn is dependent on primary key (say C).

C B A

A relation P  is said to be in third normal form (3 NF) if and only if it is in 2NF and every non-key attribute

is non-transitively dependent on the primary key.

Example:– Given a 2NF relation as Student-class

Rollno name dob addr classcd cname Headboy

3NF by decomposing into two tables:-

student class

Rollno name dob addr classcd classcd name headboy

To achieve the second normal form, the following tasks should be completed:-

F In 2NF

F It does not contain transitive dependencies.

As we obtain the relations in 3NF, our major job of designing database is over. We can still enhance the

design of the database by connecting the tables in 3NF to BCNF.
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11.4.4 Boyce-Codd Normal Form (BCNF).

A relation is in BCNF if it is in 3NF and all of its determinants i.e. the attributes on which other attributes

depend are candidate keys. To convert a 3NF into BCNF, decompose the relation such that every determinant

becomes a candidate key.

Example:– Given a  relation as

Rollno Teach_id Class_cd Grade

Here this table is in 3NF since all non-key attributes class_cd and grade are non-transitively dependent on

the primary key rollno+teach_id. This is not in BCNF because class_cd is also a determinant here since teac_id

depends on class_cd also and it is not a candidate key. To convert it into BCNF, we'll decompose the above table

into two tables.

stud Class_teach 

Rollno Class_cd Grade Class_cd Teach_id

To achieve the BCNF normal form, the following tasks should be completed:-

F In 3NF

F Every determinant in the table is a candidate key.

& CHECK YOUR PROGRESS 11.4

1. _________ relations have nonkey attributes non-transitively dependent on the primary key.

2. The _________ leads to a good database design.

3. ________ relations have every determinant in the table a candidate key.

11.5 RELATIONAL DATABASE MANAGEMENT SYSTEM(RDBMS)

In RDBMS, the data is organized in tables consisting of rows and columns, where rows of a table

represent records and column represents fields. A relational database is one that is built and operated in

accordance with the Relational Model of data proposed by E.F.Codd(1970).

11.5.1 Features of RDBMS

(i) The ability to create multiple relations and enter data into them.

(ii) Retrieval of information stored in more than one table.

(iii) An interactive query language

(iv) RDBMS product has to satisfy at least six of 12 rules of codd to be accepted as a full fledged

RDBMS.

11.5.2 The twelve(12) rules for an RDBMS(codd's rule)

(i) Information Representation - All the information is explicitly and logically represented by the data

values in the tables means any information such as table, view, column names etc. should be contained

somewhere as a table form.

(ii) Guaranteed Access - It refers that the table can be taken as a storage structure and at the intersec-

tion of each column and a row there will necessarily be only one value of data.
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(iii) Systematic treatment of NULL values - In DBMS null values are supported for the represen-

tation of missing and inapplicable information.

(iv) Database description rule - A description of the database is stored and maintained the form of

tables as is done while defining the data. This implies that a data dictionary should be present

within the RDBMS that is constructed.

(v) Comprehensive Data Sublanguage - The RDBMS must be completely manageable through

its own extension of SQL. The SQL should support Data definition, views, data manipulation,

integrity constraints, authorization, transaction boundary.

(vi) View updating - It is possible to create views with all sort of aggregates and virtual columns, it is

not possible to update through some of them. There exists a set of rules that when applied to a

view, can be used easily to determine its level of logical complexity and apply these rules to those

views that are defined as simple by such criteria.

(vii) High-level update, insert, delete  - An RDBMS must do more than just be able to retrieve

relational data sets. It has to be capable of inserting, updating and deleting data as a relational set.

A database cannot be called relational, if it uses a single-record at time procedural technique

when it comes to manipulating the data.

(viii) Physical data Independence - Different user access database through different devices or by

application programs, database must remain logically consistent even when changes to the

storage representation, or access methods to the data are changed.

(ix) Logical data Independence - Application programs must be independent of the changes made

to the base tables. This rule allows many types of database design changes to made without the

users being aware of them.

(x) Distribution Rule - RDBMS must have distribution independence. This is one of the most

attractive aspects of the RDBMS. Database systems built on the relational framework are well

suited to client/server database design.

(xi) Non-Subversion. - If an RDBMS supports a lower level language that permits row at a time

processing, then this language must not be able to bypass any integrity rules or constraints of the

relational language. Thus an RDBMS must be governed by relational rules as its primary laws.

(xii) Integrity Rule - Integrity constraints specific to a particular relational database must be

definable in the relational data sublanguages and storable in the catalogue, not in the application

programs.

11.5.3 E-R Modeling

Entity relationship modeling is a technique for analysis and logical modeling of a system's data requirements.

It uses three basic units Entity, their Attributes and the Relationships that exist between the entities. It uses a

graphical notation for representing these.

(i) Entity – An entity is an object, place or person that the system stores information about them. It can

have multiple instances or occurrences. Each instance should be uniquely identifiable. Each entity has

certain properties or attributes associated with it and operations applicable to it. Entity is denoted by

symbol
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(ii) Attributes– These are the data elements that describe an entity like rollno, name etc. and is denoted by

(iii) Relationships– This is an association between entities. It is represented by rhombus in the E-R

diagram.

Example of E-R Diagram:-

Student
Enrolls in

Course

Relationships are of three types:–

F One to One (1:1)

F One to Many (1:M)

F Many to Many (M:M)

These relationships are explained in 11.2 above.

Example:– E-R diagram of One to One(1:1)

Surveyor
Surveys In

Area

SNO Name

Topic

Area_c Name

Population

Example :– E-R diagram of One to Many(1:M)

Course

C_CD Desc

Duration

Takes 

Admission
Student

Rollno Name

Age
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Example:– E-R diagram of Many to Many(M:M)

Customer

Custno

Name

Item
Purchase

Itemcd Name

Price
A customer can purchase many 

items and a item can be purchased 

by many customers.

& CHECK YOUR PROGRESS 11.5

1. What are the basic units of E-R diagram?

2. ________ are data elements that describe an entity.

3. An RDBMS product has to satisfy at least ______ out of the 12 codd rules to be accepted as a

full fledged RDBMS.

11.6 SUMMARY

In this unit, we understand the concept of major data modeling concepts and the data models used in

DBMS. The E-R model is used increasingly as a tool for database applications modeling. Traditional data models

are hierarchical, network and relational models. The hierarchical model evolved from the file-based system, the

network model is a superset of the hierarchical model. The relational data model is based on the mathematical

relational concept.

Conceptually, a relation can be represented as a table, each column of the table represents an attribute of

the relation and each row represents a tuple of the relation. Mathematically a relation is a correspondence

between a number of sets and is a subset of the Cartesian product of these sets. The sets are the domains of the

attributes of the relation.

The process of normalization is concerned with the transformation of the conceptual schema into a

computer representable form. We discussed the different normal forms such as:1NF, 2NF, 3NF, BCNF which

leads to better database design.

11.7 GLOSSARY

Alternate key:–  A candidate key which is not a primary key.

Attribute:– A column of a relation.

BCNF:– Boyce-Codd Normal Form - A relation is in BCNF if it is in3NF and every determinant is a

candidate key.

Candidate Key:– Attribute combinations in a relation that can serve as a primary key.

Cardinality:– Number of tuples in a relation.

Data Independence:– Ability to modify a scheme definition within a database without affecting  other

scheme definitions.
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Data Redundancy:– Duplication of data.

Degree:– Number of attributes in a relation.

Domain:– A pool of values from which the actual values appearing in a given  column are drawn.

Foreign Key:– Non key attribute, which is a primary key of another table.

Normalization:– The decomposition of more complex data structures into relations. This forms the basis

of relational databases.

Primary Key:– Set of one or more attributes that can uniquely identify tuples within a  relation.

Relation :– Data arranged in rows and columns and having certain properties.

Relational:– A language providing a set of operators for manipulating relations.

Algebra Tuple :– A row of a relation.

View:–A virtual table derived from one or more underlying base tables..

11.8 FURTHER READINGS

1. Ramakrishnan and Gharke, Database management Systems, Tata McGraw Hill Pub. Co. Ltd.

2. Date Database Management Systems, Pearson Education Asia

3. Geraid V Post, Database Management Systems, Tata McGraw Hill

4. An introduction to Database Systems, Bipin C. Desai, Galgotia publications

11.9 ANSWERS TO THE SELF LEARNING EXERCISES

Answers to check your progress 11.2

1. Data Model 2. Hierarchical Data Model

3. Relational Data Model 4. Data Independence

Answers to check your progress 11.3

1. Projection, π(pie) 2. Union, U 3. Selection, σ(Sigma)

Answers to check your progress 11.4

1. 3NF 2. Normalization 3. BCNF

Answers to check your progress 11.5

1. Entity, Attribute and Relationship 2. Attributes 3. Six

11.10 UNIT-END QUESTIONS

1. What are advantages and disadvantages of Network Model?

2. What is Normalization? What is its need?

3. What do you mean by relational database and list their advantages?

4. What do you understand by unary relation and binary relation?

5. What are the set difference and set intersection operations? How are they different?

����
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Unit XII : SQL - STRUCTURED QUERY LANGUAGE

Structure of the Unit

12.0 Objectives

12.1 Introduction

12.2 Introducing Oracle

12.2.1 Features of Oracle

12.2.2 Physical Oracle

12.2.3 Logical Oracle

12.2.4 Steps for starting Oracle

12.3 SQL-Structured Query Language

12.3.1 Literals

12.3.2 Data Types

12.3.3 Null Values

12.3.4 Comments

12.3.5 Tables used in examples

12.4 Querying Database Tables

12.4.1 The SELECT statement

12.4.2 Functions and Grouping

12.4.3 Querying Multiple Tables

12.4.4 Using Relation Algebra functions - Union, Intersect and Minus

12.4.5 Nested Queries

12.5 Data Definition Language

12.5.1 Creating Tables

12.5.2 Inserting Values

12.5.3 Updating Values

12.5.4 Deleting Row(s)

12.5.5 Viewing the Structure of a Table

12.5.6 Modifying the structure of a Table

12.5.7 Removing table from the database

12.6 Transaction Control Commands

12.7 Views

12.8 Summary

12.9 Glossary

12.10 Further Readings

12.11 Answers to the self learning exercises

12.12 Unit-end questions
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12.0 OBJECTIVES

After going through this unit student will be able to :

F Identify the structures in the different models of DBMS

F Identify the meaning of normalization and different forms

F Identify the essential features of relational model.

F Able to draw E-R diagrams

12.1 INTRODUCTION

SQL, Structured Query Language, was developed in 1970s in an IBMS Laboratory. SQL sometimes

also referred to as SEQUEL is a 4th generation non-procedural language. In non-procedural languages 'WHAT is

required' is specified in contrast to 3GL's 'HOW it is to be done'. SQL the standard language of RDBMS allows

the following with ease:-

(i) Creation/Change in database structure

(ii) Querying database

(iii) Insert/Update/Delete the database contents

(iv) Reports for Printing

(v) Security Settings according to user

There are many DBMSs  are available in the market that are capable of storing and maintaining the

database of an enterprise, but ORACLE is one of the most popular DBMS's that is being used by number of

organization all over the world. Oracle falls under the category of Relational Database Management System

(RDBMS). In this unit, we will focus on all SQL commands by considering Oracle.

12.2 INTRODUCING ORACLE

The Oracle was developed by a company called Relational Software Incorporated (RSI) in year 1977. In

1979, this company launched its first commercial product called SQL RDBMS. The company now changed its

name from RSI to Oracle Corporation. Oracle has been constantly updating its product and launched several

versions. If student uses windows 98, Personal Oracle 8.0 will work, For Windows 2000, Oracle 8i will work

and for windows xp Oracle 9i will work .

12.2.1 Features of Oracle

Oracle is a powerful RDBMS product that provides efficient and effective solutions for major database

features. This includes:–

(i) Large databases and space management control:– It supports the largest of databases where

size can go up to terabytes. It allows full control on space usage.

(ii) Many concurrent database users:– It supports large number of concurrent (means many users

working at the same time on the same data) users.

(iii) High availability:– It is having very low/no down time and can work 24 hours a day. Normal

system operations like backup, partial computer system failures do not interrupt database uses.
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(iv) Controlled Availability:– It can selectively control the availability of the data at the database

level.

(v) Manageable Security:– It provides full security features to limit and monitor data access.

(vi) Database enforced integrity:– It maintains the database integrity through the use of constraints

and referential integrity.

(vii) Client/Server environment:– It takes the full advantage of a given computer system or net-

work.

(viii) Portability:– It is ported to work under different operating systems.

(ix) Compatibility:– It is compatible with industry standards. It can be used on virtually any system

with little or no modification.

(x) Industry accepted standards:– It adheres to the accepted standards for the data access lan-

guage, operating system and network communication protocols.

An oracle database system can easily take advantage of distributed processing by using its client/server

architecture. In this architecture, the database system is divided into two parts:-

F A front-end or a client portion

F A back-end or server portion

The client executes the database application that accesses database information and interacts with the

user. The server executes the Oracle software and handles the functions required for concurrent, shared data

access to oracle database.

12.3.2 Physical Oracle

At the physical level, Oracle exists in various files:

(i) Data files - A database's data file contains all the database data.

(ii) Control files - A control file contains entries that specify the physical structure of the database.

(iii) Redo Log files - The primary function of the redo log is to record all changes made to data. In case

of failure, the changes can be obtained from the redo log.

(iv) Temporary files - To store the intermediate data.

(v) Configuration and parameter files - To store the settings and providing parameters to different

oracle commands.

12.3.3 Logical Oracle

The oracle logical database is represented in several structures:-

(i) Tablespaces - A tablespace is a logical storage entity that is assigned to one or more physical datafiles

(ii) Segments– A segment is made up of one or more extents that are allocated for one specific type of

storage. The four types of segments are - data segments, index segments, temporary segments and

rollback segments.
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(iii) Extents– An extent is a combination of oracle data blocks that together make up a logical unit of

storage.

(iv) Blocks– This is the most atomic unit of storage in oracle. All oracle objects are stored in units of

blocks.

12.2.4 Steps for starting Oracle

(i) Install Oracle, versions depends on the availability and operating system of your computer.

(ii) Click on programs->Oracle->SQL Plus.

(iii) Provide User name - 'scott' and password - 'tiger' and click OK button.

After successful login, Oracle shall perform many security checks, starts oracle instance, mount the

database and finally take you to the SQL*Plus window where you can issue SQL commands and can see the

results. It will provide the SQL>prompt as shown below:-

12.4 SQL-STRUCTURED QUERY LANGUAGE

To access data from the database, all programs and users must use Structured Query Language. SQL is

the set of commands that is recognized by nearly all RDBMSs. The SQL has proved to be a language that can be

used by both casual users as well as skilled programmers.

The SQL language has several parts:

F Data-definition language (DDL). The SQL DDL provides commands for defining relation schemas,

deleting relations and modifying relation  schemas.

F Interactive data-manipulation language (DML). The SQL DML includes a query language based

on both the relational algebra and the tuple relational calculus. It includes also commands to insert

tuples into, delete tuples from, and modify tuples in the database.

F View definition. The SQL DDL includes commands for defining views.

F Transaction control. SQL includes commands for specifying the beginning and ending of

transaction.

F Embedded SQL and Dynamic SQL. Embedded and dynamic SQL define how SQL statements

can be embedded within general-purpose programming languages like C, C++, Java etc.
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F Integrity. The SQL DDL includes commands for specifying integrity constraints that the data stored

in the database must satisfy.

F Authorization. The SQL DDL includes commands for specifying access rights to relations and views.

SQL*Plus is a software product from Oracle corporation that allows users to interactively use the SQL

commands, produce formatted reports and support written command-procedures to access ORACLE database.

Through SQL*Plus a user can:–

F Enter, Edit, Store, retrieve and run SQL Commands.

F Format, perform calculations on stored and print query results in the form of reports

F List column definition of any table

F Access and copy data between SQL databases

F Send messages to and accept responses from an end user.

12.3.1 Literals

Literals in general, refer to a fixed data value. This fixed data value may be of character or numeric type

literal. For example 'Rajeev', 'Rakesh', '205' are character literals enclosed in single quotation mark.

Numeric literals can either be integer or real literals like 17 or 17.5. A numeric literal can store a maximum

of 38 digits of precision.

12.3.2 Data Types

Data types are means to identify the type of data and associated operations for handling it. Different data

types are:–

Data Type Description 

CHAR(n) To store fixed size character type of data. Max. size is 255 bytes.

VARCHAR2(n) Similar to char but can store variable number of characters

NUMBER(p, s) Stores int. and real numbers.Max.21 bytes, Number having precision 

p and scales. The precision p can range from1 to 38 digits.

DATE Stores date and time values in a table. Fixed at 7 bytes

LONG It can store up to 2 GB of characters.

RAW(n) Stores binary data such as graphics and sound. Can store up to 2000 

bytes per row.

Apart from above data types, there are many more data types that are supported but are beyond the

scope of this unit like CLOB, BLOB and BFILE data types that can store Character Large Object, Binary Large

Object and Binary File Locator.

Difference between Char and Varchar2 data types

The difference between CHAR and VARCHAR2 is that of fixed length and variable length. The CHAR

data type specifies a fixed length character string. When a column is given data type as CHAR(n), it ensures that

all values stored in that column have this length. If a value is shorter than maximum length n then blanks are added.
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VARCHAR2(n) specifies a variable length string. The maximum size a value in this column can have is n

bytes. No blanks are added if the length is shorter than maximum length.

12.3.3 Null Values

If a column in a row has no value, then column is said to be null or to contain a null. Nulls can appear in any

column provided they are not restricted by NOT NULL or PRIMARY KEY integrity constraint. Any arithmetic

expression containing a null always evaluates to null.

12.3.4 Comments

A comment is a text that is not executed; it is only for documentation purpose. You can include a comment

in a statement using either of these means:-

F Begin the comment with /* and end the comment with */ for multi line comment.

F Begin the comment with two hyphens (--). It is a single line comment.

12.3.5 Tables used in examples

Through out this unit, We are using standard tables emp, dept provided by oracle software in our example.

Structure of EMP table

Column Name Type Description 

EMPNO NUMBER(4) Employee Number

ENAME VARCHAR2(20) Employee Name

JOB CHAR(10) Designation

MGR NUMBER(4) Manager's EMPNO

HIREDATE DATE Date of Joining

SAL NUMBER(9,2) Basic Salary

COMM NUMBER(7,2) Commission

DEPTNO NUMBER(2) Department Number

Structure of DEPT table

Column Name Type Description

DEPTNO NUMBER(2) Department Number

DNAME VARCHAR2(20) Name of the department

LOC VARCHAR2(10) Location of the department

& CHECK YOUR PROGRESS 12.3

1. Single line comments are given by _________.

2. _________ specifies a variable length string.

3. _________ refers to a fixed data value.

4. _________ provides commands for defining relation schemas.

5. _________ includes a query language based on both the relational algebra and the tuple relational

calculus
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12.4 QUERYING DATABASE TABLES

To use the power of RDBMS, we need to communicate with it in a powerful way by making queries i.e.

by asking the RDBMS to show your desired data in desired format. A statement in SQL is completed with a

semicolon (;). SQL are case insensitive. However the text literal or character literals specified in quotation marks

are case-sensitive.

12.4.1 The SELECT statement

This statement allows to make queries on the database. There are various ways and combinations, a

SELECT statement can be used into. It can be used to retrieve information from a single row or column, multiple

rows and columns and single or multiple tables. The syntax of the SELECT statement is:-

Syntax

SELECT <column-name>[,<column-name>,…]

FROM <table-name>[,<table-name>….]

[WHERE <condition>]

[GROUP BY <column-name(s)>]

[HAVING <condition>]

[ORDER BY <expression>];

Examples:

F Show the empno, ename from the emp table of all employees.

SQL>SELECT empno, ename FROM emp;

F Show the all information for all employees from the emp table.

SQL>SELECT * FROM emp;

The output will look like as under:-
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Using Column Aliases

Column aliases means the heading label provided by the user in double quotation mark (not using the

default label).

SQL>SELECT ename "Name", sal*12 "Annual Salary" FROM emp;

Putting text in the query output

Adding text with the column data of every row.

SQL>SELECT empno, ename, comm.*100,'%' from emp;

Concatenating Strings(||)

This means that joining different fields or string literals and convert them into a single column value.

SQL>SELECT ename || '-' || job "Name and Job" FROM emp;

Conditional Retrieval of Rows

The rows can be retrieved on the basis of given condition by using the WHERE clause the SQL. Different

operators can also be used in conjunction with the given condition. Operators used are:-

Relational Operators 

= Equal To

> Greater Than

< Less Than

>= Greater than or equal to

<= Less than or equal to

<>, != Not equal to

Logical Operators

Logical Operators 

AND Logical AND

OR Logical OR

NOT Logical NOT

Special Operators 

IS NULL Checking for NULL values

IN Checking a value in a set.

BETWEEN Checking a value within a range

Examples:

(i) Show the list of all the employees of department number 20.

SQL>SELECT * FROM emp where deptno=20;
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(ii) Show the list of all the employees whose salary is greater than 1000.

SQL>SELECT ename, sal FROM emp where sal>1000.

(iii) Show the list of all the employees who are MANAGER.

SQL>SELECT empno,ename FROM WHERE job='MANAGER';

(iv) Show the list of all the employees who are CLERK and belongs to department number 20.

SQL>SELECT ename FROM emp WHERE job='CLERK' and deptno=20;

(v) Show the list of all the employees who joined on or before December 31st, 1981.

SQL>SELECT * FROM emp WHERE hiredate <= '31-DEC-81';

(vi) List the employees name who are having employee number 7369 or 7521 or 7839 or 7934.

SQL>SELECT ename FROM emp WHERE empno IN(7369, 7521, 7839,7934);

(vii)List the employees who do not belongs to department number 10,30 and 40.

SQL>SELECT * FROM emp where deptno NOT IN (10,30,40);

(viii) List the employees name and salary whose salary falls in the range of 1000 and 2000.

SQL>SELECT ename,sal FROM emp WHERE sal BETWEEN 1000 and 2000;

(ix) List the employee names who are not eligible for commission.

SQL>SELECT ename FROM emp WHERE comm. IS NULL;

(x) List the employees who are not assigned to any department.

SELECT ename FROM emp WHERE deptno IS NULL.

Condition based on pattern matching

SQL includes a string-matching or pattern matching operator LIKE for comparisions on character strings

using patterns. Patterns are described using two special wildcard characters:

F % (percent)– The % character matches any substring.

F _____ (underscore) – The ____ character matches any character.

Patterns are case-sensitive. The following are examples for considering patterns:

F 'Raj%' matches any string beginning with 'Raj'

F '%ee%' matches any string containing 'ee' as a substring like 'Rajeev'.

F '----' matches any string of exactly 4 characters.

F '----%' matches any string of atleast 4 characters.

Examples:–

(i) Show the employee name starting from 'A'.

SELECT ename FROM emp WHERE ename LIKE 'A%';
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(ii) Show the employee name containing a substring 'IN'.

SELECT ename FROM emp WHERE ename LIKE '%IN%';

Eliminating Redundant Data (With Keyword DISTINCT)

The DISTINCT clause is used with SELECT to suppress duplicate values if any in a column.

Example: List the different jobs available in the emp table.

SQL> SELECT DISTINCT(job) FROM emp;

Ordering the results of a Query (Sorting Results)

SQL uses the ORDER BY clause to impose an order on the result of a query. This clause orders (sort) the

query output according to the values in one or more selected columns.

Examples: (i) Show the employee name and sal in the ascending (increasing) order.

SQL>SELECT ename, sal FROM emp ORDER BY sal;

(ii) Show the employee names and hiredate in descending order of hiredate.

SELECT ename,hiredate FROM emp ORDER BY hiredate DESC;

Perform Simple Calculations in SQL

If a simple calculation needs to be done, for example 5*10. The only SQL verb to cause an output to be

written to monitor is SELECT. However, a SELECT must have a table name in FROM clause. Oracle provides

a dummy table called Dual. This table can be used for obtaining calculation results and also system date.

Example:– SELECT 5*10 FROM dual;

 SELECT sysdate FROM dual;

12.4.2 Functions and Grouping

A function is a special type of predefined command set that performs some operation and returns a single

value. SQL supports many types of functions. All these functions can be divided into two categories:–

(i) Single Row (or Scalar) functions

(ii) Multiple Row (or Group or Aggregate) functions.

Single Row Functions

These functions are further divided into many categories depending on the data types of their arguments

and return values. These categories are:-

F Numeric Functions

F Aggregate Functions

F Character Functions

F Date Functions

F Data Type Conversion Functions
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Numeric Functions

The number functions are those functions that accept numeric values and returns the numeric values after

performing the desired operation.

(i) MOD - This functions returns the modulus(remainder) of given two numbers.

Syntax

MOD(X,Y)

SQL>SELECT MOD(13,5) "Modulus" FROM dual;

It returns 3 as result(remainder).

(ii) POWER - This function calculates the power as xy i.e. x raised to power of y.

Syntax

POWER(X,Y)

SQL>SELECT POWER(2,4) FROM dual;

It returns 16 as a result.

(iii) ROUND - This function returns a number rounded off as per given specifications.

Syntax

Round(n[,d])

SELECT ROUND(20.594,1) FROM dual;

It returns 20.6 as rounded off to 1 decimal place.

(iv) SQRT - This function returns the square root of a given number.

Syntax

SQRT(n)

SELECT SQRT(25) FROM dual;

It returns 5 as a result.

Aggregate(GROUP) Functions

The group functions or aggregate functions work upon groups of rows. These functions are sometimes

also called multiple row functions.

(i) AVG - This function computes the average of a given data.

Syntax

AVG([DISTINCT | ALL] n)

SELECT AVG(sal) FROM emp;

It returns the average of the salary from emp table.

(ii) COUNT - This function counts the number of rows in a given column or expression.

Syntax

COUNT({* | [DISTINCT | ALL|] expr})
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SELECT COUNT(*) FROM emp;

It returns the total number of records present in the emp table.

(iii) MAX - This function returns the maximum value from a given column or expression.

Syntax

MAX([DISTINCT | ALL] expr)

SELECT MAX(sal) FROM emp;

It returns the maximum salary (highest) from emp.

(iv) MIN - This function returns the minimum value from a given column or expression

Syntax

MIN([DISTINCT | ALL] expr)

SELECT MIN(sal) FROM emp;

It returns the minimum salary (lowest) from emp.

(v) SUM - This function returns the total of values given in a column or expression.

Syntax

SUM([DISTINCT | ALL] n)

SELECT SUM(sal) FROM emp;

It returns the total of the salary of all employees.

Character Functions

The single row character functions are those functions that accept a character input and can return both

character and number values.

(i) CONCAT - This function concatenates(join) two strings

Syntax

CONCAT(char1, char2)

SELECT CONCAT(ename,job) from emp;

It joins the employee name and job.

(ii) INITCAP - This function capitalizes the first letter of the string.

Syntax

INITCAP(Character(s))

Select INITCAP('rajeev') from dual;

It returns 'Rajeev' from the given string.

(iii) LOWER - This function converts a string into lowercase.

Syntax

LOWER(Character(s))

Select LOWER('RAJEEV') from dual;

It returns 'rajeev' from the given string.
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(iv) LPAD - This function left-pads (insert in the left side) the given character to given string to reach at

given width.

Syntax

LPAD(Chararcter(s), n, [, character])

SELECT LPAD('Rajeev',15,'-') FROM dual;

It fills 9 hyphens before given string as '---------Rajeev'.

(v) RPAD - This function is similar to LPAD except that it fills from the right instead of left.

(vi) SUBSTR - This function extracts a substring from a given string from the specified position m and

number of characters given n.

Syntax

SUBSTR(char, m, [,n])

SELECT SUBSTR('Rajeev Srivastava',4,7) FROM dual;

It returns 'eev Sri' as output. Remember it counts spaces also.

(vii)UPPER - This function is same to LOWER except that it returns the string in uppercase.

(viii)LENGTH - This function returns the length of a given string.

Syntax

LENGTH(Character(s))

SELECT LENGTH('Rajeev Srivastava') FROM dual;

It returns 17 as output. It includes spaces also.

Date Functions

Date functions operate on values of the DATE datatype. All date functions returns a value DATE datatype

except the MONTHS_BETWEEN function, which returns a number.

(i) ADD_MONTHS(d,n) - Add or Subtracts months to or from a date. Returns a date as a result.

(ii) MONTHS_BETWEEN(d1,d2) - Returns the number of months between two dates d1 and d2.

(iii) LAST_DAY(d) - Returns the date of the last day of the month specified.

(iv) NEXT_DAY(date,day) - Finds the date of the 'day' after the date.

Example:

SELECT SYSDATE, MONTHS_BETWEEN(SYSDATE, HIREDATE), ADD_MONTHS(SYSDATE,

5), LAST_DAY(SYSDATE), NEXT_DAY(SYSDATE, 'FRIDAY') FROM emp;

Data Type Conversion Functions

It provides functions that convert a value's data type. The three functions available are:-

(i) TO_CHAR(d,f) - Converts the date to character according to the format 'f'.

(ii) To_Number(c,f) - converts a given character string to equivalent number.

(iii) To_Date(c,d) - Converts the character string to date.
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Example:- Show all the employee names who have more than 2 years of experience as on January 1st, 1984.

SELECT ename FROM emp WHERE (TO_DATE('01-JAN-84','DD-MON-YY') - hiredate)/365 > 2;

SELECT sal+TO_NUMBER('100')  FROM emp;

Grouping  the Result of a Query

The GROUP BY clause is used with SELECT to combine a group of rows based on the values of a

particular column or expression. SQL groups the result after it retrieves the rows from a table. Conditional re-

trieval of rows from a grouped result is possible with the HAVING clause. ORDER BY clause can be used to

order the final result.

Examples:

(i) Show the department numbers and number of employees in each department.

SELECT deptno, count(*) FROM emp GROUP BY deptno;

(ii) Show the department number and the total salary payable in each department.

SELECT deptno, SUM(sal) FROM emp GROUP BY deptno;

(iii) Show the total salary, maximum, minimum  and average salary of employees jobwise for department

number 20 and display only those rows having average salary greater than 1000.

SELECT job, SUM(sal), AVG(sal), MAX(sal), MIN(sal) FROM emp where deptno = 20 GROUP

BY job HAVING AVG(sal) > 1000;

12.4.3 Querying Multiple Tables

Joins are used to combine columns from different tables. The tables are listed in the FROM clause,

separated by comma. The condition of the query can refer to any column of any table joined. The connection

between tables is established through the WHERE clause.

EQUI Joins

When two tables are joined together using equality of values in one or more columns, they make an EQUI join.

Example: Show the employee numbers, names, department numbers and the department name.

SELECT empno, ename, emp.deptno, dname from emp, dept where emp.deptno = dept.deptno;

Natural Join

The join in which only one of the identical columns (coming from joined tables)  exits, is called Natural Join.

SELECT emp.* dept.dname, dept.loc FROM emp,dept WHERE emp.deptno = dept.deptno;

Self Join

A table joined with itself is called self join. When values within a column of a table are to be compared, we

require a self join.

SELECT emp1.*, emp2.empno FROM emp emp1, emp emp2 WHERE emp1.empno<> emp2.empno

AND emp1.job = emp2.job;
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Outer Join

The joins that we have seen so far are simple or inner joins.

An inner join selects only those rows from both the joining tables that have matching values with other

joining tables. On the other hand, an Outer Join selects all the rows that satisfy the join condition and those rows

from one table for which no rows from the other table satisfy the join condition.

Example : Show employee name, job, department number and department name. All the department names

should be displayed whether they have employees or not.

SELECT ename, job, dept.deptno, dname FROM emp, dept WHERE emp.deptno(+) = dept.deptno;

The outer joins can be of two types:–

(i) Left Outer Join – The outer join that returns all the rows of left(i.e. first) table whether or not they have

matching rows in right(or second table). The non-matching rows of left table have NULLs in places of

columns coming from right table. The (+) operator put with the right table gives left outer join.

(ii) Right Outer Join– The outer join that returns all the rows of right(i.e. second) table whether or not they

have matching rows in left (or first) table. The non-matching rows of right table have nulls in places of

columns coming from left table. The (+) operator put with the left table gives us right outer join.

Cartesian Join

When no WHERE clause is specified, each row of one table matches every row of the other table. This

results in a Cartesian product.

SELECT empno, ename, dname from emp,dept;

It is useful in finding out all the possible combination of columns from different tables.

12.4.4 Using Relation Algebra functions - Union, Intersect and Minus

Multiple queries can be merged together and their results can be combined.. The queries are all executed

independently, but their output is merged. Only the final query ends with a semicolon.

UNION

The union clause merges the outputs of two or more queries into a single set of rows and columns.

Example:– Show the different designations in department number 20 and 30.

SELECT job FROM emp WHERE deptno = 20

UNION

SELECT job FROM emp WHERE deptno = 30;

INTERSECT

The intersect clause takes the common output of two or more queries.

Example:– Display the jobs common to department number 20 and 30.

SELECT job FROM emp WHERE deptno = 20
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INTERSECT

SELECT job FROM emp WHERE deptno = 30;

MINUS

The minus clause gives the output from first query which is not available in the second query.

Example:– Display the jobs that are not available in department 30 but which are available in department number 20.

SELECT job FROM emp WHERE deptno = 20

MINUS

SELECT job FROM emp WHERE deptno = 30;

12.4.5 Nested Queries

The result of one query is dynamically substituted in the condition of another. SQL first evaluates the inner

query (or sub query) within the WHERE clause. The return value of inner query is then substituted in the condition

of the outer query. When using relational operators, ensure that the sub query returns a single row output.. In some

cases DISTINCT clause can be used to ensure single valued output.

Example:– Show the employees belonging to the department of 'SMITH'.

Explanation of the question - Here, we do not know the department to which 'SMITH' belongs. So, we

have to determine the department of 'SMITH' and use that department number to find out the other employees of

that department.

By Normal Procedure

SELECT deptno FROM emp WHERE ename = 'SMITH';

Output : - deptno = 10

Now, SELECT ename FROM emp WHERE deptno = 10;

Combining the above two queries as nested query

SELECT ename FROM emp WHERE deptno = (SELECT deptno FROM emp WHERE ename =

'XYZ');

& CHECK YOUR PROGRESS 12.4

1. Querying database tables is done by using the ________ statement of SQL.

2. Pattern matching is done through the ________ operator.

3. The conditions can be given by the __________ clause for grouped results.

4. In a join, the connection between tables is established using the _______ clause.

5. Joining a table to itself is called ______ join.

6. The dummy table used in Oracle for multiple purposes is ______.

7. The result of one query is dynamically substituted in the condition of another is called _____________.
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12.5 DATA DEFINITION LANGUAGE

The DDL is used to create and modify the structure of tables. It can also update, delete or insert new

records in the tables.

12.5.1 Creating Tables

Tables are created by using the CREATE TABLE command. The column names must be specified along

with their data types. The user who creates them owns tables. The column names in the table must be unique.

Syntax

CREATE TABLE <tablename>(

      <column-name>   <data-type><(size)>  [constraint],

      <column-name>   <data-type><(size)>  [constraint],

      -------------

);

Column Constraints

Constraints are the part of the table definition that limit the values entered into its column.

(i) Not Null - Prevent a column from permitting NULL values.

(ii) UNIQUE - Ensures uniqueness of the values in a column.

(iii) PRIMARY KEY - Same as UNIQUE, but only one column per table.

(iv) CHECK - Controls the value of a column(s) being inserted.

(v) DEFAULT - Assign a default value for column(s) at the time of insertion when no value is given for

that column.

(vi) REFERENCES - Assigns a foreign key constraint to maintain "Referential Integrity".

Examples:–

1. CREATE TABLE ITEMMAST(

ITNO NUMBER(4)   PRIMARY KEY,

NAME VARCHAR2(20) NOT NULL UNIQUE,

UOM CHAR(4),

RATE NUMBER(8,2)  NOT NULL

);

2. CREATE TABLE ITEMMAST(

ITNO NUMBER(4)   PRIMARY KEY,

NAME VARCHAR2(20) NOT NULL UNIQUE,

CLASS CHAR(1)   CHECK (CLASS IN('A','B','C')),

ROL NUMBER(5) CHECK (ROL>0),

STK NUMBER(5) DEFAULT 100

);
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REFERENCES (Foreign Key)

A foreign key is a combination of columns with values based on the primary key values from another table.

A foreign key constraint, also known as referential integrity constraint.

Example:-

CREATE TABLE ITTRAN(

ITNO NUMBER(4)   REFERENCES ITEMMAST(ITNO),

TRANTYPE CHAR(1)   CHECK (TRANTYPE IN('I','R')),

TRNDT DATE,

QTY NUMBER(5)

);

12.6.2 Inserting Values

All rows in a table are inserted using the INSERT command.

Syntax

INSERT INTO <tablename> VALUES(<list of values>);

Example:–

INSERT INTO emp VALUES(7311,'RAJEEV','MANAGER','18-JUN-97',5000);

While inserting data into tables, the following should be taken care of:-

(i) Character data will be enclosed within single quotes.

(ii) Column value for date type is provided within single quotes. It automatically converts the character

field to date type field.

(iii) NULL values are given as NULL, without any quotes.

(iv) If no data is available for all the columns, then the column list must be included after the table name as:

INSERT INTO emp (empno, ename,sal) VALUES(1179, 'RAJEEV', 6000);

12.6.3 Updating Values

Columns values in a table are updated using the UPDATE command. Updation can be carried out for all

the rows in a table or selected rows.

Syntax

UPDATE <tablename> SET <col-name> = <value> [,<col-name>=<value>]

[where <condition>];

Example:–

(i) UPDATE emp SET comm. = 500; (It will update column comm. By 500 for all rows .)

(ii) UPDATE emp SET sal =sal * 0.1) WHERE ename = 'SMITH'; (It will update the sal column by 10%

for employee 'SMITH')
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12.6.4 Deleting Row(s)

Rows can be deleted from a table by using the DELETE command. The entire row (record) is deleted

from the table.

Syntax

DELETE FROM <tablename> [WHERE <condition>];

Example:–

DELETE FROM emp WHERE job = 'CLERK';  (It will delete all the records of CLERK.

12.5.5. Viewing the Structure of a Table

To view the structure of a table, the DESCRIBE or DESC command is used.

Syntax

DESC[RIBE] <tablename>;

Example :

DESC emp;

12.5.6 Modifying the structure of a Table

The ALTER TABLE command is used to change the definitions of existing tables. This command

performs the following actions:-

(i) To add a column

(ii) To add an integrity constraint

(iii) To redefine a column (datatype, size, default value)

Syntax

ALTER TABLE <tablename> ADD/MODIFY <colname>  <datatype>  <size> [<constraint-name>];

Example:–

ALTER TABLE emp ADD (tel-no  number);

ALTER TABLE emp MODIFY (job  char(30));

ALTER TABLE emp ADD CONSTRAINT  empc PRIMARY KEY(empno);

12.5.7 Removing table from the database

To remove the table from the database, DROP TABLE command is used.

Syntax

DROP TABLE <tablename>;

Example:–

DROP TABLE ittran;
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& CHECK YOUR PROGRESS 12.5

1. Foreign key constraint can be enforced by using the ________ constraint.

2. The ________ command is used to modify the contents of column(s) of a table.

3. The __________ constraint is used to verify the data as per specified business rules.

12.6 TRANSACTION CONTROL COMMANDS

A transaction is one logical unit of work consisting of one or more logically related statements. The

commands used for controlling are:–

(i) Commit - Ends the current transaction by saving database changes and starts a new transaction.

(ii) Rollback - Ends the current transaction by discarding database changes and starts a new transaction.

(iii) Savepoint - Defines breakpoints for the transaction to allow partial rollbacks.

 To Rollback, Please ensure that AUTOCOMMIT feature must be off. To off this feature, give the

following command:

SQL>SET AUTOCOMMIT OFF

For Deleting, Droping, updating in a table, try to use the above command so that changes made by you

unknowingly will not  saved in the database and you can rollback to old status.

Example:–

SET AUTOCOMMIT OFF;

UPDATE emp SET comm. = 700 WHERE empno = 7499;

SAVEPOINT set_comm;

UPDATE emp SET  comm.= 9000;

ROLLBACK TO SAVEPOINT set_comm;

COMMIT;

12.7 VIEWS

A view is a virtual table and is like a window to a table. It does not have any data of its own, but derives

the data from the table it is associated with. The main properties of view are as given:–

F A view is a database object that contains no data of its own.

F It is a virtual table whose contents are taken from other tables through the execution of a query.

F The changes in the tables are automatically reflected in the views.

F A view is created with the CREATE VIEW command.

F A view is queried just like querying a table.

F A general user cannot distinguish between a table and a view.
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Syntax

CREATE VIEW <viewname> AS <query>;

Example:–

CREATE VIEW dept20 AS SELECT * FROM emp WHERE deptno = 20;

After creating a view, it can be queried just like querying a table.

SELECT * FROM dept20;

There are several advantages of views which includes:–

(i) SECURITY - Users can be given access to only the rows/columns of tables that concern them.

(ii) Data Integrity - The WITH CHECK OPTION clause is used to enforce the query conditions on

any updates to the view.

(iii) Protection from change - If the structure of the database changes, the user's view of the data can

remain the same.

12.8 SUMMARY

SQL is available in a number of database management packages based on the relational model of data. It

allows for data definition, data manipulation and data control for a relational database. It maintains the data

integrity. SQL can also be embedded in front end tools like visual basic, java, dot net etc. to provide the power of

back-end. It is easy and English type language which can be used to handle data efficiently.

12.9 GLOSSARY

Comment Text that is not executed.

Data TypeMeans to identify type of data and associated operations for handling it.

Equi-Join Join in which tables are compared for equality.

Functions edefined command set that carries out an operation and returns a single value.

Inner Join Join that selects only matching rows from joining tables.

Join A query that combines rows from one or more tables.

Literal Fixed data value

Multiple-Row A function that works on values of a group of rows.

Function

Natural Join Join that consists of only one of the identical columns, coming from joined tables.

Null Un-initialized value i.e. Column with no value.

Outer JoinJoin that selects all rows from one joining table and only matching rows from other joining

tables.

Query A command  given  to  produce certain specified information from the database table(s).

Self Join A table joined with itself.

Single-Row A function that works on a value in single row.

Function

Sub Query A query statement that appears inside another SQL statements.
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12.10 FURTHER READINGS

The following books are suggested for further reading:-

1. Ramakrishnan and Gharke, Database management Systems, Tata McGraw Hill Pub. Co. Ltd.

2. Leon and Lcon, SQL, Tata McGraw Hill

3. Abbey and Corey, Oracle 8i, Tata McGraw Hill Pub. Co. Ltd.

4. An introduction to Database Systems, Bipin C. Desai, Galgotia publications

12.11 ANSWERS TO THE SELF LEARNING EXERCISES

 Answers to check your progress 12.3

1. Two hyphens (--)

2. VARCHAR2

3. Literal

4. DDL

5. DML

Answers to Check Your Progress 12.4

1. SELECT

2. LIKE

3. HAVING

4. WHERE

5. SELF

6. DUAL

7. Nested Query

Answers to check your progress 12.5

1. References.

2. Update

3. CHECK

12.12 UNIT-END QUESTIONS

1. Name some basic SQL elements.

2. Differentiate between CHAR and VARCHAR2 data types.

3. Write a query to display details of employees who do not have manager.

4. What is the significance of GROUP BY clause in a SQL query?

5. What is the difference between WHERE and HAVING clause of SQL SELECT statement?

6. What do you mean by Join? Explain different types of joins.

7. What are views? Explain the features of views.

8. What do you mean by SavePoint?

9. What do you mean by constraints? Explain the foreign key concept.

10. What are aggregate functions? Explain with example.

����
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Unit XIII : WEB DESIGNING

Structure of the Unit

13.0 Objectives

13.1 Introduction

13.2 Basics of World Wide Web

13.2.1 World Wide Web

13.2.2 Uniform Resource Locator (URL)

13.2.3 Hyper text transfer protocol (HTTP)

13.2.4 Web Server

13.2.5 Web Page

13.2.6 Web Site

13.2.7 Web Browser

13.3 Hyper Text Markup Language (HTML)

13.3.1 Web Page Layout

13.3.2 HTML Tags

13.3.3 Color Schemes

13.3.4 Font and Font Size

13.3.5 Subscript and Superscript element

13.3.6 Heading element

13.3.7 Paragraph element

13.3.8 Horizontal Line element

13.3.9 Arranging text with Lists

13.4 Linking and Inserting Images

13.4.1 Links to Web and documents

13.4.2 Inserting Images in the web page

13.5 Arranging Information in Tables

13.6 Frames

13.7 Forms

13.7.1 Understanding Form element

13.7.2 Form control elements

13.7.3 Menu Controls by SELECT element

13.8 Getting connected and publishing your web site

13.9 Summary

13.10 Glossary

13.11 Further Readings

13.12 Answers to the self learning exercises

13.13 Unit-end questions
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13.0 OBJECTIVES

After going through this unit student will be able to :

F Understand the key concepts of WWW

F Can create web  pages with basic tags

F Can use advance concepts of tables, frames and forms

F Understand to publish the web site

13.1 INTRODUCTION

World Wide Web is expanding at an incredible pace. The basic building blocks of www are documents

developed by HTML. HTML has become the standard development language for web pages. This unit emphasizes

on building the web pages starting from the basic tags to advanced features. It also provides you the advanced

means of controlling web page layout.

13.2 BASICS OF WORLD WIDE WEB

13.2.1 WWW - World Wide Web

The World Wide Web is a collection of millions of files stored on thousands of computers (web servers)

all over the world. These files represent text documents, pictures, video, sounds, programs etc. that has ever been

recorded in computer files. The web is the largest and most diverse collection of information ever assembled.

It is an example of client-server technology. The internet user using a software known as the web browser,

requests a document located on the web. The browser makes the request to the internet host containing that

document. The flow of information is controlled by a protocol called Hyper Text Transfer Protocol (HTTP).The

client web browser marked an HTTP request and is served by an HTTP server known as Web Server.

13.2.2 Uniform Resource Locator (URL)

The technique used to address documents on the web is called the Uniform Resource Locator. The URL

provides an addressing scheme which allows the browser to request just about any document or web page

located anywhere on the internet. In most cases specification of the port address is not required as the servers

themselves have a default port address. It is 80 for HTTP. A URL normally takes the following form as below:-

P ro tocol A ccess typ e

h ttp :// H T M L do cum en ts

h ttp s :// S ecu re  H T M L  d o cu m ents

ftp :// F T P  s ites  and  file s

file :// H T M L do cum en ts on  loca l ha rd  d riv e

G o ph er:// G o ph er m enu s an d  d o cu m en ts

m a ilto : E -M ail m essages

teln et: R em o te T elne t (lo g in ) se ss io n

n ew s: U seN e t new s g rou p
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<Protocol>://<web-server-name>/<directory-name>/file-name>

Such as :   http://www.rediff.com/docs/wpage.htm

Some protocols for URLs are as given above.

There are three different types of URLs - Absolute, Relative and Fragment.

(i) Absolute URL - It uses a complete internet address to give the location of a resource. It designates

the protocol, host, path and name of a resource.

(ii) Relative URL - It is not fully qualifies, but rather it inherits the protocol, host and path information

from its parent document. Relative URLs sometimes called 'partial URLs' are used for accessing files

when the full internet address is unnecessary i.e. when most hyperlinks point to documents and other

files located on the same site. For example : images.htm is a relative URL.

(iii) Fragment URL - Using either the name attribute of an <A> element or the id attribute of any element

creates an anchor. These anchors can be referred in bookmark way as a fragment URL.

13.2.3 Hyper text transfer protocol (HTTP)

A web page is created by using a specialized language called Hyper Text Markup Language (HTML).

Web pages are requested by internet users from the internet hosts or servers and are served over the internet using

a protocol called http. The client web browser makes an http request and is served by an http server.

HTTP protocol (set of rules) enables hypertext data to be transferred from one computer to another.

HTTP enables user to retrieve a wide variety of resources such as text, graphics, sound etc. and allow hypertext

to access other internet protocols. The following steps accomplish this task:

F Connection– is the establishment of networked TCP/IP connection between a client and a server

thus enabling communication between them.

F Request– initiates from a client requesting for specific services or resources.

F Response– communicates to the client from the server. It supplies the requested resource.

F Close–is the termination of TCP/IP connection.

13.2.4 Web Server

Web server is responsible to accept connections from web browsers all over the internet and when

requested, sends the html documents that are available in the site. This is done by using the http protocol.

A web server is simply a computer with an internet connection that runs software designed to send out

HTML pages and other file formats (such as multimedia files). The server should have a high speed connection on

the internet and powerful enough to deal with a number of simultaneous connections from the internet. It requires

a robust operating system.

13.2.5 Web Page

A web page is a single unit of information, often called a document that is available via the World Wide

Web (WWW). A web page is an HTML document that is stored on a web server and that has a URL so that it can



246

 Web Designing                                           Unit-XIII

be accessed via the web. A web page can be longer than one computer screen and can use more than one piece

of paper when it is printed out.

A web page is created by using HTML. It consists of standardized codes or "tags", which are used to

define the structure of information on a web page. These codes enable web pages to have many features including

text effect like bold, italic, headings, bulleted, numbered, tabular etc. Normally a web page contains several

hyperlinks which refer to different web pages or part of the same web page or to different web site pages. A

sample web page is as follow :-

13.2.6 Web Site

A web site is a collection of Web pages belonging to a particular person or organization. Each document

on the web site, which may contain only text or a combination of text, images and multimedia is called web page.

The URLs of these pages share a common prefix, which is the address of the home page of the site. The URL of

the home page also serves as the URL of the web site. The default home page usually refers to index.htm or

default.htm web page.

The possible hierarchy of the web site is as under:-

Home page

(Index.htm or default.htm)

About the 

University

Courses Students Faculties Results

P.G. U.G.
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13.2.7 Web Browser

A browser is software that retrieves HTML documents across network connections and formats them for

viewing. A browser can be assumed as a vehicle for accessing the World Wide Web.

 A web browser is a client application that requests, receives and displays HTML pages or a web browser

is a program that clients computer runs to communicate with the web servers on the internet, which enables it to

download and display the web pages requested. Browsers are the "window to the web" for internet user around

the world. A web browser can display many types of files offline i.e. when the user is not connected to the internet.

Some popular browsers are :

F Microsoft Internet Explorer

F Netscape Navigator

F Mosaic

A good home page for a browser is one that loads quickly, contains information that user wants to check

regularly and links to a wide variety of other pages. Most browser windows have the same basic layout. These

basic elements are:–

F Menu bar

F Toolbars

F Address window

F Viewing window

F Status bar

Depending on the web browser features, user can access to some or all of the following ways to keep

track of web sites:–

F Bookmarks– browser establishes a bookmark file when it is installed and populates it with links in

a variety of categories.

F Favorites–It behaves like bookmarks. It is a folder of internet shortcuts. When  a user choose from

a menu, browser goes to the web page that the favorite denotes.

F History – Browser stores the recently visited web pages in  the  form  of  internet shortcuts that are

arranged into a hierarchy of folders inside the history folder or in a history database.

& CHECK YOUR PROGRESS 13.2

1. The default port address for HTTP is ______.

2. ______ specifies the location of the web page.

3. _______ is termed as the first home page.

4. To view any web page, we require _________.
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13.3 HYPER TEXT MARKUP LANGUAGE (HTML)

HTML is designed to specify the logical organization of a document, with important hypertext extensions.

It has its own syntax and rules for proper communication. HTML is not really a programming language instead it

is a markup language. It is designed to be a universal language for classifying the functions of different sections of

a document or to define the different parts of page i.e. which part of document is title, body etc. HTML documents

can be viewed by many different browsers of very different abilities. Pure HTML web page produces a static web

page. A dynamic web page can also be created by using JavaScript and ASP.

HTML comprises of three major elements that gives a well-structured look for a document. Some of

these elements are optional yet their usage assures a better presentation.

F Head

F Body

F Footer

HTML instructions (tags) divide the text of a document into blocks called elements. These can be divided

into two broad categories - those that define how the BODY of the document is to be displayed by the browser

and those that define information about the document such as the title or relationships to other documents. Almost

80% of HTML tags will occur within a document's body. In browser, the tags themselves are not displayed but

their effect is. Any tags and attributes that are unknown are ignored.

13.3.1 Web Page Layout

Before designing a web page it is preferable to follow the following norms:-

F The first and foremost aspect to be considered is the content that has to be written in the page.

F The paragraph should be short and to the point.

F The document should contain a title to identify the web page.

F Sufficient space must be provided between paragraph and heading for clarity.

F Usage of heavy graphics should be kept bare minimum to reduce the display time from  the server.

F The pages should not be long as the user will find it annoying to use the scroll bar to view  the rest of

the screens. In such cases pages can be split into multiple pages.

F Before uploading/publishing the web page it is better to proof read and check the spellings.

13.3.2 HTML Tags

Most of the tags supported by HTML are stand alone tags. There are few paired tags also. They are

defined as <start-of-tag>…...</end-of-tag>. The basic tags required to build a HTML documents are as under:-
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Basic tags

Tag Description

<html>…</html> Indicates the beginning and ending of HTML document

</head>…</head> Indicates the beginning of document header

</title>…</title> Indicates the title of the web page

<body>…</body> Indicates the beginning of body of the web page

A sample html document is as under:–

Example:

<html>

<head>

      <title>My First Web Page</title>

</head>

</body>

Hello Students, Our first web page ! Try out.

</body>

</html>

To see the output of the above html code, use the following steps:–

1. Open a notepad file.

2. Type the above code and save this file as a __.htm or __.html extension.

3. Now open internet explorer. Select File->Open.

4. click the Browse button and select the file that we created above or double click the file which shows

the icon of internet explorer.

Note : While saving in notepad, Remember to give file name in double quotation as "w1.htm" and save.

 There are two categories of body elements for formatting the web page :–

F Block level elements– used to define groups of text for a specific role.

F Text level elements– used to mark up text, style, links, images etc.

Formatting tags

Format Tags Description

Block Level

Paragraph <p>…</p> Indicates start and end of paragraph

Line Break <br> Indicates the change of line.

Horizontal line <hr> Draws a horizontal line on the web 

page

Preformatted Text <pre>….</pre> It preserve the white spaces, line 

breaks within the text.

Centers the text <center>…</center> Centers the entered text on the page

Indented text <blockquote>…</blockquote> Displays the indented text
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Format Tags Description

Text Level

Bold <b>…</b> bold effect on the text

Italic <i>…</i> Italic effect on the text

Underline <u>…</u> Underlines the text between the tag

Hyperlink <a href="url">…</a> Hyperlinks the text between the tag

Image <img src="url"> Displays the mentioned image

Heading <h1>…..</h1> Heading level 1

<h2>…..</h2> Heading level 2

<h3>…..</h3> Heading level 3

<h4>…..</h4> Heading level 4

<h5>…..</h5> Heading level 5

<h6>…..</h6> Heading level 6

Example

<html>

<head><title>My Second Page</title></head>

<body>

<h1>HTML is easy</h1>

<h2>HTML is easy</h2>

<h3>HTML is easy</h3>

<center><h4>HTML is easy</h4></center>

<h5>HTML is easy</h5>

<h6>HTML is easy</h6>

<B><i>HTML</i>tags are <u>case insensitive</u></b><br><hr>

<p>Though there are six levels of header supported by HTML, only first four levels

can be easily identified. It is a good practice to give consistent headings throughout

our web page.</p>

<blockquote>It is better to test the HTML document by using more than one browser.</blockquote>

<pre> This    gives the      effect of pre formatted text.     It does not

              removes the extra spaces

              and                       line breaks.   Normally HTML   removes extra spaces and

      line breaks.</pre>

<p>Now      Browser        <b>removes</b> the extra spaces

           and line breaks   </p>

</body>

</html>

You can understand the output of the above code in the Internet explorer as under:–
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Note : Avoid some characters such as the quote("), the ampersand (&) and the angle brackets (< and >)

which have some special meanings.

13.3.3 Color Schemes

To change the color scheme of your web page, you can use the six body attributes to give the effect on the

web page. The attributes are BGCOLOR, BACKGROUND,TEXT, LINK,VLINK and ALINK.

Colors can be specified by the name of the color or the RGB code. The color names can be specified as

Black, silver, grey, white, maroon, red, purple, blue, yellow, green, aqua etc.

RGB codes are always six numbers and block of two numbers are in hexadecimal, two numbers specify

an amount of red, next two represents green and last two represents blue. By tradition, hexadecimal colors are

preceded by a sign #. For example blue color can be represented as "#0000FF". FF stands for maximum and 00

for nil. The following codes will give different effects:-

<body bgcolor="red">

<body bgcolor="#FF0000"> changes the background of web page in red color.

<body text="#0000FF"> changes the text in blue color

<body background="clouds.jpg"> puts the clouds picture as the background.

<body link="#008800"> changes the hyperlink color to shade of green. Default color of hyperlink is blue.

<body alink="#9900ff"> changes the active link color. Default color is red.

<body vlink="#90909a"> changes the visited link color. Default color is a shade of purple.

We can combine all or some of the above attributes as under:-

<body bgcolor="ff0011" text="0011ff" vlink="#90909a">
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13.3.4 Font and Font Size

On the web page you can change the font, size, color of the font by using the font tag with the three

attributes:–

F Color– specifies the color of a block of text

F Size– for relative or absolute sizes of text

F Face– for specifies a font face such as verdana, arial Algerian etc.

<font color="blue"> The color of the text converted in blue</font>

<font face="verdana"> Changes the font face to verdana</font>

<font size="5"> Absolute size </font>

<font size="-1">changes size relatively to 4 or +1 to 5</font>

<big>..</big> makes text one size larger.

<small>….</small> makes text one size smaller.

There are seven size values ranging from 1 to 7. 1 is very small and 7 is larger than level one heading.

<font face="arial" color="#aa5588" size="4">Hello, See the effects </font>

13.3.5 Subscript and Superscript Element

The subscript element <sub> and </sub> changes the enclosed text in subscript. The superscript element

<sup> and </sup> changes the enclosed test in superscript.

H<sub>2</sub>O and X<sup>2</sup>+Y<sup>2</sup>

13.3.6 Heading  Element

The heading start tags <h1> to <h6> can each use one of the following attributes to control the horizontal

alignment of the heading:-

Align="LEFT" or Align="RIGHT" or Align="CENTER" or Align="JUSTIFY"

<h1 align="center"><font color="red">HTML Heading one </red></h1>

13.3.7 Paragraph  Element

<p> tag starts the paragraph from new line. This tag is also having align attribute as left,  center, right and

justify. The default alignment is left.

<p align="center"> This is a new paragraph </p>

13.3.8 Horizontal Line element

<hr> - It draws a horizontal line. It has many attributes as under:-

Align="Left" or "Right" or "Center"

NOSHADE - unshaded dark line with slightly 3d appearance.

Size="[number]"  - The number must be in pixels. The default value is 2.

Width="[number]"  - The number must be in pixels.

Width="[percent]"   - percent value
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<hr noshade>

<hr size="4">

<hr noshade size="12">

<hr size="4" width="40%" align="right">

13.3.9 Arranging text with Lists

HTML provides several styles for building lists. The list elements can be arranged using number and

bullets. This improves readability to a certain extent while organizing list elements. There are three types of lists as

under:-

F Unordered Lists by <ul>…</ul> tag. It produces bullets for list items.

F Ordered Lists by <ol>…</ol> tag. It produces numbered list in a way.

F Definition Lists by <dl>…</dl> tag. It consists a term followed by its definition.

Both ordered and unordered lists require start and end tags as well as the use of a special element to

indicate where each list item begins(<LI> tag).

<ul> tag has the Type attribute which can have the values 'CIRCLE' for hollow bullet, 'DISC' for solid

bullet or 'SQUARE' for solid block. The default is DISC.

Example of unordered list

<BODY>

<UL>

    <LI>HTML

    <LI>VB

    <LI>JAVA

</UL>

<UL TYPE="SQUARE">

    <LI>HTML

    <LI>VB

    <LI TYPE="DISC">JAVA

    <LI TYPE="CIRCLE">ASP

</UL>

One important aspect of lists is that we can nest one list inside another to create a sub list.

Ordered list uses numbers instead of bullets, and we can use and attribute to start numbering at a number

other than one.

With <OL> tag we can use the type attribute with the values given below:–

Type="1" Shows Arabic numbers
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Type="a" Shows lowercase alphabets a,b,…z, aa,ab,…

Type="A" Shows uppercase alphabets A,B,C,….

Type="i" Shows lowercase Roman Numbers as i,ii,….

Type="I" Shows uppercase Roman Numbers as I, II, III…

Start="x" to start with the desired number.

Arabic numbers are the default.

Example of ordered list

<BODY>

<OL>

    <LI>HTML

    <LI VALUE="10">VB                                 <!-- Forced Number -->

    <LI>JAVA

</OL>

<OL TYPE="I">

    <LI>HTML

    <LI>VB

    <LI TYPE="DISC">JAVA

    <LI TYPE="CIRCLE">ASP

</OL>

Defining terms and Definition List by <DL> tag. <DT> tag is used for definition terms. <DD> is used for

definition themselves.

Example of definition list

<DL>

<DT>HTML

   <DD> Creates web pages

<DT>VB

    <DD> Creates applications

</DL>

& CHECK YOUR PROGRESS 13.3

1. What is HTML?

2. What is the purpose of using <BODY> tag.

3. Differentiate between container tags and empty tags.

4. What is the method of using comment line in a HTML Code?
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13.4 LINKING AND INSERTING IMAGES

13.4.1 Links to Web and documents

We can create links of text, images etc. and can connect to the desired source. There are two types of

links as:–

F External Links–These are the links to files which are not available on the current site.

F Internal Links– These are the links to files that are the part of the own site.

Anchor element uses the <A> and </A> tags to create both external and internal links with href  and title

attribute.

<a href="http://www.rediff.com/" title="rediff link">Click to link to rediff.com</a>

It creates a external link. For internal links, follow the two steps as below:-

* In the target or current document give a name to the section

* Specify the  name in the link

<a name="first"> First Portion of the document</a><br><br>

<a href="#first">Go to First</a>

13.4.2 Inserting Images in the web page

Graphics/Images add interest and looks to web pages. By Graphics we can produce eye-catching images

to draw the attention of the end user and also we can use images as hyperlinks. We can use different types of

graphic files in our web page such as GIF(Graphics Interchange Format) and JPG or JPEG (Joint Photographic

Expert Group) files. We can include images in our web page through <IMG> tag.  It uses the following attributes:-

SRC(file or url). It specifies the location of the image file.

ALT(alternate text). It specifies the text which would be displayed, if the browser does not support

graphics.

ALIGN(TOP, MIDDLE or BOTTOM). It aligns the text according to the specified position.

<img src="clouds.jpg">  This code will create inline image with text.

To make an image appear as a separate paragraph, enclose it with the paragraph element.

<p><img src="clouds.jpg" alt="clouds"></p>

<img src="clouds.jpg" align="MIDDLE"> it align from the middle with text of the line.

<img src="clouds.jpg" width="120" height="175"> it creates a fix size image. Size is in pixels. Advantage

of giving height and width is that browsers will take less time to show the page.

<img src="clouds.jpg" border="1"> it creates a thin border around the image. By default there is no

border around the image.

Images can be used as hyperlink also as:–

<a href="http://www.yahoo.com"><img src="clouds.jpg">Go to  Yahoo</a>
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& CHECK YOUR PROGRESS 13.4

1. The location of the image file is specified by using the ________ attribute.

2. The tag provides hypertext link capabilities is __________.

3. What is hyperlink?

4. What is ALINK and VLINK?

13.5 ARRANGING INFORMATION IN TABLES

The <TABLE>..</TABLE> tag as the name indicates sets the contents in a row and column format. The

table can contain any kind of data i.e. it can include links, paragraphs, all header levels, another table, preformatted

text, images and so on. The attributes related to table are:-

F The Optional caption element consists  of the <CAPTION>…</CAPTION>  tag  for table heading.

It can be positioned using the ALIGN attribute. It can be TOP, BOTTOM, LEFT or RIGHT.

F The table row element <TR>…</TR> to define the row.

F The table data element uses the <TD> … </TD> to provide the data.

F The table heading <TH> … </TH> creates the heading cells.

F <TH> and <TD> can also be aligned. The possible alignments by using ALIGN attribute are LEFT,

RIGHT or CENTER.

<TABLE> tag contains the following attributes:–

F BORDER - This attribute makes the table border. If  border  attribute  is  omitted,  it assumes a

default value as 1 pixel. To remove the border from the table, give border="0".

F ALIGN - It aligns the table in the page. There are three alignments LEFT, RIGHT and CENTER.

The default value is LEFT.

F WIDTH - It sets the width of the table in percent or in number (in pixels). If we  don't specify the

width, then the table will be only as wide as absolutely necessary.

F CELLSPACING - It sets the space in between each cell in the table. It takes the value in

number(pixels). Default value is 2. cell spacing is the common border width around each cell.

F CELLPADDING - It determines space between the cell data and the cell borders.

<TR> tag includes the following attributes:-

BGCOLOR – It determines the background color of the row.

ALIGN – It is used for horizontal alignment as LEFT, RIGHT or CENTER.

VALIGN – It is used for vertical alignment as TOP, MIDDLE, BOTTOM and  BASELINE.

Example:-

<TABLE BORDER="3" ALIGN="CENTER" WIDTH="60%" CELLSPACING="10"

CELLPADDING="5">



Unit-XIII         Web Designing

257

<CAPTION ALIGN="BOTTOM">Computer Languages</CAPTION>

<TR BGCOLOR="#BB6699" ALIGN="RIGHT" VALIGN="BOTTOM">

<TH>S.N.

<TH>Name

</TR><TR><TD>1.

<TD>HTML</TR>

<TR><TD>2.<TD>JAVA</TR>

</TABLE>

COLSPAN and ROWSPAN attribute can be used in a cell to make the cell's contents merge with

another cell. These attributes can be used in <TD> or <TH> tag.

<TD COLSPAN="NUMBER">

<TD ROWSPAN="NUMBER">

Images and other items can be inserted in table cells as and when required.

& CHECK YOUR PROGRESS 13.5

1. What is table? What are the basic tags used for the creation of the table?

2. What is CELLPADDING?

3. The default value for the BORDER attribute is______.

13.6 FRAMES

Frames are used to divide the web page into multiple page frames. Frames can control the layout of the

browser window by segregating the window to rectangular sections and loading separate HTML files into each

section of the window. Its limitation is that all browsers do not support frames. The following basic tags are

associated with the frames:-

<Frameset>…</Frameset> tag divides pages into frames. It has the following attributes:-

COLS –Divides documents into columns

ROWS– Divides documents into rows.

<FRAME> tag specifies the file to be displayed in each frame. It has the following attributes:-

SRC– Specifies URL of the HTML file

NAME – Specifies the name of the frame

NORESIZE – Specifies that the size of the frame is fixed i.e. it cannot be altered by the users.

SCROLLING– Specifies scroll bars. It can take values Yes, No or Auto.

Frameset documents have a different structure than normal HTML documents. A regular HTML document

has a head element and a body element, but a frameset document has a head element and a frameset element.
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Example for main file which divides the page into frames:-

<html>

<head><title>A sample program for frame</title></head>

<frameset cols="50%,50%">

<frame src="file1.htm">

<frame src="file2.htm>

<noframes>

<body> Your browser does not support frames</body>

</noframes>

</frameset>

</html>

This example divides the web page into two columns. We can divide rows also or can nest the frames.

<frameset rows="25%,75%">

<frame frameborder="0" src="url">

<frameset cols="50%,50%">

<frame src="url">

       <frame src="url">

</frameset>

</frameset>

Frames can be divided in ratio also as:-

<frameset cols="1*,3*">

Frames can be named by using name attribute. We can target any html link file to the targeted frame.

<frame src="url" name="main">

In any html file shown on any frame we can use the link attribute as under:–

<UL>

<LI><A HREF="java.htm" TARGET="main">Java</A>

<LI><A HREF="vb.htm" TARGET="main">VB</A>

</UL>

If target frame name is missing then the browser will create a new full-sized window.

Four predefined names that can be targeted by an anchor. These four targets have special meanings. They all

stat with an underscore(_). All four of these special target names are case-sensitive. The special target names are:-
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1. _blank – Cause the document to be loaded into a new window.

2. _parent– it refers to the parent frameset.

3. _self – it loads the document into the current frame.

4. _top – it removes frames altogether.

& CHECK YOUR PROGRESS 13.6

1. What is a frame?

2. What is FRAMESET?

3. Frames can be used to control the ________ of the browser window.

13.7 FORMS

A form is simply a collection of fields of information. These fields of information come in many different

varieties such as text boxes, radio buttons, pull down menus and other elements. The more general term for a field

in a form is a control.

13.7.1 Understanding Form Element

The simplest type of form is just a button that links to a URL. This type of button is sometimes called a GO

button. The simplest form looks like as:-

<BODY>

<FORM ACTION="http://www.yahoo.com" METHOD="GET">

<INPUT TYPE="SUBMIT" VALUE="GOTO YAHOO">

</FORM>

</BODY>

The form element begins with the <FORM> tag. Three attributes of FORM are:-

F Action is used here to specify the address that should receive the form information.

F Method specifies that the form information should be posted to the URL  given  in  the action

attribute. There are only two possible values GET or POST.

F ENCTYPE indicates what MIME type should be used when the information is posted.

13.7.2 Form Control Elements

The form element can contain different elements to create form controls. The INPUT element is used to

create a variety of controls including text boxes and buttons.

F TEXT – is used for single line text box.

F PASSWORD – is similar to text, except characters are not revealed on screen.

F CHECKBOX – is an Yes/No Option.

F RADIO – Similar to checkbox except that in a group of radio buttons.



260

 Web Designing                                           Unit-XIII

F SUBMIT– Submits a form to be processed.

F IMAGE– Exactly the same as a submit button except that we can specify any image instead of the

normal gray button appearance.

F RESET– Clears all of the input on a form, resetting it back to its default appearance.

F HIDDEN– A hidden input is not displayed on screen at all.

F FILE – can be used to send a file from surfer's computer along with the rest of the form data.

The different types of form controls can use attributes in various ways such as the SIZE, MAXLENGTH,

VALUE and CHECKED attributes.

Example:

<FORM>

<INPUT TYPE="TEXT" NAME="nm" size="30" VALUE="RAJEEV SRIVASTAVA">

<INPUT TYPE="PASSWORD" NAME="PW">

<INPUT TYPE="CHECKBOX" NAME="mail">Pl.send me mail.

<INPUT TYPE="RADIO" NAME="LANG" VALUE="VB" CHECKED>VB

<INPUT TYPE="RADIO" NAME="LANG" VALUE="JA" >JAVA

<INPUT TYPE="RADIO" NAME="LANG" VALUE="CP" >C++

<INPUT TYPE="SUBMIT" VALUE="OK"><INPUT TYPE="RESET" VALUE="CANCEL">

</FORM>

13.7.3 Menu Controls by SELECT element

The select element must contain one or more option elements. The select element must begin with a

<SELECT> tag with a required name attribute. It will create a drop-down menu control.

<SELECT Name="Users" SIZE="5">

<OPTION SELECTED >Rajeev Srivastava

<OPTION>Ashok Sharma

<OPTION>Sanjay Gupta

</SELECT>

If size is less than the number of options than scroll bar will appear. If size is greater than number of options

than blank lines will appear. By default, only one item can be selected from the list. If we specify the optional

MULTIPLE attribute, then more than one item can be selected by holding down the CTRL key. SELECTED

element can indicate the default menu item.

TEXTAREA element is used to create multi line text. It has the following attributes:–
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F Name – specifies the name of the text area.

F Rows – Specifies the number of Rows.

F Cols – Specifies the number of columns.

<TEXTAREA ROWS="5" COLS="60" NAME="feedback">

General Comments:

</TEXTAREA>

LABEL element is used to create labels.

<LABEL>First Name : <INPUT TYPE="TEXT" NAME="fnm"></LABEL>

Forms can be processed in three ways to process a form:–

F By using a CGI program

F By using a mailto link

F By using a script.(JavaScript and VBScript)

Some HTML extensions (Not supported by some browser)

<BLINK>…</BLINK> It shows blinking text.

<MARQUEE>…..</MARQUEE> It creates a region with scrolling text.

& CHECK YOUR PROGRESS 13.7

1. What are the two methods used in FORM tag?

2. What is the purpose of SELECT tag?

13.8 GETTING CONNECTED AND PUBLISHING YOUR WEB SITE

The only way to create a web site is to publish pages to a web server. For this, we have to use File

Transfer Protocol (FTP) to copy files from your computer to the proper place. To publish on the web, we need an

internet account, web space, user name and password.

Publishing to the web

Publishing a web page involves a number of simple steps:-

1. Make sure the HTML documents and any image files are all named correctly.

2. Transfer the file(or files) to the correct directory on the web server using FTP.

3. Make sure that the permissions are correct.

When a user creates a first web file for the desired website, it will usually be the main home page that

introduces the rest of your pages. File name of the home page must be index.htm or default.htm.

When you open an account with an ISP that includes web space, they will create a URL on their server

that anyone can use to view your web pages like www.yoursite.com etc.

However, this URL is not the same address in which the user transfer the files. Web files must be trans-
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ferred to a particular FTP url that is usually different from the normal url. This FTP address is only needed when

you publish your web site.

13.9 SUMMARY

The explosive growth of the World wide web is relatively unprecedented. As personal computers become

more common in home and offices, people began to learn to use them for document creation and page layout. The

technique used to address documents on the web is called the Uniform Resource Locator(URL). A web page can

be created by using HTML. It was conceived for transmission over the internet in the form of web pages. It

follows the hyper text transfer protocol (http) to manipulate the web pages using browsers. This unit enables the

student to create simple static web pages. To create dynamic web pages, student must learn JavaScript, ASP etc.

which can be embedded in HTML pages.

13.10 GLOSSARY

Browser Clients software for displaying web pages and using hyperlinks to navigate the web.

Client A combination of computer and software capable of receiving information and instructions from a

remote host computer or server.

HTML Element Commonly referred as a tag. It is a component of hierarchical structure, defined by a

document type definition.

FTP File transfer protocols used for remote login to a computer to exchange files over a TCP/IP network.

Form An HTML component that enables web authors to have input fields on their pages, permitting

feedback from users and offering interactive options.

Frames Presents information as concurrently displayed group of pages.

Hyperlink A connection between one file and another file or inside a file.

Internet A worldwide network of computer using communication using agreed-on  protocols.

Server A combination of computer and software and network connection capable of  providing informa-

tion and acts on request.

Tags Markup instruction in a HTML document presented in angled brackets.

Uniform Resource Locator The path to  a  specific document on  the  internet  that  consists  of

protocols,  a domain name or IP address a directory structure and the document name.

Web The Web is a subset of the internet that implements the concepts of hyperlinks to exchange informa-

tion and acts according to HTTP.

13.11 FURTHER READINGS

The following books are suggested for further reading:-

HTML 4 UNLEASHED by Rick Darnell

HTML 4
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13.12 ANSWERS TO THE SELF LEARNING EXERCISES

Answers to Check Your Progress 13.2

1. 80

2. URL

3. Index.htm

4. Browser

Answers to Check Your Progress 13.3

1. HTML is the scripting language, which is used to create web documents. HTML commands specify

the layout of a document as it appears on a web client.

2. The primary purpose is to display text, images and links that you want to display in your web page.

3. The container tags are pair  tags i.e. they require a starting tag as well as an ending  tag. They affect the

text appearing between  the  both  tags. The  empty  tags  just  require a starting tag and no ending tag.

They  just  carry  out  the  job assigned to them.

4. The comment line is declared as : <-- Any comments -->

Answers to Check Your Progress 13.4

1. SRC

2. <a href …>

3. The links between web pages is known as hyperlink.

4. ALINK defines the the color of a link as it is being clicked on web page. The default color is RED.

VLINK defines the color of a link after it has been visited. The default  color is purple.

Answers to Check Your Progress 13.5

1. Table consists of a number of rows and columns. The following basic tags are used for table

creation :–

<table>…</table>, <tr>…</tr>, <td>…</td>, <th>…</th> and

<caption>…</caption>

2. CELLPADDING tells the browser how much padding  is  required  in  the  cell i.e.the space

between the side of the cell and the contents of the cell.

3. One(1) pixel.

Answers to Check Your Progress 13.6

1. Frames allow us to divide the page into several rectangular areas  and  to display  a separate

document in each rectangle.

2. This is the main container for a frame.  It  has  two  attributes  ROWS  and COLS which  divides  the

web  page.  A  frame  document  has  no  BODY tag. By using  FRAME tag it can display different

web pages.

3. Layout

Answers to Check Your Progress 13.7

1. POST and GET. Post  is  by  far  the  more popular, as it allows greater amount of data to be sent.

GET  is  a little  easier, it  is  best  used with single responses like a  single textbox.

2. SELECT is a container tag. Options are places in  this tag with particular value that gets associated

with NAME attribute that chosen.
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13.13 UNIT-END QUESTIONS

1. What would happen if a <title> tag is not closed using </title>?

2. Can we link Web pages through images? If so, how?

3. Differentiate between BR tag and HR tag.

4. Differentiate between BACKGROUND and BGCOLOR.

5. What is unordered list?

6. What is anchor tag?

7. Explain the attributes of TABLE tag.

8. What does the ACTION attribute accept in FORM tag?

9. How do you tell an HTML form to send its data to the Web Server?

10. What is web publishing?

����
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14.0 OBJECTIVES

After going through this unit student will be able to:

F Understand the importance of XML in a maturing Internet

F Weakness of HTML that make it unsuitable for Internet Commerce

F Understand the XSL (eXtensible Style Language)

F Can view the Records of XML file

14.1 INTRODUCTION

XML is defined as an application profile of SGML. SGML is the Standard Generalized Markup

Language defined by ISO 8879 and has been the standard to maintain structured documentation from long time,

but is not well suited over the web. Defining XML as an application profile of SGML means that any SGML

system will be able to read XML documents. XML is a restricted form of SGML. XSL was originally conceived

as an answer to the styling needs of XML.  XSL effectively defines a superset of the styling functionality currently

available in CSS, but the document transformation capabilities of XSL are particularly suited to XML. XSL is

based on both DSSSL (Document Style Semantics and Specification Language) and CSS(Cascading Style Sheets)

of HTML, so it represents the merging of a great deal of style sheet knowledge.

14.2 BASICS OF XML

14.2.1 HTML weaknesses

Although HTML considered as the most useful in internet application, but there have been a lot of

complaints leveled against it. People are now realizing that XML is superior to HTML. The following are the

weaknesses of HTML found by the lot of developers:-

F HTML lacks syntactic checking i.e. you cannot validate HTML code.

F HTML lacks structure.

F HTML is not suitable for data interchange.

F HTML is not content-aware.

F HTML is not object oriented.

F HTML lacks a robust linking mechanism.

F HTML is not reusable.

F HTML is not extensible.

14.2.2 Why XML?

XML was created so that richly structured documents could be used over the web. HTML is bounds with

a set of semantics and does not provide arbitrary structure. XML uses the features of SGML that it needs and tries

to incorporate the lessons learned from HTML. Why XML is considered better than SGML, the following goals

and degree that have already been met are:–
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F XML can be used with existing Web protocols and mechanisms and does not impose any additional

requirements. XML has been developed with the web in mind.

F XML is compatible with SGML and most SGML applications can be converted into XML.

F It is easy to write programs that process XML documents.

F The number of optional features in XML has been kept to an absolute minimum.

F XML documents are reasonably clear to the layperson. XML’s markup is reasonably self explanatory.

A valid XML document:-

F Describes the structural rules that the markup attempts to follow.

F Lists any external resources(external entities) that are part of the document.

F Declares any internal resources (internal entities) that are used within the document.

F Lists the types of non-XML resources(notations and binaries) used and identifies helper applications

that might be needed.

F The design of XML is formal and concise. Information marked up in XML can be easily processed by

computer programs.

F XML documents are easy to create. HTML is also famous for its ease of use, and XML capitalizes on

this strength.

14.2.3 WHAT IS XML?

XML is a markup language for documents containing structured information contains contents such as

text, pictures etc. and some indication of what role that content plays. Contents in a heading section have a

different meaning from content in a footnote etc. A markup language is a mechanism to identify structures in a

document. The XML specification defines a standard way to add markup to documents.

XML specifies neither semantics nor a tag set. XML is a meta-language for describing markup languages

or we can say XML provides a facility to define tags and the structural relationships between them. As in XML

there are no predefined tag sets, there can not be any preconceived semantics. All of the semantics of an XML

document will either be defined by the applications that process them or by style sheets.

As XML is a text-based markup language that is fast becoming the standard for data interchange on the

web. XML tags identify the data, rather than specifying how to display it. XML tag acts like a field name in our

program. It puts a label on a piece of data that identifies it. For example : <Greeting>….</Greeting>. We are free

to use any XML tags that make sense for a given application. For multiple applications to use the same XML data,

they have to agree on the tab names they intend to use. The following is the example of XML data can be used in

Greeting application:-

<greeting>

<to>coordinator_pgdca@vmou.org</to>

<from>srivastava@rediffmail.com</from>

<subject>Hello, Best wishes for PGDCA students</subject>
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<desc>

XML is easy for students. The can learn easily. Best wishes.

</desc>

</greeting>

The data between the tag and its matching end tag defines an element of the XML data. The ability for one

tag to contain another tag, which gives XML its ability to represent hierarchical data structures. As in HTML,

white space is irrelevant, so we can format the data for readability and can process it easily with a program. In

XML we can easily search a data set for greetings containing “Best” in the subject because XML tags identify the

content of the data.

& CHECK YOUR PROGRESS 14.2

1. XML is a markup language for documents containing ___________ information.

2. XML has been developed with the ________  in mind.

3. XML is fast becoming the standard for _______________ on the web.

14.3 STRUCTURE OF XML

The XML document is divided into two different structures – Logical and Physical structure.

14.3.1 Logical Structure

Each XML document contains one or more elements, The boundaries of which are either delimited by

start-tags and end-tags, or for empty elements, by an empty-element tag. Elements are the building bricks out of

which an XML document is assembled. Each XML document must have only one root element, and all the other

elements must be perfectly nested inside that element. Each element has a type, identified by name, sometimes

called as “generic identifier” (GI), and may have a set of attribute specifications. Each attribute specification has a

name and a value.

Home Page

Head

Title

Banner

Body

Main title

Rule

Text

Para

Footer

The Logical Structure of elements 
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The arrangement of the elements in an XML document is called the logical structure. In order to be usable

(technically, in order to be well-formed), the logical and physical structure of an XML document must be syn-

chronous.

14.3.2 Physical Structure

In XML, each document contains one or more elements. An XML document may consist of one or many

storage units. These are called entities, they all have content and are all identified by entity name.

Each XML document has one entity called the document entity, which serves as the starting point for the

XML processor and may contain the whole document. Entities may be either parsed or unparsed. The contents

of a parsed entity referred as its replacement text, this text is considered an integral part of the document. An

unparsed entity is a resource whose contents may or may not be text and if text, they may be other than XML

text. Each unparsed entity has an associated notation, identified by name. XML places no constraints on the

contents of unparsed entities.

Parsed entities are invoked by name using entity references, unparsed entities by name, given in the value

of ENTITY or ENTITITES attributes.

General entities are entities for use within the document content and sometimes referred with the

unqualified term entity. Parameter entities are parsed entities for use within the DTD. These two types of entities

use different forms of reference and are recognized in different contexts. They occupy different namespaces; a

parameter entity and a general entity with the same name are two distinct entities.

& CHECK YOUR PROGRESS 14.3

1. XML document may consist of one or more storage units which are called __________.

2. _________ entities are parsed entities for use within the DTD.

14.4  XML MARKUP

XML tags are created like HTML tags. Tags are most obvious component in XML syntax and are used to

describe elements. There’s a start and a closing tag like <tag>….</tag> as in HTML. The text between the

brackets is called an element. Tags are case sensitive.

Tags can also contain attributes, additional information included as part of the tag itself, within the angle

brackets. The syntax is:

<element attribute-name=”attribute-value”>…..</element>

The value of an attribute needs to be quoted, even if it contains only numbers.

Example:

<greeting from=”srivastava@rediffmail.com” to=”coordinator_pgdca@vmou.org”

 subject=” Hello-Best wishes for PGDCA students”>

<desc>

XML is easy for students. They can learn easily. Best wishes.

</desc>

</greeting>
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In XML commas between attributes are not ignored, if present, they generate an error.

XML elements can be empty, which means that they do not contain any parsed character data. Tags for

empty elements in XML must use a forward slash(/) after the element name to indicate that they are empty. So

the <br> tag becomes <br/> in XML.

One big difference between XML and HTML is that an XML document is always constrained to be well

formed. There are several rules that determine when a document is well-formed, but one of the most important is

that every tag has a closing tag. Another important aspect of a well-formed document is that all tags are completely

nested.

Comments in XML files

Comments are used in an XML document to present information that is not technically part of that

document’s content. XML comments are used to provide descriptions of document data purely for the sake of the

use or we can say, XML parsers and applications generally ignore comments.

Comments can be used anywhere within an XML document where parsed character data appears. Unparsed

characters data (CDATA) sections are the only exception to this rule.

Example : <!— Comment in XML — >

14.5 DOCUMENT TYPE DECLARATIONS AND VALIDATION

The DTD describes a model of the structure of the content of an XML document. This model says what

elements must be present, which ones are optional, what their attributes are and how they can be structured with

relation to each other. While HTML has only one DTD, XML allows to create own DTDs for applications. This

gives complete control over the process of checking the content and structure of the XML documents created for

that application. This checking process is called  validation.

Document type declarations are used in XML to specify information about a document, including the root

element and Document Type Definition (DTD). The document type declaration for a document is very important

in establishing whether the document is valid or just well-formed. The following are the three main tasks carried

out by a document type declaration:

F Specify the document’s root element.

F Defining elements, attributes and entities specific to the document (Internal DTD)

F Identifying an external DTD for the document

Example:  <!DOCTYPE EmployeeDetails SYSTEM “EmployeeDetails.dtd”>

The root element of the document is the EmployeeDetails element, and the external DTD for the

document is EmployeeDetails.dtd which is clearly specified in the document type declaration. XML parser uses

this DTD to validate the document if an application requires validation. The structure of an XML document is

determined by the document type declaration, which appears in the prolog of an XML document. Markup
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declarations are provided in the document type declaration that establishes the grammar for a document or class

of documents. The document type declaration can perform one or both of the following functions:

F Directly contain markup declaration in the prolog of the document that is collectively known as the

internal DTD subset or local DTD.

F Reference external markup declarations that are collectively known as the external DTD subset or

external DTD.

The reason for breaking the DTD into two parts has to do with flexibility. The external DTD subset

describes general document structure for a class of documents, while the internal DTD subset describes a

structure specific to a given document. The following types of markup declarations may be included within the

DTD:

F The types of elements allowed in the document, as well as their content models.

F The attributes that may be assigned to each element.

F Entities that are allowed in the document

F Notations that are allowed for use with external entities.

Internal and External DTDs

Internal DTDs must be declared in the document type declaration, while external DTDs must be refer-

enced. The following is the syntax of the document type declaration:

<!DOCTYPE RootElem SYSTEM ExternalDTDRef[Internal DTDDecl]>

Here ExternalDTDRef references the external DTD, which is the URI (Uniform Resource Identifier) of a

file containing the external DTD. The document type declaration must appear after the XML declaration but

before the first element (tag) in a document.

Example:

<!DOCTYPE organization SYSTEM “Organization.dtd”

[<!ELEMENT employee(#PCDATA)>]>

The root element of the document is organization i.e. all documents of this type must be contained within

the organization element. The document type declaration references an external DTD stored in the file

Organization.dtd. Additionally, an element named employee is declared as part of the internal DTD.

XML declaration is a processor instruction that indicates the version of XML for a document as :

<?xml version=”1.0”?>

In addition to the XML version, the XML declaration can describe the standalone status of a document,

as well as its character encoding.

<?xml version=”1.0” standalone=”no”?>

The two possible values for standalone are yes and no.
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CDATA Sections

Unparsed character data section or CDATA sections are used in XML documents to block off text that is

to be sidestepped by an XML.

<![CDATA[

<name>Rajeev Srivastava</name>

<address>Queens Road</address>

]]>

<city>Jaipur</city>

In the above example, the name and address elements are not recognized as XML markup and the data

contained  within them is not recognized as parsed character data, because the tags are placed within a CDATA

section. CDATA sections are one of the recommended ways to embed application code (JavaScript, VBScript,

perl and so on) in XML code.

& CHECK YOUR PROGRESS 14.5

1. Checking process in DTD is called _________.

2. CDATA sections are ______________.

3. _________ DTDs must be declared in the document type declaration

14.6 STYLING XML FOR DISPLAY

XML is a content based metalanguage, it does not mean much to refer to “Viewing an XML document”.

How do you view something does not include any information about how it is to be displayed ? To view an XML

document, the information must be provided about how it is to be rendered for display. This is accomplished with

style sheets that are coded using either CSS or XSL.

CSS is a cascading style sheet technology that was created for using with HTML but can also work well

with XML. XSL is more advanced style sheet technology that was created explicitly for use with XML. XSL is

more complex than CSS, but it is also considerably more powerful.

Browsing XML

The concept of browsing XML document was nothing more than a concept. Internet Explorer 5.0 is the

first commercial web browser to fully support XML 1.0. IE also supports some other closely related XML

technologies suc as XML DOM(a subset of XSL), the XSL namespaces.

14.7  THE XML DECLARATION

The first line of an XML document is the XML declaration. It’s a special kind of tag:

<?xml version=”1.0”?>

14.7.1 The root element

All XML documents must have a root element. All other elements in the same document are children of

this root element. The root element is the top level of the structure in an XML document.
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14.7.2 Structure of an XML page

<?xml version=”1.0”?>

   <root>

   <element>

<sub-element>

content

</sub-element>

    <element>

</root>

All elements must be nested. The level of nesting can be arbitrarily deep. For example:

<?xml version=”1.0”?>

<employee>

   <name>

        <firstname>Rajeev</firstname>

        <familyname>Srivastava</familyname>

         <title>Shri</title>

    </name>

    <address>

<houseno>149</houseno>

            <street>Avenue 7</street>

            <colony>Vaishali Nagar</colony>

<city>Jaipur</city>

     </address>

</employee>

& CHECK YOUR PROGRESS 14.7

1. All XML documents must have a ___________ element.

2. The first line of an XML document is the ____________.

14.8 VALID AND WELL FORMED DOCUMENTS

An XML document needs to be well formed. Well formed means that the document applies to the syntax

rules for XML. To be well formed a document needs to comply with the following rules:

F It contains a root element

F All other elements are children of the root element

F All elements are correctly paired

F The element name in a start-tag and an end-tag are exactly the same.

F Attribute names are used only once within the same element.
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14.9 USING ELEMENTS

Elements are declared in a DTD using element declarations as:

<!ELEMENT ElementName Type>

The name of the element determines the name of the tag(s) used to mark up the element in XML

document. The name must be unique within the context of a single DTD.  The type of the element is specified in

Type, which is also known as the context specification for the element. XML supports four types of elements:

F Empty– The empty element does not contain any content, but it can contain attributes.

F Element Only – The element only contains child elements.

F Mixed – The mixed element contains a combination of child elements and character data.

F Any – The any element contains any content allowed by the DTD.

The name of an element must not contain the ampersand character(&) or begin with the letter X, M and L

in any case combination(XML, xml, Xml etc.)

14.9.1 Empty Elements

Empty elements serves as a means of representing XML content via a set of attributes, as opposed to text

content. The syntax for declaration is:

<!ELEMENT ElementName Empty>

Example: <!ELEMENT img Empty>

These can be defined in a document in two ways as either with start tag/end tag pair or with an empty tag.

Example: <img src=”city.gif”></img> or

<img src=”city.gif” />

If any content appears between a tag, even a space, the document would be invalid. Second way is better

as it is concise and helps to make it clear that an element is empty.

14.9.2 Element-Only Element

An element-only element contains nothing but child elements. This can be created by listing the child

elements that can appear within the element in the element declaration. The syntax for declaration is:

<!ELEMENT ElementName ContentModel>

The content model is itself specified by using a combination of special element declaration symbols and

child element names. The symbols describe the relationship between the child elements and the container element.

Within the content model, child elements are grouped into sequences or choice groups using parentheses [()].

Groups are separated by pipes[|]. Child elements within a sequence are separated by comma[,]. The following

symbols are used to establish the content model of elements:
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Symbol Name Description 

() Parenthesis A sequence of choice of group of child elements.

, Comma Separate its items in a sequence.

| Pipe Separates the items in a choice group of alternatives.

? Question mark Shows that a child element must appear exactly once or 

not at all

* Asterisk Shows that a child element can appear any number of 
times.

+ Plus Shows that a child element must appear at least once.

No Symbol Shows that a child element must appear exactly once.

Example: <!ELEMENT empdetails(briefintro,(education|expr+)+,interest?,referedby*)>

14.9.3 Mixed Elements

Mixed elements contain both character data and child elements. The simplest mixed element is one that is

declared to contain only character data. Text-only elements are declared using the #PCDATA as:

<!ELEMENT ElementName(#PCDATA)>

The content model for text-only elements consists solely of #PCDATA contained within parentheses,

which indicates that the element contains parsed character data.

Example : <!ELEMENT course(#PCDATA)>

The following show how the course element is defined in a document:

<course>Computer Fundamentals</course>

Elements may also contain unparsed character data(CDATA), but CDATA section should be used within

parsed character data. There is no direct support for a #CDATA type in the content model of an element.

Now on the basis of knowledge gained, we can create a skeleton of a useful  DTD.

<!DOCTYPE page [

<!ELEMENT pages (page)>

<!ELEMENT page(head, body)>

<!ELEMENT head(title)>

<!ELEMENT body(title, para)>

<!ELEMENT author(#PCDATA)>

<!ELEMENT Publisher(#PCDATA)>

]

Mixed elements are declared very much like element-only elements. The content mode for a mixed

element must contain a repeating choice list using the following syntax:
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<!ELEMENT ElementName(#PCDATA | ElementList)*>

Example: <!ELEMENT memo(#PCDATA | title | subject)*>

14.9.4 ANY elements

The ANY element has virtually no structure. It can contain character data, any declared element types or

a mixed type. It can be considered as a wide-open content model. The declaration uses the following syntax:

<!ELEMENT ElementName ANY>

Due to lack of structure, it should be avoided in the document.

& CHECK YOUR PROGRESS 14.9

1. The name of an element must not contain the _______________ .

2. The _________ element has virtually no structure.

3. An __________ element contains nothing but child elements.

14.10 CREATING A XML FILE

14.10.1  File Creation

Use any standard text editor and create a file called mydoc.xml.

14.10.2  Declarations in the file

Declarations must be mentioned in the file which identifies the file as an XML document. Xml syntax does

not just deal with character data and markup. There are also processing instructions, which are special instructions

intended for use by the applications that is processing an XML document. The example of a processing instruction

is the familiar xml processing instruction as:

<?xml version=’1.0’ encoding=’utf-8’?>

14.10.3 Comments addition in XML file

Comments are ignored by XML parsers.

<?xml version=’1.0’ encoding=’utf-8’?>

<!- - A set of my documents - - >

14.10.4  Insertion of a Root Element

Every xml file defines exactly one element, known as root element. Any other elements in the file are

contained within that element.

<?xml version=’1.0’ encoding=’utf-8’?>

<!- - A set of my documents - - >

<mydocument>

  …………………

</mydocument>
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14.10.5  Attributes in an element

<mydocument

author=”Rajeev”

publisher=”abc publisher”

title=”My First XML Document”

>

</mydocument>

14.10.6  Nested Elements in xml document

<mydocument

author=”Rajeev”

publisher=”abc publisher”

title=”My First XML Document”

>

<docu type=”all”>

<title>Introduction to XML</title>

</docu>

</mydocument>

14.10.7  Addition of HTML-Style text

<title>Introduction to <i>XML<i></title>

Since XML allows to define any tags, it makes sense to define a set of tags that look like HTML. The

XHTML standard does exactly that.

14.11 EXTENSIBLE STYLE LANGUAGE (XSL) : A INTRODUCTION

XSL was originally conceived as an answer to the styling needs of XML. XSL effectively defines a superset

of the styling functionality currently available in CSS, but the document transformation capabilities of XSL are particu-

larly suited to XML. When a CSS style sheet is applied to an XML document, it uses the structure of XML tree as

the basis for applying style rules.  XSL is a style sheet technology that addresses two aspects of XML document:

F Transforming document from one type to another(XSLT)

F Styling documents according to formatting rules(XSL Formatting Objects)

XSLT and XSL formatting objects are implemented as an XML vocabulary consisting of relevant

elements and attributes for carrying out each portion of the document rendering process. As both components of

XSL are implemented as XML vocabularies, style sheets created from them are XML documents. This allows to

create XSL style sheets using familiar XML syntax. XML schema is implemented as an XML vocabulary that

replaces a pre-XML approach(DTDs) for describing the structure of XML documents. When an XML document

is transferred using XSL, the transformation applies to the logical tree structure of that XML document. This

means that the result of an XSL transformation is a tree of XML data, not an XML document.
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XSL(extensible style language) is a style sheet technology designed specifically for XML. In many ways,

XSL accomplishes the same things that CSS does. However, XSL goes much further than CSS in manipulating the

logical structure of XML documents. XSL includes some high-powered programmatic constructs that can be

complex.

Difference between XSL and CSS

There are the mainly two differences between XSL and CSS:

F CSS can be used to style HTML document, while XSL cannot.

F XSL can be used to transform XML documents, while CSS cannot.

The real comparative issue between XSL and CSS is browser support. Internet Explorer 5.0 supports a

subset of CSS1 and the proprietary version of XSL.  The following are the three ways in which XSL and CSS can

be used together to provide a hybrid XML style sheet solution:

F Use XSL on the server to transform XML documents into HTML documents that are styled with CSS

style sheet.

F Use XSL on the server to transform XML documents into XML documents that are styled with CSS

style sheet.

F Use XSL on the client to transform XML documents into HTML documents that are styled with CSS

style sheets.

14.14 PROCESSING XSL STYLE SHEET

To understand XSL, a knowledge regarding how an XSL processor processes XML document is must.

Two things are required before an XSL processor can process a document:

F The XML tree representation of the document.

F The XSL style sheet.

The XML tree representation of a document is obtained by parsing the document, which means that the

XSL processor must be coupled with an XML parser in order to function. Assuming that a document is successfully

parsed into a tree, the XSL processor can begin its work. The XSL processor starts with the root node in the tree,

using it to perform pattern matching in the style sheet. An XSL style sheet consists of templates that use patterns to

determine which portions of an XML document are to be formatted. The result tree that is generated by the XSL

processor may contain XSL formatting objects, which are used to format the result tree for display.

The goal of design the architecture of XSL is that it is as flexible and extensible as possible. The important

thing to keep in mind is that XSL is really two languages. XSLT is the XSL transformation language that is used to

transform XML documents from one vocabulary to another. XSL formatting objects is the XSL formatting

language that is used to apply formatting styles to XML documents for display purposes.

XSL Transformation (XSLT)

XSL Transformation (XSLT) is the transformation component of the XSL style sheet technology.  XSLT
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consists of an XML vocabulary that is used to create style sheets for transforming XML document. It operates on

parsed XML data in a tree form and outputs a result tree consisting of a transformed data. It uses a pattern

matching mechanism to select portions of an XML document for transformation.

XSL Formatting Objects

XSL formatting objects is the formatting component of the XSL technology. It is being designed as a

functional superset of CSS, which means that it will contain all of the functionality of CSS.  The syntax of XSL

formatting objects would not necessarily match that of CSS, but the same capabilities will be there. XSL formatting

objects operates on a tree of XML data, which can either parsed directly from a document or transformed from

a document using XSLT.

14.14 BASICS OF XSL STYLE SHEETS

The basic structure of XSL style sheet is very straightforward. An XSL style sheet consists of one or more

templates that describe patterns, which are used to match XML content for styling purposes. The two basic

constructs in an XSL style sheet are:

F Templates

F Patterns

The stylesheet element is the document element for XSL style sheets. This element is part of the XSL

namespace, along with the other elements and attributes that make up XSL. It is required to declare XSL namespace

to use XSL elements and attributes. The declaration is:

<xsl:stylesheet xmlns:xsl=”http://www.w3.org/TR/WD-xsl”>

The prefix for the XSL namespace is set to xsl, which is the common approach used in XSL style sheets.

Templates

A template is an XSL structure that describes output to be generated based upon the certain

pattern-matching criteria. In a style sheet, Single template or multiple templates can be defined. Templates are

defined in XSL stylesheets by using the xsl:template element, which is primarily a container element for patterns

and transformation data.

The xsl:template element uses an optional attribute named match to match patterns in an XML

document. The widest possible match for a document is to set the match attribute to “/”, which indicates that the

root of the tree is to be matched. The result is that the entire tree is selected for the template.

<xsl:template match=”/”>

………

</xsl:template>

The match attribute in a template is like a query in a database language. For example, the following

matches only the element named name:
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<xsl:template match=”name”>

<xsl:value-of/>

</xsl:template>

xsl:value-of element is used to insert the content of an element or attribute for output.

Patterns

Patterns are used in XSL templates to perform matches and ultimately they are responsible for determining

which portions of an XML document are passed through a particular template for transformation. The pattern

contact/city selects city element from contact element.

14.14 XSLT TEMPLATE CONSTRUCTS

The XSLT vocabulary defines several template constructs that control the application of templates in XSL

style sheets. These templates constructs are actually elements that are defined in the XSL namespace. The common

XSLT elements are:

F xsl:value-of

F xsl:for-each

F xsl:apply-templates

xsl:value-of Element

This element is used to insert the value of an element or attribute in the resulting output of the style sheet.

The template used to output of an element called name as html h1 heading is:

     <xsl:template match=”name”>

<h1><xsl:value-of/></h1>

     </xsl:template>

xsl:for-each Element

This element is used to establish a loop for iterating through elements in a document. The select attribute

determines which elements are selected as part of the loop’s iteration. Another attribute order-by specifies criteria

that are used to sort data.

<xsl:for-each select=”empaddress/contact”>

……..

</xsl:for-each>

xsl:apply-templates

This element is used to apply templates that are defined in a style sheet. It supports the select and order-

by attributes. When the XSL processor encounters this attribute, the template corresponding to the pattern in the

select attribute is applied, which means that relevant document data is fed into the template and transformed.

<xsl:apply-templates select=”name”/>

<xsl:apply-templates select=”city”/>
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On the basis of above, we may now build a complete document to view in Internet Explorer 5.0 and

above.

14.15 VIEW THE RECORDS OF XML FILE

To view the records of xml file, we must create the following three files to view in Internet Explorer. The

files are:

F empaddress.dtd

F empaddress.xml

F empaddress.xsl

The coding to see the records of employees are as under:

empaddress.dtd file

<!ELEMENT empaddress (contact)+>

<!ELEMENT contact (name,address+,city,state,pin,phone)>

<!ELEMENT name (#PCDATA)>

<!ELEMENT address (#PCDATA)>

<!ELEMENT city (#PCDATA)>

<!ELEMENT state (#PCDATA)>

<!ELEMENT pin (#PCDATA)>

<!ELEMENT phone (#PCDATA)>

empaddress.xml file

<?xml version=”1.0"?>

<?xml-stylesheet href=”empaddress.xsl” type=”text/xsl”?>

<!DOCTYPE empaddress SYSTEM “empaddress.dtd”[

<!ENTITY amp “&#38;#38;”>

<!ENTITY apos “&#39;”>

]>

<empaddress>

<!— This is my work of XML —>

<contact>

<name>RajeevSrivastava</name>

<address>149, Vaishali Nagar</address>
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<city>Jaipur</city>

 <state>Rajasthan</state>

<pin>302016</pin>

<phone>2350408</phone>

</contact>

<contact>

<name>Rakesh Srivastava</name>

<address>Vidhyadhar Nagar</address>

<city>Jaipur</city>

 <state>Rajasthan</state>

<pin>302016</pin>

<phone>2750618</phone>

</contact>

<contact>

<name>Ramesh Gupta</name>

<address>Tonk Road</address>

<city>Jaipur</city>

 <state>Rajasthan</state>

<pin>302016</pin>

<phone>2654321</phone>

</contact>

</empaddress>

empaddress.xsl file

<?xml version=”1.0"?>

<xsl:stylesheet xmlns:xsl=”http://www.w3.org/TR/WD-xsl”>

   <xsl:template match=”/”>

       <html>

   <head>
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<title>Employee Address Example</title>

   </head>

   <body bgcolor=”#ff6688">

<xsl:for-each select=”empaddress/contact”>

<xsl:apply-templates select=”name”/>

<xsl:apply-templates select=”city”/>

<xsl:apply-templates select=”phone”/>

</xsl:for-each>

   </body>

</html>

     </xsl:template>

     <xsl:template match=”name”>

<h1><xsl:value-of/></h1>

     </xsl:template>

     <xsl:template match=”address”>

<xsl:value-of/><br/>

     </xsl:template>

     <xsl:template match=”city”>

<xsl:value-of/>,

     </xsl:template>

     <xsl:template match=”phone”>

<xsl:value-of/>

     </xsl:template>

</xsl:stylesheet>

After completing the coding of all the above three files. Open the empaddress.xml file in Internet Explorer

and you will receive the output as under:
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14.16 SUMMARY

XML is a markup language in abstract terms or XML is a markup labguage for documents containing

structured information. XML document as an object constructed of various components. XML documents have

both a logical and a physical structure and there are elements and entities. XML specifies neither semantics nor a

tag set. XML is a text-based markup language that is fast becoming the standard for data interchange on the web.

. XSL effectively defines a superset of the styling functionality currently available in CSS, but the document trans-

formation capabilities of XSL are particularly suited to XML. XML document is transferred using XSL, the

transformation applies to the logical tree structure of that XML document. This means that the result of an XSL

transformation is a tree of XML data, not an XML document. A template is an XSL structure that describes output

to be generated based upon the certain pattern-matching criteria.

14.17  GLOSSARY

CSS – Cascading Style sheets, a style sheet language for rendering HTML documents.

CDATA– A part of an XML document in which markup is not interpreted, but is passed to the application

as-it-is.

DTD–A set of rules governing the element types that are allowed within an XML document and specifying

the allowed content and attributes of each element type. The DTD also declares all the external entities



Unit-XIV                       XML (eXtensible Markup Language

285

referenced within the document and the notations that can be used.

Element– A logical unit of information within an XML document.

Entity– Any data that can be treated as an object, such as an external file containing an image.

Valid XML document– A well-formed XML document that also conforms to all the rules governing the

structure of its content expressed in its DTD.

Well-formed XML– An XML document that consists of a single (root) element containing correctly

nested sub-elements. All entity references within a well-formed XML document refer to entities that have

been declared in the DTD or are one of a small set of default entities, and all attribute values are enclosed

in quotes.

XML declaration– A processing instruction at the start of an XML document that declares it to be XML

code.

XML document–A document consisting of an optional XML declaration, followed by an optional document

type declaration and then followed by a document element.

XML Processor–A program that reads XML documents, checks whether they are valid and

well-formed and makes their contents available to XML applications.

14.18 FURTHER READINGS

The following books are suggested for further reading:–

1. XML : Teach Yourself, Techmedia

2. Beginning XML, Shreoff Publishers

3. Applied XML Solutions, Techmedia

4. XML - In Record Time, BPB Publishers

14.19 ANSWERS TO THE SELF LEARNING EXERCISES

 Answers to Check Your Progress 14.2

1. Structured

2. Web

3. Data Interchange

Answers to Check Your Progress 14.3

1. Entities

2. Parameter

Answers to Check Your Progress 14.5

1. Validation

2. Unparsed character data section

3. Internal
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Answers to Check Your Progress 14.7

1. root

2. XML Declaration

Answers to Check Your Progress 14.9

1. Ampersand character(&).

2. ANY

3. element-only

14.20  UNIT-END QUESTIONS

1. What is XML? Write five features for using XML.

2. What is the document type declaration in XML?

3. What are the rules for well-formed documents in XML?

4. What are mixed elements?

5. Differentiate between internal and External DTD.

6. What is XSL? How does XSL helps to XML document?

7. How XSL is better than CSS?

8. How does and XSL processor works?

9. What is DOCTYPE?

10. How can you declare comments in XML document? Explain with example.

����



Unit-XV     Computer  Viruses

287

Unit XV : COMPUTER VIRUS

Structure of  the Unit

15-0 Objectives

15.1 Introduction

15.2 History of Viruses

15.2.1 Summary History Page

15.2.2 Why people create Computer Viruses?

15.2.3 Effects of Computer Viruses

Check your progress

15.3 What is a Virus?

15.3.1  Basic types of Viruses

15.3.2  Other malicious software

15.3.3  How Viruses work?

15.3.4  Replication Strategies

15.3.5 Host types of Viruses

Check your progress

15.4 Virus Detection

15.4.1 Getting a Virus

15.4.2 Warning Signs

15.4.3 Steps to Detect

15.4.4 Highest Risk Operating System

Check your progress

15.5 Virus Protection or Vaccination

15.5.1 Home Users

15.5.2  Business Users

15.5.3  Anti-Virus Softwares

Check your progress

15.6 Summary

15.7 Glossary

15.8 Further Readings

15.9 Answer to the Self Learning Exercise

15.10 Unit-end Questions



288

 Computer  Viruses       Unit-XV

15.0 OBJECTIVES

Before 1988, the word “virus” had a strictly biological meaning. In that year, Robert Morris wrote and

released the first “Internet worm”, forcing everyone in the computer community to immediately consider this new

electronic threat. While Morris created his virus to demonstrate a security flaw in ARPANET, the predecessor to

the Internet, today’s virus writers often have a more malicious intent. The Internet today spans the globe and

serves billions of users, providing an environment in which a single virus can conceivably cause rapid and

widespread damage to systems throughout the world. This unit will look at exploring five primary topics: what is

computer virus? An overview of the major types of viruses and how they function, strategy to handle computer

viruses, how to avoid viruses? Some commonly used viruses and their vaccines.

The most prevalent type of virus today is the e-mail worm, which often exploits security flaws in major

e-mail programs. While there are a number of effective anti-virus software packages on the market to deal with

this problem, many casual computer users do not use them. Most anti-virus response teams also take a reactive

approach to combating viruses, dealing with new threats as they appear. A computer virus comes in contact with

other programs to ‘infect’ them. The damage could consist of important files destroyed, corrupted data, slowing

down of the infected computer, interrupted or unexpected closing of important programs. Viruses have grown in

number and evolved in nature over the past decade. Now need active anti-virus programs, constantly running,

checking every file when download or execute.

15.1 INTRODUCTION TO COMPUTER VIRUSES

The person might have a computer virus infection when the computer starts acting differently. For instance

getting slow or when they turn the computer on, it says that all the data is erased or when they start writing a

document, it looks different, some chapters might be missing or something else abnormal has happened.

If the person read email at their PC or if they use diskettes to transfer files between the computer at work

and the computer at home, or if they just transfer files between the two computers they have a good possibility to

get a virus.

A computer virus is a computer program which reproduces. A computer virus is often simply called a

virus. The term is commonly used to refer to a range of malware, but a true virus does not need to be harmful. To

distribute itself, a virus needs to execute or otherwise be interpreted. Viruses often hide themselves inside other

programs to be executed.

Are all virus bad? A computer virus reproduces by making, possibly evolved, copies of itself in the

computer’s memory, storage, or over a network. This is similar to, but not exactly the same as the way a biological

virus works. It is estimated by some experts that the Mydoom worm infected a quarter-million computers in a single

day in January 2004. Another example is the ILOVEYOU virus, which occurred in 2000 and had a similar effect.

There are tens of thousands of viruses operating in the general Internet today, and new ones are discovered

every day. While a generic explanation of how viruses work is difficult due to the wide variety of infection or

spreading patterns, there are broad categories commonly used to describe various types of viruses.
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15.2 HISTORY OF VIRUS

15.2.1 Summary History Page

A program called “Elk Cloner” is credited with being the first computer virus to appear “in the wild”—

that is, outside the single computer or lab where it was created. Written in 1982 by Rich Skrenta, it attached itself

to the Apple DOS 3.3 operating system and spread by floppy disk. This virus was originally a joke, created by the

high school student and put onto a game. The game was set to play, but release the virus on the 50th time of

starting the game. Only this time, instead of playing the game, it would change to a blank screen that read a poem

about the virus named Elk Cloner. The computer would then be infected.

Elk Cloner was quite the fairy-take character, restricting itself to a fairy harmless rhyme that went like so:

It will get on all your disks

It will infiltrate your  chips

Yes it’s Cloner!

It will stick to you like glue

It will modify RAM too

Send in the Cloner!

The first PC virus was a boot sector virus called (c)Brain, created in 1986 by two brothers, Basit and

Amjad Farooq Alvi, operating out of Lahore, Pakistan. The brothers reportedly created the virus to deter pirated

copies of software they had written. However, analysts have claimed that the Ashar virus, a variant of Brain,

possibly predated it based on code within the virus.

80’s: The spread of the PC and Trojan Horses

1986: First virus

Before 1980 PC’s were the province of the rich or professional. In particular in 1982 IBM started to

release PCs and in 1984 the Apple Macintosh became available. Another thing that became a virus’ best friend

was the floppy disk. This allowed viruses to spread between computers that were not connected.

Basit and Amjad made the first virus. This was a “Laboratory virus” This virus was a boot sector virus.

This virus had no harmful payload. A year later this virus was found on some computers in the University of

Delaware, it had made it there on its own by replicating. That year another virus was made and let loose by

programmer named Ralf Burger, again the payload of the virus was generally harmless. This virus attached itself to

.com files. It was the first executable virus.

1987: Your PC is Stoned, Jerusalem virus Escapes, and Cascading Letters

In 1987 the Jerusalem virus escaped captivity and spread infecting .exe and .com files. This virus caused

infected files that were run on Friday the 13th to be deleted instead of executed. As Friday the 13ths are very rare

this virus did not do a lot of harm.
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It was a memory program. When booting from an infected floppy the message “Your PC is stoned” was

displayed. This virus caused the letters on computer screen to fall down to the bottom of the screen. Of all the

early viruses Jerusalem, Stoned, and Cascade are still common today, very common in fact.

1988: Viruses, do they exist?

1988 was the year of debate for viruses, some said they were urban legends, others believed they existed.

Because of this debate this was a free year for viruses. Viruses infected so many systems that those viruses are still

prominent today. After this year there was no debate about virus exist, they were a reality.

1989: Friday the 13th and the First Hoax Virus

The Jerusalem struck. This was the first media circus that had computer viruses in the center ring. Any

companies that went public with news of an infection were hassled by the media for interviews, until they regretted

going public. A virus called Data crime as was discovered and caused a media frenzy.

1990: Polymorphic Viruses, Other viruses, and the EICAR

1990 saw the first fully polymorphic viruses. These viruses were completely encrypted and hard to detect,

let alone disassemble. The Dark Avenger from Bulgaria started sending many viruses. This year the Whale virus

became famous, not for the damage it did but for how complex it was.

1991: Rise of the scanners, Glut of viruses and the Tequila and Ameoba

It was in this year that the virus problem began to attract large companies to help make software to

combat them. Symantec launched its Norton Anti-Virus; Central Point launched CPAV to name a few. The Te-

quila and Maltese Ameoba virus using all the current virus technology were the beginning of about twelve viruses

that caused much trouble this year.

1992: Self Mutating Engine, Michelangelo scare and Virus creation software

The Dark Avenger released the Self Mutating Engine, which allowed virus authors the world over to

create polymorphic viruses.

1993: More polymorphic engines

1993 was the year of polymorphic engines. A hacker group named Trident came out with Trident

Polymorphic Engine. Nowhere Man, of the Nuke group distributed the Nuke Encryption Device (NED). The

Dark Angel released the Dark Angel’s Multiple Encryptor (DAME).

1996: Boza, Concept, Stoag

This was the year of firsts. Boza was the first virus written just for Win95 files. After Microsoft introduced

the powerful macro language VBA, it did not take long for hackers to recognize this as a great medium for viruses.

Concept was the first Word macro virus. And finally, Stoag became the first virus for Linux.

1998: Strange Brew and Back Orifice

Strange Brew became the first Java virus. Everyone’s favorite hacker group became public this year Cult

of the Dead Cow released Back Orifice to the world at large.
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1999: Melissa, Tristate and Bubbleboy

Melissa was the fastest spreading virus yet. It was a combination macro virus and worm. It spread using

e-mail. The Tristate virus introduced a macro virus that could infect multiple types of files; Word, Excel, and

PowerPoint. Bubbleboy foiled all common beliefs; merely opening the message in OutLook or previewing it in

OutLook Express activated this virus.

2000: Love Letter

The Love Letter worm became the fastest spreading worm in history, shutting down many e-mail systems

in the process. Ironically this worm was human powered. A person needed to click on the attachment in the e-mail

message for it to execute.

15.2.2 Why people create computer viruses?

Unlike biological viruses, computer viruses do not simply evolve by themselves. Computer viruses do not

come into existence spontaneously, nor are they likely to be created by bugs in regular programs. They are

deliberately created by programmers, or by people who use virus creation software. Computer viruses can only

do what the programmers have programmed them to do.

Virus writers can have various reasons for creating and spreading malware. Viruses have been written as

research projects, pranks, vandalism, to attack the products of specific companies, to distribute political

messages, and financial gain from identity theft, spyware, and cryptoviral extortion. Some virus writers consider

their creations to be works of art, and see virus writing as a creative hobby. Additionally, many virus writers

oppose deliberately destructive payload routines. Many writers consider the systems they attack an intellectual

challenge or a logical problem to be solved; this multiplies when a cat-and-mouse game is anticipated against

anti-virus software. Some viruses were intended as “good viruses”. They spread improvements to the programs

they infect, or delete other viruses. These viruses are, however, quite rare, still consume system resources, may

accidentally damage systems they infect, and, on occasion, have become infected and acted as vectors for

malicious viruses. A poorly written “good virus” can also inadvertently become a virus in and of itself (for example,

such a ‘good virus’ may misidentify its target file and delete an innocent system file by mistake). Moreover, they

normally operate without asking for the permission of the computer owner. Since self-replicating code causes

many complications, it is questionable if a well-intentioned virus can ever solve a problem in a way that is superior

to a regular program that does not replicate itself.

15.2.3 Effects of computer viruses

Some viruses are programmed to damage the computer by damaging programs, deleting files, or

reformatting the hard disk. Others are not designed to do any damage, but simply replicate themselves and make

their presence known by presenting text, video, or audio messages. Even these benign viruses can create

problems for the computer user. They typically take up computer memory used by legitimate programs. As a

result, they often cause erratic behavior and can result in system crashes. In addition, many viruses are bug-ridden,

and these bugs may lead to system crashes and data loss.
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& CHECK YOUR PROGRESS

(1) When was the first virus made?

(a) 1982 (b) 1984 (c) 1986 (d) 1991

(2) Where did the first virus come from?

(a) A basement in Chicago (b) A Laboratory (c) Taiwan (d) Dark Avengers

(3) In 1987, which virus escaped captivity and spread infecting “.exe” and “com” files?

(a) 13th virus (b) Friday virus (c) Stoned (d) Jerusalem virus

(4) What type of virus is completely encrypted and hard to detect?

(a) Polymorphic (b) Boot Sector (c) Macro (d) Trojan

(5) When was the first fully polymorphic virus found?

(a) 1991 (b) 1998 (c) 1990 (d) 1992

(6) Which was the first Java virus?

(a) Trisate (b) Bubbleboy (c) Love Letter (d) Strange Brew

(7) In 1999, which virus was the fastest spreading virus?

(a) Trisate (b) Bubbleboy (c) Love Letter (d) Love Letter

(8) In early 2001, which was the famous computer virus?

(a) Trisate (b) Bubbleboy (c) Naked wife (d) Strange Brew

(9) What was the name of the virus that was discovered and caused the first big media frenzy?

(a) First Hoax Virus (b) Data crime (c) Media guarder (d) Dark

(10)Which company had released the “Self Mutating Engine” which allowed virus authors to

create polymorphic viruses?

(a) Dark Avenger (b) Sun (c) Teguila (d) Microsoft

(1) What is the background of the computer virus?

(2) How do create a computer virus?

(3) What are the problems arise when the virus infects computer?

15.3 WHAT IS A VIRUS?

Computer virus acronym V.I.R.U.S. - Vital Information Resources Under Siege

The word virus is derived from and used in the same sense as the biological equivalent. The term “virus”

is often used in common parlance to describe all kinds of malware (malicious software), including those that are

more properly classified as worms or Trojans. Most popular anti-virus software packages defend against all of

these types of attack. In some technical communities, the term “virus” is also extended to include the authors of

malware, in an insulting sense. The English plural of “virus” is “viruses”. The term “virus” was first used in an
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academic publication by Fred Cohen in his 1984 paper Experiments with Computer Viruses, where he credits

Len Adleman with coining it. However, a 1972 science fiction novel by David Gerrold, When H.A.R.L.I.E. Was

One, includes a description of a fictional computer program called “VIRUS” that worked just like a virus (and was

countered by a program called “VACCINE”).

A computer virus is a program that replicates and spreads by attaching 
itself to other programs. When the infected program is run, the virus 

executes an event.  

A program or piece of code that is loaded onto your computer without your knowledge and runs against

your wishes. Viruses can also replicate themselves. All computer viruses are manmade. Since 1987, when a virus

infected ARPANET, a large network used by the Defense Department and many universities, many anti-virus

programs have become available. These programs periodically check your computer system for the best-known

types of viruses.

15.3.1 Basic Types of Viruses

Virus types are used as a way for people to think about the things that viruses do, but being overly

dogmatic about these types can often be confusing. Take these descriptions for the value they bring, but don’t

assume that they are comprehensive or particularly accurate in terms of describing the potential sorts of viruses

that can be encountered. Following figure-1, is showing the families and habitates of the viruses.

Figure-1 : Viruses - Families and Habitats)

(1) File viruses

File viruses, also known as parasitic or executable viruses, are pieces of code that attach themselves to

executable files, driver files or compressed files, and are activated when the host program is run. After activation,

the virus may spread itself by attaching itself to other programs in the system, and also carry out the malevolent
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activity for which it was programmed. Most file viruses spread by loading themselves in system memory and

looking for any other programs located on the drive. Some examples of file viruses are Randex, Meve and

MrKlunky.

(2) Boot sector viruses

A boot sector virus affects the boot sector of a hard disk, which is a very crucial part. The boot sector is

where all information about the drive is stored, along with a program that makes it up. By inserting its code into the

boot sector, a virus guarantees that it loads into memory during every boot sequence. A boot virus does not affect

files; instead, it affects the disks that contain them. Examples of boot viruses are Polyboot.B and AntiEXE.

(3) Multipartite viruses

Multipartite viruses are a combination of boot sector viruses and file viruses. These viruses come in

through infected media and reside in memory. They then move on to the boot sector of the hard drive. From there,

the virus infects executable files on the hard drive and spreads across the system. There aren’t too many multipartite

viruses in existence today, but in their heyday, they accounted for some major problems due to their capacity to

combine different infection techniques. A well-known multipartite virus is Ywinz.

(4) Macro viruses

Macro viruses infect files that are created using certain applications or programs that contain macros.

These include Microsoft Office documents such as Word documents, Excel spreadsheets, PowerPoint presenta-

tions, Access databases and other similar application files such as Corel Draw, AmiPro etc. Since macro viruses

are written in the language of the application and not in that of the operating system, they are known to be

platform-independent—they can spread between Windows, Mac and any other system, so long as they are

running the required application. The first macro virus was written for Microsoft Word and was discovered back

in August 1995. Today, there are thousands of macro viruses in existence—some examples are Relax, Melissa.A

and Bablas.

(5) Network viruses

This kind of virus is proficient in quickly spreading across a Local Area Network (LAN) or even over the

Internet. Usually, it propagates through shared resources, such as shared drives and folders. Once it infects a new

system, it searches for potential targets by searching the network for other vulnerable systems. Once a new

vulnerable system is found, the network virus infects the other system, and thus spreads over the network. Some

of the most notorious network viruses are Nimda and SQLSlammer.

(6) Email Viruses

An email virus could be a form of a macro virus that spreads itself to all the contacts located in the host’s

email address book. If any of the email recipients open the attachment of the infected mail, the virus spreads to the

new host’s address book contacts, and then proceeds to send itself to all those contacts as well. Email viruses can

infect hosts even by previewing the infected email in a mail client. The most common and destructive e-mail virus

is the  ILOVEYOU virus.
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(7) Companion virus

A companion virus does not have host files per se, but exploits MS-DOS. A companion virus creates

new files (typically .COM but can also use other extensions such as “.EXD”) that have the same file names as

legitimate .EXE files. When a user types in the name of a desired program, if a user does not type in “.EXE” but

instead does not specify a file extension, DOS will assume he meant the file with the extension that comes first in

alphabetical order and run the virus. For instance, if a user had “(filename).COM” (the virus) and “(filename).EXE”

and the user typed “filename”, he will run “(filename).COM” and run the virus. Some companion viruses are

known to run under Windows 95 and on DOS emulators on Windows NT systems.

(8) Logic bomb

A logic bomb employs code that lies inert until specific conditions are met. The resolution of the

conditions will trigger a certain function (such as printing a message to the user and/or deleting files). Logic bombs

may reside within standalone programs, or they may be part of worms or viruses. An example of a logic bomb

would be a virus that waits to execute until it has infected a certain number of hosts. A time bomb is a subset of

logic bomb, which is set to trigger on a particular date and/or time. An example of a time bomb is the infamous

‘Friday the 13th’ virus.

(9) Stealth

Some viruses try to trick anti-virus software by intercepting its requests to the operating system. A virus

can hide itself by intercepting the anti-virus software’s request to read the file and passing the request to the virus,

instead of the Operating System. The virus can then return an uninfected version of the file to the anti-virus

software, so that it seems that the file is “clean”.

15.3.2 Other malicious software

Earlier, the only way a computer was at risk was when user inserted an infected floppy. With the new age

of technology, almost every computer is interconnected to the rest of the world at some point or other, so it’s

difficult to pinpoint the source and/or time of the infection. Besides the type of viruses we mentioned, here are

some of the newer problems we face today.

(1) Trojan horses

(1.1) Trojan Horses are impostor files that claim to be something desirable but, in fact, are malicious.

Rather than insert code into existing files, a Trojan horse appears to do one thing (install a screen saver, or show

a picture inside an e-mail, for example) when in fact it does something entirely different, and potentially malicious,

such as erase files. Trojans can also open back doors so that computer hackers can gain access to passwords and

other personal information stored on a computer. For a Trojan horse to spread, it must be invited onto a computer

by the user opening an email attachment or downloading and running a file from the Internet, for example.

(1.2) File-Destructive Trojans The only function of these Trojans is to destroy and delete files. They

can automatically delete all the core system files on machine. The main idea behind Denial of Service (DoS) Attack

Trojans is to generate a lot of Internet traffic on the victim’s machine, to the extent that the Internet connection is

too overloaded to let the user visit a website or download anything.
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(1.3)  Proxy/Wingate Trojans These types of Trojan turn the victim’s computer into a proxy/wingate

server. That way, the infected computer is available to the whole world to be used for anonymous access to

various risky Internet services. The attacker can register domains or access pornographic Web sites with stolen

credit cards or do similar illegal activities without being traced.

(1.4)  FTP Trojans These trojans are probably the most simple, and are outdated. The only thing they do

is open port 21 — the port for FTP transfers — and let everyone connect to machine. Newer versions are

password-protected, so only the attacker can connect to computer.

(2)  Software Detection Killers

These Trojans kill popular anti-virus/firewall programs that protect your machine, to give the attacker

access to it. A Trojan could have any one or a combination of the above-mentioned functionalities.

(3)  Worms

Computer Worms are viruses that reproduce and run independently, and travel across network connections.

Two famous examples of worms are the MS-Blaster and Sasser worms. A worm is a piece of software that uses

computer networks and security flaws to create copies of itself. It replicates itself to the new machine using the

security flaw, and then begins scanning and replicating a new worm. Worms are programs that replicate

themselves from system to system without the use of a host file. This is in contrast to viruses, which requires the

spreading of an infected host file. There is a difference between how worms and viruses use the host file. Usually

the worm will release a document that already has the “worm” macro inside the document. The entire document

will travel from computer to computer, so the entire Effects of computer viruses.

15.3.3 How Viruses work (attack)

Figure 2 : Attack Tree
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Attack trees are conceptual diagrams of threats on systems and possible attacks to reach those threats.

Attack tree for computer viruses. Here we assume a system such as Windows 95, where all users have full system

access. All child nodes operate on OR conditions. Attack trees are multi-leveled diagrams consisting of one root,

leaves, and children. From the bottom up, child nodes are conditions, which must be satisfied to make the direct

parent leaf true; when the root is satisfied, the attack is complete. Only its direct child nodes may satisfy each leaf.

A leaf may be the child of another leaf; in such a case, it becomes logical that multiple steps must be taken to carry

out an attack. For example, consider classroom computers, which are secured to the desks. To steal one, the

securing cable must be cut or the lock unlocked. The lock may be unlocked by picking or by stealing the key.

Threatening, bribing, or distracting a guard may steal the key. Thus a four level attack tree can be drawn, of which

one path is (Bribe Guard, Steal Key, Unlock Lock, Steal Computer). Figure-2 is showing four level of attack tree.

Above condition shows only OR conditions; however, an AND condition can be created by assuming an

electronic alarm which must be disabled if and only if the cable will be cut. Rather than making this task a child

node of cutting the lock, both tasks can simply reach a summing junction. Thus the path ((Disable Alarm, Cut

Cable), Steal Computer) is created.
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The following is an illustration of viruses attack modes, with specific example for each mode is:

1. Virus attacks through email, eg. LOVE-LETA.

2. Virus attacks through downloaded software eg. W32/QA2.

3. Virus attacks through computer network eg. BAT/911-B.

4. Virus attacks through WebPages visiting eg. Macroble.

5. Virus attacks through IRC eg. VBS/Stages-A.

6. Virus attacks through floppy disk eg. Wllop.

15.3.4 Replication strategies

In order to replicate itself, a virus must be permitted to execute code and write to memory. For this

reason, many viruses attach themselves to executable files that may be part of legitimate programs. Viruses can be

divided into two types, on the basis of their behavior when they are executed. Nonresident viruses immediately

search for other hosts that can be infected, infect these targets, and finally transfer control to the application

program they infected. Resident viruses do not search for hosts when they are started. Instead, a resident virus

loads itself into memory on execution and transfers control to the host program.

(1) Nonresident viruses

Nonresident viruses can be thought of as consisting of a finder module and a replication module. The

finder module is responsible for finding new files to infect. For each new executable file the finder module encoun-

ters, it calls the replication module to infect that file.

(2) Resident viruses

Resident viruses contain a replication module that is similar to the one that is employed by nonresident

viruses. However, this module is not called by a finder module. Instead, the virus loads the replication module into

memory when it is executed and ensures that this module is executed each time the operating system is called to

perform a certain operation. For example, the replication module can be called each time the operating system

executes a file. In this case, the virus infects every suitable program that is executed on the computer.

15.3.5 Host types

Viruses have targeted various types of hosts. This is a non-exhaustive list:

F Binary executable files (such as COM files and EXE files in MS-DOS, Portable

Executable files in Microsoft Windows, and ELF files in Linux).

F Volume Boot Records of floppy disks and hard disk partitions.

F The master boot record (MBR) of a hard disk.

F General-purpose script files (such as batch files in MS-DOS and Microsoft.

Windows, VBScript files, and shell script files on Unix-like platforms).

F Application-specific script files (such as Telix-scripts).

F Documents that can contain macros (such as Microsoft Word documents).
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& CHECK  YOUR  PROGRESS

(1) Generally speaking, how many TYPES are computer viruses divided into?

(a) Love-letter and naked-wife (b) Love-letter and naked-wife

(c) Love-letter and naked-wife (d) Hoax message

(2) What is a computer virus?

(a) A self-replicating program

(b) A piece of code that tricks the user

(c) A hoax message

(d) A the computer virus usually inserts itself into other program files, takes over the functionality of the

program and replicates itself

(3) What is a Trojan horse?

(a) A piece of code that tricks the user

(b) A piece of code that makes the computer run fast

(c) A piece of code that is self-replicating

(d) A piece of code that inserts itself into other program files

(4) Before the Internet became popular, what was the major spreading medium of computer

viruses?

(a) Computer books (b) diskettes (c) e-mail (d) software products

(5) Which of the following may indicate a computer virus-infection?

(a) Less available memory than it should

(b) A disk or volume name has been changed

(c) Unknown programs or files have been created

(d) all of above

(6) Computer virus acronym is…………………………………………….

Describe Type Questions?

(1) What is a Computer Virus?

(2) Illustrate how does a virus infect computer?

(3) What are the most common types of viruses and Host types?

(4) What are the replication strategies of the virus?

15.4 VIRUS DETECTION

15.4.1 Getting a Virus

It seems to be a common belief that viruses are spread by games, by shareware. The truth is more

complex. Remember how the most common sort of virus, Boot Sector Viruses, work a physical floppy disk has

to be involved, and there doesn’t need to be any software on it.
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15.4.2 Warning Signs that MAY indicate user have a Virus

1. Programs taking longer to load.

2. Programs (such as MS Word 97 or Quake) crashing for no reason.

3. The hard disk being accessed more often.

4. Files that disappear for no reason and/or frequent file corruption.

5. Devices that once worked now refusing to work even when no changes were made tothe configuration.

15.4.3 Steps to Detect if a Virus is Present

1.  Boot from the hard disk of the computer suspected to be infected.

2.  Format floppy disk in the A: drive.

3.  Copy AUTOEXEC.BAT and CONFIG.SYS from C: to this disk.

4.  Copy all files loaded in AUTOEXEC.BAT and CONFIG.SYS to this disk.

5.  Copy a few COM and EXE files to this disk, preferably programs that you often execute.

Following examples are to showing how can detect the virus from the computer.

1. Figures-3 show how user can detect virus from computer using AVG Anti-Virus

Figures 3 : Detect Virus, AVG Anti-Virus
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1. Figures-4 show User can scan files for viruses using McAfee virus scan

(a) Use the START => Programs => Network Associates => McAfee Virus scan to start Virus Scan

(b) Select the folder you want to scan by using the Browse... button

Figures-4 :  Detect Virus, McAfee Virus scan

15.4.4 Highest Risk Operating Systems

Inadequate security operating systems: following table-1 is showing the highest risk operating systems

Table-1:Highest risk operating system

57 % 47 % 37 % 27 % 17 % 14 % 14 % 14 % 14 %

DOS Macin

tosh

Wind

ows

OS/2 LAN 

Manager

Net 

Ware

Net

Ware

Net 

Ware

Net 

Ware

& CHECK YOUR PROGRESS

1. What are the symptoms and indications of a virus infection?

2. What steps should be taken in diagnosing and identifying viruses?

3. How Do Scan Files for Viruses?

4. What is the inadequate security of different operating systems?
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15.5 VIRUS PROTECTION OR VACCINATION

There  are many ways of prevention from virus those are listed below such as home user,business users,

Anti-virus.

15.5.1 Home Users

There are Steps to ensure safety:

1. Install an anti-virus program.

2. Update the program. Check the company’s web site, new viruses are always being made.

3. Create an anti-virus emergency disk so user can get a clean reboot if ever needed.

4. Use the security settings in browser

5. Update software programs, as virus writers look for holes in system.

6. Contact software makers — they typically do not send e-mail out to user. If you get e-mail, it’s

probably a hoax.

7. Don’t open attached e-mail files — even if user knows the sender, only open it if user is expecting it?

The Most Popular Anti-virus Software for the Home

F Dr Solomon’s Anti-Virus Toolkit

F F-PROT Anti-Virus Toolkit

F InoculateIT

F McAfee Virus Scan

F Norton Anti-Virus

15.5.2 Business Users

The most popular defenses against viruses and people breaking in are firewall protection. There are many

companies, which make firewall software, below are the Norton version.

(1) Norton Anti-Virus Solution Suite

The Norton Anti-Virus Solution Suite is the MAXIMUM virus protection for all corporate environments.

Every company is vulnerable to viruses from at least one entry point, the desktop; but most companies today are

vulnerable at multiple entry points: desktop, network server, Internet e-mail gateway and firewall.

(2) Desktop and Notebook Protection

The anti-virus tools deployed by the organization must protect desktops, notebooks and workstations

against all sources of potential virus threats including - - Internet downloads, floppy disks, e-mail attachments,

shared files, compressed files, CD-ROM’s and networked hard disks.

(3) Network Server and Groupware Protection.

The anti-virus tools used by an organization must provide real-time, scheduled and on-demand scanning
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to protect against transmissions within servers and workgroups running Novell NetWare, Windows NT Server,

Microsoft Exchange and Lotus Notes.

(4) Internet E-mail Gateway and Firewall Protection.

Administrators should be able to route file downloads, uploads and Internet e-mail messaging traffic

through the firewall and SMTP server, where they may be scanned for viruses.

15.5.3 Anti-Virus Software:

There is lots of Anti-Virus software available in the market those are listed below.

(1) Network Monitoring Tools are

(1.1) Argus –Argus is a network-monitoring tool that uses a client-server model to capture data and

associate it into “transactions.” The tool provides network-level auditing.

(1.2) Swatch –The Simple WATCHER program, is an easily configurable log file filter/monitor. Swatch

monitors log files and acts to filter out unwanted data and take one or more user-specified actions based on

patterns in the log.

(2) Authentication/Password Tools

(2.1) Crack – Many system administrators run Crack as a regular system administration procedure and

notify account owners who have “crackable” passwords.

(2.2) Shadow passwords – Under a shadow password system, the /etc/password file does not have

encrypted passwords in the password field. Instead, the encrypted passwords are held in a shadow file that is not

world readable.

(3) Service-Filtering Tools

(3.1) TCP/IP wrapper program -The TCP/IP wrapper program provides additional network logging

information and gives a system administrator the ability to deny or allow access from certain systems or domains

to the host on which the program is installed.

(4) Tools to Scan Hosts for Known Vulnerabilities

(4.1) ISS (Internet Security Scanner) – ISS is a program that will interrogate all computers within a

specified IP address range, determining the security posture of each with respect to several common system

vulnerabilities.

(4.2) SATAN (Security Administrator Tool for Analyzing Networks)– SATAN is a testing and

reporting tool that collects a variety of information about networked hosts. SATAN is available from many sites.

(5) Multi-Purpose Tools

(5.1) COPS (Computer Oracle and Password System) –A COP is a publicly available collection of
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programs that attempt to identify security problems in a UNIX system. COPS does not attempt to correct any

discrepancies found; it simply produces a report of its findings.

(6) Integrity-Checking Tools

(6.1) Tripwire- Tripwire checks file and directory integrity; it is a utility that compares a designated set of

files and directories to information stored in a previously generated database.

Other Tools

1. lsof- lsof lists open files and what UNIX processes have them open.

2. ifstatus -The ifstatus program can be run on UNIX systems to identify network interfaces that are in

debug or promiscuous mode.

3. Smrsh- The smrsh program can help protect against a vulnerability that can allow unauthorized re-

mote or local users to execute programs as any system user.

& CHECK YOUR PROGRESS

1. How Do Scan Files for Viruses?

2. What Anti-Virus Software is Available?

3. How do anti-virus programs work?

15.6 SUMMARY

There are lots of viruses in the world and new viruses are coming up every day. There are new anti-virus

programs and techniques developed too. It is good to be aware of viruses and other malware and it is cheaper to

protect you environment from them rather then being sorry. There might be a virus in your computer if it starts

acting differently. There is no reason to panic if the computer virus is found. It is good to be a little suspicious of

malware when you surf in the Internet and download files. Some files that look interesting might hide a malware. A

computer virus is a program that reproduces itself and its mission is to spread out. Most viruses are harmless and

some viruses might cause random damage to data files. A Trojan horse is not a virus because it doesn’t reproduce.

The Trojan horses are usually masked so that they look interesting. There are Trojan horses that steal passwords

and formats hard disks. Marco viruses spread from applications, which use macros. Macro viruses spreads fast

because people share so much data, email documents and use the Internet to get documents. Macros are also

very easy to write. Some people want to experiment how to write viruses and test their programming talent. At the

same time they do not understand about the consequences for other people or they simply do not care. Viruses

mission is to hop from program to other and this can happen via floppy disks, Internet FTP sites, newsgroups and

via email attachments. Viruses are mostly written for PC-computers and DOS environments. Viruses are not any

more something that just programmers and computer specialist have to deal with. Today everyday users have to

deal with viruses.
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15.7 GLOSSARY

Malware or malicious software is software designed to infiltrate or damage a computer system without

the owner’s informed consent

Mydoom, also known as W32.MyDoom@mm, Novarg, Mimail.R and Shimgapi, is a computer

worm affecting Microsoft Windows. It was first sighted on January 26, 2004. It became the fastest-spreading e-mail

worm ever (as of January 2004).

H.A.R.L.I.E., also referred to by the proper name HARLIE, is an acronym for Human Analog Replication,

Lethetic Intelligence Engine

The Blaster worm (also known as Lovsan or Lovesan) was a computer worm that spread on comput-

ers running the Microsoft operating systems, Windows XP and Windows 2000, during August 2003.

The Sasser is a computer worm that affects computers running vulnerable versions of the Microsoft

operating systems Windows XP and Windows 2000

A boot sector is a sector of a hard disk, floppy disk, or similar data storage device that contains code for

bootstrapping programs (usually, but not necessarily, operating systems) stored in other parts of the disk.

A boot disk is a removable digital data storage medium, normally read-only, that can load (boot) an

operating system or utility program

A filename extension is a suffix to the name of a computer file applied to show its format. It is commonly

used to infer information about what sort of data might be stored in the file.

A command line interface or CLI is a tool for interacting with computers, often using a text terminal.

Commands are entered as lines of text (that is, sequences of typed characters) from a keyboard, and output is also

received as text.

A macro virus is a virus that is written in a macro language.

A hacker is often someone who creates and modifies computer software and computer hardware,

including computer programming, administration, and security-related items.

A modem (from modulate and demodulate) is a device that modulates an analogue carrier signal to

encode digital information, and also demodulates such a carrier signal to decode the transmitted information.

A Bulletin Board System or BBS is a computer system running software that allows users to dial into

the system over a phone line and, using a terminal program, perform functions such as downloading software and

data, uploading data, reading news, and exchanging messages with other users.

Shareware is a marketing method for computer software

A master boot record (MBR) is the first sector (“sector zero”) of a data storage device such as a hard

disk. It is sometimes used for bootstrapping operating systems,

A batch file is a text file containing a series of commands intended to be executed by the command

interpreter. When a batch file is run, the shell program (usually COMMAND.COM or cmd.exe) reads the file and

executes its commands, normally line-by-line.
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CIH, also known as Chernobyl or Spacefiller, is a computer virus written by Chen Ing Hau of Taiwan.

BIOS, in computing, stands for Basic Input/Output System also incorrectly known as Basic

Integrated Operating System. BIOS refers to the software code run by a computer when first powered on.

Polymorphic code is code that mutates while keeping the original algorithm intact. This technique is

sometimes used by computer viruses, shellcodes and computer worms to hide their presence.

Encryption is the process of obscuring information to make it unreadable without special knowledge,

sometimes referred to as scrambling.

A macro in computer science is an abstraction, that defines how a certain input pattern is replaced by an

output pattern according to a defined set of rules.

Antivirus software consists of computer programs that attempt to identify, thwart and eliminate

computer viruses and other malicious software (malware).

The precursor to the Internet, ARPANET was a large wide-area network created by the United States

Defense Advanced Research Project Agency (ARPA).

Database is a collection of records or information which is stored in a computer in a systematic (i.e.

structured) way, so that a computer program can consult it to answer questions.

15.8 FURTHER READINGS

1. Lammer V., Computer Viruses, Virus Bulletin ‘93

2. Helenius M., Computer viruses in Finland - A questionnaire survey, University of Tampere 1994

3. Sudduth A., The What, Why, and How of the 1988 Internet Worm, 1988

15.9 ANSWER TO THE SELF-LEARNING EXERCISE

Answer to the Check your progress 15.2

Objective Questions

1.(c) 2. (b) 3. (d) 4. (a) 5. (c) 6. (d) 7. (a) 8.(d) 9.(b) 10.(a)

Answer to the descriptive type questions

1. A program called “Elk Cloner” is credited with being the first computer virus to appear “in the wild”

— that is, outside the single computer or lab where it was created. Written in 1982 by Rich Skrenta, it attached

itself to the Apple DOS 3.3 operating system and spread by floppy disk.

2. They are deliberately created by programmers, or by people who use virus creation software. Com-

puter viruses can only do what the programmers have programmed them to do.

3. Some viruses are programmed to damage the computer by damaging programs, deleting files, or

reformatting the hard disk. Others are not designed to do any damage, but simply replicate themselves and make

their presence known by presenting text, video, or audio messages.
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Answer to the Check Your Progress 15.3

Objective Type Questions

1.(d) 2. (d) 3. (a) 4. (d) 5. (d)

6. V.I.R.U.S. – Vital Information Resources Under Siege

Answer to the Descriptive Type Questions

1. A computer virus is a program that replicates and spreads by attaching itself to other programs. When

the infected program is run, the virus executes an event.

2. The following is an illustration of viruses attack modes, with specific example for each mode is:

1. Virus attacks through email, eg. LOVE-LETA.

2. Virus attacks through downloaded software eg. W32/QA2.

3. Virus attacks through computer network eg. BAT/911-B.

4. Virus attacks through WebPages visiting eg. Macroble.

5. Virus attacks through IRC eg. VBS/Stages-A.

6. Virus attacks through floppy disk eg. Wllop.

3. Viruses have targeted various types of hosts. This is a non-exhaustive list:

F Binary executable files (such as COM files and EXE files in MS-DOS, Portable

F Executable files in Microsoft Windows, and ELF files in Linux).

F Volume Boot Records of floppy disks and hard disk partitions.

F The master boot record (MBR) of a hard disk.

F General-purpose script files (such as batch files in MS-DOS and Microsoft Windows, VBScript

files, and shell script files on Unix-like platforms).

F Application-specific script files (such as Telix-scripts).

F Documents that can contain macros (such as Microsoft Word documents).

4. Viruses can be divided into two types, on the basis of their behavior when they are executed.

Nonresident viruses immediately search for other hosts that can be infected, infect these targets, and

finally transfer control to the application program they infected. Resident viruses do not search for

hosts when they are started. Instead, a resident virus loads itself into memory on execution and

transfers control to the host program

Answer to the Check Your Progress 15.4

1. Warning Signs that MAY indicate user have a Virus

1. Programs taking longer to load.

2. Programs (such as MS Word 97 or Quake) crashing for no reason.

3. The hard disk being accessed more often.
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4. Files that disappear for no reason and/or frequent file corruption.

5. Devices that once worked now refusing to work even when no changes were made to the

configuration.

2. Steps to Detect if a Virus is Present

1. Boot from the hard disk of the computer suspected to be infected.

2.  Format floppy disk in the A: drive.

3.  Copy AUTOEXEC.BAT and CONFIG.SYS from C: to this disk.

4.  Copy all files loaded in AUTOEXEC.BAT and CONFIG.SYS to this disk.

5.  Copy a few COM and EXE files to this disk, preferably programs that user often executes.

3. User can scan files for viruses using McAfee virus scan

(a) Use the START => Programs => Network Associates => McAfee Virus scan to start Virus Scan

(b) Select the folder you want to scan by using the Browse... button

4. Inadequate security operating systems: following table-1 is showing the highest risk operating systems

Table-1: Highest Risk Operating System

57 % 47 % 37 % 27 % 17 % 14 % 14 % 14 % 14 %

DOS Macintosh Windows OS/2 LAN 

Manager

Net

Ware

Net

Ware

Net

Ware

Net

Ware

Answer to the Check Your Progress 15.5

1. There are Steps to ensure safety:

1. Install an anti-virus program.

2. Update the program. Check the company’s web site, new viruses are always being made.

3. Create an anti-virus emergency disk so user can get a clean reboot if ever needed.

4. Use the security settings in browser

5. Update software programs, as virus writers look for holes in system.

6. Contact software makers — they typically do not send e-mail out to user. If you get e-mail, it’s

probably a hoax.

7. Don’t open attached e-mail files — even if user knows the sender, only open it if user is expecting it?

2. The Most Popular Anti-virus Software for the Home

F Dr Solomon’s Anti-Virus Toolkit

F F-PROT Anti-Virus Toolkit

F InoculateIT
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F McAfee Virus Scan

F Norton Anti-Virus

3. (a) Norton Anti-Virus Solution Suite

The Norton Anti-Virus Solution Suite is the MAXIMUM virus protection for all corporate environ-

ments. Every company is vulnerable to viruses from at least one entry point, the desktop; but most

companies today are vulnerable at multiple entry points: desktop, network server, Internet e-mail

gateway and firewall.

(b) Desktop and Notebook Protection

The anti-virus tools deployed by the organization must protect desktops, notebooks and workstations

against all sources of potential virus threats including - - Internet downloads, floppy disks, e-mail

attachments, shared files, compressed files, CD-ROM’s and networked hard disks.

(c) Network Server and Groupware Protection.

The anti-virus tools used by an organization must provide real-time, scheduled and on-demand

scanning to protect against transmissions within servers and workgroups running Novell NetWare,

Windows NT Server, Microsoft Exchange and Lotus Notes.

(d) Internet E-mail Gateway and Firewall Protection.

Administrators should be able to route file downloads, uploads and Internet e-mail messaging traffic

through the firewall and SMTP server, where they may be scanned for viruses.

SOLVED QUESTIONS

1. What Are The Most Dangerous Types of Attachments?

Ans. The following file extensions show some common file types that can contain executable instructions.

EXE (executable file), BAT (batch file), COM (command file), DOC (MS Word documents containing macros),

PIF (program information file), SCR (screen saver file), SHS (scrap object file), VBE (visual basic script file),

VBS (visual basic script file), WPD (WordPerfect documents containing).

2. How do viruses work?

Ans. Some viruses that are more sophisticated, such as worms, can replicate and send themselves

automatically to other computers by controlling other software programs, such as an e-mail sharing application.

Certain viruses, called Trojans, can falsely appear as a beneficial program to coax users into downloading them.

Some Trojans can even provide expected results while quietly damaging your system or other networked

computers at the same time.

3. How do viruses spread?

Ans. When user execute program code that’s infected by a virus, the virus code will also run and try to

infect other programs, either on the same computer or on other computers connected to it over a network. When

user share a copy of an infected file with other computer users, running the file may also infect their computers; and

files from those computers may spread the infection to yet more computers. Some viruses, known as ‘multipartite’

viruses, can spread both by infecting files and by infecting the boot areas of floppy disks.
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4. What is a Trojan horse program?

Ans. A type of program that is often confused with viruses is a ‘Trojan horse’ program.  This is not a virus,

but simply a program (often harmful) that pretends to be something else. Simply downloading a file to computer

won’t activate a virus or Trojan horse; user has to execute the code in the file to trigger it. This could mean running

a program file, or opening a Word/Excel document in a program (such as Word or Excel) that can execute any

macros in the document.

5. What’s the story on viruses and E-mail?

Ans. User can’t get a virus just by reading a plain-text E-mail message or Usenet post.  What user has to

watch out for are encoded messages containing embedded executable code (i.e., JavaScript in an HTML

message) or messages that include an executable file attachment (i.e., an encoded program file or a Word

document containing macros).

15.10  UNIT-END QUESTIONS

(1) What does antiviral software do?

(2) What are the main types of PC irses?

(3) What is a stealth virus?

(4) What is the best way to remove a virus?

(5) Is it possible to protect a computer system with only software?

(6) What is the best anti-virus program?

(7) Do local area networks (LANs) help to stop viruses or do they facilitate their spread?

(8) Can viruses spread from one type of computer to another?

(9) Is it really possible to use a computer virus for something useful?
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